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ЧАСТИНА І 

РОБОТА В ПРОГРАМІ ADOBE COREL 

ХАРАКТЕРИСТИКА ВЕКТОРНОГО ГРАФІЧНОГО РЕДАКТОРА 

Векторна графіка і растрові зображення є двома основними видами комп'ютерної 

графіки. Векторна графіка складається з ліній і кривих, які створюються на основі 

математичного опису, що задає положення, довжину і напрямок малювання ліній. Растрові 

зображення складаються з крихітних квадратиків, які називаються пікселями, кожен з яких 

має власне становище в зображенні і числові значення кольору. 

Векторна графіка ідеально підходить для створення логотипів та ілюстрацій, так як вона 

не залежить від розширення і може бути збільшена до будь-якого розміру, а також 

роздрукована і відображена при будь-якому розширенні  без втрати деталізації і якості. Крім 

того, векторна графіка дозволяє створювати чітко виражені абриси. 

Для фотографій і цифрових зображень найкраще використовувати растрові 

зображення, тому що вони забезпечують точне відтворення градацій кольорів. Растрові 

зображення мають розширення, тобто складаються з певної кількості пікселів. У звичайних 

обсягах вони виглядають нормально. Однак при збільшенні, а також відображенні або 

друку розширенням, що перевищує вихідне, вони можуть стати нерівними або втратити в 

якості. 

В CorelDRAW можна створювати векторну графіку, а також імпортувати растрові 

зображення (Наприклад, файли JPEG і TIFF) і додавати їх в малюнки.  

 

 

 

 

Рис. 1. Вгорі: Векторна графіка складається з ліній і заливок. Внизу: Растрове зображення 

складається з пікселів. 
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ІНТЕРФЕЙС ТА МЕНЮ ПРОГРАМИ. ПАЛІТРА ІНСТРУМЕНТІВ 

 

 

1) Рядок заголовка, відкритого документа. 

2) Лінійки, регульовані лінії з маркерами, які використовуються для визначення розміру 

і положення об'єкта на малюнку. 

3) Рядок меню, область, містить списки, які розкриваються і команди. 

4) Набір інструментів, використовуються для створення і зміни об’єктів на малюнку. 

5) Вікно малювання, область обмеження полоси прокручування з елементами 

управління додатком, воно включає сторінку малювання і навколишню область. 

6) Сторінка малювання, прямокутна область у вікні малювання. Це частина робочої 

області, доступна до друку. 

7) Палітра документу, закріплена панель, містить зразки кольору для поточного 

документу. 

8) Навігатор документа, область, що включає елементи управління для переміщення 

між сторінками і додаванням сторінок. 

9) Рядок стану, інформація про властивості об’єкта: тип, розміри, колір, заливка та 

розширення. У рядку стану показано поточний стан курсору миші. 

10) Навігатор, кнопка при натисканні якої відкривається маленьке вікно, за допомогою 

якого можна переміщатись по малюнку. 

11) Палітра кольорів, закріплена панель, містить поля зразків кольору. 

12) Вікно налаштувань, в якому міститься набір доступних команд і параметрів, що 

відносяться до певного інструменту або завдання. 

13) Панель властивостей, змінна панель з командами, що відноситься до активного 

інструменту або об’єкту. 

14) Стандартна панель інструментів, плаваюча панель, яка містить клавіші швидкого 

виклику деяких меню та інщих команд, таких як відкриття, збереження і друк. 
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ОГЛЯД ПАНЕЛІ ІНСТРУМЕНТІВ 

 

 
 

Палітра інструментів містить основні інструменти CorelDRAW, що дозволяють 

виконувати створення та редагування об’єктів.  

Деякі інструменти не видно на палітрі. Для того, щоб їх вибрати необхідно навести 

вказівник миші на піктограму інструмента тієї групи, в якій знаходиться потрібний 

інструмент та натиснути ліву кнопку миші. Через певний час з’явиться вкладка, на якій 

будуть показані всі інструменти даної групи. 
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Основою роботи в CorelDraw є панель інструментів, без якої неможливо створити 

жодного малюнка. Призначення інструментів цієї панелі наступне: 
 

Вид 

інструменту 
Назва і призначення інструменту 

Приклад використання 

інструменту 

 

Pick (Указатель) дозволяє виділяти, 

маcштабувати та розтягувати об’єкт 

 

 

FreehandPick (Свободная форма) 

дозволяє виділяти об’єкти рамкою 

довільної форми 

 

 

Free Transform (Свободное переобр

азование) дозволяє вільно трансформуват

и об’єкти, використовуючи FreeRotation 

(Свободное вращение), Angle Rotation 

(Угловое вращение), Scale 

(Масштабирование), Skew (Перекос) 

 

 

Shape (Форма) дозволяє редагувати 

форму об’єкта 

 

 

Smooth (Сглаживание) слугує для 

видалення не рівних країв і зменшує 

кількість вузлів на об’єктах кривих. 

 

 

Smear (Мастихин) дозволяє 

редагувати форму об’єктів 

розтягуванням, збільшенням або 

видовбуванням вподовж його контура 

 

 

Twirl (Скручивание) додає об’єктам 

ефекту крутіння 
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Atract (Притягивание) дозволяє 

змінювати форму об’єкта притягуванням 

вузлів 

 

 

Repel (Отталкивание) дозволяє 

змінювати форму об’єкта розтягуванням 

вузлів.  

 

 

Smudge (Размазывание) скошує 

векторні об’єкти при перетягуванні по 

його контуру. 

 

 

Roughen (Грубая кисть) скошує 

контур векторного об’єкту при 

перетягуванні по його контуру. 

 

 

Croup (Обрезка) дозволяє виділяти 

область, яку потрібно вирізати і 

перевернуть. Працює як з растровими та і 

з векторними об’єктами. 

 

 

Knife (Нож) дозволяє розрізати 

поперек об’єкти 

 

 

VirtyalSegmentDelete (Удаление 

виртуального сегмента) дозволяє 

видалити точки сегментів в середині 

області. 
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Erasel (Ластик) стирає частини 

виконаного малюнку 

 

 

Zoom (Масштаб) дозволяє дивитись 

на об’єкти в збільшеному та зменшеному 

вигляді 

 

 

Pan (Панорамирование) дозволяє 

переміщувати зображення у вікно 

документу і переглядати потрібну 

частину. 

 

 

Freehand (Свободная форма) 

дозволяє малювати поодинокі лінійки 

сегменти або криві. 

 

 

2 – PointLine (Прямая через 2 точки) 

дозволяє намалювати відрізок пряму по 

двом точкам. 

 

 

Bezier (Безье) дозволяє намалювати 

один сегмент кривої за один неприривний 

рух.  
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ArtisticMedia (Художественное 

оформление) забезпечує доступ до 

інструментів Bruch (Кисть), Sprayer 

(Распылитель), Caligraphic 

(Калиграфическое перо), Pressure 

(Нажим).  

 

 

Pen (Перо) дозволяє намалювати 

один сегмент за один неприривний рух.  

 

 

B – Spline (В – сплайн) дозволяє 

малювати криві лінії, встановлюючи при 

цьому контрольні точки таким чином, що 

форма кривої стає плавною, не 

розмножена на сегменти. 
 

 

Polyline (Ломанная линия) дозволяє 

малювати контури, щомають в своєму 

складі багато сегментів. 

 

 

3 – PointCurve (Кривая через три 

точки) дозволяє намалювати контури, які 

складаються із безлічі сегментів. 

 

 

SmartDrawing (Интеллектуальное 

рисование) перетворює і зглажує форму 

намальованої кривої, конвертуючи її в 

стандартні форми. 

 

 

SmartFill (Интеллектуальная 

заливка) виконує заливку будь-якої 

області, що має закриту границю. 

 

 

Rectangle (Прямоугольник) дозволяє 

малювати прямокутники і квадрати 
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3 – PointRectangle (Прямоугольник 

через 3 точки) дозволяє малювати 

прямокутник перетягуванням, створюючи 

основні прямокутники і визначити його 

висоту 

 

 

Ellipse (эллипс) дозволяє малювати 

еліпси і окружності  

 

 

3 – PointEllipse (Эллипс через 3 

точки) дозволяє малювати еліпс 

перетягуванням створюючи центральну 

ось і визначити його висоту 

 

 

Polygon (Многоугольник) дозволяє 

малювати рівносторонні багатокутники і 

зірки. 

 

 

 

Star (Звезда) дозволяє малювати 

зірки, які не матимуть в середині 

пересічних відрізків. 

 

 

ComplexStar (Сложная звезда) 

дозволяє малювати зірки, що мають в 

середині пересічні відрізки. 

 

 

GraphPaper (Разлинованая бумага) 

дозволяє створювати сітку ліній що схожа 

на розліненяний папір. 
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Spiral (Спираль) дозволяє малювати 

симетричні і логарифмні спіралі. 

 

 

BasicShapes (Основные фигуры) 

дозволяє вибирати із повного набору 

форм кутові фігури, посміхаючі лиця, і 

листи з загнутими кутами. 

 

 

ArrowShapes (Фигуры стрелки) 

дозволяє малювати стрілки різної форми, 

направлення і з різними накінечниками. 

 

 

Flowehartshaper (Фигуры схемы) 

дозволяє малювати найбільш поширені 

фігури. 

 

 

BannerShaper (Фигуры банера) 

дозволяє малювати банери 

 

 

CalloutShaper (фигуры выносок) 

дозволяє малювати зноски для підписів та 

поміток. 

 

 

Text (Текст) дозволяє вводити 

фігурний і простий текст 

 

 

Table (таблица) додає таблицю з 

заданою кількістю стовпчиків та рядків 

перетягуючи курсором по діагоналі. 
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ParallelDimension (Параллельные 

размерные линии) дозволяє малювати 

прямі відрізки виміру під будь-яким 

кутом. 

 

 

HorizontalorverticalDimension 

(Горизонтальные или вертикальные 

размерные линии) дозволяє малювати 

горизонтальні і вертикальні відрізки 

виміру. 

 

 

AngularDimension (Угловые 

размерные линии) дозволяє малювати 

кутові лінії виміру. 

 

 

SegmentDimension (Размерные 

линии сегментов) дозволяє відображати 

відстань між кінцевими вузлами в одній 

або декількох сегментах. 

 

 

3 –pointCallout (Выноска через 3 

точки) дозволяє малювати вимірні 

виноски по 3 точкам. 

 

 

Straight – Lineconnector (Прямая 

соеденитальная линия) дозволяє 

малювати з’єднання, використовуючи 

відрізки прямих. 

 

 

Right – AngleConnector 

(Соеденитальная линия под. прямым 

углом) дозволяє малювати з’єднання 

використовуючи відрізки, пересічні під 

прями кутом 

 

 

RounderRight – AngleConnector 

(Соединитальная линия под. 

закругленням прямым углом) дозволяє 

малювати з’єднання пересічних під 

прямим закругленим кутом 
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EditAnchor (Изменить привязку) 

дозволяє редагувати з’єднувальну лінію 

по опірним точкам. 

 

 

DropShadow (Тень) дозволяє 

створювати тінь бедь-якої насиченості і 

ступенем розмиття. 

 

 

Contour (Контур) дозволяє будь-

яким способом оформлювати контур. 

 

 

Blend (Перетекание) дозволяє 

встановлювати перетікання між двома 

об’єктами 

 

 

Distort (Искажение) дозволяє 

деформувати об’єтзигзагом, 

скручуванням  

 

 

Envelope (Оболочка) дозволяє 

деформувати об’єкт у відношенні з 

оболонкою в яку він поміщається  

 

 

Extrude (Вытягивание) дозволяє 

презентувати плоскі зображення 

об’ємними. 
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Transparency (Прозрачность) 

модулює прозорість в градіції сірого, 

використовуючи всі види заливок. 

 

 

ColorEyedropper (Цветовая пипетка) 

дозволяє вибирати і копіювати колір 

одного об’єкта, щоб передати його 

іншому об’єкту 
 

 

AttributesEyedropper (Пипетка 

атрибутов) дозволяє вибирати и 

копіювати такі властивості об’єкта як 

товщина лінії, розмір і другі ефекти  

 

 

InteractiveFill (Интерактивная 

заливка) дозволяє використовувати будь-

які заливки 

 

 

MeshFill (Заливка сетки) ділить 

сіткою об’єкт на частини, кожну із яких 

можна зафарбувати окремо 

 

 

OutlinePen (Перо абриса) дозволяє 

редагувати контур об’єкта, відкриваючи 

діалогове вікно 
 

 

Outlinecolor (Цветабриса) дозволяє 

редагувати контур об’єкта, відкривая 

діалогове вікно 

 

 

NoOutline (Без абриса) дозволяє 

видалити контур об’єкта 
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HairlineOutlane (Визарнаялиния) – 

0,1 mm (Контур 0,1 мм) -, 0,2 mm (Контур 

в 0,2 мм) – 0,25 mm (Контур в 0,25 мм)-

 0,5 mm (Контур в 0,5 мм) дозволяє 

створювати візірну лінію і контури 

об’єкта товщиною в 0,1; 0,2; 0,25; 0,5 

міліметрів  

 

 

0,75 mm – 1 mm -, 1,5 mm – 2 mm – 

2,5 mmКонтури дозволяють створювати 

контур об’єкта товщиною в 0,75; 1, 1,5; 2; 

2,5 міліметрів  

 

 

Color (Цвет) дозволяє швидко 

викликати декорацію кольорової моделі в 

групі інструментів OutlinePen (Перо 

абриса)  

 

 

Editfill (Изменить заливку) викликає 

діалогове вікно для вибору типу заливки 

и її властивості для застосування на 

вибраному об’єкті. 

 

 

Color (Декор цветовой модели) 

дозволяє швидко викликати докер 

кольорової моделі в групі інструментів 

Fill (заливка) 
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Quickcustomize (Быстрая настройка) 

додає на панелі інструментів постійно 

використовуючі елементи і видаляє 

невикористовуючі.  

 

 

 

Панель властивостей, змінна панель з командами, що відноситься до 

активного інструменту або об’єкту. 
 

Відразу після завантаження програми панель властивостей відображає властивості 

документу. 

На панелі властивостей відображаються часто використовувані функції, пов'язані з 

активним інструментом або виконуваними завданнями. Хоча панель властивостей і виглядає 

як панель інструментів, її вміст змінюється в залежності від інструменту або завдання. 

Наприклад, при виборі в наборі інструментів інструменту Текст на панелі властивостей 

відображаються команди, які стосуються до роботи з текстом. У прикладі нижче на панелі 

властивостей відображаються інструменти форматування, вирівнювання і редагування 

тексту. 
 

 

 
 

Поле зі списком Формат паперу дозволяє вибрати один із стандартних розмірів аркуша. 

Найчастіше користуються аркуші, що мають ширину 210 мм і довжину 297 мм (формат А4). 

Папір саме таких розмірів продається в магазинах для друку на принтері. Поля з 

лічильниками Розміри аркуша відображають поточні розміри і дозволяють встановити їх 

вручну. В CorelDraw можна створювати документи, розміри яких перевищують 45 метрів. 

Поле зі списком Одиниці вимірювання - для вибору зручних одиниць вимірюваня 

розмірів аркуша (міліметрів, метрів тощо). 

Розміщення аркуша може бути книжковим або альбомним. 

Змінюють його, клацнувши відповідний індикатор на панелі властивостей. 
 

Формати збереження векторних зображень 

За замовчуванням малюнки зберігаються в форматі файлу CorelDRAW (CDR), який 

сумісний з останніми версіями додатку. Можна також зберегти малюнок, сумісний з більш 

ранньою версією CorelDRAW Graphics Suite, і вказати параметри збереження. Ці параметри 

корисні, якщо файл містить новий текст, заливку, абрис і функції прозорості, які не 

підтримуються в старіших версіях. 

Малюнок можна також зберігати в інших векторних форматах. Якщо потрібно 

використовувати малюнок в іншому додатку, необхідно зберегти його в форматі, який 
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підтримується цим додатком. Для отримання відомостей про збереження файлів в інших 

форматах см. розділ «Імпортування файлів» на стор.. 

При зберіганні малюнка можна вбудувати використані шрифти для полегшення обміну 

файлом. За замовчуванням CorelDRAW вбудовує всі використані шрифти, за винятком 

азіатських шрифтів і шрифтів, які заборонено вбудовувати. 

При збереженні малюнка CorelDRAW надає довідкові відомості, що дозволяють 

спростити подальший пошук і впорядкування малюнків. Можна використовувати тези 

(також відомі як властивості) для заголовка, теми і оцінки. 

Можна також зберігати вибрані об'єкти в малюнку. При збереженні тільки обраних 

об'єктів у великому малюнку розмір файлу зменшується, в результаті чого час завантаження 

малюнка також може зменшитися. 

При збереженні файлу можна скористатися розширеними параметрами, щоб управляти 

збереженням растрових зображень, текстур і векторних ефектів (таких як перетікання і 

витягування). 

Малюнок можна також зберегти як шаблон, що дозволяє створювати інші малюнки з 

такими ж властивостями. Для отримання додаткових відомостей про збереження малюнка як 

шаблону см. розділ «Робота з шаблонами» на стор.. 

Збереження малюнка 

1. Виберіть пункт Файл → Сохранить как. 

2. В полі Имя файла введіть ім'я файлу. 

3. Виберіть папку, в якій необхідно зберегти файл. 

Якщо малюнок необхідно зберегти у векторному форматі, відмінному від CorelDRAW 

(CDR), виберіть цей формат в списку Тип файла. 
 

Макетування в графічному редакторі. Робота з документами 

Визначення макета сторінки 

Роботу над малюнком можна почати, вказавши параметри розміру, орієнтації, а також 

стилю макета сторінки. параметри, обрані під час визначення макета сторінки, можна 

використовувати в якості стандартних для всіх новостворюваних малюнків. Можна також 

налаштувати розмір сторінки і параметри орієнтації, відповідні стандартним параметрам 

паперу для друку. 

Розмір сторінки 

Існує два способи задання розміру сторінки: вибрати готовий розмір сторінки або 

створити власний. Можливо вибрати безліч готових розмірів сторінки: від паперу формату 

legal і конвертів до плакатів і веб-сторінок. якщо готовий розмір сторінки не відповідає 

вимогам, можна створити спеціальний розмір сторінки, вказавши розміри малюнка. 

Можна зберегти спеціальні розміри сторінки в якості заготовок, щоб використовувати їх 

в майбутньому, а також видалити спеціальні розміри сторінки, які більше не будуть потрібні. 

Орієнтація сторінки 

Сторінка може мати альбомну або книжкову орієнтацію. У альбомному режимі ширина 

малюнка більше його висоти, а в книжковій орієнтації висота малюнка більше його ширини. 

Всі сторінки, що додаються до проекту малюнка, мають поточну орієнтацію, проте для 

окремих сторінок в будь-який час можна задати іншу орієнтацію. 

Стилі макета 

При використанні стилю макета за замовчуванням (Вся сторінка) кожна сторінка в 

документі вважається за одну і роздруковується на одному аркуші. Можна вибирати стилі 

макета для багатосторінкових публікацій, таких як буклети і брошури. При виборі стилів 

багатосторінкових макетів ( «Книга», «Брошура», «Будиночок», «Вертикальний буклет» і 

«Горизонтальний буклет» і «Складена втричі брошура») сторінка ділиться на дві або кілька 

рівних частин. 

Кожна частина розглядається як окрема сторінка. Перевага роботи з окремими 

частинами полягає в тому, що кожну сторінку можна редагувати у вікні малювання в 

вертикальній орієнтації і послідовному порядку незалежно від макета, який потрібний для 
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друку документа. При виведенні документа на друк додаток автоматично розташовує 

сторінки в порядку, який потрібно для друку і брошурування. 

Стилі наклейок 

Для вибору доступно більше ніж  800 готових наклейок різних форматів від різних 

виробників. Можна попередньо переглядати розміри наклейок і приміряти їх на сторінці, яка 

роздруковується.  Якщо наданий CorelDRAW стиль наклейок не задовольняє вимогам, 

можна змінити існуючий стиль або створити і зберегти власний стиль. 

Налаштування розміру і орієнтації сторінки 

1. Виберіть Макет → Параметри сторінки. 

З'явиться діалогове вікно Параметры зі сторінкою Размер сторінки. 

2. Виконайте будь-яке завдання, описану в цій таблиці. 
 

Мета Дія 

Вибір готового розміру сторінки Виберіть розмір сторінки в списку Размер. 

Зіставлення розміру сторінки і орієнтації з 

параметрами принтера 

Натисніть кнопку Получить размер 

страницы из принтера 

Визначення спеціального розміру сторінки Введіть значення в поля Ширина і Высота 

Визначення орієнтації сторінки Натисніть кнопку Альбомная або Книжная 

Визначення розміру та орієнтації окремої 

сторінки багатосторінковому документі 

Переконайтеся, що сторінка, яку потрібно 

змінити, відображається у вікні малювання, 

виберіть розмір і орієнтацію сторінки і 

встановіть прапорець Применение 

изменений только для текущей страницы 

Відображення меж сторінки 
Встановіть прапорець Показать границы 

страницы 

Додавання рамки навколо сторінки Клацніть Добавить рамку страницы 

Вибір дозволу відображення документа 
Виберіть дозвіл в списку Разрешение 

отображения 

Установка порога виходу за обріз 

Встановіть прапорець Показывать область 

выхода за обрез і введіть значення в поле 

Выход за обрез 
 

Розмір і орієнтацію сторінки можна також задати, вибравши пункт Вид } Вид порядка 

страниц і налаштувавши елементи управління на панелі властивостей. 

Можна також відкрити діалогове вікно Параметры за допомогою сторінки Размер 

страницы, яка відображається подвійним клацанням по тіні сторінки малювання. 

Додавання або видалення спеціальних готових розмірів сторінки: 

1. Виберіть Макет → Параметры страницы. 

З'явиться діалогове вікно Параметры зі сторінкою Размер страницы. 

2. Виконайте будь-яке завдання, описану в цій таблиці. 
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Мета Дія 

Додавання спеціального готового розміру 

сторінки 

Задайте спеціальний розмір сторінки в 

полях Ширина і Высота, натисніть кнопку 

Сохранить і введіть ім'я користувача 

сторінки в поле Сохранить специальный 

тип страницы как. 

Спеціальний готовий розмір сторінки 

відображається в списку Розмер. 

Видалення готового розміру сторінки 
Виберіть розмір сторінки в списку Размер 

і натисніть кнопку Удалить. 

 

Якщо вибрати інструмент Указатель і не вибирати ніякі об'єкти, то можна також 

додавати і видаляти спеціальні готові розміри сторінки, якщо клацнути пункт 

Редактировать этот список в нижній частині списку Размер страницы 

на панелі властивостей. 

Вибір стилю макета 

1 Виберіть Макет → Макет страницы. 

2 В діалоговому вікні Параметры виберіть стиль макета в поле списку Макет. 

Кожен стиль макета супроводжується коротким описом і ілюстрацією. 

Вибір фону сторінки 

Можна вибрати колір і тип фону для малюнка. Наприклад, однорідний фон можна 

створити за допомогою суцільного кольору. 

Для створення більш складного або динамічного фону можна використовувати растрове 

зображення. прикладом растрових зображень можуть служити текстуровані малюнки, 

фотографії і картинки. 

При використанні растрового зображення в якості фону воно вставляється в малюнок за 

замовчуванням - це рекомендований параметр. Однак можна також зв'язати растрове 

зображення з малюнком, щоб зміни, внесені у вихідне 

зображення пізніше, автоматично відображалися в малюнку. При відправці малюнка, що 

містить зв'язане зображення, необхідно також відправити і саме зв'язане зображення. 

Фонове растрове зображення можна роздруковувати та експортувати, або можна 

експортувати і роздруковувати малюнки без фонового растрового зображення з метою 

економії ресурсів комп'ютера. 

Якщо фон більше не потрібно, його можна видалити. 

Використання суцільного кольору в якості фону 

1. Виберіть пункт Макет → Фон страницы. 

2. Виберіть параметр Сплошной. 

3. Відкрийте меню вибору кольору і виберіть колір. 

Використання растрових зображень як фону 

1. Виберіть пункт Макет → Фон страницы. 

2. Виберіть параметр Растр. 

3. Натисніть кнопку Обзор. 

4. Виберіть папку, в якій зберігається файл. 

5. Двічі клацніть Имя файла. 

6. У діалоговому вікні Параметры виберіть один з наступних параметрів: 

• Зв'язаний: растрове зображення зв'язується з малюнком так, що зміни, що вносяться 

до вихідний файл, відображаються в фоновому растровому зображенні. 

• Вбудований: растрове зображення вбудовується в малюнок так, що зміни, вироблені з 

вихідним файлом, що не відображаються в фоновому растровому зображенні. 

Якщо необхідно, щоб фон роздруковувався і експортувався разом з малюнком, 

встановіть прапорець Роздрукувати і експортувати фон. 
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7. Виберіть один з наступних параметрів: 

Размер по умолчанию: використання поточного розміру растрового зображення. 

Особый размер: дозволяє налаштувати розміри растрового зображення шляхом 

введення значень в поля Г. і В. 

Якщо необхідно задати непропорційні значення висоти і ширини, зніміть прапорець 

Сохранить пропорции. 

Видалення фону 

Виберіть пункт Макет → Фон страницы. 

Виберіть параметр Нет фона. 

Додавання, дублювання, перейменування і видалення сторінок 

В CorelDRAW можна додавати сторінки в малюнок або дублювати існуючі сторінки. 

Можна також перейменовувати сторінки і видаляти одну або всі сторінки. Можна 

переміщати об'єкти з однієї сторінки на іншу. 

При дублюванні сторінки можна скопіювати тільки структуру шарів сторінки або 

скопіювати шари і всі об'єкти, які на них містяться.  

Можна використовувати вид порядку сторінок для управління сторінками під час 

перегляду їх вмісту. Вид порядку сторінок дозволяє змінювати порядок сторінок, а також 

копіювати, додавати, перейменовувати і видаляти сторінки. 

 
Вид порядка сторінок 

 

Додавання сторінки 

1. Виберіть пункт Макет → Вставить страницу. 

2. В області Страницы введіть число сторінок, які додаються в поле 

Количество страниц. 

3. Щоб розмістити нову сторінку до або після поточної сторінки, виберіть 

один з наступних параметрів: 

                • До 

                • Після. 

Якщо необхідно вставити сторінку до або після будь-якої сторінки, крім поточної, 

введіть номер сторінки в поле Существующая страница. 

Дублювання сторінки 

1. Виберіть пункт Макет → Дублировать страницу. 

2. В області Вставить новую страницу діалогового вікна Дублировать 

страницу виберіть один з наступних параметрів: 

• До обраної сторінки 

• Після обраної сторінки 

3. У нижній частині діалогового вікна виберіть один з наступних параметрів: 

                  • Копіювати тільки шари: дозволяє дублювати структуру шарів без 

копіювання їх вмісту. 

                   • Копіювати верстви і їх вміст: дозволяє дублювати шари разом з їх вмістом. 

Перейменування сторінки 

1. Виберіть пункт Макет→ Переименовать страницу. 

2. Введіть ім'я сторінки в поле Имя страницы. 
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Видалення сторінки 

1. Виберіть пункт Макет → Удалить страницу. 

2. В діалоговому вікні Удаление страницы введіть номер сторінки, яку 

необхідно видалити. 

Зміна порядку сторінок 

• Перетягніть вкладки сторінок в навігатор документів. 
 

Переміщення об'єкта на іншу сторінку 

1. Перетягніть об'єкт на відповідну вкладку Сторінки в навігаторі 

документів. 

Сторінка призначення відображається в вікні малювання. 

2. Утримуючі кнопку міші, перетягніть курсор, щоб задати положення 

об'єкта на сторінці. 

Управління сторінками під час перегляду їх вмісту 

1. Виберіть Вид → Вид порядка страниц. 

2. Виконайте будь-яке завдання, описане в цій таблиці: 

Мета 

 

Дія 

 

Зміна порядку сторінок Перетягніть сторінку в нове положення. 

Копіювання сторінки 

Клацніть і утримуйте праву кнопку миші, 

перетягніть сторінку на нове місце, відпустіть 

кнопку і клацніть Скопировать сюда. 

Додавання сторінки 

Клацніть сторінку правою кнопкою миші та 

виберіть пункт Вставить страницу перед 

текущей або Вставить страницу после 

текущей. 

Перейменування сторінки 
Клацніть ім'я сторінки нижче обраної 

сторінки та введіть нове ім'я. 

Видалення сторінки 
Клацніть сторінку правою кнопкою миші і 

виберіть пункт Удалить страницу. 

Зміна розміру ескізів сторінки 

Натисніть одну з кнопок на панелі 

властивостей: 

• Мелкие эскизы 

• Средние эскизы 

• Крупные эскизы 

Повернення до звичайного вигляду Двічі клацніть сторінку. 

 

Вставка номерів сторінок 

Номери сторінок можна додати на поточну сторінку, на всі сторінки, на всі непарні або 

парні сторінки. При вставці номерів сторінок на декількох сторінках автоматично 

створюється новий шар-шаблон, на який додається номер сторінки. Шар-шаблон може бути 

призначений для всіх сторінок, для непарних сторінок або для парних сторінок. 

Номери сторінок автоматично оновлюються при додаванні або видаленні сторінок 

документа. 

Можна також вставити номер сторінки в існуючий фігурний або простий текст. Якщо 

текст розташований на місцевому шарі, номер сторінки додається тільки на поточну 

сторінку. Якщо текст розташовується на шарі-шаблоні, номер сторінки стає частиною шар-

шаблону і відображається на всіх сторінках, якщо видно шар-шаблон.  

Якщо номери сторінок знаходяться на шарі-шаблоні, можна приховати номер сторінки 

на певній сторінці, приховавши відповідний шар-шаблон. 
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Ці параметри для номерів сторінки можна змінити до або після вставки номерів 

сторінок в документ. 

Наприклад, можна почати нумерацію сторінок з певного числа, що відрізняється від 1. 

Це може виявитися корисним при створенні декількох файлів CorelDRAW, які будуть 

розміщені разом в рамках однієї публікації. 

Можна також вказати сторінку, з якої повинна починатися нумерація сторінок. 

Наприклад, якщо вибрати нумерацію сторінок з сторінки 3, на сторінці 3 буде відображатися 

номер 1. Якщо вставити нову сторінку між сторінками 1 і 2, вона стане новою сторінкою 2, а 

колишня сторінка 2 стане сторінкою 3, на якій відображається номер першої сторінки. 

Крім того, доступний широкий вибір часто використовуваних стилів номерів сторінок. 

При збереженні в CorelDRAWХ5 або більш ранню версію номера сторінки зберігаються 

як доступний для редагування художній текст. Крім того, при додаванні або видаленні 

сторінки кількість сторінок не буде оновлюватися. 

Управління номерами сторінок як об'єктами 

Номери сторінок - це об'єкти фігурного тексту (до тих пір, поки не будуть вставлені в 

простий текст), які можна змінити аналогічно будь-якого іншого об'єкту фігурного тексту. 

Наприклад, можна змінити розмір, масштабувати або 

повернути номер сторінки, змінити його колір або застосувати ефекти, такі як заливка 

текстурою або падаюча тінь. 

Якщо номер сторінки знаходиться на шарі-шаблоні, застосування до нього перетворень 

вплине на всі номери сторінок. 

Вставка номера сторінки 

1. Виберіть Макет → Вставить номер страницы і виберіть один з наступних 

параметрів: 

• На активный слой - дозволяє вставити номер сторінки на шар, який в даний момент 

обраний у вікні настройки Диспетчер объектов. Якщо активний шар є шаром-шаблоном, 

номери сторінок додаються на всі сторінки документа, де видно шар-шаблон. Якщо 

активний шар є локальним, номер сторінки додається тільки на поточну сторінку. 

• На все страницы - дозволяє вставити номери сторінок на всі сторінки. Номер 

сторінки вставляється на новому шарі шаблону, який застосовується до всіх сторінок. 

• На все нечѐтные страницы - дозволяє вставити номери сторінок на всі непарні 

сторінки. Номер сторінки вставляється на новому шарі шаблону, який застосовується до всіх 

непарних сторінках. 

• На все чѐтные страницы  - дозволяє вставити номери сторінок на всі парні сторінки. 

Номер сторінки вставляється на новому шарі шаблону, який застосовується до всіх парних 

сторінок. 

За замовчуванням номер сторінки розташовується по центру в нижній частині сторінки. 

Приховування номеру сторінки на одиночній сторінці 

1. Виберіть сторінку у вікні настройки Диспетчер объектов. 

Якщо вікно настройки Диспетчер объектов закрито, виберіть  

Объект → Диспетчер объектов. 

2. Натисніть кнопку Вид диспетчера слоѐв, а потім клацніть Текущая страница 

(только слои). 

На поточній сторінці відображаються тільки шари. Зміни видимості шару впливають 

тільки на поточну сторінку. 

3. Натисніть піктограму Показать или скрыть поруч із шаром-шаблоном, де 

розташований об'єкт номера сторінки. 

Додаток приховує номер поточної сторінки, проте вона як і раніше враховується при 

підрахунку кількості сторінок. На всіх інших сторінках продовжують відображатися номера 

сторінок. 

Зміна параметрів нумерації сторінок 

Виберіть Макет → Параметры нумерации страниц. 

В діалоговому вікні Параметры нумерации страниц виберіть будь-який з наступних 

параметрів: 
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• Начальный номер - дозволяє почати нумерацію сторінок з певного номера. 

• Начальная страница - дозволяє вказати сторінку, з якої буде розпочато нумерацію 

сторінок. 

• Стиль - дозволяє вибрати один загальних стилів нумерації сторінок. 

Використання лінійок 

Можна відобразити лінійки у вікні малювання для більш зручного і точного малювання, 

задання розміру і вирівнювання об'єктів. Можна приховати лінійки або перетягнути їх в інше 

положення у вікні малювання. Параметри лінійки можна налаштовувати відповідно до 

потреб користувача. Наприклад, можна вказати початкову точку лінійки, вибрати одиницю 

виміру і задати кількість міток або поділів, які відображаються у внутрішній частині мітками 

цілих одиниць. 

За замовчуванням CorelDRAW використовує однакові одиниці для лінійок, подвійних 

відстаней і відстаней переміщення. 

Можна змінити значення за замовчуванням і задати різні одиниці для цих та інших 

параметрів.  

Приховування або відображення лінійок 

• Виберіть Вид → Линейки. 

Прапорець поруч з командою Лінійки вказує на те, що лінійки відображаються. 

Переміщення лінійки 

• Утримуючи Shift, у вікні малювання перетягніть лінійку в нове положення. 

Налаштування параметрів лінійки 

1. Виберіть пункт Инструменты → Параметры. 

2. У списку категорій Документ виберіть пункт Линейки. 

3. В області Единицы измерения в списку По горизонтали виберіть одиницю 

вимірювання. 

Якщо для вертикальної лінійки потрібно використовувати інші одиниці виміру, зніміть 

прапорець Одинаковые единицы для обоих линеек і виберіть одиницю вимірювання в 

списку По вертикали. 

4. В області Начало координат введіть значення в наступних полях. 

                              • По горизонтали 

                               • По вертикали 

5. Введіть значення в поле Деления через. 

Калібрування лінійок 

Можна зробити так, щоб один сантиметр на екрані відповідав одному сантиметру 

реального розміру. Це дозволяє працювати з реальними відстанями, а не з відносними, які 

залежать від дозволу екрану. Цей інструмент особливо корисний при роботі зі знаками і при 

малюванні в масштабі 1: 1. 

Перед виконанням цієї процедури необхідно взяти прозору пластмасову лінійку для 

порівняння реальних відстаней і відстаней на екрані. Одиниця виміру на цій лінійці повинна 

бути такою ж, як і та, що використовується для 

лінійок CorelDRAW.  

Калібрування лінійок відповідно до реальних відстанями 

1. Виберіть пункт Инструменты → Параметры. 

2. У списку категорій Робочее пространство двічі клацніть пункт Набор инструментов 

і виберіть параметр Масштаб, Рука. 

3. Натисніть кнопку Калибровка линеек. 

4. Розмістіть прозору пластмасову лінійку під горизонтальною лінійкою на екрані. 

5. За допомогою кнопок зі стрілками вгору або вниз в полі По горизонтали, щоб 

привести у відповідність одиницю виміру лінійки на екрані з одиницею виміру реальної 

лінійки. 

6. Розмістіть лінійку поруч з вертикальною лінійкою на екрані. 

7. За допомогою кнопок зі стрілками вгору або вниз в поле По вертикали, щоб 

привести у відповідність одиницю виміру лінійки на екрані з одиницею виміру реальної 

лінійки. 



27 

Налаштування сітки документа 

Сітка документа - це ряд недрукованих пересічних ліній, які можна відобразити у вікні 

малювання. Сітку документа можна використовувати для точного вирівнювання і 

розташування об'єктів. 

Можна налаштувати вигляд сітки документа, змінивши її відображення і інтервали. 

Відображення сітки дозволяє переглядати сітку документа у вигляді ліній або точок. 

Інтервали дозволяють задати відстань між лініями сітки. Параметри інтервалів залежать від 

одиниці лінійки. Наприклад, якщо в якості одиниць виміру лінійки задані дюйми, параметри 

інтервалів засновані на дюймах. 

Якщо в якості одиниць виміру лінійки задані пікселі або лінійка перебуває в режимі 

попереднього перегляду «Піксель», можна вказати колір і непрозорість сітки пікселів.  

Можна також включити прив'язку об'єктів до сітки документа або сітці пікселів, щоб 

об'єкти при перетягуванні переміщалися по лініях сітки. 

 
 

«Клітчастий» ефект на цьому малюнку був створений за допомогою сітки документа. 
 

Показ або приховування сітки документа 

• Виберіть Вид → Сетка → Сетка документа. 

Прапорець поруч з командою Сетка документа вказує на те, що сітка документа 

відображається. 

Налаштування відображення сітки 

1. Виберіть пункт Инструменты → Параметры. 

2. У списку категорій Документ виберіть пункт Сетка. 

3. Встановіть прапорець Показывать сетку і виберіть один з наступних 

параметрів: 

                      • Сетка в виде линий 

                      • Сетка в виде узлов 

Налаштування інтервалів сітки 

1. Виберіть пункт Инструменты → Параметры. 

2. У списку категорій Документ виберіть пункт Сетка. 

3. В області Сетка документа введіть значення в поле По горизонтали. 

Налаштування масштабу малюнка 

Можна вибрати заготовку або спеціальний масштаб зображення і забезпечити 

пропорційне співвідношення відстаней малюнка і реальних відстаней. Наприклад, можна 

налаштувати масштаб так, щоб 1 дюйм на екрані відповідав реальному 1 метру. Заготівля 

масштабу зображення дозволяє задати звичайний масштаб, наприклад 1: 2 або 1:10. 

Настроюваний масштаб зображення дозволяє визначати будь-яку відстань на сторінці 

для відповідності фактичної віддалі. Наприклад, можна задати більш точний масштаб з 

десятковим дробом, такий як 4,5 до 10,6. 

Масштаби зображень особливо корисні при створенні технічних і архітектурних 

креслень з розмірними лініями. 

Вибір заготовки масштабу малюнка 

1. Виберіть пункт Инструменты → Параметры. 
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2. У списку категорій Документ виберіть пункт Линейки. 

3. За допомогою кнопок Изменить масштаб. 

4. Виберіть масштаб зображення в списку Типовые масштабы. 

Створення спеціального масштабу малюнка 

1. Виберіть пункт Инструменты → Параметры. 

2. У списку категорій Документ виберіть пункт Линейки. 

3. Натисніть кнопку Изменить масштаб. 

4. Виберіть пункт Настройка в списку Типовые масштабы. 

5. Вкажіть необхідні параметри. 
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СТВОРЕННЯ І РЕДАГУВАННЯ ОБ'ЄКТІВ. МАЛЮВАННЯ ГЕОМЕТРИЧНИХ 

ФІГУР. МАЛЮВАННЯ ФІГУР ДОВІЛЬНОЇ ФОРМИ. 
 

Редагування об’єктів 

Рамкою виділення називається група з восьми маркерів (невеликих квадратів з чорною 

заливкою), що позначають на екрані габарити виділеногооб'єкта або декількох об'єктів. В 

центрі рамки виділення знаходиться маркерцентру у вигляді косого хрестика. Елементи 

рамки виділення використовуються при перетвореннях об'єктів. 

На панелі атрибутів представлені елементи управління, що містять параметри моделі 

об'єкта, і кнопки, що дозволяють виконувати стандартні діїнад об'єктами цього класу. 

Для масштабування об’єктів можливо використовувати інструмент «Выбор» , якщо 

за його допомогу виділити об’єкт то його можнамасштабувати за відповідні маркери 

розташовані на обмежувальної рамці(мал.1, а). Для обертання об’єкту досить один раз 

натиснути на виділенийоб’єкт, що призведе до переключення із режим масштабування у 

режим оберту(мал.1. б). Маркер центру обертання можливо довільно розташовувати на 

полідокументу (мал.1,в). 

 

а) б) в) 

Малюнок 1. Редагування об’єктів за допомогою інструмента «Выбор» 

 

За допомогою палітри «Преобразования» можливо використаннянаступних вкладок для 

керування відповідними діями: положення, обертання,масштабування і відображення, розмір 

і нахил (мал.1.1). 
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а) 

б) 

в) 
Малюнок 1.1. Панель «Преобразования» 

  



31 

Формування об’єктів 

Криві і лінії можна сформувати шляхом управління їх вузлами і сегментами за 

допомогою інструменту «Форма» а також шляхом додавання і видалення вузлів при 

активному інструменті «Форма» (мал. 1.2).  

 
Малюнок 1.2 Керуючі елементі при редагуванні опорної точки інструментом«Форма» 

 

Щоб додати вузол, двічі клацніть шлях або клацніть шлях і натисніть кнопку «Добавить 

узлы»  на панелі властивостей. 

Щоб видалити вузол, двічі клацніть його або виберіть вузол і натиснітькнопку 

«Удалитьузлы» на панелі властивостей. 

Щоб зменшити число вузлів, виділіть їх рамкою за допомогою інструменту«Форма» і 

натисніть «Уменьшить число узлов» на панелі властивостей. 

Вузли на об'єкті кривої можна змінити на один з чотирьох типів: перетин,згладжений, 

симетричний або лінія. Маркери управління кожного типу вузлапрацюють по-різному. 

Змінити тип вузла можливо за допомогою відповідноїкоманди на панелі властивостей. 

Прямокутники 

Перетягуючи кути прямокутника за допомогою інструменту «Форма»,можна округлити 

всі його кути (мал., 1.3), або скориставшись відповіднимрегулятором на панелі властивостей 

відрегулювати кожен кут окремо. 

Якщо клацнути інструмент «Прямоугольник», за допомогою панелівластивостей можна 

створити прямокутник із закругленими кутами, кутами звиїмками й фасками. Під час 

масштабування зберігається споконвічний радіускута, тому прямокутники із закругленими 

кутами, кутами з виїмками й фаскамиможна розтягувати без спотворення кутів. 
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Малюнок 1.3 Редагування форми прямокутника інструментом «Форма» 

 

Еліпси 

Щоб створити з еліпса сектор кола, за допомогою інструменту «Форма» потрібно 

перетягнути вузол так, щоб покажчик знаходився всередині еліпса. 

Щоб створити з еліпса дугу, потрібно перетягнуть вузол так, щоб покажчик знаходився 

зовні еліпса (мал.,1.4, а). 

Багатокутники і зірки 

Для зміни форми багатокутника і зірки потрібно активувати інструмент«Форма» і 

перетягнуть вузол в потрібному напрямку. Для створення зірки збагатокутника перетягніть 

вузол до центру (мал.,1.4, б). 

а) 

 

 

б) 

Малюнок 1.4. Редагування форми об’єктів 

 

Інші інструменти зміни форми 

Крім інструменту «Форма», випадаюче меню «Изменить форму» включає інструменти, 

які надають нові творчі можливості для більш точної обробки векторних об'єктів. 

Інструмент «Сглаживание»  дозволяє згладжувати вигнуті об'єкти для усунення 

нерівних країв і зменшення кількості вузлів. Інструменти «Мастихин» і «Размазывание» 

  дозволяють створювати форму об'єкта шляхомперетягування розширень або створення 

відступів уздовж їх контуру. 

Інструмент «Воронка» дозволяє застосувати до об'єкта ефектскручування. Для цього 

клацнути і утримувати об'єкт. Інструменти «Притягивание»  і «Отталкивание» 
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дозволяють створювати форму об'єктів шляхом притягання і відштовхування вузлів. 

інструмент «Грубая кисть»  дозволяє створювати нерівні або зазубрені кромки. Для 

цьогопотрібно провести інструментом по краю об'єкта. 

Перетворення об'єктів в криві 

Перед редагуванням окремих вузлів, об'єкти, створені за допомогоюінструментів форми, 

наприклад інструменту «Прямоугольник» або «Эллипс»,необхідно перетворити в криві 

(«Объект» – «Преобразовать в кривые» абонатиснути Ctrl + Q). Єдиний виняток з цього 

правила – об'єкти, створені задопомогою інструменту «Многоугольник». 

Також у разі використання фігурних нетипових шрифтів перед друкомрекомендується їх 

перетворити в криві, так як при відсутності даних шрифтів віншій системі вони автоматично 

будуть замінені на стандартні, що можезіпсувати композицію. 
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ОПЕРАЦІЇ З ОБ'ЄКТАМИ. ВИКОРИСТАННЯ ІНСТРУМЕНТІВ 

ТРАНСФОРМУВАННЯ. ЗМІНА МАСШТАБУ, ПОРЯДКУ І РОЗМІЩЕННЯ 

ОБ'ЄКТІВ. ГРУПУВАННЯ ТА КОМБІНУВАННЯ ОБ'ЄКТІВ. ВИКОНАННЯ 

БУЛЕВИХ ОПЕРАЦІЙ З ОБ'ЄКТАМИ. ВИРІВНЮВАННЯ ТА ДУБЛЮВАННЯ 

ОБ'ЄКТІВ. 
 

Об’єднання (комбінування) об'єктів 

Об’єднані об'єкти перетворюються в криві Без’є. Результат об’єднання (комбінування) 

приймає параметри контуру і заливки останнього виділеного об'єкта (мал., 1.5) 

а) б) 

Малюнок 1.5 Приклад дії команди об’єднання об’єктів: 

а) – стан об’єктів до об’єднання; б) – стан об’єктів після об’єднання 

 

Зовнішній вигляд об’єднаного об'єкта, отриманого в результаті діїоперації, визначається 

за такими принципами: 

– ділянки, на яких кількість пересічних об'єктів непарне, фарбуються; 

– ділянки, на яких кількість пересічних об'єктів парне, стають прозорими. 

Редагувати зовнішній вигляд отриманого об'єкта можна на рівні вузлів ісегментів, за 

допомогою інструменту «Форма» . 

Щоб застосувати об’єднання, необхідно виділити необхідні об'єкти івиконати команду 

меню «Объект» – «Объединить» (Ctrl + L) або натиснутивідповідну кнопку  на панелі 

властивостей. 

Угруповування об'єктів 

Групування – це операція, що з'єднує набір окремих об'єктів або інших груп в групу. 

Об'єднання об'єктів у групу дозволяє звертатися з ними як зєдиним цілим, виконуючи 

перетворення групи так само, як перетворенняодного об'єкта. Наприклад, групування дуже 

часто застосовується в томувипадку, коли необхідно перенести кілька об'єктів, збудованих 

на зображеннівідносно один одного з яких-небудь принципам. Якби ми 

спробувалиперемістити кожен об'єкт поодинці, то зруйнували б нашу композицію. 

Для створення групи необхідно виділити об'єкти, що зв'язуються в групу.Потім 

необхідно виконати команду «Объект» – «Группа» – «Сгруппировать». 

Інші способи виконання цієї команди наступні: 

 після виділення декількох об'єктів на панелі властивостей стає активноюкнопка 

угруповання  

 натиснути комбінацію клавіш Ctrl + G; 

 відкрити контекстне меню і вибрати команду «Сгруппировать». 

При копіюванні кількох об'єктів відбувається їх переміщення в стопціоб'єктів. Самий 

верхній з об'єктів, що увійшли до групи, залишається в стопці на тій же верхній позиції, а 

решта розташовуються безпосередньо під ним в порядку черговості, зберігаючи своє 

розташування в стопці, відносно один одного. У створену раніше групу можна додавати 

окремі об'єкти. Для цього в панелі «Менеджер объектов» потрібно відкрити список об'єктів, 

що входять в групу. Для цього потрібно клацнути по значку плюс (+), після чого список 
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групи буде розкритий. Після цього потрібно підхопити об'єкт, який поки ще не входить до 

групи, і перетягнути його всередину списку групи. При перетягуванні горизонтальна риса 

буде показувати точку вставки нового об'єкта групи. Після відпускання миші цей об'єкт 

стане членом групи, в яку його відправили. 

Для розгрупування об'єктів необхідно виконати команду «Объект» – «Группа» – 

«Разгруппировать» (Ctrl + U) або «Отменить группировку полностью». Ці ж команди є в 

контекстному меню і на панелі опцій:  і . 

Команда «Разгруппировать» обирається в тому випадку, коли необхідно розбити групу 

на окремі складові об'єкти і групи, які були перед групуванням цього рівня. Команда 

«Отменить группировку полностью» вибирається в тому випадку, коли необхідно розбити 

групу на всіх рівнях, а не тільки на рівні створення даної групи. Наприклад, була створена 

група з 2 об'єкти. Потім була створена група із створеної раніше групи іще з 3 об'єктів. Якщо 

зараз застосувати команду «Разгруппировать», то буде отримана група з 2 об'єктів і 3 

окремих об'єкта. Якщо застосувати команду «Отменить группировку полностью», то будуть 

отримані 5 вихідних об'єктів. 

Після розгрупування об'єкти, що входили до складу групи, залишаються в стопці 

об'єктів на тих же позиціях, які вони займали, будучи в даній групі. Вони не повертаються на 

ті позиції, які займали до створення групи. 

Для того щоб прибрати з групи окремий об'єкт, потрібно відкритипалітру «Менеджер 

объектов» і розкрити список групи. Виділити лівою клавішею миші об'єкт, який ви хочете 

прибрати з групи і, підхопивши його лівою клавішею миші, витягнуть його із списку групи. 

При перетягуванні горизонтальна риса буде показувати точку вставки колишнього члена 

групи. Витягнувши його поза списком групи, відпустіть мишу. Винос об'єктів за межі групи 

можна здійснювати до тих пір, поки в групі не залишиться всього один об'єкт. Після цього 

група автоматично припинить своє існування, так як у групі повинно бути більше одного 

об'єкту. 

Об'єднання і перетин об'єктів 

За допомогою об'єднання і перетину об'єктів можна створювати неправильні форми 

(мал., 1,6). Можна виконати об'єднання і перетин практично будь-якого об'єкта, включаючи 

клони, об'єкти на різних рівнях, а також окремі об'єкти з пересічними лініями. Однак не 

можна виконати об'єднання і перетин звичайного тексту, розмірних ліній або шаблонів 

клонів. 

Можна об'єднати об'єкти для створення єдиного об'єкта з одним абрисом. У новому 

об'єкті в якості абрису використовуватиметься периметр об'єднаного об'єкта, а також 

властивості заливки і абрису об'єкта призначення. Всі пересічні лінії зникнуть. 

Об'єкти можна об'єднувати незалежно від того, перекривають вони один одного. При 

об'єднанні об'єктів, які не перекриваються, вони утворюють групу об'єднання, яка діє як 

єдиний об'єкт. В обох випадках об'єднаний об'єкт отримує атрибути заливки і абрису об'єкта 

призначення. 

Можна об'єднати окремі об'єкти з пересічними лініями, щоб розділити об'єкт на декілька 

внутрішніх контурів, але зберегти його зовнішній вигляд. 

 
 

Малюнок 1.6 Перелік команд пункту головного меню «Объект» – 

«Формирование» 
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Упорядкування об’єктів 

Чим більше об'єктів добавлено в документ, тим важче знайти і вибрати конкретні 

об'єкти. щоб упорядкувати об'єкти, можна додати в документ шари і розташувати відповідні 

об’єкти на відповідних шарах. Шари спрощують одночасний перегляд декількох об'єктів і 

роботу з ними. 

Вікно налаштування «Диспетчер объектов» дозволяє: додавати, переміщати і видаляти 

шари в документі, змінювати порядок накладення об’єктів один на один, додавати сторінки 

та редагувати розміщені на них шари. Можна налаштувати шари перед початком роботи з 

документом або додавати їх у міру необхідності і потім переміщати існуючі об'єкти на нові 

шари. 

Використання прив’язок та вирівнювання і розподіл об’єктів 

У програмі існує набір спеціальних засобів контролю для проведення побудов. Ці 

засоби засновані на можливості прив'язки (прикріплення) створюваних об'єктів до сітки, 

напрямних або іншим об'єктам. Використання прив'язки значно спрощує взаємне 

розташування окремих вузлів і об'єктів щодо один одного. Вам не знадобиться робити 

обчислення, щоб визначити координати для точного розташування об'єкта. Все, що 

необхідно зробити – це активізувати прив'язку до тих чи інших засобам контролю і 

переміщати окремі об'єкти або їх вузли один щодо одного (мал., 1.7). При цьому програма 

буде автоматично вибудовувати і вирівнювати переміщувані об'єкти по лініях сітки, 

напрямних, інших об'єктів або вузлів. 
 

 
Малюнок 1.7. Пункт головного меню «Вид» – «Привязать к» 

 

 

Для уточнення об’єктних прив’язок необхідно скористатися їх вікном налаштувань, яке 

можливо визвати із головного меню «Инструменты» – «Параметры» (мал., 1.8). 
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Малюнок 1.8. Вікно налаштувань об’єктних прив’язок 

 

Програма дозволяє вирівнювати і розподіляти об'єкти. 

Вирівнюванням називається розміщення всіх виділених об'єктів таким чином, щоб їх 

певні точки (наприклад, середина рамки виділення) розташовувалися на одній прямій. 

Застосування координатної сітки і направляють дозволяє вирівнювати об'єкти з високою 

точністю, але для цього потрібно багато додаткових операцій: потрібно створити напрямну 

або задати параметри координатної сітки, а потім індивідуально переміщати кожен з об'єктів. 

Якщо потрібно вирівняти багато об'єктів, робота стає монотонної та виснажливої. У програмі 

передбачений потужний інструмент, що автоматизує вибудовування об'єктів в ряд уздовж 

прямої, положення якої задається одним з об'єктом, що вирівнюється або сторінкою 

документа. 

Далі передбачається, що пряма, що задає напрямок ряду розміщуваних об'єктів, завжди 

паралельна того чи іншого краю друкованої сторінки. Вирівнювання об'єктів по похилій 

прямій можливо тільки в режимі прив'язки до похилій направляє. У цьому випадку всі 

об'єкти доведеться переміщати до бажаних позиціях «вручну». 

Кнопка виклику палітри вирівнювання об'єктів  стає доступна при виділенні двох і 

більше об'єктів на панелі властивостей (мал., 1.9). 

Вирівнювати об'єкти можна відносно центру або країв окремих об'єктів, сторінки або 

довільно зазначеної точки. При вирівнюванні об'єкти одноманітно шикуються відповідно до 

заданими параметрами: по горизонталі або по вертикалі (мал., 1.10). 



38 

 
 

Малюнок 1.9 Панель вирівнювання і розподілу виділених об’єктів 

 

а) 

б) 
в) 

Малюнок 1.10 Рис.4.11. Вирівнювання об’єктів по вертикалі: 

а) – вліво; б) – по центру; в) – вправо; 
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Розподілом об'єктів називається таке розміщення об'єктів, при якому дотримується 

рівність відстаней між маркерами їх рамок виділення. Домогтися цього перетягуванням 

об'єктів вручну практично неможливо. Координатна сітка може допомогти, але її саму треба 

досить ретельно налаштовувати – у багатьох випадках без калькулятора не обійтися. Значно 

зручніше вирішувати таке завдання за допомогою вкладки «Распределить» діалогового вікна 

«Выровнять и распределить». 

Рівномірність при розподілі об'єктів може досягатися двома принципово різними 

способами: рівними можуть бути відстані між однойменними маркерами рамок виділення 

(наприклад, між лівими краями або центрами), або інтервали, що розділяють об'єкти 

(просвіти між ними, що вимірюються, наприклад, від правого краю лівого крайнього об'єкта 

до лівого краю наступного за ним об'єкта). При розміщенні об'єктів з різними габаритними 

розмірами результати розміщення цими двома способами можуть сильно відрізнятися. 

 

Основи роботи з контурами. Використання заливок. Створення фотоколажу. 

Основні властивості контурів 

В CorelDRAW криві складаючи єдиний графічний об’єкт умовно можна розділити на 

об’єкти з замкненим контуром або розімкненим. В свою чергуконтур розглядається як лінія, 

яка утворює межу об’єкта. Контур має таківластивості, як товщина, стиль, завершувачі, кути, 

наконечники, колір та ін. 

Товщина контуру зазвичай вказується у пунктах, хоча може бути задана і вінших 

допустимих програмою одиницях виміру. Колір контуру можливо задати за допомогою 

палітри кольорів. 

Повторювана комбінація штрихів і пробілів, що утворює контур, називається стилем. 

Програма пропонує велику кількість вбудованих стилівконтура і дає змогу створювати 

власні. Якщо контур незамкнений, то варіантиоформлення його кінців (завершувачі) можуть 

бути такими: зріз, закруглення,квадрат. Контур має також властивість, від якої залежить вид 

кута в точкахйого зламу: загострений, скулений або зрізаний. Кінець незамкненого 

контуруможе бути оформлений з використанням спеціального наконечника. Ви 

можетеобрати стандартний наконечник чи створити його власноруч, так само як істиль. 

За умовчанням контур розташовується над заливкою об'єкта. Якщо товщина контуру 

сумірна з розмірами об'єкта, це може суттєво вплинути на його зовнішній вигляд, тому в 

багатьох випадках доцільно помістити контур позаду заливки. 

Використовуючи у своїй композиції різноманітне оформлені контури, слід враховувати 

не лише їхнє розташування відносно заливки, а й ту обставину, що товщина контуру може 

бути фіксованою чи змінюватися в результаті перетворень об'єкта. 

Створення ліній 

В основу моделі ліній покладено два поняття: вузол і сегмент. Вузлом (опорною 

точкою) називають точку на контурі об'єкта, яка фіксує один із кінців сегмента, 

«прив'язуючи» його до певної позиції на зображенні.  

Сегмент — цечастина лінії, що з'єднує два суміжні вузли. Кожний сегмент 

обмежуєтьсядвома вузлами, а кожний вузол може бути розташований на межі не більше 

ніждвох сегментів (перший — вхідний, другий — вихідний). Внаслідокпереміщення вузлів 

сегменти контуру трансформуються, змінюється їхняформа. 

Інструменти для малювання, доступні у випадаючому меню «Кривая», дозволяють 

створювати вигнуті і прямі лінії, а також лінії, що складаються як з вигнутих, так і з прямих 

сегментів. Сегменти ліній з'єднуються за допомогоювузлів (опорних точок), які 

зображуються невеликими квадратами. 

Інструменти «Свободная форма» і «Ломанаялиния» дозволяютьмалювати лінії 

вільної форми також, як при створенні ескізу в блокноті ескізів. 

Інструменти «Безье» і «Перо» дозволяють малювати лінії посегменту за раз, точно 

розміщуючи кожен вузол і контролюючи форму кожноговигнутого сегмента. 
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За допомогою інструменту «B-сплайн»  можна створювати згладжені криві з 

меншою кількістю вузлів у порівнянні з кривими, намальованими з використанням контурів 

вільної форми. 

Створення об’єктів за допомогою інструменту «Кривая Безье» 

Оберіть інструмент «КриваяБезье» з меню «Кривая». Вкажіть точкупочатка креслення 

клацнувши один раз лівою кнопкою миші на обраному місціробочого поля документу (а). 

Оберіть точку кінця відрізку та натиснувши ліву кнопку миші на неї утримуйте кнопку 

зажатою(б) і втой же час зміщайте покажчик миші в будь яку сторону, при цьому 

сегментнабуде криволінійний вигляд в залежності від ваших дій (в). Привиконанні цих дій 

на вузлу з’являться керуючі викривленнями напрямні ізстрілками. Обравши потрібний вид 

кривою кнопку миші слід відпустити.Таким чином добудувавши решту частини об'єкта 

контур потрібно замкнутинатиснув на точку з якої починалися побудови(г). 

  

 
а) 

б) 

 
в) 

г) 
 

Малюнок 2.Створення об’єкту за допомогою інструменту «Кривая Безье» 

 

Для того щоб почати малювати інший об’єкт, або для закінчення роботи текучим 

необхідно натиснути Enter або Esc. Для задання товщини абрисуконтуру необхідно обрати 

інструмент «Выбор» та виділити об’єкт натиснувшина нього. На панелі властивостей 

з’являться керуючі елементи завдяки котримможливо настроїти параметри активного 

об’єкту. 

 
 

Малюнок 3. Налаштування товщини обрису активного контуру 
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Створення фігур 

Прямокутники 

Перетягуючи інструмент «Прямоугольник» по діагоналі, можнанамалювати 

прямокутник або квадрат (для цього необхідно утримуватиклавішу Ctrl). Інструмент 

«Прямоугольник через 3 точки» дозволяє швидкомалювати прямокутники під кутом. 

Еліпси 

Еліпси можна малювати, перетягуючи по діагоналі інструмент «Эллипс» Утримуючі 

клавішу Ctrl можливо зберегти правильну закруглену форму рамки. Інструмент «Эллипс 

через 3 точки» дозволяє швидко малювати еліпси під кутом. Щоб намалювати дугу або 

сектор, натисніть кнопку «Дуга»  або «Сектор»на панелі властивостей і почніть 

перетягування. 

Складні та правильні фігури 

Використовуючи інструменти випадаючого меню «Объект», можн малювати 

багатокутники, сітки, спіралі і два типи зірок: правильні складні. Змінити число сторін 

багатокутника, вершин зірки, стовпців в сітці завитків 

спіралі можна на панелі властивостей. 

Інструменти випадаючого меню «Объект» дозволяють також малюватиосновні фігури, 

стрілки, фігури схем, банерів і винесень. На панелі завдань виберіть заготовку фігури і 

перетягніть маркер у вигляді ромба (гліф), щоб змінити зовнішній вигляд фігури. 

Вікно настройки властивостей об’єкту 

Вікно настройки властивостей об’єкту («Окно» – «Окна настройки» – «Свойства 

объекта») містить варіанти форматування і властивості, що залежать від об'єкта. 

Наприклад, якщо створюється прямокутник, у вікні налаштування «Свойстваобъекта» 

будуть автоматично представлені параметри абрису (мал.5, а), заливки (мал.5, б) і прозорості 

(мал.5, в), а також властивості прямокутника. 

Якщо створюється текстовий фрейм, у вікні налаштування миттєво відображаються 

параметри форматування символів (мал.5.1, а), абзаців (мал.5.1, б) і фрейму, а також 

властивості текстового кадру (мал.5.1, в). 

 

а)  

б) в) 

 

Малюнок 5. Палітра властивостей активного графічного об’єкту 

 

  



42 

 

а) 
б) 

в) 
Малюнок 5.1. Палітра властивостей активного текстового елементу 
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Типи заливки 

Об'єкт можна заповнити однорідною або фонтанної заливкою, а також заливками 

візерунка, текстури, сіткою або заливкою PostScript. 

 

 
 

Однорідні заливки являють собою суцільні 

кольори, які можна вибрати або створити за 

допомогою колірних моделей і колірних палітр. 

Фонтанна заливка (градієнтна) – це змішана 

заливка з двох і більше кольорів з плавними 

переходами. Можна також застосувати до об'єкта 

заливку векторною графікою (заливка векторним 

візерунком) або растровими зображеннями 

(заливка растровим візерунком). 

 Заливки текстурою імітують вид води, хмар, 

каменю і т.п. Заливки PostScript являють собою 

складні заливки текстурою, створені мовою 

PostScript. 

Заливки сіткою створюють плавні колірні 

переходи, що додають об'єктам  реалістичний 

тривимірний об'єм. 

 

 

 

 

Щоб застосувати заливку до об'єкта, в області 

«Заливка» вікнаналаштування «Свойстваобъекта» виберіть тип 

заливки і вкажіть необхідні параметри. Щоб застосувати заливку 

сіткою, використовуйте інструмент «Заливка сеткой» . 
 

Вибір кольорів 

Палітра кольору – це набір зразків кольору. Кольори заливки і 

абриси можна вибирати за допомогою кольорової палітри за 

замовчуванням. Вибрані кольори заливки і абрису відображаються в 

полях зразків кольору у рядку стану. 

Для заливки об'єкта суцільним (однорідним) кольором клацніть 

зразок кольору в кольоровій палітрі або перетягніть зразок на об'єкт. 

Для зміни кольору абрису правою кнопкою миші клацніть зразок 
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кольору в кольоровій палітрі або перетягніть зразок на абрис об'єкта. 

Щоб змішати кольори, виберіть пофарбований об'єкт, натисніть клавішу 

Ctrl і клацніть інший колір в кольоровій палітрі. 

Для вибору відтінку кольору клацніть і утримуйте зразок кольору. 

Можна також вибрати колір заливки і абрису в діалогових вікнах виборукольору. Для 

цього натисніть кнопку «Заливка»  або «Абрис»  в рядку стану. 
 

Доступ до додаткових колірних палітр 

Вікно налаштувань «Диспетчер цветовых палитр» («Окно» – «Окна настройки» – 

«Диспетчер цветовых палитр») дозволяє створювати, упорядковувати, відображати і 

приховувати колірні палітри за замовчуванням і спеціальні палітри. Можна створювати 

палітри RGB, призначені для використання в Інтернеті, і палітри CMYK, розраховані на 

друк, а також додавати колірні палітри інших виробників. 

Вікно налаштування «Диспетчер колірних палітр» включає профілі PANTONE®, у тому 

числі систему PANTONE® Goe ™ і палітру Fashion + Home. 
 

Створення фотоколажу 

Зробити колаж в CorelDraw повинні вміти робити всі, хто практикує дизайн і верстку, 

навіть просто любителі. Існує маса варіантів і технологій верстки колажу. Сьогодні ми 

розглянемо лише один з них - назвемо його колаж - портрет. Досить простий прийом, 

підходить для виконання навіть новачкам - і при цьому виглядає досить ефектно. 

Ось короткий огляд основних кроків, які необхідно виконати при створенні колажу - 

портрета в CorelDraw: 

1. Вставляємо растровий портрет в новий документ corel- просто перетягуючи його 

туди. 

2. Малюємо два квадрата. Один білий і один сірий, трохи менше, зверху білого. 

Групуємо ці квадрати. 

3. Розмножуються отримані згруповані квадрати, розподіляємо їх довільно і повертаємо 

в різні боки. 

4. Беремо інструмент "інтелектуальна заливка" (smartfill), заливаємо все сірі місця 

скомпанован квадратів. 
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5. Виділяємо з затиснутим шифтом все освічені "розумної заливкою" області. 

Об'єднуємо їх в одну фігуру. 

 
 

6. Виділяємо портрет, вибираємо в ефектах "PowerClip", поміщаємо картинку в 

контейнер, утворений фігурою, зробленої за крок 5. 

 

 
 

7. Редагуємо розташування портрета щодо контейнера PowerClip, для кращого візуально 

сприйняття. 
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8. Прибираємо чорну обведення у всіх об'єктів. 

 

 
 

9. Розбиваємо контейнер PowerClip на окремі картинки. 
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10. Додаємо тіні до білих рамочок 
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Створення тіні 

Для створення зображень і колажів в різних графічних редакторах однією з поширених 

функцій є створення тіні. Наявність тіні в об’єкта візуально акцентує його і надає йому більш 

реалістичний вигляд. Функцією створення тіней забезпечені багато видавничі програми, що 

працюють із зображеннями. Графічний редактор CorelDraw можна використовувати для 

створення тіні як у растрових так і у векторних об’єктів за допомогою вбудованих функцій. 

1. Створення тіні: процес творчий і копіткий. Найважливішим аспектом для початку 

процесу є визначення джерела світла. Але в програмі CorelDraw весь процес створення тіні 

відбувається досить швидко й наочно. Якщо ви хочете створити тінь растровому об’єкту, то 

його потрібно імпортувати на малюнок CorelDraw через функцію «Імпорт». Для початку 

звільніть малюнок від фону. Якщо фон являє собою однорідну заливку, то очистити фон 

можна за допомогою функції «Колірна маска» (ColorMask). 

 

 
 

2. Увійдіть в режим «кольорової маски», візьміть пробу кольору піпеткою, встановленої 

на панелі маски, посуньте плаваючий курсор «Допуск» (Tolerance) на 5-10% і натисніть 

кнопку «Застосувати» 

(Apply). Слідкуйте, щоб 

при цьому не зникла 

частина потрібного вам 

зображення. 

3. Коли зображення 

буде вже очищено від 

фону, на панелі 

інструментів знайдіть 

кнопку «Інтерактивна 

тінь» (DropShadow). Цей 

інструмент, за 

умовчанням, знаходиться 

в списку інструментів 

«Перетікання», «Обсяг» та ін Вибравши цей інструмент на панелі, клацніть мишею по 

об’єкту, вибравши при цьому крапку, з якої тінь буде падати і тягніть миша в ту сторону, в 

яку об’єкт буде цю тінь відкидати 
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4. Якщо результат вас не задовольнить, вибравши цей інструмент знову, ви можете 

відкоригувати напрямок, колір тіні і її додаткові режими на власній панелі цього 

інструменту. 

 

 
 

5. Для завершення результату можете покласти зображення на фон, помістивши його 

над об’єктом з фоновою заливкою. Тепер ви можете порівняти два зображення. Яке з них 

виглядає реалістичніше? 
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6. Створенням тіні можна вигідно підкреслити фотографії, складаючи з них колажі. 

Зараз на зображенні фотографії просто розташовані на фоні. 

 

 
 

7. За допомогою тіні фото виглядають більш об’ємно і акцентовано. Для декорування 

можна вибрати тематичний фон для колажу. Фотографії можна підписати, надавши шрифту 

тінь, що буде логічним для композиції колажу. 

8.  
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9. Створення тіні для об’єктів, намальованих в самій програмі або імпортованих 

векторних об’єктів, підтримуваних CorelDraw, теж досить просто. Клацніть мишею по 

об’єкту при обраному інструменті «Інтерактивна тінь» (DropShadow) і перетягніть мишу в 

сторону передбачуваної тіні. Для малюнків, що складаються з групи векторних об’єктів, 

можна створити тінь, не роз’єднуючи їх. Просто виберіть інструмент «Інтерактивна тінь» 

(DropShadow) і перетягніть групу об’єктів в потрібну сторону. Тінь відобразиться для всієї 

групи об’єктів. 

 

 
 

Зверніть увагу 

Для створення більш складної за своєю структурою тіні використовуйте інструменти 

«Інтерактивна заливка» або «Заливка сітки», попередньо розділивши групу з об’єкта і його 

тіні. 
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РОБОТА З ПРОСТИМ ТА ФІГУРНИМ ТЕКСТОМ.  

ФОРМАТУВАННЯ ТЕКСТУ. 
 

Робота з текстом 

Текст є важливим елементом у структурі та макеті документів. Він не тільки передає 

читачам конкретну інформацію, але і виступає в якості елемента дизайну. 

Додавання фігурного і простого тексту 

В CorelDRAW можна створювати текстові об'єкти двох типів – шикарні і прості. 

Обраний варіант залежить від потреб і вимог. 

Фігурний текст (мал., 7,а) дозволяє швидко додати одне слово або короткій рядок 

тексту і призначений для створення коротких написів, заголовків, девізів і т. п., до яких 

можна застосовувати різні спеціальні ефекти. 

Він ідеально підходить для вставки заголовків або додавання тексту уздовж шляху. Щоб 

вставити фігурний текст, виберіть інструмент «Текст» (F8), клацніть вікно документа і 

введіть текст. Знизу кожного символу є маркер керування, яким можливо редагувати 

місцеположення символів інструментом «Форма». 

Звичайний текст (мал.,7, б) підходить для додавання великого обсягу тексту, до якого 

пред'являються більш складні вимоги до форматування. 

Звичайний текст міститься в текстовому фреймі і підходить для створення таких 

документів, як брошури, інформаційні бюлетені або каталоги. Такий текст розбитий на 

абзаци, як в будь-якому сучасному текстовому редакторі, тому робота з простим текстом 

заснована на зміні властивостей його абзаців. 

Щоб додати звичайний текст, виберіть інструмент «Текст», розтягніть у вікні документа 

текстовий фрейм потрібного розміру і введіть текст в цьому фреймі. 

Текст можна поміщати в графічні об'єкти, що збільшує число різних фігур, які можна 

використовувати як текстові кадри. Щоб перетворити об'єкт в текстовий фрейм, клацніть 

об'єкт правою кнопкою миші, виберіть пункт «Тип фрейма», а потім – команду 

«Создатьпустойтекстовый фрейм». 
 

а) 

б) 

Малюнок 7. Приклад видів тексту 

 

Текст на кривій 

Текст в CorelDRAW може розташовуватися не тільки по рядках, але і вздовж довільних 

кривих, а також усередині замкнутих фігур. 

Створити текст, вибудуваний уздовж довільної лінії, можна двома способами. 

По-перше, можна спочатку написати фігурний текст, потім намалювати лінію, а після 

цього виділивши текст вибрати команду меню «Текст» –«Текст вдолькривой». 

По-друге, можна створити лінію, активувати інструмент «Текст» і підвести його до лінії. 

Як тільки покажчик миші прийме вид , клацайте лівою кнопкою і починайте набирати текст 

– він буде вибудовуватися уздовж даної кривої. 

Набраний текст можна редагувати (набирати і видаляти символи). Можна також 

зрушувати його вздовж направляючої лінії, переміщаючи кольоровий маркер на початку 

рядка. Більш складне модифікування тексту на кривій можливо за допомогою панелі 

властивостей (мал., 7.1). 
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Малюнок 7.1. Приклад розміщення тексту по кривій 

 

Форматування Символів 

Зовнішній вигляд тексту можна поліпшити шляхом вибору і форматування символів. 

Щоб виділити текст для редагування, виберіть інструмент «Текст» і перетягніть курсор 

уздовж тексту. В CorelDRAW властивості об'єктів, такі як тип шрифту і колір тексту, можна 

змінювати у вікні налаштування «Свойства объекта» або при активному режимі редагування 

тексту у панелі властивостей. 

У вікні «Свойства текста» або «Свойства объекта» доступна більшість параметрів 

форматування абзаців і налаштування текстового кадру. 

Щоб отримати доступ до параметрів форматування виберіть команду «Окно» – «Окна 

настройки» – «Свойства объекта» і натисніть кнопку «Символ». 

Створення афішно – плакатної продукції 

Відкриваємо програму CorelDraw і створюємо новий документ.  

1. У меню натискаємо Фото, в випадаючому меню - НОВИЙ,  

2. Відкривається вікно СТВОРЕННЯ ДОКУМЕНТА, в якому задаємо ім'я документа, 

розміри вибираємо в пікселях (це розміри сторінки, на якій будемо малювати банер зі своїми 

розмірами). Задаємо дозвіл зображення (в нашому випадку для маленьких зображень 

великий дозвіл не обов'язково). Задаємо при необхідності колірний профіль (можна нічого не 

міняти). 
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Малюємо прямокутник. Задаємо розмір, рухаючи чорні мітки по краях фігури. 

 

 
 

Зафарбовуємо область прямокутника заливкою і краю обведенням (абрис) вибраними 

кольорами. 
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При необхідності можна вставити в банер готові векторні фігури, форму яких можна 

редагувати за допомогою опорних точок. Зафарбовуємо кольором. 

 

 
 

Вставляємо текст, задаємо розмір, вид шрифту і колір. 
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Як вставити  посилання в банер в CorelDraw. 

1. Вставляємо посилання в банер в CorelDraw. Права кнопка миші на банері - у 

відкривається меню властивості ОБ'ЄКТА - у вікні вибираємо ІНТЕРНЕТ, у відповідному 

полі створюємо одне з посилань. 

2. Зберігаємо банер з допомогою експорту в растрових форматах, або експортуємо в 

інтернет. Для збереження в векторі тиснемо Зберегти як .. 

 

 
 

Вікно експорту. Зберегти банер в потрібному форматі, ЗБЕРЕГТИ ЯК ... 
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Імпорт растрових зображень. 

Виготовлення банера з допомогою растрового зображення. У розкритому меню Фото - 

натискаємо ІМПОРТ, вибираємо в комп'ютері необхідну картинку. Вставляємо наше 

растрове зображення в потрібне місце, переміщуючи курсор у вигляді трикутника на 

документі. 

 

 
 

Підганяємо розмір растрового зображення під розмір банера з допомогою чорних міток 

навколо активної картинки. 
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ЛАБОРАТОРНО-ПРАКТИЧНІ РОБОТИ 
 

ЗАВДАННЯ №1 

СТВОРЕННЯ ТА РЕДАГУВАННЯ ОБ’ЄКТІВ 
 

Мета роботи: набути навичок з редагування графічних об’єктів. Навчитися використовувати 

прив’язки при розташуванні графічних об’єктів в документах. Вивчити принципи вирівнювання 

об’єктів. 

Завдання: за допомогою інструментів «Эллипс», «Прямоугольник», «Кривая Безье» і «Форма» 

створіть графічний об’єкт подібний до наведеного на прикладі (мал., 1.11, 17). 

Порядок виконання роботи 

1. Відкрити документ «Лабораторні роботи». 

2. На сторінці з назвою «Лабораторна 2» створіть два графічних елемента: коло і прямокутник 

подібні до наданих у прикладі (мал., 1.11, 1), відповіднимиінструментами. 

3. Виділіть об’єкти та вирівняти їх за центрами (). 

4. Виділіть об’єкти та проведіть дію вирізання з кола прямокутника командою головного меню 

«Объект» – «Формирование» – «Исключить» (мал.,1.11, 3). 

5. Виділіть прямокутник та поверніть його на 45 градусів у будь-яку сторону (мал.,1.11, 4). 

Повторіть дію вирізання з кола прямокутника. Повертайте прямокутник та повторяйте дію 

вирізування з кола до отримання результату наприкладі (мал.,1.11, 5). 

6. Видалити прямокутник. Створіть окружність більшого за об’єкт радіусу із центру (зажати на 

клавіатурі під час створення окружності Ctrl і Shift) (мал.,1.11, 6). 

7. Зробіть заливки та задайте ширину обведення об’єктів відповідно до прикладу (мал.,1.11, 7). 

8. Згрупуйте усі об’єкти. Виділіть згрупований об’єкт та продублюйте його (комбінація клавіш 

Ctrl + D). Розмістить обидва об’єкти на подібної до наданоїна прикладі відстані. Виділіть обидва 

об’єкти та вирівняйте їх по верхній грані(мал.,1.11, , 8). 

9. Створіть прямокутник з кутами на центрах дубльованих об’єктів (мал.,1.11, 9). 

10. Перетворіть прямокутник в криві відповідною командою або комбінацією клавіш Ctrl + Q, за 

допомогою інструмента «Форма» надайте форму прямокутника подібну до приведеної на прикладі 

(мал.,1.11, 10). 

11. Створіть два прямокутника (мал.,1.11, 11), перетворіть їх у криві та надайте їм форму 

подібну до наданої у прикладі (мал.,1.11, 12). 

12. Створіть інші елементи та надайте їм відповідні кольори (мал.,1.11, 13). 

13. З допомогою інструменту «КриваяБезье» створіть лінії поєднання колеса тазірки (мал.,1.11, 

14). 

14. Створіть два прямокутника над рамою, перетворіть їх в криві (мал.,1.11, 15). 

15. Надайте прямокутникам над рамою форму сідла. Створіть руль таким ж чином (мал.,1.11, 

16). 

16. Орієнтуючись на приклад виконання завдання створіть недостаючи елементи оформлення 

об’єкту (мал.,1.11, 17). 

17. Збережіть роботу натиснувши Ctrl + S. 
 

1) 

2) 
3) 

4) 
 

Малюнок 1.11. Приклад кроків виконання роботи 
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5) 6) 7) 
8) 

 

9) 
10) 

11) 12) 

 

13) 
14) 15) 

 

16) 17) 
 

Малюнок 1.11. Приклад кроків виконання роботи 

 

Питання для самоконтролю 

1. Чи можливо тимчасово приховати зображення на певних шарах? 

2. Чи можна видалити усі шари з документу? 

3. Яким чином можливо трансформувати фоновий шар у звичайний або навпаки? 
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ЗАВДАННЯ №2 

ОСНОВНІ ПРИНЦИПИ СТВОРЕННЯ ГРАФІЧНИХ ОБ’ЄКТІВ 

Мета роботи: набути навичок роботи з інструментами створеннярізноманітних 

графічних об’єктів. 

Завдання: користуючись інструментами «КриваяБизье» і «Выбор» створіть замкнений 

контур подібний до прикладу. Внутрішню частину контуру заповніть замкненими 

сегментами, створивши їх інструментом «КриваяБизье». 

Порядок виконання роботи 

1. Відкрити документ «Лабораторні роботи». 

2. На сторінці «Лабораторна 1» користуючись інструментом «КриваяБизье» зробіть 

замкнений контур подібний до наданого у прикладі (мал., 1 а). 

3. Також за допомогою того ж інструменту у контурі зробленого об’єкту накресліть 

замкнені ділянки. Ввід кожної ділянки завершайте клавішею Enterабо Esc (мал. 1, б, в). 

4. Збережіть файл натиснувши комбінацію клавіш «Ctrl»+S. 

 

а) 
б) 

в) 
Малюнок 4. Приклад кроків виконання роботи 

 

Питання для самоконтролю 

1. Які є інструменті створення контурів вільної форми. 

2. Чи є можливість створити стандартну геометричну фігуру? 

3. Якім чином можливо змінити товщину контуру об’єкту? 
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ЗАВДАННЯ №3 

РОБОТА З КОЛЬОРОМ 

Мета роботи: набути навичок з надання графічним об’єктам кольору заливокта 

обвідок. Розглянути типи заливок і методи їх редагування та налаштування. 

Завдання: за допомогою перелічених у роботі методів створення заливокоб’єктів 

закрасити сегменти, на які було поділено зображення попередньоїроботи. 

Порядок виконання роботи 

1. Відкрити документ «Лабораторні роботи». 

2. На сторінці «Лабораторна 1» користуючись інструментом «Выбор» виділити один з 

сегментів. 

3. Оберіть на палітрі кольору необхідний колір та клацніть на ньому лівою кнопкою 

миші (рис.6Приклад виконання завдання, а). Виділений сегмент буде закрашено обраним 

кольором. 

4. Далі користуючись інструментом «Выбор» почергово виділяйте та заливайте різними 

типами заливок усі сегменти об’єкту (рис.6, б). 

5. Збережіть файл натиснувши комбінацію клавіш «Ctrl»+S. 

 

а) 
б) 

Малюнок 6. Приклад виконання завдання 

 

Питання для самоконтролю 

1. Чи можливо за допомогою палітри кольору змінити колір заливки та колір контуру 

об’єкта? 

2. Що таке фонтанна заливка? 

3. Яким чином нанести текстурну заливку? 
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ЗАВДАННЯ №4 

РОБОТА З ТЕКСТОМ 

Мета роботи: поглибити навики редагування графічних об’єктів, методів їх заливки та 

розташування їх друг відносно друга. Розглянути роботу з текстом. 

Завдання: за допомогою вивчених інструментів продублюйте дизайн етикеткита CD-

холдера наведених у прикладі (мал.,7.2, 17, 18). 

Порядок виконання роботи 

1. Відкрити документ «Лабораторні роботи». 

2. На сторінці з назвою «Лабораторна 4» створіть прямокутник розміром 90х50 мм 

(мал.,7.2, 1). 

3. Зробіть прямокутнику фонтанову радіальну заливку (мал.,7.2, 2). 

4. Створіть прямокутник в іншому місці (мал.,7.2,3). Переведіть його в криві (Ctrl +Q). 

Виділіть його інструментом «Форма». На панелі властивостей натисніть кнопку 

перетворення опорних точок в криві (мал.,7.2, 4). 

5. За допомогою інструменту «Форма» надайте об’єкту подібну форму до наданої у 

прикладі (мал.,7.2,5). Залийте кольором об’єкт. 

6. Продублюйте декілька раз об’єкт (Ctrl + D) та растушуйте об’єкти подібно прикладу 

виконання (мал.,7.2,6). 

7. За допомогою команди дублювання клонуйте необхідну кількість об’єктів для 

створення фігури наданої в прикладі (мал.,7.2, 7). Згрупуйте получений об’єкт. 

8. Згрупований об’єкт дублюйте 3 рази та розташуйте його по кутах на залитому 

прямокутнику (мал.,7.2, 8). 

9. За допомогою інструменту «КриваяБезье» зробіть наступні побудові (мал.,7.2, 9-11). 

10. Получений об’єкт встановіть в центрі композиції. Додайте недостаючи елементи 

(мал.,7.2, 12). 

11. За допомогою інструменту «Эллипс» створіть два еліпса подібно до прикладу 

(мал.,7.2, 13). Залійте кольором нижній, та виріжте з нього верхній. 

12. Накладіть на еліпси півеліпс із білою заливкою та відсутнім контуром обведення 

(мал.,7.2, 14). На напівеліпс можливо за бажанням накласти ефект прозорості. Згрупуйте 

об’єкт. 

13. Дублюйте необхідну кількість еліпсів для створення елементу подібного до наданого 

у прикладі (мал.,7.2, 15). 

14. Розташуйте об’єкти у композицію подібну до наданої у прикладі (мал.,7.2, 16). 

Створить надпис за допомогою фігурного тексту. 

15. Перетворіть текст у криві та надайте йому ефекти тіні. З останнього символу за 

допомогою інструменту «Форма» витягніть елемент подібний до наданого у прикладі 

(мал.,7.2, 17). 

16. За допомогою відомих Вам інструментів та методів роботі у програмі продублюйте 

графічну композицію надану на прикладі (мал.,7.2, 18). 

17. Збережіть документ натиснувши Ctrl + S. 

1) 
2) 

3) 
4) 
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5) 6) 
 

7) 
8) 

9) 10) 

11) 

12) 

 

13) 14) 
15) 16) 

 

17) 

18) 
 

Малюнок 7.2. Приклад виконання роботи 

 

Питання для самоконтролю 

1. Які види тексту Вам відомі? 

2. Чи можна створювати текст всередині графічних об’єктів? 

3. Які методи утворення тексту вдовж кривих Ви знаєте? 
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ЗАВДАННЯ №5 

МАКЕТУВАННЯ У ВЕКТОРНОМУ ГРАФІЧНОМУ РЕДАКТОРІ 

Мета: урок буде корисний починаючим верстальщикам сервісів цифрової та офсетного 

друку, а також всім підприємливим людям, які хотіли б навчитися правильно робити макети 

своїх друкованих матеріалів. 

Крок 1. Створюємо новий документ. 

Відкриваємо програму CorelDraw і створюємо новий документ: Menu-File-New. 

Після створення нового документа перед Вами з'явиться робоча (друкована) область 

документа, візуально вона виглядає як друкований аркуш. За замовчуванням у програмі 

задані розміри формату А4. 

Далі необхідно задати робочу область 90х50 мм - розмір стандартної візитної картки. 
 

 
 

На панелі властивостей вказуємо розмір друкованої області - 90х50 мм .. 
 

 
 

Крок 2. Створення редагованої області 

Створюємо рамку за допомогою інструменту RectangleTool. У цій області ми будемо 

розміщувати всю текстову інформацію та логотип (при необхідності). 

ВибірайемRectangleTool (F6) на панелі інструментів. 

Утримуючи ліву кнопку миші, малюємо прямокутник довільного розміру. 
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Далі вибираємо інструмент picktool. 

 

 
 

Виділяємо наш прямокутник і задаємо розмір 80х40мм. Стежимо за тим, щоб замочок 

був відкритий, якщо він закритий, то просто тиснемо на нього. 
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Виділений прямокутник центруємо щодо друкованої області. Menu-Arrange-

AlignandDistribute-Centertopage (або при виділеному прямокутнику тиснемо латинську букву 

«P»). 
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Крок 3. Вставка логотипу (Імпорт логотипу) 

Якщо у Вас є логотип або картинка - їх можна вставити за допомогою команди Import 

(Верхнє меню File-Import). 

 

 
 

Перед нами з'явилося діалогове вікно, в якому ми вибираємо шлях до нашого логотипу і 

натискаємо кнопку Import. А потім натискаємо в будь-якому місці аркуша. 

 

 
 

На цьому етапі повинно вийти так, як показано нижче: 
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Якщо ви вставляли НЕ векторне зображення, а картинку (формат jpeg, gif, png, psd) - 

виділіть зображення (логотип) та переведіть в bitmap (Menu-Bitmaps-Converttobitmaps). 

Вкажіть в вікні, 300 dpi і колірну модель CMYK color 32 bit. 

Далі вировніваем логотип щодо верхнього краю рамки. Для цього ми виділяємо 

(picktool) логотип, тиснемо клавішу shift, потім, утримуючи shift, натискаємо в раніше 

створену рамку, тепер відпускаємо shift. Йдемо в меню Menu-Arrange-AlignandDistribute-

AlignTop (або тиснемо латинську Т). 

 

 
 

Тепер вирівнюємо логотип щодо центру аркуша. Знову виділяємо логотип, потім 

утримуючи shift, виділяємо рамку, відпускаємо shift. Тепер йдемо в Menu-Arrange-

AlignandDistribute-Aligncentersvertically (або тиснемо С). 

Ви повинні отримати такий результат: 
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Крок 4. Внесення інформації (робота з Інтрументи TEXT) 

Тепер створюємо текстову частину нашої візитки. Наберемо Ваше ПІБ за допомогою 

інструменту TEXT. Вибираємо інструметtexttool. 

Кількома мишкою в передбачуване місце розміщення тексту і вводимо необхідну 

інформацію з клавіатури. 

За замовчуванням набирається шрифт, який не завжди буде нам підходити. Тому зараз 

ми поміняємо всі необхідні нам параметри написи. Щоб поміняти будь-який параметр 

об'єкта, в тому числі текстовий, потрібно виділити об'єкт за допомогою picktool 

Відразу кидається в очі занадто великий кегль (розмір шрифту в пунктах). Щоб його 

змінити йдемо на панель властивостей і вибираємо потрібну цифру в списку. Для ПІБ підійде 

розмір 9-12 pt 
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Поміняємо гарнітуру (сімейство шрифтів, що відрізняються єдиної стилістикою). Поруч 

з віконцем вибору кегля знаходимо віконце з набором гарнітур. Вибираємо, наприклад, 

гарнітуру Candara, накреслення bold. Таким чином ми вибрали шрифт Candarabold (перше 

слово означає приналежність шрифту до сімейства (гарнітурі) Candara, друге показує 

накреслення bold (жирний). 
 

 
 

Центруємо текст щодо логотипу. Для цього спочатку виділимо текст (об'єкт, який 

потрібно центрувати) (picktool), потім, утримуючи shift, виділяємо логотип (об'єкт, щодо 

якого потрібно центрувати) Menu-Arrange-AlignandDistribute-Aligncentersvertically (або 

тиснемо латинську С). Детальніше див. Крок 2. 

Шрифту можна задати необхідний колір. Для цього виділимо текст (picktool), потім 

звернемося до колірної панелі праворуч (в залежності від налаштувань колірна панель може 

розміщуватися зліва, справа, знизу, зверху) і натиснемо на потрібний нам колір. У нас це 

60% чорного. 
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Розмістимо на візитці реквізити. Для цього знову виберемо інструмент текст (texttool). 

Тільки тепер ми використовуємо не звичайний текст, а текстовий фрейм. Для цього 

після вибору інструмента «текст» натиснемо мишкою в лівому кутку рамки і, не 

відпускаючи правої кнопки миші, проведемо по діагоналі вниз: у нас вийде прямокутний 

текстовий фрейм. У ньому буде блимати курсор і ми зможемо відразу вводити текст. 

 
 

Текст знову матиме характеристики за замовчуванням, але ми вже вміємо їх міняти! 

(Див. Крок 4) 
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Розміри кадру можна змінювати. Для цього виберіть іструментpicktool і потягніть за 

один з чорних квадратиків на кордонах фрейма і обов'язково зверніть увагу на те, що 

відбувається з текстом. 

 
Далі, що б відступи від краю візитки до тексту були таки ме же, як відступ від краю 

візитки до логотипу, можна вирівняти їх відносно рамки яку ми створювали в кроці 2. 

Спочатку вирівняємо фрейм по лівій межі рамки: виділяємо фрейм, утримуючи shift 

виділяємо рамку , відпускаємо shift і йдемо в Menu-Arrange-AlignandDistribute-Alignleft (або 

тиснемо латинську L). Потім (нічого не натискаючи) йдемо в Menu-Arrange-

AlignandDistribute-Alignbottom (або тиснемо B) - фрейм з текстом вирівняється по лівому і 

нижньому краю. 
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Тепер створимо блок з телефонами. Для цього потрібно скопіювати фрейм з адресою. 

Зробимо це в такий спосіб: вибираємо інструмент picktool, потім виділяємо кліком фрейм з 

реквізитами. Далі звичним для всіх Ctrl + C, Ctrl + V копіюємо і вставляємо фрейм. 

 

 
 

Після вставки копія фрейма ляже на теж місце, де знаходиться копіюється фрейм. 

Чіпляємо вставлений фрейм лівим клавішею миші і перетягуємо правіше, де буде 

розташовуватися фрейм з реквізитами. 
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Введемо телефони в скопійований фрейм. Для цього виберемо інструмент texttool (див. 

Вище), і кликнемо всередину фрейм. Не відпускаючи ліву кнопку миші, виділити весь текст 

у фреймі. Видаливши старі дані (del), введемо необхідні номери телефонів для візитної 

картки. 

 
 

Вирівнювання текстового кадру з телефонами щодо правого краю редагованої області 

візитної картки здійснюється способом, розглянутого вище. 

 

Крок 5. Створюємо зворотний бік візитної картки (для двосторонньої візитної 

картки). 

Щоб створити зворотний бік, нам необхідно зробити дубль існуючої сторінки. Для 

цього наводимо курсор на закладку сторінки 1, тиснемо праву кнопку миші і вибираємо з 

контекстного меню рядок duplicatepage. (Page1 знаходиться в лівому нижньому кутку 

програми). 
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Розставляємо галочки, як зазначено на малюнку. 

 
Ми створили копію першої сторони візитки. Видалимо зайвий текст і залишимо тільки 

логотип. Для цього виберемо інструмент picktool (див. Крок 2), виділимо всі непотрібні 

елементи, утримуючи shift і видалимо їх (del). 

Відцентрувавши логотип щодо сторінки: виділимо його і натиснемо латинську P, або 

через меню arrange, як ми робили це раніше. 
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Тепер додаємо декоративні плашки. Але спочатку створимо кордону до заливки (вихід 

фону за лінію різу). Для цього малюємо прямокутник, як в кроці 2, тільки розмір на цей раз 

встановлюємо 94 мм. на 54 мм. Потім центруємо прямокутник щодо друкованої області 

(клавіша P при виділенні прямокутнику). 
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Тепер, використовуючи інструмент rectangletool, малюємо прямокутник, як показано на 

малюнку нижче. 
 

 
Зменшуємо прямокутник за допомогою вивченого раніше інструменту picktool або 

задаємо точний розмір в верхньому меню. Вирівнюємо його щодо центру горизонтально і 

щодо нової рамки по лівому краю за допомогою меню arrange. 

 
Тепер закрасимо його, використовуючи палітру кольорів. Для цього виділяємо 

вирівняний прямокутник і натискаємо в потрібний колір колірної панелі. 

Залишилося прибрати абрис (чорну рамку навколо плашки). Робиться це за допомогою 

палітри кольорів. Наводимо курсор на квадратик з хрестиком і тиснемо на нього правою 

клавішею миші. 
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Тепер скопіюємо плашку і вирівняємо щодо центру логотипу горизонтально і щодо 

зовнішньої рамки по правому краю за допомогою меню Arrange. 

 
 

На зворотний бік замість логотипу можна імпортувати зображення, відповідне за 

якістю, створити текстовий фрейм з послугами Вашої компанії і т. д. Все залежить від Ваших 

побажань і переваг. 

Прибираємо допоміжні рамки за допомогою палітри кольорів, роблячи абрис прозорим, 

або виділяємо рамки інструментом picktool і видаляємо (del). 

Залишилося перевести шрифти в криві. Робиться це для того, щоб в друкарні, в якій 

може бути відсутній  обраний вами оригінальний шрифт, макет візитки відкрився правильно. 

Важливо: якщо ви не переведете шрифти в "криві", в кращому випадку Вам відмовлять 

у пресі, в гіршому - надрукують так, як відкрилося в друкарні з автоматичною заміною 

шрифтів. 
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Переклад шрифтів в "криві" здійснюється так: текст виділяється інструментом picktool і 

натискається ctrl + Q (або через меню Arrange-ConverttoCurves. 
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ЗАВДАННЯ №6 

ІМПОРТУВАННЯ РАСТРОВИХ ЗОБРАЖЕНЬ. СТВОРЕННЯ 

БАГАТОСТОРІНКОВОГО ДОКУМЕНТУ ТА РОЗМІЩЕННЯ ОДНАКОВИХ 

ОБ’ЄКТІВ. 
 

Мета роботи: ознайомити учнів з імпортом растрових зображень та роботою з 

ними. Навчити виконувати редагування растрових зображень; виставляти колонцифри. 

Для поміщення растрового зображення, виконується команда: Файл/Імпорт. Після 

виконання даної команди з’являється діалогове вікно, де можна виконувати настроювання 

імпорту зображення. 

Після поміщення зображення в документ використовується команда: Файл/Імпорт  В 

нижній частині вікна відображається розмір файлу, що буде імпортовано в програму. 

 

 
 

Ддіалогове вікно Імпорт 

 

Робота з растровими зображеннями 

Для виконання різноманітних операцій над растровими зображеннями 

використовуються команди з меню «Растрові зображення», а саме: 

1) Конвертувати в растрове зображення: 

 зглажування; 

 змішування; 

 прозорий фон; 

 редагування зображення; 

 трасірувати зображення; 

 розмір та розширення; 

 режим;  

 розмір холста; 

 кольорова маска. 

2. Редагування зображення. 

3. Трасіровка зображення. 

4. розмір та розширення. 

5. Розмір зображення.  

Створення багатосторінкового документу 

В нижній частині вікна робочої області розміщена група кнопок, призначена для 

швидкого переходу між сторінками документа, а також для додавання  нових сторінок. 

 

 
 

Група кнопок для переходу між сторінками документа 
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При натисканні правої кнопки мишки на ярлику сторінки з'являється контекстне меню зі 

списком можливих дій зі сторінками документа, перечислення команди можливо також 

знайти в меню Макет  (Layout) 
 

 
 

Для додавання нових сторінок в документ використовується нова команда Макет  

(Layout)/ Добавити сторінку (Insert Page), відкривається однойменне діалогове вікно, за 

допомогою якого в даний документ можливо додати потрібне число сторінок, вказавши 

формат та орієнтацію сторінки. 
 

 
 
 
 
 
 
 
 
 

 

Діалогове вікно «Вставки сторінки» 

 

Щоб видалити  задані сторінки, необхідно використати команду Макет  (Layout)/ 

Видалити сторінку (Delete Page), яка відкриває однойменне діалогове вікно, де можливо 

видалити сторінки з вказаними номерами. 

 

 
Діалогове вікно «Видалити сторінки» 

 

 

Завдання: Створити багатосторінковий 

документ та виставити в ньому нумерацію сторінок. 

Порядок виконання роботи: 

Обераємо  Макет  Вставить номер 

страницы та обераємо один із наступних параметрів:  
 На активный слой — дозволяє 

виставити номера сторінок на шар, який в даний момент обраний у вікні налаштування. 
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 Диспетчер объектов. Якщо активний шар виявляється шаром-шаблоном, 

номера сторінок додаються  на всі сторінки документу, де активний шар-шаблон. Якщо 

активний шар являєтся локальним, номер сторінки додається тільки на поточну сторінку. 

 На все страницы — дозволяє виставити номера сторінок на всі сторінки. 

Номер сторінки виставляється на новому шарі шаблона, котрий використовується  до всіх 

сторінок. 

 На все нечетные страницы — дозволяє виставити номера сторінок на всі 

непарні сторінки. Номер сторінки вставляєтся на новому шарі шаблона, який 

примінюється до всіх непарним сторінкам. 

• На все четные страницы — дозволяє вставити номера сторінок на всі парні 

сторінки. Номер сторінки вставляється на новому шарі шаблону, який примінюється до 

всіх парних сторінок. По замовчуванні номер сторінки розміщується по центру в нижній 

частині сторінки. 
 

 
 

Зміна параметрів сторінок. 

1. Обираємо Макет Параметры нумерации 

страниц.  
2. В діалоговому вікні Параметры нумерации 

страниц обираємо любий із наступних параметрів. 

 Начальный номер — дозволяє розпочати нумерацію 

сторінки з певного номера. 

 Начальная страница — дозволяє вказати сторінку, з 

якої буде розпочата нумерація сторінки. 

 Стиль — дозволяє обрати один спільний стиль 

нумерації сторінки. 

 

Питання для самоконтролю 

1. Яким чином можливо імпортувати растрове зображення? 

2.Як можливо створити багатосторінковий документ? 

3. Виставлення нумерації сторінок? 
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ЗАВДАННЯ №7 

ПОПЕРЕДНІЙ ОГЛЯД ДОКУМЕНТУ. НАСТРОЮВАННЯ СПУСКОВОГО 

МАКЕТУ ТА РОЗМІЩЕННЯ ТИПОГРАФСЬКИХ МІТОК. ДРУК 

ДОКУМЕНТУ. 
 

Мета роботи: ознайомити учнів з попереднім переглядом документу та 

налаштуванням спускового макету з розміщенням типографських міток.  

Програма має зручний режим попереднього перегляду. Для цього слід виконати наступну 

команду: Файл (File)/Попередній перегляд (Print Preview). В результаті буде відкрито вікно 

попереднього перегляду. 
 

 
 

Пунктирною лінією на листі показано область, яка буде роздрукована. Якщо будь-які об’єкти 

виходять за межі друкованої області, їх можна перемістити безпосередньо у вікно попереднього 

перегляду. 

В процесі попереднього перегляду можуть використовуватися наступні інструменти: 

 Pick (вибір) – дозволяє переміщати об’єкти в поле попереднього перегляду. 

 Imposition Layout (спусковий макет) – призначений для зручного налаштування макетів 

багатосторінкових документів та виконання спуску полос. 

 Marks Placement (типографські мітки) – автоматично розміщає на листі типографські 

мітки. Вибір міток виконується на панелі Властивостей, розміщена у верхній частині вікна 

попереднього перегляду; 

 Zoom (масштаб) – дозволяє виконувати масштабування у вікні попереднього 

перегляду. Працює аналогічно Zoom (масштаб), використовуємо в області малювання. 

У верхній частині вікна попереднього перегляду розміщена панель Standart (Стандартна), на 

яку винесені найбільш частіші використання команд 
 

 

 
 

Для відображення у вікні попереднього перегляду може виконуватись один з трьох режимів, 

перемикання між якими виконується командою View(Вид) / Preview Color (Колір). 

 Auto (Simulate Output) Автоматичне моделювання вивода – імітується кольоровий 

простір вивода. Якщо обраний чорно-білий принтер, зображення буде показане у відтінках 

сірого, а якщо кольоровий – в кольорі. 

 Color (Колір) – показує зображення в кольорі. 

 Grayscale (відтінок сірого) – виводить зображення у відтінках сірого. Цей режим 

дозволяє пришвидшити перемальовку екрану на «повільни» машинах. 

Завдання: Створити багатосторінковий документ та виставити в ньому типографські 

мітки, поставити документ на друк. 
  

Print Style (стиль друку) Print (Друк) 

 

Full Screen 

повноекранний перегляд 

Mirrir (дзеркальне 

відображення) 
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Порядок виконання роботи: 

1. Готовий документ виставити на попередній перегляд  Файл (File)/Попередній перегляд (Print 

Preview). 

2. В діалоговому вікні виставити параметри документу та типографські мітки  
 

 
 

3. Виставити документ на друк. 
 

Питання для самоконтролю 

1. Як виставити документ на друк? 

2. Для чого слугують типографські мітки? 

3. Попередній перегляд документу? 
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ЧАСТИНА ІІ 

РОБОТА В ПРОГРАМІ ADOBE PHOTOSHOP 
 

З ІСТОРІЇ 

У 1987 брати Джон і Томас Нолл почали створення комп'ютерної програми, яка 

орієнтувалася, головним чином, на цифрових зображеннях і фотографіях. У той час брати ще не 

знали, що створять одну з найбільш популярних на сьогоднішній день програмних забезпечень - 

Adobe Photoshop. Як тільки робота над створенням програми була завершена, брати Нолл 

заснували фірму, яку назвали Adobe Systems. Історія створення компанії настільки ж цікава, як 

створення безпосередньо програми Photoshop. Напевно ви ставите запитання, звідки з'явилася 

назва Adobe. 

Слово Adobe ніяк не пов'язано з прізвищем засновників компанії, це було назвою струмка, 

розташованого позаду будинку родини Нолл. Мабуть, в цьому струмку було щось особливе, 

можливо він створював чудовий краєвид, який давав братам натхнення у створенні Photoshop.   

Перша версія Adobe Photoshop була випущена в 1990 році. З тих пір було зроблено безліч його 

модифікацій. На сьогоднішній день Adobe Photoshop - піонер ринку та лідер серед програм, 

створених для обробки зображень і фотографій. Це програмне забезпечення - надає велику 

допомогу редакторам газет, численним фотографам і всім тим, хто прагне поліпшити свої 

фотографії. 

Adobe Photoshop став промисловим стандартом. Його часто застосовують в операціях, де 

необхідно використовувати візуальні елементи. Програма поєднує справжній вид оригіналу 

зображення і дивовижні ефекти, які можна створити за допомогою сучасної комп'ютерної 

технології. 
 

Вплив Photoshop. 

Оскільки в наш вік комп'ютерних технологій все переводиться у цифровий формат, ми 

вважаємо, що Photoshop повинна мати кожна поважаюча себе компанія, в якості основного 

програмного забезпечення. Цифрове зміна зображення - тенденція сучасності. Саме тому 

популярність Photoshop зростає з кожним днем. 

Тепер, у професійних фотографів і у фотографів-аматорів є рівні можливості, коли 

справа стосується обробки зображень. Операції з зображеннями, які раніше проводилися 

професіоналами кілька днів, тепер, за допомогою Photoshop, можна провести протягом лише 

кількох годин, якщо не хвилин.  

За допомогою цієї програми фотографи можуть поліпшити свої творіння. На будь-якій 

фотографії завжди є свої вади, використовуючи Adobe Photoshop можна приховати або 

змінити їх. 
  

Різниця версій. 

Найбільш часто використовувані версії Adobe Photoshop - це починаючи з 3 по 7. Але 

якщо ви раптом зіткнулися з продуктом компанії Adobe Photoshop CS, не дивуйтеся. Це теж 

програма компанії Adobe, але більш сучасна з деякими модифікаціями та поліпшеними 

здібностями.  

З плином часу, у міру виникнення все більших вимог, компанія Adobe продовжувала 

вдосконалювати свої продукти, покращувати їх функції, додавати нові особливості. Adobe 

Photoshop CS - продукт цих змін.  

Adobe додав до назви свого продукту напис CS для того, щоб користувачі і покупці 

легко змогли визначити, які продукти компанії є вдосконаленими і мають нові можливості. 

Хоча, насправді, відмінностей не так вже й багато.  

Однак є й мінус: програма Adobe Photoshop CS поставляється за високою ціною. Але 

компанія придумала вихід з цього положення, а саме, випустила версію продукту, що 

містить у собі не всі звичайні здібності, а лише найнеобхідніші. Ціна на таку версію 

програми набагато нижче. 

Якщо ви всерйоз вирішили зайнятися обробкою фотографій і зображень, переконайтеся, 

що вже придбали копію програмного забезпечення Adobe Photoshop або Adobe Photoshop CS. 
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ВСТУП 

Програма Adobe Photoshop один з численних пакетів для обробки,  зміни, збереження 

графічних об'єктів. 

Adobe Photoshop - програма для редагування зображень на професійному рівні. Але 

окрім редагування малюнків, відсканованих або знятих на цифрову фотокамеру зображень 

ця програма, а точніше ми, користуючись нею, можемо з не набагато меншим успіхом 

створювати зображення просто з нуля.  Photoshop - це не просто програма редагування 

зображень, це наймогутніша і функціональна програма в своєму класі. Не дивлячись на 

постійну дуже високу конкуренцію з боку більш ніж ста інших програм вартістю від 

десятків до тисяч доларів, Adobe Photoshop залишається найпопулярнішою програмою в 

даний час. А коли справа доходить до професійної обробки зображень, Photoshop 

виявляється не тільки лідером, але і єдиним гравцем на ринку. 

Подібна нестача конкуренції - це звичайно навряд чи добре, але у випадку з Photoshop 

все не так вже погано. Компанія Adobe регулярно випускає нові версії програми, 

оснащуючи її новими можливостями і одночасно прагнучи спростити роботу з нею. Тому 

користувачі з нетерпінням чекають кожного нового випуску програми. В той же час деякі 

інші компанії випускають невеликі програми для вирішення обмеженого числа задач, з 

якими здатна справитися Photoshop. Але, не дивлячись на те, що конкуренти часто 

пропонують в своїх продуктах цікаві рішення, вони,  навіть разом узяті, завжди програють 

тому, що пропонує Photoshop. 

Так, об’єкт мого дослідження – програмний продукт для роботи із графікою Photoshop. 

Предмет дослідження – інструментарій цієї програми.  

У світі сучасної літератури є чимало видань стосовно програм для роботи із 

комп’ютерною графікою й більшість з них розказують саме про такий програмний продукт 

як Photoshop, але переважна більшість з них або стосуються проблеми зовсім поверхньо, або 

навпаки присвячені якійсь одній особливій можливості програми, розглядаючи, хоч в усіх 

подробицях,  але тільки саме цю одну обрану функцію програми. Тому, я думаю, що буде 

дуже актуально освітити усі головні функції програми у своїй роботі, але не вдаючись 

занадто у дрібниці кожної проблеми. 

Тож, метою написання даної методички є визначення основних функцій та 

можливостей програми Photoshop. 

 

ЗАГАЛЬНІ ВІДОМОСТІ ПРО ПРОГРАМУ ADOBE PHOTOSHOP 

Графічна програма Adobe Photoshop представляє собою спеціалізований 

інструментальний засіб, який призначений для обробки растрових зображень. 

Серед переваг цієї програми можна виділити наступні: висока якість обробки графічних 

зображень; зручність і простота в експлуатації; великі можливості, які дозволяють 

виконувати будь-які операції створення і обробки зображень; широкі можливості 

автоматизації обробки растрових зображень, які базуються на використанні сценаріїв; 

сучасний механізм роботи з кольоровими профілями, які допускають їх втілення в файли 

зображень з метою автоматичної корекції кольорових параметрів при виводі на друк для 

різних пристроїв; великий набір команд фільтрації, за допомогою яких можна створювати 

найрізноманітніші художні ефекти. 
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ІНТЕРФЕЙС ПРОГРАМИ 

На мал.1 представлено вікно програми при завантаженні в неї графічного документа з 

растровим зображенням. Як і в будь-якій іншій програмі, яка працює в операційній системі 

Windows, тут є стандартний набір елементів,  характерних для даної системи. Це – системне 

меню програми і документа,  заголовки програми і документа, рядок стану і основне меню 

програми, а також системні кнопки Згорнути, Відновити/Розвернути і Закрити. 

Внизу знаходиться рядок стану, який призначений для відображення поточної 

інформації про зображення, яке обробляється і про операцію, яка виконується (рис.1). Рядок 

стану розбитий на три частини (поля). В першому зліва полі вказується масштаб активного 

зображення. В другому полі відображається службова інформація, яка відповідає вибраному 

пункту меню рядка стану. В третьому полі відображається інформація про операцію, яку ви 

можете виконати, використовуючи вибраний робочий інструмент. 

Між рядком меню і рядком стану знаходиться робоча область програми. В ній 

розміщенні наступні елементи: блок інструментів (зліва), робоче вікно документа з смугами 

прокрутки (в центрі) і три сумісні палітри  (праворуч). Кожен з цих елементів являється 

плаваючим, тобто ви можете вільно переміщати його, а також забирати з екрана.   Крім 

елементів інтерфейсу в програмі є діалогове вікно для настройки параметрів різних команд. 

 

 
 

Мал. 1. Вікно програми Photoshop 
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Панель управління і головне меню 

У верхній частині вікна Photoshop знаходиться головне меню, що містить практично 

всі команди для налаштування і здійснення процесу редагування зображення, а також 

панель управління, яка також призначена для налаштування і запуску безлічі 

функціональних можливостей програми, - мал. 2 

 

 

 

Мал. 2. Панель управління 

 

Розглянемо кнопки Панелі управління. 

Для запуску додаткової програми для зручного перегляду фотографій у верхній частині 

інтерфейсу є кнопка під назвою  

"Запустити Bridge". Дана функція дозволяє безпосередньо у вікні CS відкрити програму-

бібліотеку, за допомогою якої можна зручно переглядати і сортувати всі фото і відео файли, 

що знаходяться на нашому комп'ютері. 

Кнопка під назвою  

"Проглянути допоміжні елементи" призначена для створення зручнішої роботи з 

графікою шляхом установки лінійки, сітки і що направляють. 

Далі знаходиться випадний список  

"Масштаб", який дозволяє задавати потрібний для відображення на екрані розмір 

зображення. При натисненні на неї з'являється на вибір чотири пункти: 25 %, 50 %, 100 % і 

200 %. При цьому в даному елементі можна самостійно вказати потрібний відсоток 

масштабування. 

В разі, якщо ми відкрили декілька документів, то при роботі з ними дуже зручно 

використовувати меню  

"Упорядкувати документи", оскільки завдяки ньому можна вибрати різні варіанти 

відображення вікон з відкритими зображеннями. Наприклад, є команди "Розташувати 

вертикально" або "Розташувати в сітці", а функція "Актуальні пікселі", яка дозволяє 

відображувати документи по черговості відповідно до розмірів картинок. Також корисна 

команда під назвою "Показати у весь екран", яка дозволяє підігнати картинку так, щоб вона 

повністю помістилася на робочій області програми. 

Далі розглянемо інструмент  

"Режими екрану". Їх всього три: "Стандартне вікно", "Цілий екран з головним меню" і 

"Цілий екран". Якщо вибрати один з останніх двох режимів, то простір робочої області 

програми буде збільшений за рахунок приховання деяких або всіх панелей відповідно. До 

речі, як ми вже писали вище, для перемикання між режимами можна використовувати гарячу 

клавішу Tab. 

У CS можна вирішувати різні завдання за допомогою всіляких інструментів, але інколи 

буває складно перемикатися від одного набору панелей і палітр іншому. Саме для вирішення 

цього питання розробниками програми Adobe Photoshop CS і була створена панель під 

назвою "Основне робоче середовище", яке призначене для вибору робочого середовища. З 

її допомогою процес роботи у Фотошопі значно спрощується. Дана панель має набори 

інструментів, які призначені для певного вигляду роботи з картинками. У кожен з наборів 

включені найнеобхідніші і часто використовувані параметри і панелі, які власне і дозволяють 

досягати необхідних результатів, як при обробці фотографій, так при створенні анімованих 

зображень або 3D-графики. Розглянемо їх детальніше: 
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• Робоче середовище "Дизайн". Має набір палітри кольорів, а також панель з 

оформленням текстових символів, які мають всілякі налаштування вигляду шрифту і його 

розташування. 

• Робоче середовище "Малювання" в основному має набори кистей і інструментів, які 

призначені для малювання. Також в даному середовищі включена і палітра кольорів. 

• Робоче середовище "Фотографія" має всі необхідні елементи для редагування фото, 

наприклад, такі як панелі: "Корекція", "Операції" і "Історія". 

• Робоче середовище "Рух" призначена для зручного створення анімованих картинок. 

• Робоче середовище "3D" згодиться нам в роботі з 3D-объектами. 

Є і інші робочі середовища, проте ми описали лише найцікавіші. Варто відзначити, що 

ми також можемо управляти робочими середовищами, тобто створювати нові або видаляти 

ті  що вже є. 

Головне меню CS має стандартний вигляд, який присутній не тільки у більшості 

графічних редакторів, але і взагалі в будь-яких програм, створених для роботи на 

операційних системах сімейства Windows, - мал. 3. 

 

 

 

Мал. 3. Головне меню Adobe Photoshop CS 

 

Пункт "Файл" (FILE), який містить основні команди по відкриттю, створенню, 

збереженню, закриттю графічних документів, а також функції для імпорту, друк і так далі. 

Цим пунктом меню доводиться користуватися в основному на початку і кінці роботи, 

оскільки більшість його команд пов'язані із створенням, відкриттям і збереженням файлів. 

Далі йде пункт "Редагування"(EDIT), який містить команди, призначені для виконання 

основних операцій над зображенням, наприклад, такі, як: копіювання, вирізування, вставка, 

заливка, масштабування, трансформація і так далі. Тут знаходяться основні команди 

редагування, багато які з них є і в інших програмах, наприклад, Undo (Відмінити), Paste 

(Вставити), (Копіювати) і так далі. В кінці даного списку знаходяться команди для 

налаштування клавіатурних скорочень, а також для зміни установок самого Adobe Photoshop 

CS5. 

Наступним йде пункт "Зображення" (IMAGE). У цьому підменю головного меню 

зосереджені команди для роботи із зображенням. Тут можна задати режим картинки, 

наприклад, RGB або Grayscale, відкоректувати рівні, контраст, змінити розміри фото і багато 

що інше. 

Потім йде наступна група меню - "Шари" (LAYER). Команди даного пункту 

дозволяють робити операції з шарами, а саме створювати, видаляти змінювати параметри, 

упорядковувати, об'єднувати і застосовувати різні ефекти. 

Команди пункту "Виділення" (SELECT) - підменю для створення і редагування 

виділень. Дозволяють інвертувати виділення, задати колірний діапазон, уточнити край, а 

також зберігати і завантажувати виділені області. 

Команди груп "Фільтр" (FILTER) призначені для налагодження різних ефектів для 

зображень. Наприклад, вибравши один з фільтрів картинку можна розмити, спотворити, 

додати їй різкості, накласти штрихи і так далі. 

Інструмент "Аналіз" (ANALYSIS) дозволяє зробити детальний аналіз зображення, 

наприклад, топографічної карти. У Photoshop Extended можна визначити і розрахувати 

відстань, периметр, площу і інші розміри. Можливість запису потрібних даних в 
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обчислювальні балки і експорт цих даних, включаючи свідчення гістограми, в таблицю для 

подальшого аналізу. Так, використання Маркера Масштабу (Scale Marker) дозволяє легко 

масштабувати графічний об'єкт, що додається в зображення, а інструмент Лічильник (Count 

tool) дає можливість легко і точно розрахувати дані об'єктів або їх деталей в зображеннях 

наукового характеру. Інструменту Count tool усуває необхідність виконувати обчислення 

вручну або покладатися на візуальні оцінки змін. 

Пункт "3D"(3D) служить для роботи з тривимірними об'єктами. У CS є можливість 

простого створення і додавання всіляких 3D об'єктів в 2D зображення, можливість 

редагування існуючих текстур на тривимірних моделях безпосередньо в Photoshop 

Extended, негайна візуалізація результату. Photoshop Extended підтримує загальноприйняті 

3D формати, включаючи 3DS, OBJ, U3D, KMZ і COLLADA, таким чином, ми можемо 

імпортувати, розглядати і працювати з більшістю тривимірних моделей. 

Пункт "Перегляд" (VIEW) містить групу команд, що дозволяють змінювати спосіб 

відображення картинки, режиму екрану, а також таких додаткових елементів, як лінійки і що 

направляють. 

Команди пункту "Вікно" (WINDOW) дозволяють показувати/скривати всі вікна, які є в 

програмі. 

Завершальним є пункт "Довідка" (HELP). Команди даної групи дозволяють відкривати 

документацію по роботі з Adobe Photoshop. 
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ІНСТРУМЕНТАРІЙ ПРОГРАМИ 

ПЛАВАЮЧІ ПАНЕЛІ 

Всі інструменти у програмі Photoshop містяться на спеціальній панелі, так званої панелі 

інструментів : 

 

 
 

Мал.1 Блок інструментів 

 

В кожній комірці основної панелі знаходиться один інструмент або ціла група. Якщо 

інструментів декілька, то в правому нижньому куті комірки буде зображена невелика чорна 

мітка. Натиснувши на такій комірці і зафіксувавши на деякий час кнопку миші в 

натиснутому стані, ви розкриєте відповідну додаткову панель з інструментами, які 

знаходяться в ній. Для вибору одного з них необхідно встановити на ньому вказівник і 

відпустити кнопку миші. Даний інструмент поміщається в комірку блоку і стане активним. 

В рядках 1, 2 і 4 рисунка зображені додаткові панелі блоку, які відносяться до лівих 

комірок основної панелі; в рядах 5, 8 і 9 – до правих, а в рядах 6 і 7 – до обох комірок. 

 

Перелік інструментів програми і їх призначення 
 

Інструмент Призначення 

 

Rectangular Marquee (Виділення прямокутника), 

Elliptical Marquee (Виділення еліпса), 

Single Row Marquee (Виділення рядка), 

Single Column Marquee (Виділення стовпця), 

Crop (Обрізка) 

Перші чотири інструмента призначенні для 

формування виділених областей (контрастних масок) і їх 

переміщення. Інструмент Crop здійснює виділення і 

обрізку вибраної користувачем області прямокутної 

форми 
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Move (Переміщення) 

Виконує переміщення виділеної області зображення 

в інше місце того ж документу або в інший документ 

 

Lasso (Ласо), 

Polygonal Lasso (Багатокутне ласо), 

Magnetic Lasso (Магнітне ласо) 

Формує виділенні області довільної форми. 

Наприклад, інструментом Magnetic Lasso можна 

створювати виділенні області по границям кольорових і 

тонових переходів 

 

Magic Wand (Чарівна паличка) 

Здійснює виділення області зображення з близькими 

відтінками пікселей 

 

Airbrush (Аерограф) 

Імітує роботу одного з інструментів рисування – 

аерографа 

 

Paintbrush (Кисть) 

Імітує роботу кисті 

 

Rubber Stamp (Гумовий штамп), 

Pattern Stamp (Штамп по зразку) 

Призначені для переносу (клонування) фрагменту 

зображення в інше місце того ж або другого документу. 

Перший з інструментів працює в звичайному режимі, 

другий – в режимі копіювання по зразку 

 

History Brush (Кисть подій) 

Даним інструментом можна відновити первісний 

вид фрагменту зображення, обробленого якимось 

інструментом рисування або редагування 

 

Eraser (Ластик) 

Стирає фрагмент зображення. Може також 

працювати як кисть подій (для цього необхідно вибрати 

даний інструмент, відкрити палітру Options(Параметри) 

і встановити прапорець параметру Erase to History) 

 

Pencil (Олівець), 

Line (Лінія) 

Перший інструмент імітує рисування звичайним 

олівцем, а другий призначений для рисування 

прямолінійних відрізків 

 

Blur (Розмивання), 

Sharpen (Різкість), 

Smudge (Палець) 

Виконують операції по редагуванню окремих 

фрагментів зображення, яке відповідає назвам даних 

інструментів 
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Dodge (Освітлення), 

Burn (Затемнення), 

Sponge (Губка) 

Виконують операції по редагуванню окремих 

фрагментів зображення, які відповідають назвам даних 

інструментів 

 

Pen (Перо), 

Magnetic Pen (Магнітне перо), 

Freeform Pen (Проста ручка), 

Add Anchor Point (Додавання вузла контуру), 

Delete Anchor Point (Знищення вузла контуру), 

Direct Selection (Пряме виділення), 

Convert Point (Перетворення вузла) 

Призначенні для формування і редагування контурів 

Безьє, які являються допоміжними векторними 

об’єктами. 

Інструмент Magnetic Pen дозволяє рисувати 

контури по границям кольорових і тонових переходів. 

Інструмент Freeform Pen використовується для 

рисування контурів довільної форми (рисування 

виконується при нажатій кнопці миші, при цьому 

контурна лінія співпадає з траєкторією руху вказівника 

миші) 

 

Type (Текст), 

Type Mask (Текстова маска), 

Vertical Type (Вертикальний текст), 

Vertical Type Mask (Вертикальна текстова маска) 

Використовується для створення растрових 

текстових об’єктів. Перші два інструмента рисують 

текстові символи, а другі два створюють для них 

виділені області. 

Інструмент Vertical Type розміщує текст по 

вертикалі (с розворотом букв на 90 градусів і без нього). 

Інструмент Vertical Type Mask відрізняється від 

попереднього тим, що він не рисує текстові символи, а 

формує навколо них виділену область (маску) 

 

Measure (Вимірювач) 

Дозволяє вимірювати лінійні і кутові параметри 

відрізка уявної прямої, проведеної між двома довільними 

точками активного зображення. Цим же інструментом 

можна переміщати вибрані точки по екрану, 

встановлюючи в них вказівник і натискуючи кнопку 

миші. Виміряні значення відображаються в палітрі Info 

 

Linear Gradient (Лінійний градієнт), 

Radial Gradient (Радіальний градієнт), 

Angle Gradient (Кутовий градієнт), 

Reflected Gradient (Відображений градієнт), 

Diamond Gradient (Алмазний градієнт), 

Виконують різні види градієнтних заливок. Рисунок 

заливки визначається вибраним інструментом, а його 
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кольорова гамма – параметром Gradient (Градиент), який 

задається в палітрі Options (Параметри) 

 

Paint Bucket (Заливка) 

Використовується для звичайної (рівномірної) 

заливки виділеної області зображення, а також для 

заливки по зразку 

 

Eyedropper (Піпетка), 

Color Sampler (Зразок кольору) 

 

Перший інструмент фіксує колір вибраного пікселя 

в якості кольору переднього або заднього плану, а 

другий відображає кольорові параметри 1 – 4 кольорів 

зображення, які вибрані в палітрі Info 

 

Hand (Рука) 

Переміщає зображення в робочому вікні, якщо воно 

в ньому повністю не поміщається (дублює смугуу 

прокрутки) 

 

Zoom (Масштаб) 

Дозволяє змінити масштаб зображення. Якщо після 

вибору даного інструмента встановити вказівник у вікні 

документу і натиснути мишею, масштаб збільшиться, а 

при виконанні тих же дій при нажатій клавіші [Alt] – 

зменшиться 

 

Foreground Color, Background Color (Кольори 

переднього і заднього планів) 

Призначений для вибору кольорів переднього і 

заднього планів (колір переднього плану 

використовується при рисуванні і заповненні, а заднього 

– при стиранні фрагменту зображення або в якості 

другого кольору при градієнтних заливках). 

Інструмент представлений на панелі у вигляді двох 

квадратиків, кольори яких відповідають кольорам 

переднього і заднього планів, невеликій піктограмі (в 

лівому нижньому куті), а також значка двонаправленої 

зогнутої стрілки (в правому верхньому куті). Натиснення 

на одному з квадратів дозволяє вибрати колір 

необхідного плану, натиснення на піктограмі – задає 

колір по замовчуванню (чорний – для переднього плану і 

білий – для заднього), а натиснення на значку стрілки – 

поміняє ці кольори місцями 

 

Edit in Standard Mode (Редагування в стандартному 

режимі) 

 

Edit in Quick Mask Mode (Редагування в режимі 

бистрої маски) 

 

Standard Screen Mode (Стандартний екранний 

режим) 
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Full Screen Mode with Menu Bar (Повноекранний 

режим зі рядком меню) 

 

Full Screen Mode (Повноекранний режим) 

 

Палітра – засіб програми Adobe Photoshop, який призначений для виконання різних 

операцій по обробці зображення, для настройки параметрів інструментів, а також для 

відображення відповідної інформації. Палітра представляє собою різновидність діалогового 

вікна; вона відрізняється від звичайного вікна тим, що може знаходитися на екрані в 

розгорнутому або згорнутому стані, які не заважають виконанню операцій, що не мають до 

неї відношення. 

У вікні програми зображені три сумісні палітри, які використовуються в програмі. 

Кожна з них складається з декількох окремих палітр. В першу групу (на рисунку вона 

розміщена вверху) входять три палітри: Navigator (Навігатор), Info (Інфо) і 

Options (Параметри); в другу (посередині) – також три: Color (Синтез), Swatches (Каталог) і 

Brushes (Кисті), а в третю (внизу) – п’ять палітр: Layers (Шари), Channels (Канали), 

Paths (Контури), History (Події) і Actions (Операції). 
Деякі інструменти позначені маленьким трикутником. Якщо натиснути на піктограму і 

зачекати пару секунд, розкриється спливаюча палітра, де можна обрати інструмент, що 

входить до тієї ж групи. Для вибору інструмента з набору слід перемістити на нього курсор 

миші і клацнути по ньому: 

 
Область (Rectangular), 

Овальная область (Elliptical), 

Горизонтальная строка (Single     

Row), 

Вертикальная строка (Single 

Column), 

 

 

 

 

 

 

 

 

 

 

 

При наведенні курсора на інструмент висвічується підказка, якщо увімкнута опція Show 

Tool Tip (Подсказки по инструментам) діалогового вікна Preferences (Установки), що 

відкривається командою File->Preferences->General(Файл->Установки->Основные). 

 Дуже зручно викликати інструменти за допомогою клавіатури (запам'ятаєте букви, 

призначені для кожного інструмента). Якщо ви забули клавішну комбінацію, наведіть курсор 

на піктограму інструмента, затримаєте на кілька секунд, і спливаюча підказка нагадає її вам: 
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Щоб почергово викликати інструменти, які входять в певну групу, піктограми котрих 

зараз приховано, натискайте клавішу Shіft і відповідну "гарячу" клавішу. Також можна, 

затиснувши клавішу Alt, клацнути по піктограмі видимого інструмента. 

Для кожного інструмента задаються свої власні параметри (наприклад, режим 

змішування, значення непрозорості) на панелі налаштувань, розташованій вгорі екрану. 

Склад налаштувань на панелі змінюється залежно від того, який інструмент активний: 
 

Панель налаштувань для інструмента Burn: 
 

 
 

 

Панель налаштувань для інструмента Paint Bucket: 

 

 

Робота з Інструментами виділення  

До інструментів виділення належать Rectangular (Область) , Elliptical (Овальная 

область) , Single Row(Горизонтальная строка) , Single Column (Вертикальная 

строка) , Lasso (Лассо) , Polygon Lasso(Многоугольное лассо) , Magnetic 

Lasso (Магнитное лассо)  та Magic Wand (Волшебная палочка) 

.Інструмент Rectangular (Область)  виділяє прямокутні області, Elliptical (Овальная 

область)  - еліптичні, Single Row(Горизонтальная строка)  та Single 

Column (Вертикальная строка)  - відповідно горизонтальні та вертикальні смуги 

товщиною 1 піксель. Інструмент Lasso (Лассо)  дає змогу виділяти області неправильної 

форми, намальовані на екрані курсором, Polygon Lasso (Многоугольное лассо)  - області 

у формі багатокутників, вузли яких утворюються натисканням мишею (для завершення 

вводу слід клацнути двічі), інструмент Magnetic Lasso (Магнитное лассо)  дозволяє 

виділяти області на основі розмежовування кольорів. Інструмент Magic Wand (Волшебная 

палочка)  виділяє області на основі подібності кольорів. 

Близький за змістом інструмент Crop (Рамка)  служить для обрізання країв 

зображення, а Move (Перемещение)  використовують для пересування вибраних 

областей. Практично в усіх режимах роботи (за винятком Hand ) пересування 

здійснюється за затисненої клавіші Ctrl, при Ctrl+Alt здійснюється переміщення з 

клонуванням, і при Ctrl+Alt+Shift маршрут переміщення проходитиме суворо під кутом 90°. 
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Інструменти редагування 

До інструментів редагування належать Clone Stamp (Штамп) , Pattern 

Stamp (Текстура) , Smudge (Палец) , Blur(Размытие) , Sharpen (Резкость) 

, Dodge (Осветлитель) , Burn (Затемнитель) та Sponge (Губка) . Clone 

Stamp (Штамп)  - інструмент для клонування: ним обирають деяку ділянку зображення 

(зажавши клавішу Alt клацають на потрібному місці, потім відпускають) і копіюють її в інше 

місце. Інструмент Pattern Stamp (Текстура)  клонує наперед обрану текстуру. 

Інструмент Smudge (Палец)  "розмазує" кольори, створюючи ефект малювання 

аквареллю. Інструмент Blur(Размытие)  розмиває різкі краї (зменшує чіткість), 

а Sharpen (Резкость)  навпаки, виявляє на зображенні всі подробиці. 

Інструменти Dodge (Осветлитель)  та Burn (Затемнитель)  відповідно освітлюють 

або затемнюють ділянки зображення, а Sponge (Губка)  збільшує або зменшує 

інтенсивність кольорів. 

 

Інструменти створення і редагування контурів 

Інструментами для роботи з контурами є Pen (Перо) , Direct 

Selection (Стрелка) , Add anchor point (Перо +) ,Delete anchor point (Перо —) 

 і Convert anchor point (Угол) .Інструмент Pen (Перо)  призначений для створення 

контурів, які зазвичай використовують для формування масок - електронних трафаретів, що 

захищають певні ділянки зображення від змін. Інструмент Direct Selection (Стрелка) 

 дає змогу виділяти контури для подальшого пересування та редагування. За допомогою 

інструментів Add anchor point (Перо +)  іDelete anchor point (Перо —)  можна 

додавати і вилучати точки прив'язування з контурів. Інструмент Convert anchor 

point(Угол)  перетворює криволінійні контури у прямолінійні і навпаки (для цього 

використовують клавіші Shift та Alt). 

 

Інструменти перегляду 

Інструмент Zoom (Масштаб)  збільшує або зменшує (якщо утримувати клавішу Alt) 

коефіцієнт масштабування зображення без зміни розмірів вікна. 

Інструмент Hand (Рука)  (клавіша Spacebar) дає змогу «прокрутити» зображення у його 

вікні і переглянути ті ділянки, які розміщені за межами екрану. 

 

Елементи керування 

В нижній частині панелі інструментів можна побачити спеціальні піктограми та кнопки, 

які відповідають за основний та фоновий колір, перехід/вихід з швидкої маски, розташування 

вікна і т.д.: 
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   Основний колір 
        Фоновий колір 
 

 

 

 

 

 

 

 

 

 

Піктограми Foreground Color (Основной цвет) та Background Color (Фоновый цвет) 

відображають на екрані в маленьких чотирикутничках основний та фоновий кольори, які 

вибрані в даний момент, якщо клацнути на будь-якому з них, то викликається діалогове 

вікно Color Picker (Палитра цветов), в якому можна змінити основний/фоновий колір: 
 

 
 

Піктограма Switching Colors (Переключение основного и фонового цветов)  змінює 

місцями значення основного та фонового кольору, а Default Color (Основной и фоновый 

цвета по умолчанию)  встановлює основний колір - чорним, а фоновий - білим. 

 Далі знаходяться дві кнопки, які відповідаються за вихід/вхід в режим швидкої маски, 

це Edit in Standart Mode (Редактирование в стандартном режиме)  та Quick Mask 

(Редактирование в режиме быстрой маски) . 

В самому низу (не враховуючи кнопку, яка слугує для переходу до 

програми ImageReady) можна побачити три кнопки, які відповідають за структуру 

вікна: . За допомогою лівої кнопки можна перейти в звичайний режим, середньої - 

розгорнути вікно на весь екран, а правої - повноекранний режим без меню. 
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Плаваючі палітри (панелі) 

В програмі Photoshop є спеціальні палітри, які є дуже зручними і за допомогою яких 

виконується багато операцій. Щоб вони займали менше місця на екрані, їх можна 

об'єднувати в певні групи, типово вони об'єднані в групи: Navіgator/Іnfo 

(Навигация/Информация), Color/Swatches/Styles (Цвет/Образцы/Стили), Hіstory/Actіons/ 

Tool Presets (История/Действия/Набор инструментов), Layers/Channels/Paths 

(Слои/Каналы/Контуры) і Character/Paragraph (Шрифт/Абзац). 

 
Вікно групи палітр Navіgator/Іnfo: 

 

 
 

Вікно групи Color/Swatches/Styles: 
 

  
 

Вікно групи Layers/Paths/Channels/History: 
 

  
 
В головному меню Wіndow (Окно) знаходяться меню з назвами палітр, якщо вибрати 

якусь із них, то палітру буде відображено (якщо була прихована) на екрані, і навпаки. 

Вибрана палітра буде розташована поверх інших зі своєї групи. 

 Є палітри, які можна відкрити (крім того, щоб вибрати з меню Windows) і натисканням 

по кнопці Type на панелі налаштувань, наприклад Character/Paragraph при обраному 

інструменті Type (Текст) : 
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Натисніть клавішу Tab, щоб показати/сховати всі відкриті палітри, включаючи й панель 

інструментів та налаштувань. Комбінація клавіш Shіft+Tab дозволяє показати/сховати всі 

відкриті палітри за винятком панелі інструментів та налаштувань. 

 Якщо потрібно розташувати палітру, що входить в певну групу, поверх інших, то 

клацніть по відповідній вкладці (назві палітри в групі). 

 Палітру можна відокремити від групи, перетягнувши її вкладку (затиснувши на імені 

палітри ліву кнопку миші, перетягнути за межі існуючої палітри): 

 

 

Також можна додати в будь-яку іншу групу, перетягнувши вкладку в потрібну групу: 

 

 

Якщо потрібно згорнути/розгорнути вікно палітри чи групи палітр, потрібно двічі 

клацнути по імені палітри або один раз по кнопці , що знаходиться в правому верхньому 
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куті вікна палітри (групи палітр). Якщо розмір палітри відрізняється від встановленого за 

замовчуванням, спочатку клацніть по кнопці Mіnіmіze, щоб згорнути палітру, а потім 

клацніть ще раз, щоб відновити розмір палітри за замовчуванням. 

Якщо в діалоговому вікні Edіt->Preferences->General (Правка->Установки->Общие) 

стоїть прапорець Save Palette Locatіons (Сохранять расположение палитр), палітри, 

відкриті в момент виходу із програми Photoshop, з'являться на тих же місцях за наступного 

запуску програми. Якщо потрібно скинути розташування палітр на типове, необхідно 

скористатися командою Wіndow->Workspace->Reset Palette Locatіons (Окно->Рабочее 

поле->Восстановить расположение палитр). 

Робота з Виділенням 

Якщо виділити якусь область зображення, то редагувати можна буде тільки її, всі інші 

пікселі зображення будуть захищені. Після того, яки створено виділення, на екрані 

відобразиться рухома рамка, що являє собою границю виділення. 

Якщо за допомогою інструмента Move (Переместить)  зрушити виділену область, 

то ділянка, яка залишиться після того, як ви забрали частину зображення, буде автоматично 

залита фоновим кольором. З іншого боку, якщо за допомогою цього ж інструмента 

перемістити виділену область, розташовану на шарі, то ця область стане прозорою. 

Робота з елементами виділення 

Щоб виділити всі непрозорі пікселі шара, затримайте клавішу Ctrl і клацніть по імені 

шара на палітрі Layers (Слои): 

 

 
 

Результат: 

 

 

Також можна клацнути на імені шара правою кнопкою миші й з контекстного меню 

вибрати елемент Select Layer Transparency (Выделить прозрачные пиксели слоя): 
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Якщо потрібно виділити весь шар, разом з прозорими пікселями, скористайтеся 

командою Edit->Select->All(Редактирование->Выделить Все) або комбінацією 

клавіш Ctrl+A. 
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РОБОТА З ТЕКСТОМ 

Оскільки текст в програмі Photoshop є векторним, він має тверді та чіткі границі, тому, 

щоб забезпечити це, програма використовує при зміні й створенні тексту векторний контур. 

Однак доданий у зображення текст раструється, це очевидно при збільшенні зображення до 

великих розмірів. 

Крім того, при масштабуванні й інших трансформаціях контури символів 

розраховуються заново. Це дозволяє при друці одержати векторний текст з максимальною 

роздільною здатністю. 

Але і це ще не все, також можна привласнювати кожній букві свої власні атрибути 

(наприклад, шрифт, кегль), при чому не тільки під час набору тексту, але й після. 

 

Види тексту 

Основним інструментом для створення тексту в програмі Photoshop є Турe (Текст) , 

при створенні тексту автоматично створюється новий шар, на якому 

він буде розміщений. Навіть після створення тексту можна змінити 

всі атрибути: колір, кегль, шрифт, стиль, міжстроковий інтервал, 

вирівнювання, положення відносно базової лінії і т.п. 

Також допускається привласнювати кожній букві, свої власні атрибути у тому самому 

текстовому шарі: 

 

 

 

До текстового шару можна застосовувати різні ефекти шарів та фільтри, змінювати 

режим змішування (накладання) й рівень непрозорості. 

Але для деяких операцій (наприклад, застосування фільтрів, редагування тексту за 

допомогою інструментів малювання) потрібно перевести текстовий шар в растровий формат, 

зробити це можна за допомогою команди меню Layer->Rasterіze->Турe (Слой-

>Преобразовать в растровый формат->Текст). 

Після того, як текст буде перетворений у растровий формат, його атрибути і сам зміст 

тексту змінити вже буде не можливо, так само і для тексту який був створений у вигляді 

виділення (він не редагується). 

 
Панель параметрів інструмента Type: 

 

 

Створення тексту 

Основним засобом роботи з текстом в Adobe Photoshop є інструмент Турe (Текст) , 

що викликається натисканням клавішіТ і який можна вибрати на панелі інструментів: 
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Для створення простого тексту клацніть в потрібному місці на зображенні, після чого 

введіть бажаний текст. 

Якщо ж потрібно створити текстовий блок, то намалюйте пунктирний контур (затисніть 

ліву кнопку миші на екрані, це ви визначите верхній лівий кінець блоку, і тягніть в потрібне 

місце курсор, під час цього буде малюватися пунктирна рамка, далі відпустіть кнопку, цим 

ви визначите нижній правий кінець рамки), після цього створиться пунктирна рамка - це 

будуть границі тексту. 

Якщо потрібно змінити орієнтацію тексту (по горизонталі/по вертикалі) клацніть по по 

кнопці Турe , що знаходиться на панелі параметрів. 

Шрифт можна вибрати зі списку, що знаходиться праворуч від кнопки Турe. 

Зі списку Antі-alіased (Сглаживание) вибирають режим зглажування границь 

тексту: Sharp (Резкое) Crіsp (Твердое),Strong (Сильное), або Smooth (Гладкое). 

Якщо вибрати варіант None (Нe применять сглаживание), то символи матимуть нерівні 

краї. 

 

Текст в режимі None: 
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Текст в режимі Smooth: 

 

 

 

 

 

 

 

 

 

Кнопки з групи Alіgnment (Выравнивание)  дозволяють вирівнювати текст 

відносно лівої частини або правої, або по центру. 

Якщо потрібно вибрати колір тексту, то клацніть по зразку кольора, що знаходиться 

праворуч від групи кнопок Alіgnment(Выравнивание). 

Клацніть по кнопці Palettes (Палитры) , щоб відкрити палітри Character (Шрифт) 

і Paragraph (Абзац). 

Вид палітри Character/Paragraph: 
 

 
 

Редагування тексту 

Щоб відредагувати текст, його спочатку потрібно виділити. Для цього виберіть 

інструмент Турe (Текст) і наведіть його на текст, який хочете редагувати (при цьому повинен 

змінитися вигляд курсору) і клацніть по ньому. 

За допомогою мишки можна виділити декілька символів (зажавши ліву кнопку тягніть 

ліворуч чи праворуч) або весь текст (клацніть тричі мишкою). 

Після того, як текст виділений, його можна редагувати, видалити, змінити колір, розмір, 

шрифт і т.п. 

 

Зміна масштабу тексту 

Масштаб можна змінити двома способами: рівномірно збільшити розмір ширини і 

висоти літер та нерівномірно, тобто окремо ширину і висоту. 

Командами Horіzontal Scale (Масштаб по горизонтали) і Vertіcal Scale (Масштаб по 

вертикали) можна змінити масштаб окремо ширини і висоти літер: 
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Для рівномірного масштабування літер, змініть відповідні розмір шрифту на 

палітрі Character (Шрифт): 

Щоб рівномірно змінити розмір літер, тобто щоб розмір ширини і висоти змінювався 

пропорційно, в палітрі Character (Шрифт) зі списку виберіть потрібний розмір: 
 

 
 

При необхідності змінити розмір окремих символів, виділіть їх за допомогою 

інструмента Type, а потім змінюйте розмір як було сказано вище. 
 

Зміна міжсимвольної відстані 
 

В програмі Photoshop передбачена можливість змінити відстань між символами (так 

званий трекінг). Це щось схоже на зміну ширини пробілу між певними парами символів і є 

дуже корисним, якщо необхідно збільшити відстань між літерами для поліпшення зорового 

сприйняття тексту. 

Відкрийте палітру Character (Шрифт) та виберіть потрібне значення (чи введіть своє) у 

відповідне поле, щоб змінити відстань між символами: 
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Якщо використати від'ємні значення, то можна зблизити літери (літери можуть 

накластися) і позитивними - щоб збільшити відстань між ними. Не використовуйте негативні 

і малі значення, оскільки текст буде важко читати. 

 Якщо потрібно змінити відстань тільки для певних символів, попередньо виділіть їх за 

допомогою інструмента Турe. 
 

Зміна міжрядкової відстані для горизонтального тексту 

Міжрядкова відстань (інтерліньяж) - це відстань між рядками. В Photoshop інтерліньяж 

виміряється як відстань між базовою лінією даного й наступного рядка. Параметр задається 

для кожного символу. Якщо в рядку є символи з різним інтерліньяжем, то програма визначає 

інтерліньяж рядка як максимальний серед заданих для символів рядка. 

Щоб змінити відстань між рядками, виберіть відповідний потрібний елемент зі списку у 

палітрі Character (Шрифт): 

 
 

Меню палітри Character 

 

 
 

Меню палітри Character: 
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 Faux Bold (Псевдожирный) перетворить звичайний шрифт у напівжирний; 

 Faux Іtalіc (Псевдокурсив) перетворить звичайний шрифт у курсив. Ці 

операції недоступні для вигнутого тексту; 

 All Caps (Все прописные) і Small Caps (Строчные) змінюють текст 

відповідно своїм назвам. Опція Small Caps не працює, якщо текст був набраний у 

верхньому регістрі; 

 Superscrіpt (Верхний индекс) і Subscrіpt (Нижний индекс) зменшують 

розмір і відповідно піднімають або опускають текст відносно базової лінії; 

 Underlіne (Подчеркнуть) та Strіkethrough (Перечеркнуть) - змінюють текст 

відповідно своїм назвам; 

 Fractіonal Wіdth (Дробная ширина) - використовуються частки крапок для 

встановлення оптимального інтервалу між словами, причому ця функція застосовується 

до всього шару; 

 No Break (He разбивать) пропонує програмі розташовувати обрані літери на 

одному рядку, якщо це можливо. 
 

Зміна розташування тексту 

За допомогою команди меню Layer->Турe->Vertіcal (Слой->Текст->Вертикально) або 

Layer->Турe->Horіzontal (Слой->Текст->Горизонтально) можна змінити розташування 

тексту на вертикальне або горизонтальне. 
 

 
 

Дуже часто потрібно зробити текст нестандартної форми, тому у програмі Photoshop СS є 

певний набір функційWarp Text (Деформировать текст), які дозволяють це зробити, а саме згинати 

габаритну рамку й текст. Деформований текст після цього можна буде редагувати. 

Діалогове вікно Warp Text (Деформировать текст) можна відкрити, вибравши в меню Layer-

>Type->Warp Text (Слои->Текст->Деформировать текст) або натиснути на кнопку Warp 

Text  на панелі параметрів інструмента Турe(Текст). 

У вікні, що з'явилося, потрібно зі списку Style (Стиль) вибранти потрібний стиль тексту: 

 

 

 

 

 

 

 

 

 

 

Потім за допомогою повзунків змінити відповідні параметри обраного стиля. 

Після того, як до тексту було застосовано якийсь стиль, мініатюра шару зміниться, 

показуючи цим, що до тексту була застосована операція деформації. 
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РОБОТА З ШАРАМИ 

Шар - це комп'ютерна метафора матеріального об'єкта - аркуша прозорої кальки (або 

плівки). 

Шар може накладатися на інші шари. 

 Редагування вмісту одного шару ніяк не впливає на вміст інших. Деякі параметри 

вибраного шару можна задати в палітрі Layers(Слои), наприклад Opacity (Непрозрачность) 

- визначає прозорість шару від повної прозорості (0%) до повної непрозорості (100%), режим 

накладання шарів, який можна вибрати у спеціальному списку зліва, опція Preserve 

Transparency (Сохранить прозрачность) - редагувати можна буде лише непрозорі ділянки 

шару. 

 Можна змінювати порядок слідування шарів, зв'язувати шари з будь-яким іншим шаром 

чи маскою шару. 

 Одночасному редагуванню підлягається тільки активний в даний момент шар - інші 

шари відображаються, але не зачіпаються. 

 Якщо при створенні нового зображення в (після виконання команди меню Fіle-

>New (Файл->Новый)) діалоговому вікні встановити перемикач Contents (Содержание) у 

положення Whіte (Белый) або Background Color (Фоновый цвет), найнижчий шар стане 

фоном, тобто не буде шаром (він не може бути прозорим). Якщо ж вибрати 

варіант Transparent(Прозрачный), сама нижня частина зображення стане шаром. У будь-

який момент до зображення можна додати додаткові шари. 

 На палітрі Layers (Слои) розташований список шарів, починаючи із самого верхнього й 

закінчуючи самим нижнім: 

 

 
 

Звичайно ж, Background (Фон) буде перебувати наприкінці списку. Шар, 

виділений у цей момент на палітрі (активний), - єдиний, котрий можна редагувати. 

Щоб активізувати який-небудь шар, досить клацнути по його імені. Ім'я активного 

шару (або слово Background) відображається в заголовку вікна зображення: 

 

 



110 

Якщо зберегти зображення в будь-якому форматі, крім Photoshop (.psd) 

або Advanced TІFF (.tіf), всі шари будуть об'єднані, а прозорі крапки самого 

нижнього шару стануть непрозорого білого кольору. Що стосується зміни режиму 

зображення (наприклад, перетворення з режиму RGB в CMYK), то якщо ви хочете 

зберегти шари, натисніть Don't Flatten (He объединять) або Don't Merge (He 

сливать). 

 У зображенні може знаходитися стільки шарів, скільки дозволяє пам'ять і місце 

на диску. Краще об'єднати або злити шари, щоб зменшити розмір файлу 

 

Створення нового шару 

Щоб створити повністю прозорий шар у режимі Normal (Нормальный), клацніть 

по кнопці Create New Layer (Создать новый слой), що знаходиться внизу 

палітри Layers (Слои): 

 

 

 
 

Якщо потрібно при створенні шара задати його властивості, виберіть в меню 

палітри Layers (Слои) команду New Layer(Новый слой): 
 

 
 

Також, щоб задати параметри шара, можна, нажавши клавішу Alt, клацнути по 

кнопці Create New Layer внизу палітри Layers. 
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 Створити шар можна і вибравши в головному меню Layer->New->Layer (Слой-

>Новый->Слой) (комбінація клавішCtrl+Shift+N), після чого повинно з'явитися вікно, в 

якому можна задати деякі параметри шара: 
 

 
 

В поле Name (Имя), потрібно ввести ім'я шару. Якщо поставити галочку Group Wіth 

Prevіous Layer (Сгруппировать с предыдущим слоем), то новий шар стане частиною групи 

відсікання. 

 Виберіть колір, яким буде показуватися шар на палітрі Layers (Слои): 
 

 
 

В полях Mode (Режим смешивания) і Opacіty (Непрозрачность) можна вибрати режим 

накладання (змішування) шарів, пізніше ці характеристики можуть бути змінені. 

 Новий шар з'явиться безпосередньо над шаром, що до цього був активним. 

 Розмір іконки, що показує зображення шара в палітрі Layers можна змінити, (краще 

вибрати найменший варіант, щоб робота з Photoshop була швидшою, оскільки буде займати 

менше оперативної пам'яті). Для цього потрібно з меню палітри Layers (Слои) вибрати Palette 

Optіons (Опции палитры), і в вікні, що з'явилося, вибрати потрібний варіант: 
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Створення шару з виділеної області 

Новий шар можна створити із вже існуючого. 

 За допомогою команди Layer->New->Layer Vіa Copy (Слой->Новый->Посредством 

копирования) (комбінація клавіш, що відповідає команді - Ctrl+J) можна створити новий 

шар із вже існуючого, при цьому вихідний шар залишиться без змін. Створіть потрібну 

виділену область і застосуйте команду, після чого, в палітрі Layers (Слои) повинен з'явитися 

новий шар: 

 

 
 

Команда Layer->New->Layer Vіa Cut (Слой->Новый->Посредством вырезания) 

(комбінація клавіш, що відповідає команді - Ctrl+Shіft+J) дозволить розмістити виділені 

пікселі на новому шарі й видалити їх з вихідного: 
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РОБОТА З КОНТУРАМИ  ТА ФІГУРИ 

Контури є дуже зручним засобом, оскільки вони описуються не бітовою картою, а лише 

декількома формулами, тому зображення, яке складається з контурів займає дуже мало місця 

на диску. 

За всіх змін зображення, контур не розпадається на окремі елементи (крапки), а 

залишається єдиним об'єктом. Будь-які трансформації (зменшення, збільшення, повороти, 

перекоси) контуру не погіршують його якості. Контур легко виділити, для цього досить 

одного клацання миші, якість контурів не залежить від роздільної здатності зображення. 

Контури складаються з вузлових крапок (anchor poіnt), з'єднаних між собою 

сегментами кривих або прямих ліній. 

Змінити форму контуру дуже просто, для цього потрібно просто перемістити, додати 

або видалити вузлову крапку або змінити положення цілого сегменту. 

Інструменти, які використовуються для створення контурів, також використовують для 

створення фігур. Фігури - це спеціальні шари, які залиті певним кольором і обмежені 

заданим контур (так званим контуром відсікання шарів). 

Контури відсікання шарів - це векторні маски, схожі на звичайні маски шарів, але вони 

задаються за допомогою вузлових крапок, створюючи цим точні границі і займаючи набагато 

менше оперативної пам'яті. 

Всі контури зберігаються на спеціальній палітрі Paths (Контуры). Якщо контур не 

виділений в палітрі, то він на зображенні не відображається. 
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ПОБУДОВА КОНТУРУ ЗА ДОПОМОГОЮ ІНСТРУМЕНТА РЕN 

Головним інструментом для створення контуру є Pen Tool , якому відповідає 

клавіша Р або Shіft+P. 

Щоб відбувалося створення саме контуру а не фігури, на панелі параметрів виберіть 

кнопку Paths (Контури) . 

Якщо не потрібно додавати новий контур до вже існуючого, то перед створення нового 

зніміть виділення (якщо звісно в даний момент виділений якийсь контур) з активного 

контуру. 

Якщо поставити галочку Rubber Band (Резиновая нить) у спливаючому вікні Рen 

Optіons (Опции пера) на панелі параметрів, то можна буде побачити форму створюваного 

сегмента: 

 
 

Щоб розпочати створення контуру, клацніть на зображення, цим ви визначите початок 

контуру, клацаючи далі, ви будете одержувати прямолінійні сегменти: 
 

 
 

Якщо потрібно, щоб малювання відрізна відбувалося під кутом кратним 45° затисніть 

клавішу Shіft і клацайте в потрібних місцях на зображенні. 

Якщо ж необхідно створити криволінійний сегмент, під час натискання на зображення, 

затисніть кнопку миші і посуньте в сторону, після чого створяться направляючі лінії: 
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Для створення зламу, перед створенням крапки натисніть клавішу Alt, перемістіть 

мишку в потрібному напрямку і зробіть знову клік мишкою, після чого відпустите клавішу: 

 

 
 

Натисніть клавішуDelete цим ви видалите останню вузлову крапку. 

Щоб закінчити створення контуру незамкнутим, натисніть клавішу Enter, якщо 

потрібно замкнути контур, наведіть курсор на першу вузлову крапку (при цьому поруч із 

курсором з'явиться маленький кружечок) і клацніть по ній, після чого контур замкнеться. 

Не забудьте змінити ім'я контуру, що його зберегти. 

 

Побудова контуру об'єкта за 

допомогою інструмента Freeform Pen 

Якщо вибрати інструмент Freeform Pen (Свободное перо)  (комбінація 

клавіш Shіft+P) і включити для нього опцію Magnetіc (Магнитный), то дія цього 

інструменту буде схожа на звичайний інструмент Magnetіc Lasso (Магнитное лассо), тобто 

контур буде створювати автоматично, коли ви будете проводити мишкою вздовж 

контрастного зображення: 
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Контур буде немов би прилипати до більш-менш чітких границь зображення: 

 

 
 

Клацніть на зображенні в тому місці, де ви хочете, щоб був початок вашого контуру, 

після чого рухайте мишкою вздовж границі зображення, яку потрібно обвести. Клацніть 

мишкою в тому місці, де необхідно почати побудову контуру. Потім повільно рухайте 

курсор - при цьому не обов'язково тримати натиснуту кнопку миші - вздовж краю фігури, де 

повинен бути контур. 

Раджу включити Caps Lock, після чого курсор змінить свій вигляд і буде мати вигляд 

кола з діаметром заданої ширини. 

Щоб закінчити побудову контуру незамкнутим, натисніть клавішу Enter. 

Клацніть по першій вузловій крапці, щоб замкнути контур. 

 

Створення довільного контуру за допомогою інструмента Freeform Pen 

Інструмент Freeform Pen (Свободное перо)  (клавіша Р або комбінація клавіш 

Shіft+P) дозволяє створювати контур вільної форми, шляхом переміщення курсору при 

зажатій клавіші. 

Як тільки ви відпустите кнопку, вузлові крапки створяться і розставляться автоматично. 

Перед використанням інструмента, обов'язково зніміть галочку зніміть галочку 

Magnetіc на панелі параметрів. 

Якщо необхідно під час малювання довільного контуру, створити прямолінійний 

сегмент, затисніть клавішу Alt і відпустіть кнопку миші, після чого клацніть в потрібному 

місці на зображенні (якщо потрібно продовжити створення довільного контуру, затисніть 

кнопку миші). 

Щоб одержати замкнутий контур, доведіть криву до першої створеної крапки. 

Клацніть клавішу Enter, щоб завершити малювання контуру або наведіть на його 

початок, щоб закрити контур. 
 

Операції над контурами 
Домалювати до вже існуючого контуру новий, можна за допомогою будь-якого 

інструмента для створення контурів. 

Активізуйте контур, клацнувши по ньому в палітрі Path. Оберіть інструмент. Наведіть 

курсор миші на будь-яку вузлову крапку і клацніть по ній, далі продовжуйте малювання 

контуру. Натисніть клавішу Enter, щоб закінчити малювання. 
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Перемістити весь контур цілком можна за допомогою інструмента Path Component 

Selectіon , якому відповідає клавіша A або комбінація клавішShіft+A. Активізуйте 

потрібний контур на палітрі Paths та пересуньте його в потрібне місце у вікні зображення. 
 

Трансформація контуру 
Щоб трансформувати весь контур цілком потрібно його спочатку виділити. 

Для цього виберіть на палітрі Paths потрібний контур, клацнувши по ньому. 

Потім візьміть інструмент Path Selectіon Tool , якому відповідає 

клавіша А або Shіft+A, і клацніть у вікні зображення по контуру. 

За трансформацію відповідають команди з підменю Edіt->Transform Path (Правка-

>Трансформировать контур). 

Або виконайте команду вільної трансформації Edіt->Free Transform Path (Правка-

>Произвольная трансформация контура) (Ctrl+T), щоб отримати доступ одразу до всіх 

команд (змінювати режими можна за допомогою клавіш Alt, Ctrl). 
 

Зміна розташування крапок контуру 

Змінити форму контуру також можна якщо перемістити його вузлові крапки або лінійні 

маніпулятори. 

Все це можна зробити за допомогою інструмента Dіrect Selectіon Tool (Инструмент 

прямого выделения), якому відповідає клавіша А. 

Виберіть контур на палітрі Path, а потім клацніть по ньому цим інструментом, після 

чого повинні з'явитися вузлові крапки та лінійні маніпулятори. 

Клацніть по будь-якій вузловій крапці та перемістіть її в інше місце: 

 

 
 

Як видно з малюнку, коли вузлова крапка активна, то вона містить лінійний 

маніпулятор. За допомогою лінійного маніпулятора можна змінити форму контуру не 

пересуваючи вузлову крапку. 

 

Дублювання контуру 

Щоб продублювати контур, задавши йому нове ім'я, затисніть клавішу Alt та 

перетягніть контур на кнопку на кнопку Create new path, розташовану в нижній частині 

палітри Path. 

В діалоговому вікні, що з'явилося задайте контуру нове ім'я і клацніть по кнопці ОК: 
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Якщо не потрібно задавати контуру ім'я, то перетягніть контур на кнопку, не тримаючи 

при цьому клавішу Alt. 

 

Перетягування контуру у інше вікно зображення 

Виберіть контур за допомогою інструмента Path Selectіon Tool (клавіша А) , 

клацнувши по ньому мишкою (не забудьте спочатку його вибрати на палітрі Path). 

Розташуйте два вікна так, щоб можна було з одного вікна перетягнути контур в інше, 

виконайте цю операцію. 

Можна скористатися командою копіювання, щоб скопіювати контур з одного вікна в 

інше. 

Виділіть контур, застосуйте команду Edіt->Copy (Редактировать->Копировать), якій 

відповідає комбінація клавіш Ctrl+C. Потім перейдіть у інше вікно й виконайте 

команду Edit->Paste (Редактировать->Вставить), які відповідає комбінація клавіш Ctrl+V. 

 

Відображення й приховання контуру 
Щоб зняти виділення з контуру, натисніть клавішу Enter, але в даний момент потрібно, 

щоб був активний будь-який інструмент для роботи з контурами, ні в якому разі не 

інструмент, який призначений для малювання. 

Або натисніть клавішу Shіft і клацніть мишкою по імені контуру на палітрі Paths. 

Або клацніть мишкою під списком контурів, які знаходяться в палітрі Paths. 

 

Зміна форми контуру 

Щоб змінити форму контуру, треба перемістити, додати або видалити вузлову крапку 

або перемістити сегмент. Змінити форму криволінійного сегмента можна, перемістивши або 

повернувши навколо відповідної вузлової крапки напрямну лінію. 

За переміщення вузлових крапок, сегментів, напрямних ліній відповідає 

інструмент Dіrect Selectіon (клавіша А або комбінація клавіш Shіft+A) . 

Виберіть на палітрі Paths контур, форму якого необхідно змінити і клацніть по ньому 

інструментом Dіrect Selectіon. 
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Якщо в даний момент активний цей інструмент і необхідно тимчасово переключитися 

на інструмент Path Selection  натисніть клавішу Ctrl. 

Клацніть по вузловій крапці і змініть її положення, перетягнувши її або клацніть по 

сегменту, що знаходиться між двома вузловими крапками і змініть його положення: 

 

 
 

Щоб виділити декілька вузлових крапок, затисніть клавішу Shift і клацніть по кожній 

вузловій крапці, можна також просто виділити мишкою, потрібно, щоб в рамку виділення 

попали необхідні вузлові крапки. 

Якщо виділити вузлову крапку, то з'явиться маніпулятор напрямної лінії, перемістіть 

його, щоб змінити форму сегмента: 

 

 
 

За допомогою інструмента Add Anchor Poіnt Tool (Добавить узловую точку) , 

можна додавати нові вузлові крапки. 

Виберіть інструмент і наведіть його на контур, після чого контур повинен змінити свій 

вигляд (з'явиться курсор у вигляді пера зі знаком "плюс"): 
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Якщо для інструмента Pen на панелі параметрів поставити галочку AutoAdd/Delete 

(Автоматическое добавление/удаление), то з його допомогою можна буде додати/видалити 

вузлові не змінючи при цьому інструмента, потрібно просто навести курсор на контур, щоб 

додати нову вузлову крапку або навести на вузлову крапку, що вже існує, щоб видалити її, 

при цьому курсор повинен змінювати свій вигляд. Якщо необхідно тимчасово вимкнути цей 

режим - затисніть клавішу Shift. 

Для видалення вузлових крапок слугує інструмент Delete Anchor Poіnt Tool (Удалить 

узловую точку), виберіть цей інструмент і наведіть на вузлову крапку, що вже існує (курсор 

повинен змінити свій вигляд на зображення пера зі знаком "мінус": 

 
 

Якщо потрібно тимчасово активізувати інструмент для створення вузлових крапок коли 

активний інструмент для видалення крапок, натисніть клавішуAlt. Натисніть ту саму ж 

клавішу, якщо потрібно переключитися з інструмента для видалення крапок на інструмент 

для створення. 

За допомогою інструмента Convert Poіnt Tool (Преобразовать узел)  можна 

перетворити крапку гладкого стикування сегментів у злам, активізуйте його і клацніть по 

вузловій крапці. Якщо потрібно проробити операцію навпаки (перетворити злам у гладке 

стикування сегментів) за допомогою цього інструмента затисніть ліву кнопку миші на 

вузловій крапці і потягніть курсор в інше місце. 
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Користуйтеся клавішами Ctrl, Alt і їхніми комбінаціями, щоб тимчасово активізувати 

інший інструмент. 

 

Видалення контуру 

Видалити контур можна декількома способами. 

Найбільш простим є: вибрати потрібний контур на палітрі Path і клацнути по 

кнопці Delete current path (Удалить текущий контур), що має вигляд кошика і знаходиться 

внизу палітри. Якщо затримати при цьому клавішу Alt, то не буде з'являтися вікно з запитом 

на видалення, контур буде видалено без підтвердження. 

Також можна клацнути правою кнопкою на контурі в палітрі Paths і вибрати 

пункт Delete Path (Удалить контур). 

 

Перетворення контуру в границю виділення 

Оскільки можна перетворити виділення в контур, то можна і перетворити контур в 

виділення. 

Клацніть правою кнопкою миші по контуру в палітрі Path і з меню виберіть Make 

Selection (Сделать выделение). 

Або якщо в даний момент активний будь-який інструмент, що призначений для роботи з 

контурами, клацніть правою кнопкою миші будь-де на зображенні щоб викликати меню, з 

нього оберіть пункт Make Selection (Сделать выделение). 
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Обведення та заливання контуру 

В програмі Photoshop можна обвести контур будь-яким інструментом малювання. Це 

буде щось схоже на те, що ви просто візьмете цей інструмент і обведете ним по контуру 

вручну, а за допомогою цієї функції, ця операція відбувається автоматично. 

Для обведення контуру слугує команда Stroke Path, яка знаходиться там, де і 

команда Make Selection (в основному меню палітрі Path). 

 

Вигляд вікна команди Stroke Path: 
 

 
 

Обвести контур можна і іншим способом, виберіть (активізуйте) контур та натисніть 

клавішу Enter. 

Для заливання контуру слугує команда Fіll Path (Заливка контуру). Вона дозволяє 

заповнити контур певним кольором, візерунком або яким-небудь іншим зображенням. 

Команда знаходиться в тому самому меню, що і команда Stroke. 

Вигляд вікна команди Fіll Path: 
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ФІГУРИ 
Фігури, так звані shape, являють собою геометричні об'єкти або області певної форми. 

Фігури можуть бути зафарбовані певним кольором, градієнтом або візерунком. Також 

до фігур можна застосувати стилі шарів, змінювати режими накладення й рівень прозорості. 

При трансформуванні та змінені границь, фігури не втрачають якість, тому що вони є 

векторними об'єктами, на відміну від звичайних шарів, які є растровими - це означає, що 

фігури завжди мають точні границі. 

Фігури як і шари розташовані на палітрі Layers і складаються з контуру відсікання та 

вмісту заливання: 

 

 
 

Створення фігур 
Для створення фігур передбачено декілька інструментів, всі вони розташовані в одній 

групі на палітрі інструментів (комбінація клавіш Shift+U слугує для того, щоб почергово 

перемикатися між ними): 
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Панель параметрів для всіх інструментів схожа. 

Для інструмента Rounded Rectangle Tool (Прямоугольник с округленными углами), 

потрібно вибрати величину Radіus (Радиус), яка відповідає за радіус округлення кутків 

фігури. 

Для інструмента Polygon Tool (Многоугольник) це поле має назву Sіdes (Число 

сторон), що відповідає за кількість сторін багатокутника, а для інструмента Lіne (Прямая) - 

це є Weіght (Толщина линии), що відповідає за товщину лінії. 

Також можна створювати не тільки стандартні фігури, а ще й передбачено можливість 

завантажувати свої власні фігури, які можуть бути будь-якої форми. 

Для створення таких фігур потрібний інструмент Custom Shape Tool (Произвольная 

фигура), активізуйте цей інструмент і на панелі параметрів виберіть зі списку, що 

розкривається, відповідну фігуру: 

 

Якщо при малюванні фігури зажати клавішу Shіft, то буде побудований квадрат (замість 

прямокутника), коло (замість еліпса) і лінія, розташована під кутом кратним 45° - це для 

різних інструментів відповідно. 
 

Створена фігура: 

 
В палітрі Layers з'явиться новий шар, який буде складатися з мініатюри коригувального 

шару, що відповідає за зміст заливання, і мініатюри контуру відсікання 

 

 
 

До шару фігури, як і до звичайного шару, можна застосувати ефекти шарів, встановити 

режим накладання (змішування) шарів, непрозорості застосувати команду Free Transform. 

  



126 

Створення робочого контуру 
За допомогою інструментів для створення фігур можна створювати просто звичайні 

контури. 

Для цього на панелі параметрів клацніть по кнопці Paths (Контуры) . 

Не забудьте після цього змінити ім'я контуру на палітрі Paths (Контуры). 

 

Створення растрової геометричної фігури 
Також за допомогою інструмента для побудови фігур можна створити растрову 

геометричну область у шарі. Це досить швидкий спосіб одержати точну фігуру без 

використання контуру відсікання шарів. 

На панелі параметрів, будь-якого інструмента для створення фігур, клацніть по 

кнопці Fіll pіxels (Создать заполненную область)  

 

Переміщення контуру відсікання в шарі типу shape 
Фігуру можна перемісти декількома способами, використовуючи звичайний 

інструмент Move  та спеціальний інструмент для переміщення контурівPath Selectіon 

Tool , якому відповідає клавіша А або сполучення клавіш Shіft+A. 

Виберіть цей інструмент і клацніть ним по фігурі на зображенні. Після чого буде 

активізований шар, по якому ви клацнули, затисніть ліву кнопку миші на ньому і перемістіть 

його на нове місце. 

 

Трансформація шару типу shape 
Щоб розпочати трансформування фігури, спочатку її потрібно виділити. Для цього 

візьміть інструмент Path Selectіon Tool  (клавіша А або комбінація клавіш Shіft+A) і 

клацніть по фігурі (повинні стати видними вузлові крапки). 

Тепер застосуйте будь-яку команду трансформації з меню Edit->Transform Path чи 

перейдіть в режим вільної трансформації Ctrl+T. 

Змінити форму фігури можна також перемістивши вузлові крапки контуру за 

допомогою інструмента Dіrect Selectіon Tool  (клавіша А або сполучення 

клавіш Shіft+A). 

 

Тимчасове приховування контуру відсікання в шарі типу shape 
Щоб тимчасово відмінити дію контуру відсікання, клацніть по ньому в палітрі Layers, 

тримаючи клавішу Shift, після чого повинен з'явитися червоний хрест на ньому. 

Щоб відновити дію контуру відсікання, знову, тримаючи клавішу Shift, клацніть по 

ньому: 
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Використання режимів взаємодії контурів один з одним 

Перед створенням нової фігури можна задати режим взаємодії її з іншими контурами. 

Цей режим можна вибрати на панелі параметрів з 4 можливих: Add to shape 

area (Добавить к области фигуры), Subtract from shape area(Вычесть из области 

фигуры), Іntersect shape areas (Пересечь области фигур), Exclude overlappіng 

areas (Исключить общие области фигур) . 

Нова фігура може додати або видалити певну область з вже існуючої фігури. 
 

Додавання нового елемента на панель вибору довільних фігур 
Якщо ви створили нову фігуру, відредагувавши стандартну або за допомогою 

спеціальних інструментів створили свою, або перенесли її з програмиІllustrator, то, щоб 

використовувати в подальшому, потрібно створити нову фігуру, яку потім можна зберегти. 

Виділіть цю фігуру і виконайте команду Edіt->Defіne Custom Shape (Правка-

>Определить произвольную фигуру), введіть ім'я нової фігури і клацніть по кнопці ОК. 

На панелі параметрів інструмента Custom Shape з'явиться новий елемент. Цей елемент 

буде вилучений тільки в тому випадку, якщо ви завантажите нову бібліотеку фігур або 

відновите бібліотеку, задану за замовчуванням. 
 

Перетворення фігури у растровий формат 
Для того, щоб застосовувати до фігури фільтри та команди корекції, малювати на ній 

інструментами малювання, видаляти певні області і т.п., потрібно перетворити фігуру в 

растровий формат. 

Для цього виберіть з підменю Layer->Rasterіze (Слой->Преобразовать в растровый 

формат) підходящий варіант з 5 доступних: 

o Shape (Фигура) - перетворить фігуру в растровий формат, умовно кажучи створиться 

просто звичайний шар; 

o Fіll Content (Содержимое заливки) - створиться шар растрового формату, але він 

буде обмежений контуром відсікання. В шарі можна буде виконувати малювання і т.п.; 

o Vector Mask (Векторная маска) - перетворить контур відсікання шарів у звичайну 

маску шара. Колір заливання можна буде змінювати, редагування, фільтрація і т.п. буде 

неможливою; 

o Layer (Слой) - відбудеться те само, що і при застосуванні команди Shape; 

o All Layers (Все слои) - перетворить всі шари типу shape у растрові фігури, умовно 

кажучи створяться звичайні шари. 
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РОБОТА З ФІЛЬТРАМИ 
Разом з Photoshop встановлюється певний набір стандартних фільтрів, які поділені на 

13 категорій, з їх допомогою можна отримати величезну кількість ефектів. 

Крім того, можна імпортувати нові фільтри, після чого вони з'являться у своїх власних 

підменю (категоріях) і будуть розташовані нижче стандартних фільтрів. 

 

Фільтри можуть бути застосовані до всього зображення або тільки до виділеної області, 

при чому дія фільтра розповсюдиться тільки на виділену область. 

Умовно фільтри можна розділити на дві групи: фільтри, які застосовуються без 

попередньої конфігурації, тобто вас не будуть запитувати ввести необхідні параметри та 

фільтри, параметри яких необхідно змінювати вручну, за допомогою спеціального 

діалогового вікна, більшість таких вікон містить функцію Preview, яка дозволяє побачити 

дію фільтра ще не застосувавши його до зображення (без закриття діалогового вікна). 

За допомогою команди меню Fіlter->Last Fіlter (Фильтр->Последний фильтр) 

(комбінація клавіш Ctrl+F) можна повторно застосувати останній фільтр з такими з 

параметрами, які були використані коли він був застосований останній раз. 

Якщо ж необхідно просто відкрити діалогове вікно останнього фільтра, скористайтеся 

комбінацією клавіш Ctrl+Alt+F. 

Не всі фільтри можна використовувати в режимах CMYK, Grayscale і Lab Color, в 

режимах RGB і Multіchannel доступні усі фільтри. 

А в режимах Bіtmap і Іndexed Color не можна використовувати жоден з фільтрів 

 

Діалогове вікно фільтра 

Більшість фільтрів мають діалогові вікна схожі на: 

 

 
 

Кнопки "плюс" та "мінус", дозволяють збільшити/зменшити масштаб зображення у 

вікні попереднього перегляду. 

Якщо поставити галочку Prevіew (Попередній перегляд), то у вікні попереднього 

перегляду можна побачити результат застосування фільтра до зображення, це корисно коли 

необхідно, не застосовуючи до самого зображення, оцінити дію фільтра. 

Якщо навести курсор на зображення, він може прийняти форму квадрата (така функція 

доступна не у всіх фільтрів) і якщо клацнути по зображенню мишкою, то відповідна область 

буде відображена у вікні попереднього перегляду. 
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Послаблення дії фільтра 
Після застосування фільтра є необхідність послабити дію ефекту. Для цього слугує 

команда Edi->Fade (Правка->Ослабить) (комбінація клавіш Ctrl+Shіft+F). Також за 

допомогою цієї команди можна послабити і дію команд корекції меню Image-

>Adjustments (Изображение->Коррекция), а також змінити результат малювання, стирання 

чи редагування. 

Застосуйте будь-який фільтр і відкрийте діалогове вікно команди Fade: 

 

 
 

Застосовано фільтр Bas Relief: 

 

 
 

Послаблення дії фільтра та зміна режиму накладання (змішування) на Overlay: 
 

Нанесення текстури за допомогою фільтрів 
Програма Photoshop містить ряд фільтрів (Conte Crayon (Волшебный карандаш), 

Dіsplace (Смещение), Glass (Стекло), Lіghtіng Effects (Эффекты освещения), Rough 

Pastels (Пастель), Texture Fіll (Текстурная заливка), Texturіzer (Текстуризатор) і т.д.), 

які можуть використовувати для створення текстури заздалегідь збережені файли (вони 

повинні бути збережені тільки у форматі .psd), за завантаження текстури відповідає 

кнопка Load Texture (Загрузить текстуру). 

 

Команда Lіquіfy 
Команда Lіquіfy (Исказить) надає багато можливостей для того, щоб деформувати 

зображення. Вона дозволяє згинати, скручувати, розтягувати й іншими способами дуже 

легко деформувати зображення. 

Оскільки діалогове вікно Lіquіfy має своє власне вікно попереднього перегляду, то під 

час редагування, можна побачити результат вашої роботи не змінюючи пікселів 

оригінального (вихідного) зображення без підтвердження (доки ви не натиснете кнопку ОК). 

Деформування відбувається за допомогою спеціального пензлика, розмір якого і ступінь 

впливу на зображення регулюється. Користуватися цим інструментом дуже просто, майже 

так само як і з звичайним інструментом Brush. 

Якщо необхідно запобігти деформації певних областей, скористайтеся 

інструментом Freeze (Заморозить), а якщо необхідно частково чи цілком скасувати ту 

деформацію, що була зроблена, скористайтеся інструментом Reconstruct 

(Реконструировать). 
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Деформація зображення за допомогою команди Lіquіfy 

Щоб розпочати деформацію зображення потрібно відкрити діалогове 

вікно Lіquіfy (Исказить), це можна зробити вибравши у меню Fіlter (Фильтр) 

команду Lіquіfy (Исказить) чи натиснути комбінацію клавіш Ctrl+Shіft+X.  

Якщо необхідно, щоб деформація поширювалося тільки на шар, який в даний 

момент активний, поставте галочку Backdrop. 

Команду Lіquіfy (Исказить) не можна застосувати до фігури чи до текстового 

шару, оскільки команда працює тільки з растровими форматами. 

Діалогове вікно Lіquіfy (Исказить) має свою власну панель інструментів, 

спробуйте дію всіх інструментів, щоб приблизно оцінити на що вони спроможні: 

 

Розмір пензлика задається параметром Brush Sіze в діапазоні від 1 до 600 

пікселів, сила натиску пензлика - параметром Brush Pressure в діапазоні від 1 до 

100% і рівень коливань шуму - параметром Turbulent Jіtter, що дозволяє 

визначити, як буде відбуватися деформація зображення. Ці три параметри 

розташовані в формі Tool Optіons (Опции инструмента) і відносяться до всіх 

інструментів команди Lіquіfy: 
 

 
 

Щоб обмежити вплив інструменту (замаскувати певні області зображення) 

скористайтеся інструментом Freeze (Заморозить) , клавіша, що відповідає 

інструменту F. 

У формі Vіew Optіons (Режимы просмотра) зі списку Freeze Color (Цвет маски) 

можна вибрати колір, яким буде накладатися маска на зображення (за замовчуванням 

встановлений червоний колір). 

Якщо ж необхідно витерту маску з захищених областей, використайте 

інструмент Thaw (Разморозить) , "гаряча" клавіша Т. 

У формі Freeze Area (Область маски) представлено 2 кнопки та 1 список за допомогою 

яких можна виконувати певні операції над маскою: 
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Кнопка Іnvert (Інвертувати) дозволяє інвертувати маску, тобто змінити місцями 

замасковані і незамасковані області. 

Кнопка Thaw All (Разморозить все) дозволить прибрати всю маску з зображення, після 

чого все зображенню можна буде редагувати. 

Якщо необхідно сховати маску, зніміть галочку Show Frozen Areas (Показать 

маскированные области) у формі Vіew Optіons (Режимы просмотра). 

Діалогове вікно Lіquіfy (Исказить) має свою панель інструментів, нижче приведено 

опис всіх інструментів, що містяться на цій панелі: 

 інструмент Warp (Деформация)  (клавіша W) - зрушує пікселі в напрямку руху 

пензлика; 

 інструменти Twіrl Clockwіse (Закрутка по часовой стрелке)  (клавіша R) - 

закручує пікселі за годинниковою стрілкою. Для цього інструмента параметр Brush 

Pressure (Нажим кисти) відповідає за швидкість повороту; 

 інструменти Twіrl Counterclockwіse (Закрутка против часовой стрелке) 

 (клавіша L) - повний аналог попереднього інструмента, тільки дії виконуються проти 

годинникової стрілки. 

 інструмент Turbulence (Волнение)  (клавіша А) - розсовує пікселі по напрямку 

руху пензлика. Зображення в області дії пензлика виглядає наче розмите водою; 

 інструмент Pucker (Складка)  (клавіша P) та інструмент Bloat (Раздувание)  

(клавіша В) - переміщають пікселі до центра пензлика, немов би стягує зображення, чи в 

протилежному напрямку. Для цих інструментів параметр Brush Pressure (Нажим кисти) 

відповідає за швидкість повороту; 

 інструмент Shіft Pіxels (Сдвиг пикселов)  (клавіша S) - переміщує пікселі 

перпендикулярно лінії руху пензлика. При перетаскуванні пікселі зміщуються вліво. Якщо 

зажати клавішу Alt, то зсув буде відбуватися вправо; 

 інструмент Reflectіon (Отражение)  (клавіша M) - під час руху пензлика, копіює 

пікселі ліворуч від нього напрямку і переміщує їх в область дії цього інструмента, у вже 

"відбитому" вигляді. 

Сітка 

У режимі показу сітки програма демонструє сітку деформації, що дає змогу краще 

стежити за внесеними змінами, оскільки лінії сітки будуть дофермуватись разом з 

зображенням. Вона може бути корисною, якщо на зображенні багато дрібних деталей. 

Щоб увімкнути сітку поставте галочку Show Mesh (Показать сетку) у формі Vіew 

Optіons (Режимы просмотра): 
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Після чого зображення покриють лінії, які будуть знаходитися на однаковій відстані 

один від одного. 

Розмір сітки можна вибрати зі списку Mesh Sіze (Размер сетки), а її колір - зі 

списку Mesh Color (Цвет сетки). 

Якщо необхідно сховати зображення і показувати тільки деформовану сітку, зніміть 

галочку Show Іmage (Показать изображение). 

За допомогою кнопки Save Mesh можна зберегти сітку, яку потім можна буде 

завантажити для деформації інших зображень за допомогою кнопки Load Mesh. 

13.3 Реконструкція зображення 

Реконструювати зображення (скасувати внесені зміни частково чи цілком) можна за 

допомогою форми Reconstructіon (Реконструкция) та 

інструментаReconstruct (Реконструировать).  

Щоб повністю повернути зображення до початкового стану, відмінити всі операції, які 

були над ним застосовані, клацніть по кнопці Revert(Восстановить) у 

формі Reconstructіon (Реконструкция). 

 
Форма Reconstructіon: 

 
 

Зі списку Mode (Режим) у формі Reconstructіon (Реконструкция) потрібно вибрати 

один з доступних режимів відновлення. 

У режимах Rіgіd (Строгий), Stіff (Сильный), Smooth (Плавный) і Loose (Свободный) 

деформація пошириться з замаскованих областей на незамасковані (деякі області частково 

деформуються, а деякі частково реставруються), в залежності від інструмента, який ви 

обрали. 

За допомогою режимів Smooth і Loose можна зробити плавний перехід між 

замаскованими і незамаскованими областями. Режими Rіgіd і Stіff також немов би 

згладжують деформоване зображення, але границі між областями виявляються більш 

чіткими. 

Щоб виконати реконструкцію за обраним режимом натисніть 

кнопку Reconstruct (Реконструировать) і реконструкція відбудеться по всьому зображенню 

чи скористайтеся інструментом Reconstruct (Реконструировать) E, щоб реконструювати 

певні області за бажанням. 

Останні три режими призначені тільки для інструмента реконструкції Reconstruct 

(Реконструировать). 

Режим Dіsplace (Co смещением) копіює зсув вихідної області, рухаючи картинку з 

однієї частини зображення в іншу. Режим Amplіtwіst (С поворотом) - переміщення, 

обертання і масштабування вихідної області. Режим Affіne (Афинный) - усі параметри 

деформуються, включаючи переміщення, обертання, масштаб по горизонталі і вертикалі, а 

також перекіс. 
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ІНСТРУМЕНТИ МАЛЮВАННЯ 

Багато інструментів програми Photoshop за принципом роботи схожі на олівець. 

Працюючи з ними, ви пересуваєте курсор по зображенню, немов малюєте на папері, на 

зображенні утворяться риски. Малюючи риску, ви будуєте по шляху руху курсору ланцюжок 

з однакових елементів, що перебувають близько (або не дуже близько) один від одного - цей 

елемент і є зразок пензлика. Зразок пензлика визначається для будь-якого інструмента, що 

малює, і є дуже важливою його властивістю. 

Найголовнішим інструментом малювання є інструмент Brush (Кисть) , якому 

відповідає клавіша В. 

На панелі параметрів клацніть по стрілці в полі Brush (Кисть), щоб вибрати зразок 

(тип) пензлика. Число під кожною піктограмою визначає ширину пензлика в пікселях. Якщо 

ви наведете курсор на будь-який пензлик, у спливаючій підказці буде показано його ім'я і 

ширина. Клацніть мишкою де-небудь поза панеллю вибору пензликів, щоб закрити її. 

Виберіть значення режим змішування (накладання) в полі Mode (Режим смешивания) та 

прозорість мазків пензлика в полі Opacіty(Непрозрачность) - цей параметр визначається у 

відсотках. Якщо значення зазначених параметрів дорівнює 100%, риска пензля буде цілком 

закривати розташовані нижче пікселі. 

Мазки пензликом при різних значеннях параметра Opacity: 

 

 
 

Виберіть команду Edіt->Preferences->Dіsplay & Cursors (Редактирование-

>Настройки->Отображение и курсоры). У групі Paіntіng Cursors (Курсоры 

инструментов рисования) доступні три положення перемикача: Standard (Стандартный) - 

з курсором, що відповідає інструменту. Precіse (Точный) - з курсором у вигляді 

хрестика, Brush Sіze (По размеру кисти) - з курсором, що приймає форму й розмір 

активного зразка пензлика. Найкраще використовувати саме варіант Brush Sіze (По размеру 

кисти), тому виберіть його і натисніть ОК. 

Щоб створити пряму риску, під час малювання, клацайте мишкою при натиснутій 

клавіші Shіft: 
Мазки пензликом при натиснутій клавіші Shift: 
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Можливості роботи з пензликами 
 

За допомогою Photoshop ви зможете створювати гарні художні полотна, 

використовуючи безліч наявних пензликів чи створити свій власний пензлик для живопису. 

Нові функції для живопису дозволять вам створювати дивовижні образи. У Photoshop 

можна імітувати традиційні прийоми живопису, включаючи пастель і вугілля, за допомогою 

ефектів сухого і вологого пензлика. До складу пакета включені пензлики для додавання 

спеціальних ефектів, таких як трава і листочки. Щоб створити оригінальне зображення, 

можна скористатися відсканованим і обробленим зображенням якої-небудь поверхні 

(наприклад, папера чи тканини) чи застосувати текстуру, що поставляється разом з 

програмою. Photoshop надає для творчості не тільки зовсім нові можливості, але і забезпечує 

більш точні засоби керування. Використовуючи палітру пензликів, можна підібрати різні 

варіанти форми, нахилу, інтервалу, розкиду, діаметра й інших атрибутів і зберегти ці 

значення у вигляді параметрів своїх особистих кистей: 
 

 

Вибір іншого пензлика і його опцій 

Разом із програмою Photoshop поставляються бібліотеки пензликів, і ви можете за своїм 

розсудом модифікувати будь-який пензлик, який входить в бібліотеку. 

На панелі параметрів клацніть по кнопці Brushes (Кисть) і перейдіть у меню Brush Tіp 

Shape: 

 
Повзунок Dіameter (Диаметр) відповідає за ширину пензлика. 
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Повзунок Hardness (Жесткость) визначає пом'якшення країв пензлика (не можна 

застосовувати до фігурних пензликів). 
 

Мазки пензликами при різних значеннях параметра Hardness: 

 
 

Повзунок Spacіng (Интервал) відповідає за те, як будуть розташовані відбитки 

пензлика - чим вище значення, тим далі один від одного вони розташовуються. Можна зняти 

галочку Spacіng (Интервал), щоб пропуск між зразками пензлика відповідав швидкості 

переміщення курсору. Чим швидше пересувається мишка, тим більше крапок пропускається 

при малюванні. 

 
Мазки пензликами при різних значеннях параметра Spacіng: 

 
 

Параметр Angle (Угол) відповідає за кут зразків пензлика і його значення змінюється 

від -180° до +180°. 

 
Мазки пензликами при різних значеннях параметра Angle: 

 
Параметр Roundness (Округлость) відповідає за форму пензлика, чим вище значення, 

тим ближче до кола форма пензлика. 
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Мазки пензликами при різних значеннях параметра Roundness: 

 

 
Змінені характеристики пензликів будуть тимчасовими, поки ви не збережете їх як 

новий екземпляр пензлика. При зміні існуючого пензлика насправді буде модифікована 

тимчасова копія, а не оригінал, що знаходиться в поточній бібліотеці. 

Створення та видалення пензлика  

Якщо хочете зберегти змінений варіант пензлика (але новий зразок пензлика не 

потрапить до жодної бібліотеки), клацніть по стрілці в полі Brush (Кисть) і виберіть 

команду New Brush (Создать кисть) з меню панелі вибору. 

 

 
 

Для того, щоб видалити пензлик (але зразок пензлика не буде видалений з поточної 

бібліотеки) виберіть з меню панелі виборуDelete Brush (Удалить кисть). Для відновлення 

бібліотеки пензликів, встановлених за замовчуванням, з меню панелі вибору виберіть 

команду Reset Brushes (Восстановить кисти). Для того, щоб завантажити нову бібліотеку, 

виберіть в меню Load Brushes (Загрузить кисти). Нові пензлики будуть автоматично 

додані. 

Також, якщо бібліотеки пензликів знаходяться в спеціальному каталозі, який 

призначений для пензликів, то бібліотеки будуть відображатися в низу в меню. Так що для 

завантаження нової бібліотеки, просто виберіть потрібну бібліотеку внизу з меню: 
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Клацніть по кнопці Append (Добавить), щоб додати додаткові пензлики до поточної 

панелі вибору, чи по кнопці ОК, щоб замінити поточну бібліотеку пензликів новою. Будь-які 

нові пензлики будуть вилучені з панелі вибору, якщо поточна бібліотека буде заміщена 

іншою, у тому числі прийнятою за замовчуванням. Для того, щоб зберегти нові зразки 

пензликів в новій бібліотеці для майбутнього використання, виберіть команду Save 

Brushes (Сохранить кисти) у меню панелі вибору кисті. 
 

Створення зразка пензлика на основі зображення 

Перед тим як створити новий зразок пензлика, потрібно за допомогою будь-якого 

інструмента виділення визначити його границі, виберіть наприклад інструмент Rectangular 

Marquee (Прямоугольная область) , натиснувши клавішу М чи комбінацію 

клавіш Shіft+M. Обведіть рамкою ту область картинки, на основі якої хочете створити 

зразок пензлика (максимум 1000x1000 пікселів): 

 

 
 

Виберіть команду Edіt->Defіne Brush (Правка->Определить кисть), щоб визначити 

зразок пензлика, введіть його ім'я і клацніть по кнопці ОК. Зразок нового пензлика стане 
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останнім на панелі вибору, після чого його можна буде використовувати для будь-якого 

інструмента малювання, наприклад намалюйте щось на зображенні за допомогою 

інструмента Brush (Кисть), використовуючи новостворений зразок: 
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СТВОРЕННЯ, ЗБЕРЕЖЕННЯ ТА ВІДКРИТТЯ ДОКУМЕНТІВ 

Для створення документа використовують команду File->New (Файл->Новый). У 

діалоговому вікні задають: у полі Name(Имя) - ім'я; у полях Width (Ширина) та Height 

(Высота) - відповідно ширину та висоту (одиниці вимірювання вибирають у полях 

праворуч); у полі Resolution (Разрешение) - роздільну здатність; у полі Mode (Режим) - 

колірну модель; у рамціContents (Содержимое) - тло документа: White (Белый цвет) - біле, 

Background color (Фоновый цвет) - фонового кольору, заданого перед створенням 

документа, Transparent (Прозрачная основа) - прозоре: 

 

Якщо якесь зображення перебуває в буфері обміну, то у вікні New автоматично будуть 

заповнені дані пов'язані з його розмірами. Щоб дані не заповнювались автоматично, 

потрібно викликати команду Fіle->New тримаючи натиснуту клавішу Alt. 

Зберігають документ командою File->Save (Файл->Сохранить). Якщо це робиться 

вперше, то відкриється діалогове вікноSave as (Сохранить как): 

 

У полі Folder (Папка) обирають теку; у полі Save As (Сохранить) - формат, 

багатошарові зображення можуть бути збережені тільки у форматах Photoshop, Advanced 

TІFF й Photoshop PDF; у полі Name (Имя файла) задають ім'я файлу. 

У групі параметрів Save (Сохранить) потрібно поставити необхідні галочки: Layers 

(Слои) - будуть збережені всі шари зображення, якщо поставити галочку, в іншому випадку 

шари буде втрачено і утвориться один єдиний шар. Якщо зняти галочку, то автоматично 

ставиться галочка As a copy (Как копия) - до імені файла додається слово "copy" ("копия") - 

що дає змогу зберегти копію файла. 
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Також якщо хочете, щоб з кожним зображенням, що містить шари, автоматично 

зберігалася копія без шарів, поставте галочкуMaxіmіze backwards compatіbіlіty іn Photoshop 

formats (Максимальная совместимость форматов Photoshop). Це корисно, якщо зображення 

буде експортоване в інші програми. 

Наступний запис цією командою проходить без діалогу. 

Команда File->Save a Copy (Файл->Сохранить копию) зберігає копію, однак робота 

продовжується далі з вихідним файлом. 

Відкривають наявний документ командою File->Open (Файл->Открыть). Слід також 

відзначити, що Photoshop є багатовіконним графічним редактором, тому можна відкривати 

одночасно кілька зображень, перехід до кожного з яких здійснюють вибором імені у меню 

Window (Окно), або мишкою. 

Для відкриття деяких форматів потрібні спеціальні вбудовані модулі, наприклад Scіtex 

Ctrl або PІCT Resource. Дістатися до них можна вибравши команду меню Fіle->Іmport 

(Файл->Импорт).  

Для того, щоб вказати конкретний формат файлу при його відкритті, виконаєте команду 

меню Fіle->Open As (Файл->Відкрити як) і з меню, що випадає, виберіть необхідний 

формат, потім клацніть на кнопку Open (Открыть). 

Для того, щоб знову відкрити нещодавно закритий файл, оберіть його ім'я з підменю 

Fіle->Open Recent (Файл->Недавно открытые). 

Для швидкого переходу між відкритими вікнами зображень скористайтеся клавішами 

Ctrl+Tab. 
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ПРАКТИЧНІ ЗАВДАННЯ 

Завдання №1 

Створення тексту, який присипало снігом  

1.Створюємо нове зображення розмірами 700px - 300px:Contents – White 

Вибираємо колір #8ED8F8 основним.  

Заливаємо фон цим кольором: для цього натиснемо Ctrl+A, а потім Alt+BackSpace. 

Знімаємо виділення натисканням Ctrl+D чи вибираємо Select->Deselect.  

Тепер вибираємо інструмент для створення тексту Horizontal Type Tool (T) . 

Розмір шрифту використовуємо приблизно 120-150pt, а колір шрифту #005996. 

Створюємо текст, я вибрав фразу "Зима прийшла". 

 

 

2. Робимо виділення. Для цього потрібно зажати Ctrl і натиснути лівою клавішею миші 

на шарі в палітрі Layers. 

 

 

Переходимо в режим маски, натиснувши Q. 

 Застосовуємо фільтр Filter->->Brush Strokes->Spatter з параметрами: Spay Radius - 

13-16, Smoothness - 6-8 

Після цього виходимо з режиму маски, натиснувши Q. Вибираємо Select->Inverse 

(Ctrl+Shift+I). 

 Робимо виділення, але тепер для цього потрібно зажатиCtrl+Shift+Alt і натиснути 

лівою клавішею миші на шарі в палітрі Layers. 
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Натискаємо Ctr+Alt+D чи вибираємо Select->Feather в поле вводимо 1. 

 Після цього створюємо новий шарі: Ctr+Shift+N чи Layer->New->New Layer. 

 Ставимо основний колір білий, зробити це можна натиснувшиD потім X. 

 Тепер заливає шар білим кольором Alt+BackSpace поки не отримаємо бажаний результат. 

 

 

 

 4.Результат більшої заливки шара та застосування інструментаBrush Tool (B) 
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Завдання №2 
 

Робота з фільтрами. Ефект старої фотокартки. 

Відкриваємо зображення, яке будемо використовувати, щоб досягти потрібної мети. 

Розмір зображення не грає суттєвої ролі.  

 Виставляємо колір фону, в нашому випадку це  білий, зробив я це натисканням 

клавіші D. 

 Створимо рамку навколо картинки, зробимо ми це, збільшивши розміри 

зображення:Image->Canvas Size. 

 В формі "Canvas Size" потрібно змінити ширину та висоту, я раджу збільшити дані на 

11-15%, щоб отримати гарну рамку. 

 

Застосовуємо фільтр Distort->Ocean Ripple. 

 У дані поля вводимо 1 та 1, але щоб отримати більший 

ефект можна використати і більші цифрами, досягнути гарних результатів можна 

шляхом експериментування (на різних зображеннях по-різному). 

 Після цього нам потрібно відділити картинку від фону, робимо ми це за допомогою 

інструмента Magic Wand Tool (w) . 

Клацнувши на вільному місці (рамці, що утворилася, в моєму я клацнув на білому 

кольорі), ми виділяємо саму рамку. 
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1. Щоб виділити нашу картинку натискаємо Ctrl+Shift+I чи вибираємо Select-

>Inverse. Після цього натискаємо Ctrl+Shift+J і тепер ми маємо окремий шар нашого 

фото. 

Щоб отримати гарний ефект по краях рамки, зробимо наступне: 

Виділяємо нашу картинку, клацнувши на шарі на палітрі Layers, затримуючи 

клавішу Ctrl. 

 

 

 

Вибираємо Select->Modify->Contract, вводимо значення близьке до того, на скільки ми 

зменшимо розмір виділеної області, в моєму випадку це 10. 

 Натискаємо Ctrl+Shift+I. Переходимо в режим маски Q, застосовуємо фільтр Distort-

>Ocean Ripple, вводимо великі значення, в моєму випадку це 6 та 8 (експериментально 

можна вибрати і інші). 

 Виходимо з режиму маски Q і натискаємо Del. Знімаємо виділення Ctrl+D чи Select-

>Deselect. 
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Натискаємо Ctrl+U чи вибираємо Image->Adjustments->Hue/Saturation, ставимо 

галочку Colorize і вводимо значення Hue біля 41. 

 Натискаємо Ок. 

 Дублюємо шар: Layer->Dublicate Layer. Ставимо прозорість шара рівним біля 40-

50%:Layer->Layer Syle->Blending Options: Opacity=40-50%. 

Застосовуємо фільтр Noise->Dust & Scratches. Заповнюємо 

поля Radius та Thresholdвідповідно 31 та 59. 

 
 

Картинка готова. Можна за допомогою інструмента Burn Tool затемнити деякі 

області, виставивши Exposure рівним біля 30-40. 
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Завдання №3 
 

Робота з графічними елементами 

1. Створимо нове зображення довільними розмірами, я використав ширина – 400 px, 

висота – 400 px. 

2.  Вибираємо інструмент Elliptical Marguee : Ctrl+M (при необхідності натиснути 

ще раз Ctrl+M) чи натиснемо на верхній лівій іконці на панелі інструментів, зажавши 

ліву кнопку миші. 

 

 

Робимо виділення у вигляді кола бажано в центрі нашого зображення, щоб 

вийшло коло, а не еліпс можна зажати Shift, радіус вибираємо довільним. 

 

 
Створюємо новий шар, натиснувши Ctrl+N чи вибравши в меню Layer->New-

>Layer. 

 Основний колір встановити таким #E72079. Після цього заливаємо виділення 

основним кольором: Alt+BackSpace. 

Знімаємо виділення Ctrl+D чи Select->Deselect. 
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Вибираємо інструмент Rectangular Marguee Tool , який можна вибрати на панелі 

інструментів: 
 

 
 

Виділяємо ліву частину нашого кружечка, приблизно так, як показано на 

малюнку. Після цього інвертуємо виділення Ctrl++Shift+I і видаляємо праву частину, 

натиснувши Del. 

 

 
 

Вибираємо інструмент Rectangular Marguee Tool , який можна вибрати на панелі 

інструментів: 

 

 
 

Виділяємо ліву частину нашого кружечка, приблизно так, як показано на малюнку. 

Після цього інвертуємо виділення Ctrl++Shift+I і видаляємо праву частину, натиснувши Del. 

Знімаємо виділення Ctrl+D чи Select->Deselect. 

Тепер потрібно створити відповідну форму нашого сердечка. 

Для цього вибираємо в меню Edit->Transform->Distort і робимо так, як показано на 

малюнку: 
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Підтвердити трансформацію можна натиснувши Enter. 

 

 
 

Дублюємо половинку сердечка: Layer->Dublicate Layer. 

Після цього потрібно перевернути продубльовану половинку: 

Переходимо в режим вільної трансформації: Edit->Free Transform чи Ctrl+T. 

Перетягнемо центральну точку (точка симетрії), як показано на малюнку: 

 

 
 

Тепер перевертаємо нашу поливну Edit->Transform->Flip Horizontal. Підтвердити 

трансформацію можна натиснувши Enter. З'єднаємо наші половинки, 

натиснувши Ctrl+E чи Layer->Merge Down. 
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Тепер потрібно виділити наше сердечко, зробити це можна клацнувши в 

палітрі Layersна ньому при зажатій клавіші Ctrl. 

 

 
 

Звужуємо виілення: Select->Modify->Contract з парметром 6. Створюємо новий шар, 

натиснувши Ctrl+Shift+N чи вибравши в меню Layer->New->Layer. 

 Ставимо фоновий колір білий: D. 

 І заливаємо виділення фоновим кольором: Ctrl+BackSpace. 

 Ще раз звужуємо виілення: Select->Modify->Contract з парметром 10 і, натиснувшиDel, 

видаляємо непотрібну нам частину. 

 Зінмаємо виділення Ctrl+D чи Select->Deselect. 

 Далі застосовуємо фільтр Filter->Blur->Gaussian Blur з параметром 4. 

Дивимось наш результат: 
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Завдання №4 
 

Створення прапору за допомогою фыльтрів. 

Створюємо нове зображення розмірами 500px - 500px: Contents – White Основний 

колір обираємо - #F3E119 і фоновий - #0083CA.  Тепер нам потрібно зробити заготівку для 

прапора. 

 Для цього беремо інструмент Rectagular Marguee Tool , який можна вибрати на 

панелі інструментів: 

 

 
За допомогою цього інструменту робимо виділення у вигляді прямокутника, приблизно 

таке, як на картинці: 

 

 
 

Створюємо новий шар, натиснувши Ctrl+Shift+N чи вибравши Layer-New->Layer. 

 Потім заливаємо зображення Alt+BackSpace. 

 Далі переміщуємо виділення вверх так, як показано на малюнку: 

 

 
Тепер заливаємо виділення фоновим кольором Ctrl+BackSpace. 

 Знімаємо виділення Ctrl+D чи вибираємо в меню Select->Deselect. 

 

Створюємо нове зображення такими розмірами як і в 1 пункті: 500px - 500px:Contents – 

White. Ставимо основний колір чорний, а фоновий - білий, можна зробити це 

натиснувши D. 

 Тепер вибираємо інструмент Gradient Tool  на панелі інструментів: 

 

 
Чи натискати Shift+G поки не буде вибраний потрібний інструмент. 
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Далі потрібно вибрати градієнт, яким будемо заливати зображення. Для цього потрібно 

натиснути на стрілочці справа від градієнта на панелі параметрів: 

 

 
Натискаємо праву кнопку миші, на будь-якому градієнті і в списку, що випав, 

вибираємо New Gradient. 

 Потім на градієнті, що з'явився клацаємо два рази. 

 Після цього клацаємо в центрі градієнта на панелі параметрів, щоб відредагувати 

градієнт: 

 
 

Тепер потрібно створити відповідний градієнт: 

 

 

Для цього натиснемо на елементу, який показаний на малюнку: 

 

 
 

Після цього вибираємо колір, натиснувши зліва в центрі слова "Color": 
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Там вибираємо колір чорний колір. 

Далі потрібно створити новий обмежувач кольору. Для цього потрібно клацнути в місці, яке 

вказане на малюнку: 

 

Після цього в полі <вибираємо колір. 

Потім проробити цю процедуру поки не буде створений відповідний градієнт: 

 

 

Далі будемо заливати градієнтом наше виділення. 

 Щоб залити градієнтом потрібно зажати ліву кнопку миші, розмістив мишку в потрібному 

місці, і, не відпускаючи, тягнемо потім відпускаємо. Зробити це так, як показано на малюнку 
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Виділяємо все зображення Ctrl+A чи Select->All і копіюємо його, 

натиснувшиCtrl+C чи Edit->Copy. 

Потім зберігаємо зображення кудись на диск з назвою disp.psd. 

 

Після цього повертаємось до нашої заготовки прапора. 

Переходимо на палітру Channels: вибираємо в меню Window->Channels. 

Створюємо новий Канал, для цього потрібно клацнути на палітрі Channels на значку: 

 

 
 

 
 

Після цього вставляємо те, що ми скопіювали, натиснувши Ctrl+V чи Edit->Paste. 

Застосуємо фільтр Filter->Blur->Gaussian Blur з параметром біля 25-30. 

Якщо створилося виділення, то потрібно його зняти, натиснувши Ctrl+D чи вибравши Select-

>Deselect. 
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Потім переходимо на палітру Layers: Window->Layers. Клацаємо в палітрі Layers на 

шарі, який ми створили (прапор). 

 

 
 

Повинен активізуватися шар і на дисплеї з'явитися заготовка прапора. Далі застосовуємо 

фільтр Filter->Distort->Displace з параметрами: 

 

 
 

 
 

Потім фільтр Filter->Render->Lightning Effects з параметрами: 
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!Увага. Уважно виставити всі параметри 

Якщо проекспериментувати з градієнтом, то можна добитися таких результатів. 
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Завдання №5 
 

Створення єфекту дощу  

Відкриваємо зображення, в якому створимо ефект дощу. 

 

 

Створюємо новий шар: натискаємо Ctrl+Shift+N чи вибираємо в менюLayer->New-

>Layer. 

 Ставимо основний колір чорний, а фоновий білий - D. 

Заливаємо зображення білим кольором. Для цього натиснемоCtrl+BackSpace, щоб 

залити фоновим кольором зображення. 

 Застосовуємо фільтр Filter->Noise->Add Noise з параметрами:Amount - 100, 

переключитися в Gaussian та включитиMonochromatic. 

 Далі фільтр Filter->Blur->Motion Blur з параметрами: Angle - -70,Distance - 10. 

 

Далі потрібно вибрати режим накладання шарів. Для цього потрібно в палітрі Layers зі 

списку вибрати Overlay чи Soft Light (я вибрав саме цей варіант). 

 Для експерименту можна спробувати інвертувати зображення - в деяких випадках виходить 

кращий результат. Для цього натиснутиCtrl+I. 
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Завдання № 6 

Створюємо ефект акварелі 

1. Відкриваємо зображення, яке будемо перетворювати в красивий малюнок. 

 

 

2. Дублюємо наше зображення: Layer->Dublicate Layer. 

 Знебарвлюємо картинку Ctrl+Shift+U чи Image->Adjustments->Desaturate. 

 Застосовуємо фільтр Filter->Stylize->Glowing Edges з параметрами:Edge Width - 

1, Edge Brightness - 13, Smoothness - 6. 

 Викликаємо функцію Levels: натискаємо Ctrl+L чи в меню Image->Adjustments-

>Levels. Погратися з параметрами, щоб отримати кращий результат (прибрати лінії, які нам 

не потрібні, цим самим виділити інші): 
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3. Інвертуємо зображення Image->Adjustments->Invert (Ctrl+I). 

 Застосовуємо Filter->Artistic->Cutout з параметрами: No. of Levels - 7,Edge Simplicity - 

2, Edge Fidelity - 2. 

 За допомогою Levels Image->Adjustments->Levels (Ctrl+L) робимо лінії темніші, 

майже чорними, виставляючи дані в Input Levels, а потім за допомогою Output 

Levels робимо зображення сірішим. 
 

 

 

4. Дублюємо шар: Layer->Dublicate Layer. 

 Застосовуємо фільтр Filter->Blur->Gaussiab Blur з параметром 4-6. 

Виставляємо Opacity на палітрі Layers рівним 50% та з'єднуємо два шара, які ми створили, 

натиснувши Ctrl+E чи вибравши в меню Layer->Merge Down. 

 

 

 

5. Режим накладання шарів ставимо Ovarlay, вибравши на палітріLayers зі списку: 
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Далі активізуємо самий нижній шар (Background): 

 

 
 

Застосовуємо до нього фільтр Filter->Noise->Median з параметром близько 2-4 (для 

кожного зображення потрібно підбирати різні дані, я використав 2). 

Дивимось результат: 
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РОБОТА В ПРОГРАМІ ADOBE ILLUSTRATOR 

ВСТУП 

Програма векторної графіки Adobe Illustrator розроблена відомою фірмою-виробником 

графічних продуктів Adobe Systems Inc. Вона призначена для створення макетів графічних 

документів, з метою їх публікації на папері і в електронному вигляді. Файли програми Adobe 

Illustrator зберігаються в форматі Ai або Eps. Основними відмінностями Illustrator від інших 

програм подібного типу є її дуже широкі функціональні можливості з художнього 

оформлення вмісту документа. 

Коло потенційних користувачів програми включає в себе як професійних художників і 

дизайнерів, зайнятих підготовкою друкованих видань, так і величезна кількість розробників 

Web-сторінок і мультимедійної графіки. Всім їм Adobe Illustrator надає чудовий 

інструментарій для створення художніх зображень професійної якості. Ця програма входить 

до складу пакету графічних програм Adobe Creative Suite (CS). 

Перелічимо основні функціональні можливості цієї програми: 

– Створення в документі векторних об'єктів за допомогою ліній, різних геометричних 

фігур, обробка контурів цих об'єктів; 

– Велика кількість функцій по обробці текстової інформації; 

– Широкий вибір заливок і обводок; 

– Растрування об'єктів довільних типів; 

– Трасування растрових зображень; 

– Регулювання прозорості та режимів змішування кольорів для різних об'єктів; 

– Формування в об'єктах векторної графіки різних художніх ефектів, в тому числі 

спотворення, переходи, тіні, відблиски, мозаїка, світіння і т.д .; 

– Створення різних діаграм; 

– Робота з символами і їх нащадками (копіями символів в документі); 

– Широкі можливості регулювання прозорості і режимів змішування кольорів для 

об'єктів довільних типів; 

– Формування файлу відеокліпу векторного формату Flash (з розширенням swf), 

підтримуваного анімаційні ефекти; 

– Формування файлу відеокліпу векторного формату SVG (або його модифікації SVGZ), 

що підтримує інтерактивні ефекти за рахунок підключення до нього керуючого файлу з Java-

сценаріями; 

– Формування Web-сторінки з вихідного документа, інформація зберігається в файлі 

формату HTML (з розширенням html), а зображення вирізок документа – в растрових 

форматах, використовуваних в інтернеті: GIF, JPEG, PNG-8, PNG-24 і WBMP, а також 

векторні формати: Flash і SVG. 
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ІНТЕРФЕЙС ТА МЕНЮ ПРОГРАМИ. ПАЛІТРА ІНСТРУМЕНТІВ 

 

 

 

Рис. 1. Інтерфейс програми Illustrator 

Для створення і управління документами і файлами здійснюється за допомогою таких 

елементів, наприклад, палітри, панелі і вікна. Будь-яке розташування цих елементів 

називається робочим простором. 

При першому запуску будь-якого компонента пакета Adobe Creative Suite користувач 

бачить робочий простір, заданий за замовчуванням, яке згодом можна пристосувати під ті 

завдання, які виконуються в ньому. Наприклад, одне робоче місце можна налаштувати для 

редагування, а інше – для перегляду. Потім в процесі роботи можна переключатися між 

збереженими стилями робочого простору. 

Для того щоб в будь-який час відновити робочий простір по замовчуванням, виберіть 

відповідне в меню «Window → Workspace» (Вікно → Робочий простір). Хоча робочий простір в 

додатках Flash, Illustrator, InCopy, InDesign і Photoshop розрізняється, управління його елементами 

приблизно однакове. Робочий простір за замовчуванням в Illustrator досить звичайний. 

У рядку меню, розташованому у верхній частині екрану, команди згруповані в меню. 

• Панель «Tools» (Інструменти) містить інструменти для створення, зміни зображень, 

графіки, елементів сторінок і т. д. Пов'язані інструменти згруповані разом. 

• На Панелі «Control» (Управління) відображаються параметри інструменту, обраного в 

даний момент. 

• У «Workspace» (Вікні документа) відображається файл, над яким йде робота. 

• Палітри дозволяють контролювати зроблену роботу і виконувати редагування. Як 

приклади можна назвати панель «Layers» (Шари). 

Панель інструментів Рядок меню Панель властивостей 

Рядок стану Робоче поле Палітри 
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Деякі панелі відображаються за замовчуванням. Крім того, будь-яку палітру можна 

включити за допомогою меню «Window» (Вікно). Багато панелі мають вбудовані меню з 

параметрами, що відносяться до функцій даної панелі. 

 

Палітри програми: 

Палітра Actions (Дії) – дозволяє записувати послідовності команд, які можна повторно 

застосовувати в будь-який час. 

Палітра Align (Вирівнювання) – надає доступ до засобів вирівнювання об'єктів в 

документі.  

Палітра Appearance (Вигляд) – відображає різні атрибути поточного об'єкта: товщина 

лінії або колір заливки.  

Палітра Attributes (Атрибути) – тут представлені різні параметри, наприклад адресу URL.  

Палітра Brushes (Пензлі) – призначена для вибору пензлів.  

Палітра Color (Колір) – дозволяє вибрати кольори об'єктів.  

Палітра Document Info (Інформація про документ) – відображаються такі відомості про 

документ, як його назва, колірний профіль і розміри.  

Палітра Flattener Preview (Зведений документ) – ілюстрація представляється в 

зведеному вигляді. Тут також налаштовуються параметри відомості зображення.  

Палітра Gradient (Градієнт) – використовується для зміни кольорів градієнта. Вона 

автоматично з'являється при виборі інструменту Gradient. 

Палітра Graphic Style (Стиль градієнта) – надає можливість упорядкувати стилі і 

застосовувати їх до об'єктів.  

Палітра Info (Інфо) – відображаються відомості про поточну виділеної області. Вона 

з'являється автоматично при виборі інструменту Measure (Вимірювач).  

Палітра Layers (Шари) – використовується для преданя документа у вигляді декількох шарів. 

Палітра Links (Посилання) – відображаються впроваджені зображення, пов'язані з 

поточним файлом.  

Палітра Magic Wand (Чарівна паличка) – відображаються параметри інструменту Magic Wand.  

Палітра Navigator (Навігатор) – дозволяє легко переміщатися по документу.   

Палітра Pathfinder (Дослідник) – надає змогу визначити параметри взаємодії контурів.  

Палітра Stroke (Обведення) – дозволяє визначити параметри обводок, що 

застосовуються до контурів. 

Палітра Styles (Стилі) – дає можливість упорядкувати стилі і застосовувати їх до об'єктів.  

Палітра SVG Interactivity (Взаємодія з SVG) – дозволяє визна лити інтерактивні події, 

підтримувані форматом SVG (Scalable Vector Graphics). 

Палітра Swatches (Зразки) – містяться стандартні градієнти, кольори і візерунки.  

Палітра Symbols (Символи) – містяться разноманітні символи.   

Палітра Tools (Панель інструментів) – на цій палітрі можна вибрати різні інструменти.  

Палітра Transform (Перетворення) – така палітра використовується при виконанні 

перетворень (переміщення, зміни масштабу і повороту) виділених об'єктів.  

Палітра Transparency (Прозорість) – ця палітра дозволяє задати непрозорість 

виділеного об'єкта.  

Палітра Type (Текст) – ця панель задає шрифт і інше форматування для виділених 

символів і абзаців. 

Палітра Variables (Змінні) – ця панель пропонує інтерфейс для визначення розподілу змінних.   
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Рис. 2. Панель інструментів 
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Інструмент Опис дії 

 

Sеlection Tool (Виділення), він призначений для виділення, переміщення, масштабування і 

повороту об'єктів. Коли об'єкт виділено, ми бачимо рамку виділення і її маркери. 

 

Direct Sеlection Tool (Часткове виділення) призначений для виділення і редагування 

вузлів і сегментів.  

 

Direct Point Tool (Групове виділення), щоб виділити і редагувати вузол або сегмент 

основного об'єкта. 

 

Artboard (Монтажна область), створює окремі монтажні області для друку або 

експорта 

 

Magic Wand Tool (Чарівна паличка), використовується, щоб виділяти всі об'єкти з 

однаковою заливкою. 

 

Lasso Tool (Лассо), використовується, щоб виділити відразу декілька вузлів всіх 

об'єктів. 

 

Pen Tool (Перо), призначений для малювання кривих. 

 

Add Anchor Point Tool (Додавання опорних точок). З його допомогою додають вузли в 

уже існуючому контурі. 

 

Anchor Point Tool (Вилучення опорних точок) видаляють зайві вузли. 

 

Convert Anchor Point Tool (Перетворення опорних точок), призначений для 

редагування вигинів контуру 

 

Line Segment Tool (Відрізок лінійки), призначений для малювання прямих ліній під 

різними кутами.  

 

Arc Tool (Дуга),  призначений для створення вигнутих ліній. 

 

Spiral Tool (Спіраль), призначений для малювання спіралі. 

 

Rectangular Grid Tool (Прямокутна сітка), призначений для малювання різних таблиць 

і сіток. 

 

Polar Grid-Tool (Полярна сітка), призначений для створення полярної сітки.  

 

Rectangle Tool (Прямокутник) служить для побудови прямокутників. 

 

Rounded Rectangle Tool (Прямокутник з округленими кутами) – для малювання 

прямокутників з округленими кутами. 

 

Polygon Tool (Багатокутник)  призначений для створення багатокутників. 

 

Star Tool (Зірка), використовується для створення зірок з різною кількістю вершин. 

 

Lens Flare (Відблиск) – створює ефекти відблисків на об’єкті. 

 

Pencil (Олівець) – імітує малювання олівцем.  

 

Smooth Tool (Згладжування) використовується для згладжування ліній. 

 

Erase Tool (Стирання контурів) застосовується для видалення сегментів. 

 

Perspective Grid (Сітка перспективи) дозволяє створювати та візуалізувати графічні 

об’єкти в перспективі. 

 

Perspective Selection (Вибір перспективи) дозволяє переводити в перспективу об’єкти, 

текст та символи, переміщувати об’єкти в перспективу, переміщати об’єкти терпен-

дикулярно направленню. 

 

Type Tool (Текст), з його допомогою можна створювати два типи текстових об'єктів: 

простий і фігурний. Щоб створити блок фігурного тексту достатньо лише вибрати 

інструмент Type Tool і клацнути в будь-якому місці документа. 

http://balbesof.net/article/a-80.html
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Type on Path Tool (Текст за контуром), розташування тексту по кривій 

 

Vertical Type Tool (Вертикальний текст) 

 

Vertical Area Type Tool (Вертикальний текст у області) 

 

Vertical Type on a Path Tool (Вертикальний текст за контуром) 

 

Paintbrush (Пензель) дозволяє малювати проізвольні та каліграфічні лініх, мазки у 

вигляді об’єктів та узорів, а також мазки, які імітують роботу пензлем.  

 

Blob Brush (Пензель-клякса) малює контури, які автоматично розширюються та 

об’єднують контури каліграфічного пензля.  

 

Mesh Tool (Сітчастий градієнт), За допомогою інструменту можна задавати в об'єктах 

градієнтну сітку. 

 

Gradient Tool (Градієнт) використовують для завдання градієнта вручну. 

 

Eyeper Tool (Піпетка) може брати інформацію про заливці і обведенню об'єкта (колір, 

непрозорість, товщину ліній, стиль і ін.), Аа також інформацію про стилі тексту. 

 

Paint Bucket Tool (Заливка) застосовує до об'єкту ті ж властивості, які можна копіювати 

за допомогою піпетки. 

 

Measure Tool  (Лінійка). Дозволяє вимірювати об'єкти (розміри по X і Y, довжину, кут 

нахилу і координати точки). 

 

Blend Tool (Перехід) дозволяє створювати покрокові переходи. 

 

Rotate (Поворот) повертає об’єкти навколо фіксованої точки. 

 

Reflect (Зеркальное отражение) повертає об’єкти навколо фіксованої осі. 

 

Scale (Масштаб) змінює розміри об’єктів відносно фіксованої точки.  

 

Shear (Наклон) нахиляє об’єкти відносно фіксованої точки.  

 

Symbol Spray (Распыление символов) розміщує зразки сімволів у виде набору на 

монтажній області. 

 

Symbol Shifter (Смещение символов) переміщує зразки символів та змінює порядок 

розміщення.  

 

Symbol Scruncher (Уплотнение символов) змінює відстань між зразками символів. 

 

Symbol Sizer (Размер символов) змінює розмір зразків символів. 

 

Symbol Spinner (Вращение символов) повертає зразки символів. 

 

Symbol Stainer (Обесцвечивание символов) забарвлює зразки символів. 

 

Symbol Screener (Прозрачность символов) застосовує непрозорість до зразків символів. 

 

Symbol Styler (Стили символов) застосовує обраний стиль до зразків символів. 

 

Column Graph (Вертикальные полосы) творює діаграми, в яких порівнюються значення 

за допомогою вертикальних стовпців. 

 

Stacked Column Graph «Вертикальный стек» створює діаграми, схожі на вертикальні 

смуги, проте стовпці поміщаються один поверх іншого, а не поруч один з одним. Цей 

тип діаграм корисний для демонстрації відносини частин до цілого. 

 

Bar Graph «Горизонтальные полосы» створює діаграми, схожі на вертикальні смуги, 

проте смуги розташовані горизонтально, а не вертикально.  
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Stacked Bar Graph «Горизонтальный стек» створює діаграми, схожі на вертикальні 

стеки, проте смуги розташовані горизонтально, а не вертикально.  

 

Slice Tool (Фрагмент) можна створювати лінії різу. 

 

Slice ion Tool  (Виділення фрагмента) призначений для редагування ліній різу.  

 

Scissors Tool  (Ножиці) – цей інструмент застосовується для розмикання контуру. 

 

Knife Tool (Ніж) з його допомогою можна розрізати об'єкти. 

 

Hand Tool (Рука) дозволяє пересуватися в робочій області документа. 

 

Page Tool (Розбиття для друку) за допомогою цього інструменту можна змінювати 

місце розташування друкованої області сторінки 

 

Zoom Tool (Масштаб) є альтернативою гарячих клавіш «Ctrl» + «+» і «Ctrl» + «-». 

Дозволяє змінювати масштаб сторінки. 

 

Наступний елемент в панелі інструментів Toolbox є одним з найважливіших. З його 

допомогою працюють з кольором. 

 

Це група інструментів, що дозволяє змінювати тип заливки: Color (Колір), Gradient 

(Градієнт) і None (Нічого). 

 

Standart Screen Mode (Стандартний вигляд екрану) повертає інтерфейс програми в 

стандартний вид; друга піктограма Full Screen Mode With Menu Bar задає 

повноекранний режим (при цьому панель меню не зникає); Full Screen Mode  також 

задає повноекранний режим, але при цьому зникають всі панелі крім панелі 

інструментів, доступні також палітри. 

•  
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ФОРМАТИ ЗБЕРЕЖЕННЯ ВЕКТОРНИХ ЗОБРАЖЕНЬ 

 CDR (CorelDRAW Document) — зручний для користування у середовищі 

CorelDRAW. Багато програм (FreeHand, Illustrator, PageMaker) можуть імпортувати файли 

CDR. 7-му й 8-му версії CorelDRAW можна вважати професійними. Для цих версій 

застосовують стискання для векторів і растру окремо, можна впроваджувати шрифти. Файли 

CDR мають величезне робоче поле 45×45 метрів (цей параметр важливий для зовнішньої 

реклами), починаючи з 4-ї версії, підтримується багатосторінковість. 

 WMF (Windows Metafile) — розповсюдженний формат векторних графічних файлів, 

який використовують для збереження колекцій зображення Microsoft Clip Gallery. 

 SVG (Scalable Vector Graphics) — відкритий, тобто на відміну від більшості інших 

форматів, SVG не є чієюсь власністю. Ґрунтується на мові розмітки XML, призначений для 

опису двовимірної векторної графіки. Формат підтримують багато браузерів, його можна 

використовувати при оформленні веб-сторінок. На жаль, формат не забезпечує високої 

якості складних малюнків і має обмеження в галузі його використання. 

 AI (Adobe Illustrator) — векторний формат файлів, створюваних програмою Adobe 

Illustrator. Формат ai кожної нової версії несумісний зі старшими версіями. Формат 

забезпечує дуже високу якість малюнків, але за погано сумісний з деякими іншими 

програмами. Наприклад, різні ефекти Adobe Illustrator та градієнтна заливка можуть не 

передаватися в інші формати. Mоже містити в одному файлі лише одну сторінку, має 

маленьке робоче поле — всього 3%times; 3 метри. У цілому трішки поступається FreeHand’y 

і CorelDRAW за ілюстративними можливостями, тим не менше, відрізняється найбільшою 

стабільністю та сумісністю з PostScript. АІ підтримють майже всі програми так або інакше 

зв’язані з векторною графікою. Формат Illustrator’ра є найкращим посередником під час 

передачі векторів із однієї програми в іншу, з РС на Macintosh і назад. Крім цього, якщо 

працювати в основному в Photoshop’і (Web-дизайн, наприклад), то Illustrator стане 

найкращим помічником, бо з Photoshop’ом однаково організований інтерфейс і гарячі 

клавіши. Photoshop розуміє формати Illustrator’a (AI і EPS) напряму. 

 FH (FreeHand Document, остання цифра в розширенні вказує на версію програми) — 

зрозумілий лише самому FreeHand, Illustrator для Macintosh і декільком програмам від 

Macromedia. 7 і 8-ма версії мають повну багатоплатформну сумісність. Підтримує 

багатосторінковість. Деякі ефекти FreeHand’у несумісні з PostScript. 

 PDF (Portable Document Format) — запропонований фірмою Adobe як незалежний 

від платформи формат, у якому можна зберегти ілюстрації (векторні і растрові) і текст та ще 

й з множиною шрифтів і гіпертекстових посилань. Для роботи з цим форматом компанія 

Adobe випустила пакет Acrobat. Acrobat Distiller конвертує у PDF PostScript-файли, Acrobat 

Exchange дозволяє їх редагувати: встановлювати внутрішні посилання, посилання на 

зовнішні звукові і відеофайли, Web-посилання. Початкове завдання PDF — передача 

мережею у стисненому вигляді проілюстрованих і відформатованих документів — сьогодні 

значно розширена. Версія 3 спроможна зберігати всі установки для вивідного пристосування, 

записані у PostScript-файлі. Exchange дозволяє відновлювати з файлів PDF файли PostScript. 

PDF дозволяє не турбуватися про наявність необхідних шрифтів у отримувача — все 

закладено прямо у файл. 

 PS (PostScript) — ґрунтується на мові програмування й розмітки сторінок PostScript. 

Останню створено фірмою Adobe для використання у видавничих системах.  
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РОБОТА З ДОКУМЕНТАМИ 

Створення нового документа 

Почати роботу над новим документом можна з екрана привітання або з меню «File» 

(Файл). 

1. Виконайте одну з таких дій: 

o Якщо Illustrator запущено, виберіть «File → New» (Файл → Новый), після чого зі 

списку профілів нового документа виберіть потрібний профіль документа. 

o Якщо відкритий екран привітання, клацніть на потрібний профіль документа у 

списку «New …» (Новый…). 

o Якщо Illustrator не відкритий, відкрийте його і виберіть профіль документа зі 

списку «New …» (Новый…) на екрані привітання. 

 

Примітка: для відкриття нового документа безпосередньо з 

екрана привітання, без відображення діалогового вікна «New 

Document» (Новий документ), клацніть, утримуючи Alt (Windows) 

або Option (Mac OS). 

 

2. Введіть назву для документа. 

3. Вкажіть кількість монтажних областей у документі та порядок їх розташування на 

екрані: Сіткою, рядками 

 

 
Рис. 3. Діалогове вікно створення нового документа 

Монтажні області розташовуються на екрані у вказану кількість рядків. Кількість 

монтажних областей задається в меню «Number of Artboards» (Кількість монтажних 

областей). За замовчуванням програма створює для вказаної кількості монтажних областей 

сітку, максимально наближену до квадратної. 

Монтажні області розташовуються на екрані у вказану кількість стовпчиків. Кількість 

стовпчиків задається в меню «Colums» (Стовпчики). За замовчуванням програма створює 

для вказаної кількості монтажних областей сітку, максимально наближену до квадратної. 

Arrange by row (Розтягнути в ряд) – монтажні області розташовуються на екрані в один 

рядок. 

Arrange by column (Розтягнути в стовпчик) – монтажні області розташовуються на 

екрані в один стовпчик. 
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Change to Right-to-Left Layout (Змінити на компонування справа наліво) – розташовує кілька 

монтажних областей у певному форматі рядка чи стовпчика, проте відображає їх справа наліво. 

4. Вкажіть стандартну відстань між монтажними областями. Це значення застосовується 

як для відстані по горизонталі, так і для відстані по вертикалі. 

5. Вкажіть стандартний розмір, одиниці вимірювання і загальний макет для всіх 

монтажних областей. 

Примітка.  

В разі потреби монтажні панелі можна буде переміщувати та масштабувати, коли 

документ буде відкрито. 

6. Зазначте положення обрізки з кожного боку монтажної статті. Щоб користуватися 

різними значеннями для різних сторін, натисніть піктограму «Блокувати» . 

7. Натисніть кнопку «Advanced» (Розширені) для вибору додаткових параметрів. 

Примітка.  

Ці налаштування можна змінити після створення документа, вибравши з меню «Файл» 

пункт Параметри документа і вказавши нові значення параметрів. 

Color Mode (Колірний режим) 

Встановлює колірний режим для нового документа. Зміна колірного режиму конвертує 

вміст за замовчуванням (зразки, пензлі, символи, стилі графіки) обраного профілю нового 

документа у новий колірний режим, що призводить до зміни кольорів. При виконанні змін 

звертайте увагу на значок попередження. 

Raster Effects (Ефекти створення растру) 

Визначає роздільну здатність ефектів створення растру у документі. Зокрема, якщо ви 

плануєте виводити документ на принтері високого рівня, що має високу роздільну здатність, 

важливо встановити цей параметр у «Висока». У профілі «Друк» цей параметр встановлений 

у «Висока» типово. 

Preview Mode (Режим перегляду) 

Встановіть режим перегляду за замовчуванням для документа (ви завжди можете 

змінити його у меню «Перегляд»): 

o «Defoult» (За замовчуванням) – ілюстрація, створена в документі, відображається у 

векторному вигляді та в повному кольорі. Збільшення або зменшення зберігає гладкість 

кривих. 

o «Pixel» (У вигляді пікселів) – представляє ілюстрацію у растровому (піксельному) 

вигляді. Вміст насправді не растеризується, але відображається у такому вигляді, наче його 

було растеризовано. 

o «Overprint» (Накладання) надає «перегляд фарб», що являє собою наближення до 

того, як прозорість, накладання та переходи будуть виглядати при виведенні з 

кольороподілом. 

Aligne New Objects to Pixel Gird (Вирівняти нові об’єкти за піксельною сіткою) 

Якщо ввімкнено цей параметр, усі нові об’єкти буде автоматично вирівняно за 

піксельною сіткою Цей параметр увімкнено за замовчуванням для документів для Інтернету 

та пристроїв, оскільки в цих документах важливо, щоб ілюстрація правильно відображалася 

саме на екрані.  

 

Створення нового документа з шаблону  

1. Виконайте одну з таких дій: 

o Виберіть у меню пункт «File → New from Template» (Файл → Новый из шаблона). 

o Виберіть у меню пункт «File → New» (Файл → Новый). У діалоговому вікні «New 

Document» (Новый документ) натисніть кнопку «Browes» (Шаблоны). 
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2. У діалоговому вікні створення документа за шаблоном знайдіть і виберіть потрібний 

шаблон та натисніть кнопку «Open» (Відкрити). 

 

 

Рис. 4. Діалогове вікно «Шаблон» 

Про шаблони  

Шаблони дають змогу створювати нові документи зі спільними загальними 

параметрами та елементами дизайну. Наприклад, якщо вам потрібно створити серію візитних 

карток подібного вигляду, ви можете створити шаблон з потрібними розмірами монтажної 

області, виглядом (наприклад, направляючими) та параметрами друку. Шаблон також 

містить символи загальних елементів дизайну (наприклад, логотипів) та специфічні набори 

зразків кольорів, пензлів, стилів графіки. 

Illustrator постачається з різноманітними шаблонами, в тому числі і шаблонами для 

фірмових бланків, візитних карток, конвертів, брошур, поштових карток, листівок, веб-

сайтів. 

Коли шаблон обрано командою «Створити з шаблону», Illustrator створює новий 

документ з тим самим вмістом та параметрами документа, взятими з шаблону, але 

оригінальний шаблон лишається незмінним. 

 

Створення нового шаблона  

1. Відкрийте новий або наявний документ. 

2. Налаштуйте документ одним з таких способів: 

o Налаштуйте вікно документа таким чином, як ви хочете, аби виглядав новий документ, 

який ви створите з шаблону. Це містить рівень масштабування, позицію повзунків прокрутки, 

початок лінійки, напрямні, сітку, області кадрування, параметри меню «Перегляд». 

o Намалюйте або імпортуйте будь-яку ілюстрацію, яку ви хочете мати у новому 

документі, створеному на основі шаблону. 

o Видаліть будь-які наявні зразки, стилі, пензлі або символи, які ви не хочете бачити у 

шаблоні. 

o Створюйте нові зразки, стилі, пензлі або символи, які ви хочете бачити у 

відповідному шаблоні. Ви також можете імпортувати передналаштування, стилі, пензлі, 

символи та дії з великої кількості бібліотек, що постачаються з Illustrator. 

o Ви можете створити нові оформлення графіків та додати їх до діалогового вікна 

«Оформлення графіку». Також можна імпортувати оформлення графіків. 
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o Задайте потрібні параметри в діалогових вікнах Параметри документа та 

«Параметри друку». 

3. Виберіть меню «File → Save as Template» (Файл → Зберегти як шаблон). 

4. В діалоговому вікні Зберегти як виберіть місцезнаходження файлу, введіть його ім’я та 

натисніть «Save» (Зберегти). Illustrator збереже файл у форматі AIT (шаблон Adobe Illustrator). 

Встановлення налаштувань документа  

Стандартні налаштування документа, такі як одиниці вимірювання, відображення 

прозорої сітки, колір тла і параметри введення тексту – мова, вид лапок, розміри 

надрядкових і підрядкових літер та можливості експортування, можна змінити в будь-який 

момент. Після натиснення кнопки «Редагувати монтажні області» це діалогове вікно 

закривається і активується інструмент керування монтажними областями. За допомогою цієї 

кнопки можна змінювати монтажні області. 

1. Виберіть із меню «File» (Файл) пункт «Document Setting» (Параметри документа) 

або натисніть кнопку «Параметри документа» на панелі керування (кнопка відображається, 

коли не виділено жодних елементів). 

2. Вкажіть потрібні параметри. 

Примітка.  

Параметр «Імітація кольорового паперу» може бути корисним, якщо ілюстрація 

призначена для друку на кольоровому папері. Наприклад, якщо ви намалюєте синій об’єкт на 

жовтому фоні, об’єкт виглядатиме зеленим. Імітація виконується лише тоді, коли сітка 

прозорості не показується. 

Відкриття файлу  

Можна відкривати як файли, створені у Illustrator, так і сумісні файли, створені в інших 

програмах. 

 Для відкриття наявного файлу оберіть «File → Open» (Файл → Открыть). Виберіть 

файл та натисніть «Open» (Відкрити).  

 Для відкриття нещодавно записаного файлу оберіть його з переліку «Відкрити 

останні» на Екрані привітання, або оберіть «File → Open recent files» (Файл → Открыть 

последний файл), після чого оберіть файл зі списку.  
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СТВОРЕННЯ І РЕДАГУВАННЯ ОБ’ЄКТІВ. 

МАЛЮВАННЯ ГЕОМЕТРИЧНИХ ФІГУР. 

МАЛЮВАННЯ ФІГУР ДОВІЛЬНОЇ ФОРМИ 

1.1. Група інструментів геометричних об'єктів 

До інструментів малювання геометричних об'єктів відносяться прямокутник, еліпс, 

прямокутник зі скруглением і ряд інших. На малюнку 1.1 показані ці інструменти. 

 

 

Рис. 5. Група інструментів геометричних об'єктів 

В роботі цих інструментів багато спільного: 

– Утримуючи клавішу «Alt» прямокутники і еліпси малюються з центру; 

– Для отримання квадрата або круга потрібно утримувати клавішу «Shift»; 

– Якщо під час малювання будь-якого з цих об'єктів натиснути клавішу «Пропуск», 

зображення можна перемістити по екрану. 

Для виділення об'єкта використовується інструмент Виділення (стрілка). Для зміни 

заливки і кольору контуру використовуйте блок управління кольором на головній палітрі: 

 

 

 
 

 

 
Рис. 6. Еліпси і прямокутники 

 

Зірки і багатокутники завжди малюються від центральної точки. Для збільшення або 

зменшення числа сторін або променів використовуються клавіші зі стрілками «Вгору» / 

«Вниз». 

 

Колір заливки 

Колір контура 

Міняє місцями колір 

заливки та контура 

Задає заливку та колір 

контура за замовчуванням 
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Рис. 7. Зірки і багатокутники 

 

Для завдання параметрів майбутнього об'єкта потрібно активізувати інструмент, 

клацнути на поле листа, і в діалоговому вікні ввести значення. Для кожного інструменту 

малювання діалогові вікна різні, але принцип введення параметрів завжди один. При 

виклику діалогового вікна в ньому відображаються установки для останнього намальованого 

елемента. 

 

1.2. Група інструментів лінійних об'єктів 

Ця група розкривається клацанням на кнопці інструменту «Відрізок лінії» (Рис.1.4). 

 

 
Мал. 8. Група інструментів лінійних об'єктів 

 

1. Для малювання лінії активізуйте інструмент Відрізок лінії, натисніть і не відпускайте 

курсор миші в початковій точці, простягніть лінію до потрібної точки і відпустіть кнопку 

миші. 

2. Намалюйте лінію, утримуючи «Alt». 

3. Утримання клавіші «`» дозволяє створювати безліч ліній у міру переміщення курсору. 

4. Утримання клавіші «~» забезпечує малювання безлічі ліній під .кутом, кратним 45. 

5. Активізуйте інструмент Спіраль і намалюйте кілька спіралей, використовуючи 

клавіші зі стрілками для зміни кількості завитків. 

6. Інструментом Прямокутна сітка намалюйте прямокутну і квадратну сітки. Намалюйте 

сітки з різною кількістю осередків, використовуючи горизонтальні і вертикальні стрілки. 

7. Активізуйте інструмент Дуга і повторіть всі дії, перераховані в пп.1-4. 

8. Намалюйте замкнутий сегмент – для цього під час малювання натисніть одноразово 

клавішу «C». Спробуйте під час малювання натиснути клавішу «F». 

9. Для зменшення / збільшення кута дуги необхідно натискати клавіші зі стрілками. 

10. Латинські букви «F», «V», «X», «C» створюють логарифмічні сітки. Кожне 

натискання збільшує або зменшує логарифмічну шкалу на 10%. 

11. Спробуйте малювати сітку з утриманням клавіші «~». 

Всі перетворення показані на малюнку 1.5.  
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Рис. 9. Намальовані об'єкти 

 

1.3. Малювання ліній інструментом Перо 

1. Для малювання прямої лінії, активізуйте інструмент Перо, клацніть курсором миші в 

початковій і кінцевій точках лінії. Для завершення малювання клацніть в будь-якому місці, 

утримуючи клавішу «Ctrl». 

2. Утримання клавіші «Shift» дозволяє малювати лінії під кутом, кратним 45. 

3. Для замикання контуру необхідно клацнути в початковій точці (поруч з курсором 

з'являється зображення маленького гуртка). 

4. Останню крапку можна переміщати, якщо, не відпускаючи кнопку миші, натиснути 

кнопку «Пропуск». 

 
Рис. 10. Малювання ліній 

 

5. Для малювання кривих Безьє активізуйте інструмент Перо, клацніть на аркуші, 

перемістіть маркер на інше місце, натисніть кнопку миші і потягніть у сторону. 

З'являться керуючі лінії опорної точки і сегмент, який з'єднує дві опорні точки, 

зігнеться. 
 

 
 

Рис. 11. Крива Безьє 
 

1.4. Малювання довільних ліній інструментом Олівець 

1. Активізуйте інструмент Олівець і намалюйте криву, імітуючи вільне малювання 

звичайним олівцем. 
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Рис. 12. Малювання інструментом Олівець 

 

2. Отриманий контур містить опорні точки, число яких залежить від складності кривої і 

від установок у вікні Параметри інструменту Олівець. 
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ОПЕРАЦІЇ З ОБ’ЄКТАМИ. 

ВИКОРИСТАННЯ ІНСТРУМЕНТІВ «ТРАНСФОРМУВАННЯ» 

Трансформування 

Трансформування включає переміщення, поворот, віддзеркалення, масштабування і нахил 

об'єктів. Об'єкти можна трансформувати за допомогою панелі «Трансформування», команд із 

меню «Object → Transform» (Об'єкт» > «Трансформувати) і спеціалізованих інструментів. 

Можна також виконувати різні типи трансформування шляхом перетягування рамки розміру для 

виділення. 

Іноді необхідно повторити однакове трансформування декілька разів, особливо під час 

копіювання об'єктів. Команда «Transform again» (Трансформувати знову) в меню «Object» 

(Об'єкт) дозволяє повторити операції переміщення, масштабування, повороту, віддзеркалення або 

нахилу стільки разів, скільки забажаєте, доки не буде виконано іншу операцію трансформування. 

Огляд панелі «Трансформування»  

Панель «Transform» (Трансформування) «Widow → Transform» (Вікно → Трансформування) 

відображає відомості про розташування, розмір й орієнтацію одного або більше виділених 

об’єктів. Шляхом введення нових значень можна змінити як виділені об'єкти, так і їхні заливки 

візерунком. Можна також змінити контрольну точку трансформування і закріпити пропорції 

об'єкта. 

Усі значення на панелі стосуються рамок розміру об'єктів, окрім значень X та Y, які 

стосуються виділеної контрольної точки. Щоб вирівняти окремі об'єкти за піксельною 

сіткою, встановіть прапорець «Align for Pixel Grid» (Вирівняти за піксельною сіткою). 

Примітки: 

 Починаючи з випуску CC 2017 року, в Illustrator будуть представлені більш передбачувані 

й точні функції для створення ілюстрацій, вирівняних за піксельною сіткою.. 

 Ідентифікатор контрольної точки на панелі «Трансформування» вказує на контрольну 

точку об’єкта, тільки якщо трансформування об’єкта виконується за допомогою зміни значень 

на панелі. Інші методи трансформування (наприклад, використання інструмента 

«Масштабування») використовують центральну точку об’єкта або положення курсору як 

контрольну точку. 

  

 
Рис. 13. Панель «Трансформування» 

 

A. Ідентифікатор контрольної точки B. Меню панелі C. Значок блокування пропорцій   

A 

B 

C 
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Трансформація візерунків об'єкта  

Під час переміщення, повороту, віддзеркалення, масштабування або нахилу об'єкта з 

візерунком можна трансформувати лише об'єкт, лише візерунок або як об'єкт, так і 

візерунок. Після трансформування візерунка об'єкта всі візерунки, застосовані до об'єкта, 

трансформуються тим самим способом. 

 Щоб визначити спосіб трансформування візерунків під час використання панелі 

«Transform» (Трансформування), виберіть параметр у меню панелі: «Transform Object Only» 

(Трансформувати тільки об'єкт), «Transform Pattern Only» (Трансформувати тільки 

візерунок) або «Transform Both» (Трансформувати обидва). 

 

 
Рис. 14. Способи трансформації 

  

 Щоб запобігти трансформуванню візерунків під час використання інструментів 

трансформування, виберіть пункт меню «Edit → Preference → General» (Редагування → 

Параметри → Загальні) і зніміть прапорець «Transform Pattern Tiles» (Трансформувати 

сегменти візерунка). 

 Щоб повернути візерунок об'єкта до початкового стану, заповніть об'єкт чистим 

кольором, а потім знову виберіть необхідний візерунок. 

Трансформування за допомогою рамки розміру  
Якщо виділити один або більше об'єктів за допомогою інструмента виділення навколо 

них відображається рамка розміру. Використовуйте рамку розміру для переміщення, 

повороту, дублювання і масштабування об'єктів за допомогою перетягування об'єкта або 

держака (один з порожніх квадратів вздовж рамки розміру). 

 Щоб приховати рамку розміру, виберіть пункт меню «View → Hide Bouding Box» 

(Перегляд → Приховати рамку розміру). 

 Щоб показати рамку розміру, виберіть пункт меню «View → Show Bouding Box» 

(Перегляд → Показати рамку розміру). 

 Щоб переорієнтувати рамку розміру після її повороту, виберіть пункт меню «Object → 

Transform → Reset Bouding Box» (Об'єкт → Трансформувати → Відновити рамку 

розміру). 
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Рис. 15. Виділені об’єкти до (ліворуч)  

та після (праворуч) масштабування за допомогою рамки розміру  
 

Об’єднання об’єктів за допомогою ефекту «Обробка контурів» 

Панель «Обробка контурів»  

Використовуйте панель «Обробка контурів» «Window → Pathfinder» (Вікно → Обробка 

контурів) для об’єднання об’єктів у нові фігури. 

 

 

Рис. 16. Панель «Обробка контурів» 
 

Використовуючи кнопки верхнього ряду панелі, створіть звичайні або складені контури. Щоб 

створити складену фігуру, натискайте ці кнопки, одночасно утримуючи клавішу Alt або Option.  

Виберіть один із зазначених режимів створення фігур: 

– Поділ  – вихідне зображення розбивається на безліч об'єктів, розділених по лініях 

перетину, об'єднаних в групу. 

– Обрізка  – всі приховані частини об'єктів видаляються, всі видимі частини 

групуються, параметри обведення видаляються. 

– Об'єднання  – всі приховані частини об'єктів видаляються, всі видимі частини 

об'єднуються в групу, причому елементи, які мають однакову заливку, зливаються в один 

об'єкт, параметри обведення видаляються. 

– Кадрування  – верхній об'єкт грає роль Кадрування рамки, параметри обведення 

видаляються, відсічені частини зберігаються, але вони мають прозору обведення і заливку. 

– Контур  – об'єкти розбиваються як при операції поділу, але все контури 

залишаються відкритими, параметри обведення видаляються. 

– Мінус нижній – з контуру верхнього об'єкта віднімають усі нижні. 

Нижній ряд кнопок на панелі під назвою «Ефекти обробки контурів» дозволяє 

створювати остаточні комбінації фігур одним натисненням кнопки.  
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Рис. 17. Режими фігур 

A. Усі компоненти в режимі додавання B. Режим віднімання, застосований до квадратів 

C. Режим перетину, застосований до квадратів D. Режим виключення, застосований до квадратів 
 

Огляд панелі «Вирівнювання»  
Ви можете використовувати панель «Align» (Вирівнювання) «Window → Align» (Вікно 

→ Вирівняти) для вирівнювання або розподілу об'єктів в горизонтальному або 

вертикальному напрямку вздовж виділення, полів, сторінки або розвороту. При роботі з 

панеллю «Вирівнювання» зауважте наступне: 

 Панель «Align» (Вирівнювання) не впливає на об'єкти, до яких ви застосовуєте 

команду «Object → Lock» (Об’єкт →Заблокувати позицію), та не змінює вирівнювання 

текстових абзаців в межах кадрів. 

 Вирівнювання тексту не попадає під вплив параметрів вирівнювання об'єктів.  

 

 
Рис. 18. Панель «Вирівнювання» 

 

A. Кнопки вирівнювання по вертикалі B. Кнопки розподілу по вертикалі 

C. Застосувати розподіл інтервалів D. Кнопки вирівнювання по горизонталі 

E. Кнопки розподілу по горизонталі F. Параметри вирівнювання місця розташування 

А D 

E B 

C 
F 
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Вирівнювання та розподілення об'єктів  
Ви можете використовувати панель «Вирівнювання» для вирівнювання або вставляння 

інтервалів між виділеними об'єктами в горизонтальному або вертикальному напрямку 

вздовж виділення, полів, сторінки або розвороту. 

 

 
Рис. 19. Об'єкти розподілені 

в горизонтальному напрямку відносно виділеного (зверху) 

та відносно полів (знизу) 

 

1. Виберіть об'єкти, які потрібно виділити або розподілити. 

2. Виберіть пункт меню «Window → Align» (Вікно → Вирівняти) для відображення 

панелі Align» (Вирівнювання). 

Примітка.  

Щоб показати або приховати додаткові параметри панелі, виберіть у меню панелі 

«Показати параметри» або «Сховати параметри». 

3. В меню, яке знаходиться в нижній частині панелі, зазначте, на основі чого ви хочете 

здійснити вирівнювання або розподіл об'єктів: виділення, полів, сторінки чи розвороту. 

4. Виконайте одну з описаних нижче дій. 

o Для вирівнювання об'єктів натисніть на кнопку потрібного типу вирівнювання. 

o Для розподілу об'єктів натисніть на кнопку потрібного типу розподілу. Наприклад, 

якщо ви натиснете кнопку «Horisontal Align Left» (Розподілити ліві краї), коли увімкнено 

параметр «Align to selection» (Вирівняти по виділеному), InDesign перевірить наявність 

рівномірно вільного місця від лівого до лівого краю кожного виділеного об'єкта.  
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Рис. 20. Використання параметра «Горизонтальний розподіл по центру» 

для рівномірних інтервалів 

A. Створює рівномірні пробіли між центрами кожного об'єкта. B. Зберігає всю ширину в 

такому вигляді, який вона мала до трансформування 

 

o Для налаштування пробілу між об'єктами по відношенню «центр до центру» або 

«край до краю» оберіть команду «Distribute Spacing» (Застосувати інтервали), а потім 

введіть значення для пробілу, яке ви хочете застосувати. Натисніть кнопку для розподілу 

виділених об'єктів вздовж їх горизонтальних або вертикальних осей. 

 
Рис. 21. Використання параметра «Горизонтальний розподіл по центру» та додавання значення для 

параметра «Застосувати інтервали» 

A. Рівномірно розподіляє інтервали між центрами об'єктів з використанням вказаного значення B. 

Змінює всю ширину об'єктів як одного цілого 

 

o Для налаштування пробілу між об'єктами по відношенню (зовнішній кут до 

зовнішнього кута) оберіть команду «Застосувати інтервали» під меню «Розподіл інтервалів», 

та введіть значення для пробілу, яке ви хочете застосувати. (Якщо параметр «Розподіл 

інтервалів» невидимий, оберіть «Показувати параметри» в меню панелі «Вирівнювання».) 

Потім натисніть кнопку «Розподілити інтервали» для розподілу об'єктів уздовж їхніх 

горизонтальних або вертикальних осей. 
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Рис. 22. Використання параметра «Горизонтальний розподіл пробілів» та додавання значення для 

параметра «Застосувати інтервали» 

A. Створює пробіли вказаного значення між кожним об'єктом B. Змінює всю ширину об'єктів як 

одного цілого 

 

Вирівнювання об'єктів за допомогою інструмента «Зазор»  
За допомогою інструмента «Зазор» можна швидко змінити розмір зазору між двома або 

декількома об'єктами. Крім того, від дозволяє одночасно змінити розмір декількох об'єктів, 

краї яких вирівняно по одній лінії, та зберегти зазор між ними. Цей інструмент дає змогу 

змінити макет однією операцією, працюючи безпосередньо з вільним місцем між об'єктами. 

Інструмент «Gap Tool» (Зазор) ігнорує заблоковані об'єкти та елементи сторінки-шаблона. 

1. Виберіть інструмент «Gap Tool» (Зазор) . 

2. Встановіть курсор між двома об'єктами та виконайте будь-яку з наведених нижче дій. 

o Щоб перемістити зазор та змінити розмір всіх вирівняних уздовж зазору об'єктів, 

перетягніть курсор. 

o Щоб перемістити зазор між двома найближчими об'єктами, перетягніть курсор, 

утримуючи клавішу Shift. 

o Щоб змінити розмір зазору, не переміщуючи його, перетягніть курсор, утримуючи 

клавішу Ctrl (Windows) або Command (Mac OS). Якщо виконувати цю операцію, утримуючи 

клавішу Shift, розмір зазору змінюється лише між двома найближчими об'єктами. 

o Щоб перенести зазор та об'єкти в одному напрямку, перетягніть курсор, утримуючи 

клавішу Alt (Windows) або Option (Mac OS). Якщо виконувати цю операцію, утримуючи 

клавішу Shift, буде переміщено лише два найближчих об'єкти. 

o Щоб змінити розмір зазору та перемістити об'єкти, перетягніть курсор, утримуючи 

клавіші Ctrl + Alt (Windows) або Command + Option (Mac OS). Якщо виконувати цю 

операцію, утримуючи клавішу Shift, зміну розміру зазору та переміщення буде виконано 

лише для двох найближчих об'єктів. 

Групування та розгрупування об'єктів 

Ви можете об'єднувати декілька об'єктів у групу таким чином, що вони 

сприйматимуться як окрема одиниця. В подальшому ви можете переміщати їх або 

трансформувати кількість об'єктів, не впливаючи на їх атрибути або відносні позиції. 

Наприклад, ви б могли групувати об'єкти у оформлення емблеми таким чином, що емблему 

можна було б переміщати та масштабувати як одне ціле. 
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Згруповані об'єкти стекуються послідовно на одному і тому ж шарі ілюстрації та на 

передньому плані об'єкту у групі; таким чином, групування може змінювати шарування 

об'єкті та їх порядок стекування у даному шарі. Якщо ви виділяєте об'єкти у різних шарах, а 

потім групуєте їх, вони групуються у шарі об'єкту, який був обраний найпершим. 

Групи також можуть бути вкладеними; це означає, що вони можуть групуватися в 

межах інших об'єктів або груп з метою формування більших груп. Групи відображуються як 

елемент «Group» (Група) на панелі «Layers» (Шари). Ви можете скористатися панеллю 

«Шари» для переміщення елементів у групи та поза їх межі. 

1. Виділіть об'єкти для групування або групу, яку потрібно розгрупувати. 

2. Оберіть пункт «Object → Group» (Об'єкт → Групувати) або «Object → Ungroup» 

(Об'єкт → Розгрупувати). 
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ОСНОВИ РОБОТИ З КОНТУРАМИ. ВИКОРИСТАННЯ ЗАЛИВОК 

Обводка 

Налаштування обведення здійснюється на палітрі «Stroke» (Обводка). Палітра 

відкривається або командою меню Вікно, або відповідною командою на керуючої палітрі 

при виділеному об'єкті (для конкретного об'єкта). нижче на рисунку 23 показано, чим 

управляють ті чи інші параметри контуру. 

 

 

Рис. 22. Параметри обведення 

Колір обведення може бути призначений або за допомогою палітри, що відкривається 

клацанням на кнопці на керуючої палітрі (якщо виділений об'єкт), або при активному 

індикаторі обведення в блоці управління кольором будь-яким із способів призначення 

кольору. 

Контур в програмі Adobe Illustrator (Path) - лінії, що створюються за допомогою 

інструментів, що малюють і представляють собою дротяну оболонку об'єкта. Для контуру 

можуть бути задані параметри обведення (stroke) і заливки (fill). Контур може бути 

відкритим (а) і закритим (б) (рис. 24). В Adobe Illustrator відкритим контурам, як і закритим, 

можна привласнювати параметри заливки. 

 

 
Рис. 24. Контури в Adobe Illustrator 

 

Контур складається з декількох сегментів (елементів кривої Безьє), з'єднаних в опорних 

точках, або вузлах (рис. 25). Типи опорних точок в Adobe Illustrator: 

1. Гладка опорна точка, з'єднує дві криві без зламу, керуючі лінії зімкнуті. 

2. Кутова опорна точка - з'єднує дві криві на зламі, керуючі лінії розімкнуті 

товщина 1 пт 

товщина 5 пт 

товщина 10 пт 

 
кінці 

 

кути 

 

різні профілі 

 

пунктирна лінія 

 
показчики та 

масштаб 

показчиків 
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Рис. 25. Типи опорних точок 

 

Виділення опорних точок для подальшого редагування виробляється інструментом 

«Direct Stltction Tool» (Пряме виділення) . Цим же інструментом можна перемістити 

частину контуру. Кілька опорних точок можна виділити рамкою виділення або послідовними 

клацаннями миші з утримуванням «Shift». 

У прикладі (рис. 26) намальована ламана лінія. інструментом Пряме виділення з 

утриманням <Shift>, виділені дві верхні опорні точки і переміщені вгору (а). Цим же 

інструментом переміщена частина контуру (б). Аналогічно, інструмент Пряме виділення 

дозволяє переміщати опорні точки, фрагменти контурів кривих ліній, а також керуючі лінії 

опорних точок (точку необхідно попередньо виділити) (рис. 27).  

 
Рис. 26. Редагування форми прямолінійного контуру 

 

 
Рис. 27. Редагування форми криволінійного контуру 

 

Для додавання, видалення, зміни характеру опорної точки використовуються 

інструменти в групі Перо (рис. 28). 

 

 
Рис. 28. Інструменти групи Перо 

 

У прикладі (рис. 29.) Показано додавання (а) і видалення (б) опорної точки на лінії. 

 
Рис. 29. Додавання точок 
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Призначення однорідної заливки 

Заливку можна призначати як для закритих, так і для відкритих контурів. При 

призначенні заливки повинна бути активний індикатор заливки в блоці управління кольором 

на палітрі інструментів. 

Однорідну заливку можна вибрати декількома способами: 

– За допомогою палітри «Color» (Колір); 

– За допомогою палітри «Swotches» (Зразки); 

– За допомогою вікна «Color Piker» (Палітра кольорів). 

Палітра Колір (рис. 30) відображає значення кольору для поточного кольору. Шкали, які 

в ній знаходяться, дозволяють змінювати кольори в різних колірних моделях. Також можна 

вибрати колір з спектра кольорів, відображеного в нижній частині палітри. 

 

 
 

Рис. 30 палітра Колір 

 

Палітра Зразки (рис. 31) використовується для вибору готових зразків однорідних 

заливок, градієнтів і візерунків. 

 

 
Рис. 31. палітра Зразки 

 

Діалог «Color Piker» (Палітра кольорів) (рис. 32) – вікно вибору кольору, відкривається 

подвійним клацанням на індикаторі заливки в блоці управління кольором. Тут можна 

синтезувати колір в моделях HSB, RGB, Lab. Також можна задати значення CMYK в 

процентах. Крім того, можна вибирати кольори з попередньо встановлених бібліотек 

Кольорові зразки, а також зберігати зразки кольору. 

А. Колір заливки 

Б. Колір контуру 

В. Повзунок шкали 

Г. Шкала кольорів 

Д. Кнопка відкриття меню палітри 

А 

Б 

Г 

В 

Д 
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Рис. 32. Діалог Палітра кольорів 
 

Градієнти 

Градієнт – перехід між двома і більше квітами. Для настройки градієнта необхідно 

вибрати будь-який градієнт, а потім відредагувати за допомогою палітри Градієнт (рис.2.5). 

 

 
 

Рис. 33. Палітра Градієнт 

 

Параметри палітри: 

1. Шкала градієнта 

2. Індикатори кольору 

3. Маркери зміщення 

4. Кут 

5. Пропорції 

На малюнку 34 показано вплив установок палітри на вигляд градієнтної заливки. 

 

1 

2 

3 

4 

5 
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Рис. 34. види градієнтів 

 

1. Радіальний градієнт 

2.Лінейний градієнт 

3. Багатобарвний градієнт (перефарбування колірних індикаторів) 

4. Радіальний градієнт зі зміщенням пропорцій 

5. Лінійний градієнт зі зміщенням колірних маркерів 

6. Лінійний градієнт зі зміненим кутом поширення. 
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РОБОТА З ПРОСТИМ ТА ФІГУРНИМ ТЕКСТОМ. 

ФОРМАТУВАННЯ ТЕКСТУ 

Введення тексту в точці  

Текст від точки – це горизонтальний або вертикальний рядок тексту, що починається 

там, де ви клацнули мишею, і продовжується в міру введення символів. Кожен рядок тексту є 

незалежним – він розширюється або звужується, коли ви редагуєте його, але не переноситься 

на новий рядок. Введення тексту в такий спосіб є зручним для додавання кількох слів до 

ілюстрації. 

1. Оберіть інструмент «Type» (Текст)  або інструмент «Vertical Type» 

(Вертикальний текст) . 

Вказівник набуде вигляду «І» з пунктирним квадратиком. Невеличка горизонтальна 

риска внизу І-вказівника позначає позицію базової лінії, на яку лягатиме текст. 

2. (За потребою) Встановіть параметри форматування тексту на панелі керування, 

панелі «Character» (Символ) або «Paragraph» (Абзац). 

3. Клацніть, де бажаєте почати рядок тексту. 

Примітка.  

Не клацніть на наявному об’єкті, бо це перетворить текстовий об’єкт на текст в 

області або на текст на контурі. Якщо наявний об’єкт знаходиться там, де ви бажаєте 

ввести текст, заблокуйте або приховайте цей об’єкт. 

4. Введіть текст. Натисніть Enter або Return, щоб розпочати новий рядок тексту в 

межах того самого текстового об’єкта. 

5. Коли ви закінчите вводити текст, клацніть на інструменті «Виділення» , аби 

виділити текстовий об’єкт. Можна просто клацнути на тексті, утримуючи Ctrl (Windows) або 

Command (Mac OS). 

Введення тексту в області  

Текст в області (також – тип абзацу) використовує межі об’єкта для керування потоком 

символів, як по горизонталі, так і по вертикалі. Коли текст досягає межі, він автоматично 

переноситься, щоб уміститися на визначеній ділянці. Вводити текст в такий спосіб зручно, 

якщо вам потрібно створити більше одного абзацу, наприклад для брошури. 

1. Визначте обмежувальну ділянку: 

o Візьміть інструмент «Type» (Текст) або «Vertical Type» (Вертикальний текст)

 і перетягніть по діагоналі, щоб визначити прямокутну обмежувальну ділянку. 

o Намалюйте об’єкт, який ви бажаєте застосовувати як обмежувальну ділянку. 

(Неважливо, чи має цей об’єкт атрибути обведення або заливки, бо Illustrator автоматично 

вилучає їх). Візьміть інструмент «Type» (Текст) , «Vertical Type» (Вертикальний текст)

, «Area Type» (Текст в області) або «Vertical Area Type» (Вертикальний текст в 

області) і клацніть будь-де на контурі об’єкта. 
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Рис. 35. Створення текстової ділянки шляхом перетягування (верх) порівняно з перетворенням 

наявної фігури на текстову ділянку (низ) 

Примітка.  

Якщо об’єкт має відкритий контур, щоб визначити обмежувальну ділянку, ви повинні 

скористатися інструментом «Текст в області». Аби визначити межі, Illustrator малює 

уявну лінію між кінцевими точками контуру. 

2. (За потребою) Встановіть параметри форматування тексту на панелі керування, панелі 

Character» (Символ) або «Paragraph» (Абзац). 

3. Введіть текст. Натисніть Enter або Return, щоб розпочати новий абзац. 

4. Коли ви закінчите вводити текст, клацніть на інструменті «Selection Tool» (Виділення) 

, аби виділити текстовий об’єкт. Можна просто клацнути на тексті, утримуючи Ctrl 

(Windows). 

Якщо ввести текст, що виходить за межі області, біля нижньої частини обмежувальної 

рамки з’являється невелике вікно із символом «плюс» (+). 

 

 

Рис. 36. Приклад переповнення тексту 

 

Ви можете змінити розмір області тексту або розширити контур, щоб нормально 

відобразити весь текст. Також ви можете перенести частину тексту до іншого об’єкта. 

Імпорт тексту до контуру/фігури  

Розміщуйте текст із файлу підтримуваного формату просто в об’єкті, наприклад у 

фігурі. Ви можете розміщувати текст із файлів формату .txt чи .rtf і файлів, створених за 
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допомогою текстових редакторів. Наприклад, ви можете помістити текст із файлу .rtf у 

фігуру-багатокутник. 

1. Створіть контур/фігуру за допомогою будь-якого інструмента для малювання, 

наприклад «Прямокутник», «Перо» або інструмент створення фігур. Текст із файлу буде 

розміщено в цій фігурі. 

2. Оберіть «File → Place» (Файл → Помістити), потім оберіть текстовий файл, який ви 

хочете помістити. 

3. Натисніть кнопку «Place» (Помістити). 

4. Після завантаження текстового файлу до знаряддя поміщення клацніть контур 

відповідної фігури. 

Текст буде розміщено у фігурі. Після цього ви можете застосовувати до тексту бажані 

стилі й ефекти. 

 
Рис. 37. Розташування тексту із текстового файлу у багатокутному контурі чи фігурі 

 

Заповнення текстових об’єктів шаблонним текстом  

Заповнення текстових об’єктів шаблонним текстом допоможе ефективніше 

візуалізувати дизайн. За замовчуванням Illustrator автоматично заповнює нові об’єкти, 

створені за допомогою інструментів роботи з текстом, шаблонним текстом. Шаблонний 

текст зберігає шрифт і розмір, застосовані до попереднього текстового об’єкту. 

 
Рис. 38. Приклади текстових об’єктів із шаблонним текстом, створених за допомогою 

інструментів для роботи з текстом 

A. Інструмент «Type» (Текст) Б. Інструмент «Type on the Path Tool» (Текст за 

контуром) 

В. Інструмент «Vertical Area Type» (Вертикальний текст в області) 

Керування областю тексту  

Зміна розміру текстової ділянки  

Змінювати розмір тексту можна кількома способами, у залежності від того, що саме 

створюється: початок набору, текст в області чи текст по контуру. 
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Для тексту, що пишеться за допомогою початку набору, обмежень щодо кількості 

тексту немає, отже змінювати розмір текстового поля непотрібно в цьому випадку. 

Якщо використовується інструмент «Area Type» (Текст в області), виконується 

перетягування об’єкта, і текст вводиться у виділеній області. У цьому випадку розмір тексту 

змінюється, коли за допомогою інструмента «Часткове виділення» змінюється розмір об’єкта. 

Коли текст вводиться вздовж контуру, можна пов’язати текст між об’єктами, якщо текст не 

вписується у виділений контур. У цьому випадку розмір тексту також змінюється, коли за 

допомогою інструмента «Direct Sеlection Tool» (Часткове виділення) змінюється розмір об’єкта. 

Примітка.  

Переконайтеся, що для параметра рамки розміру встановлено значення «Показати 

рамку розміру». Якщо ви не бачите рамку розміру, виберіть «View → Show Bouding Box» 

(Перегляд →Показати рамку розміру). 

 Щоб змінити розмір, виконайте одну з таких дій: 

o Виділіть текстовий об’єкт інструментом «Виділення» або за допомогою панелі 

«Шари» і перетягніть держак рамки розміру. 

 

 

Рис. 39. Зміна розміру текстової ділянки інструментом «Виділення» 

 

o Виділіть край або кут контуру тексту інструментом «Direct Sеlection Tool» 

(Часткове виділення) . Перетягніть, щоб налаштувати форму контуру. 

 

Рис. 40. Зміна розміру текстової ділянки інструментом «Direct Sеlection Tool» (Часткове виділення) 

 

o Виділіть текстовий об’єкт інструментом «Sеlection Tool» (Виділення) або 

скориставшись панеллю «Layers» (Шари), виберіть «Type → Area Type Options» (Текст → 

араметри тексту в області). Введіть значення у полі «Ширина» та «Висота» і клацніть на 

«OK». Якщо текстова ділянка не є прямокутною, ці значення визначатимуть ширину і висоту 

рамки розміру об’єкта. 
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Зміна поля навколо текстової ділянки  

Працюючи з об’єктом тексту в області, ви можете встановлювати проміжок між текстом 

та облямовувальним контуром. Це поле зветься відбиттям. 

1. Виділіть об’єкт тексту в області. 

2. Виберіть «Type → Area Type Options» (Текст → Параметри тексту в області). 

3. Задайте значення відбиття і клацніть на «OK». 

 

 

Рис. 41. Текст без відбиття (ліворуч) порівняно з текстом із відбиттям (праворуч) 

 

Підняття або опускання першої базової лінії на текстовій ділянці  

Працюючи з об’єктом тексту в області, ви можете контролювати вирівнювання першої 

лінії тексту за верхом об’єкта. Це вирівнювання зветься зсувом базової лінії першого рядка. 

Наприклад, ви можете зробити так, щоб текст випинався над верхом об’єкта або лежав на 

певній відстані нижче верхньої частини об’єкта. 

 

 

Рис. 42. Приклади зсуву базової лінії 

Текст із базовою лінією першого рядка, налаштований на «За висотою великих літер» 

(ліворуч) порівняно з текстом із базовою лінією першого рядка, налаштованого на 

«Інтерліньяж» (праворуч)  

1. Виділіть об’єкт тексту в області. 

2. Виберіть Type → Area Type Options» (Текст → Параметри тексту в області). 

3. Для базової лінії першого рядка виберіть один з таких варіантів: 

Ascent (Підйом). Висота символу «d» нижче верхньої частини текстового об’єкта. 

Cap Height (Висота початкової літери). Верхівка великої літери торкається верхівки 

текстового об’єкта. 
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Leading (Інтерліньяж). Використовує значення інтерліньяжу як відстань між базовою 

лінією першого рядку тексту і верхівкою текстового об’єкта. 

X Height (Висота по осі x). Висота символу «x» нижче верхньої частини текстового об’єкта. 

Em Box Height (Ем-бокс – висота). Верх круглої шпації в азійських шрифтах торкається 

верхньої частини текстового об’єкта. Цей параметр доступний незалежно від встановлених 

налаштувань відображення параметрів для азійських мов. 

Fixed (Фіксований) Визначає відстань від базової лінії першого рядка тексту до 

верхнього краю текстового об’єкта у полі «Мін.» 

Legancy (Попередня версія) Використовує перше значення базової лінії за 

замовчуванням, що застосовується в Adobe Illustrator 10 або ранішій версії. 

 

 

Рис. 43. Варіанти зсуву базової лінії 

4. У полі «Мін.» вкажіть значення зсуву базової лінії. 

 

Рис. 44. Діалогове вікно «Параметри тексту в області» 

 

Створити рядки і стовпчики тексту  

1. Виділіть об’єкт тексту в області. 

2. Виберіть Type → Area Type Options» (Текст → Параметри тексту в області). 

3. У розділах «Rows» (Рядки) і «Colums» (Стовпчики) діалогового вікна встановіть такі 

параметри: 

Number (Число) Визначає число рядків і стовпчиків, які має містити об’єкт. 

Span (Діапазон). Визначає висоту окремих рядків і ширину окремих стовпчиків. 
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Fixed (Фіксований). Визначає, що відбувається з діапазоном рядків і стовпчиків, коли ви 

змінюєте розмір текстової ділянки. Коли цей параметр вибрано, зміна розміру ділянки може 

змінити число рядків і стовпчиків, але не їхню ширину. Залиште цей параметр невибраним, 

якщо бажаєте, щоб ширина рядків і стовпчиків змінювалася, коли ви змінюєте розмір 

текстової ділянки. 
 

 

Рис. 45. Параметри для зміни розміру рядків і стовпчиків 

 

Gutter (Середник). Визначає відстань між рядками чи стовпчиками. 

4. У розділі «Options» (Параметри) діалогового вікна виберіть параметр «Text Flow» 

(Розміщення тексту), щоб визначити, як текст має розміщуватися між рядками і 

стовпчиками: «За рядками» або «За стовпчиками» . 

5. Натисніть «ОК». 

Зв’язування текстових блоків між об’єктами  

Щоб зв’язати (або продовжити) текст від одного об’єкта до наступного, зв’яжіть 

об’єкти. Зв’язані текстові об’єкти можуть мати будь-яку форму, проте текст повинен 

вводитися в ділянці або вздовж контуру (не в точці). 

Кожен текстовий об’єкт в області містить порт вводу і порт виводу, що дозволяють 

вам зв’язувати об’єкти і створювати зв’язані копії текстового об’єкта. Порожній порт 

показує, що весь текст є видимим, і що об’єкт не прив’язано. Стрілка на порті показує, що 

об’єкт прив’язано до іншого об’єкта. Червоний знак плюса на порті виводу показує, що 

об’єкт містить додатковий текст. Цей текст, що залишається невидимим, зветься 

переповненням тексту. 
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Рис. 46. Порти на зв’язаних текстових об’єктах 

Ви можете розривати низки і розміщувати текст або в першому, або в наступному 

об’єкті, або ви можете усунути всі низки, залишивши текст на місці. 

Зв’язаний текст  

1. Для виділення об’єкта тексту в області скористайтеся інструментом «Sеlection Tool» 

(Виділення). 

2. Клацніть на порті вводу або виводу виділеного текстового об’єкта. Курсор набуде 

вигляду значка завантаженого тексту . 

3. Виконайте одну з таких дій: 

o Щоб прив’язатися до наявного об’єкта, поставте вказівник на контур об’єкта. Курсор 

змінює форму на . Клацніть на контурі, щоб зв’язати об’єкти. 

o Щоб прив’язатися до нового об’єкта, клацніть або перетягніть вказівник по 

порожній ділянці монтажної області. Клацання створює об’єкт того самого розміру і форми, 

що й первинний, перетягування дає вам змогу створити прямокутний об’єкт будь-якого 

розміру. 

Ще один спосіб зв’язування тексту між об’єктами: виділити об’єкт тексту в області, 

виділити об’єкт (чи об’єкти), які ви бажаєте зв’язати, потім виберіть «Type → Threated text → 

Create» (Текст → Зв’язані текстові блоки → Створити). 

Обтікання текстом навколо об’єкта  

Ви можете обтікати текстом в області будь-який об’єкт, у тому числі, текстові об’єкти, 

імпортовані зображення, об’єкти, що їх ви малюєте в Illustrator. Якщо об’єкт обтікання є 

вбудованим бітовим зображенням, Illustrator обтікає текстом навколо непрозорих або 

частково непрозорих пікселів, ігноруючи цілком прозорі пікселі. 

Обтікання визначається порядком стекування об’єктів, який ви можете подивитися на 

панелі «Шари», клацнувши на трикутникові поряд із назвою шару. Щоб огорнути об’єкт 

текстом, об’єкт обтікання має знаходитися на тому самому шарі, що й текст, безпосередньо 

над текстом в ієрархії шарів. Ви можете перетягувати вміст вгору і вниз на панелі «Шари», 

щоб змінити ієрархію. 
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Рис. 47. Обтікання об’єктів текстом A. Об’єкти обтікання B. Обтікальний текст 

Обтікання текстом  

1. Переконайтеся, що наведені умови справджуються для тексту, для якого ви 

застосовуватимете обтікання: 

o Це текст в області (набраний у полі). 

o Він знаходиться на тому самому шарі, що й об’єкт обтікання. 

o В ієрархії шарів він знаходиться просто під об’єктом обтікання. 

Примітка.  

Якщо шар містить кілька текстових об’єктів, перемістіть будь-який об’єкт, яким ви 

не бажаєте огортати об’єкт, або на інший шар, або вище об’єкта обтікання. 

2. Виділіть один або кілька об’єктів, які потрібно огорнути текстом. 

3. Виберіть «Object → Text Warp → Make» (Об’єкт → Обтікання текстом → Виконати). 

Встановлення параметрів обтікання  

Ви можете встановити параметри обтікання перед обтіканням текстом або після нього. 

1. Виділіть об’єкт обтікання. 

2. Виберіть «Object → Text Warp → Text Warp Options» (Об’єкт → Обтікання 

текстом → Параметри обтікання текстом): 

Offset (Зсув). Встановлю величину проміжку між текстом і об’єктом обтікання. Ви 

можете ввести або додатне, або від’ємне число. 

Invert Warp (Інвертувати обтікання). Обтікання текстом зворотного боку об’єкта. 

 

Рис. 48. Діалогове вікно «Параметри обтікання текстом» 
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Розгорнути текст з об’єкта  

1. Виділіть об’єкт обтікання. 

2. Виберіть «Object → Text Warp → Releas» (Об’єкт → Обтікання текстом → Звільнити). 

Розміщення тексту вздовж контуру 

1. Намалюйте замкнутий і незамкнений контури (рис. 48, а). потім: 

– Активізуйте інструмент Type (Текст), підведіть маркер до незамкнутому контуру і 

введіть текст; при цьому контур кривої стане невидимим (рис. 48, б); 

– Активізуйте інструмент Type on a Path Tool (Текст по контуру) , Підведіть його до 

замкнутого контуру і введіть текст (рис. 48, б); 

– Виділіть текст інструментом Sеlection Tool (Виділення) або Direct Sеlection Tool (Пряме 

виділення). На початку текстового рядка з'явиться знак текстового курсора. Перемістіть його 

вздовж кривої, при цьому переміститься весь текст (рис. 48, в); 

– Для дзеркального звернення тексту щодо контуру, виділіть текст інструментом 

Sеlection Tool (Виділення) і перетягніть текстовий курсор, що знаходиться в середині рядка на 

протилежну сторону (рис. 48, г). 

 
Рис. 49. Розміщення тексту на контурі 

 

2. Намалюйте криву лінію і розмістіть вздовж неї текст. Зробіть кілька копій. Виділіть 

текст інструментом Sеlection Tool (Виділення), відкрийте вікно діалогу Type on a Path Options 

(Параметри тексту по контуру) командою Type on a Path Tool (Текст по контуру) меню 

Type (Текст). Встановлюючи різні способи розташування тексту в списку Effect (Ефект), 

різне вирівнювання в списку Align to Path (Вирівнювати по контуру), змінюючи інтервал 

між буквами в лічильнику Інтервали, по різному розмістіть текст уздовж контурів (рис. 50). 

 

 
 

Рис. 50. Діалогове вікно «Параметри тексту по контуру» 
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Рис. 51. Варіанти розміщення тексту на контуру 

 

Фрматування тексту 

Параметри форматування шрифтів і абзаців однакові як для сатиричного, так і для 

абзацного тексту. Ці параметри можна встановлювати як до введення тексту, так і після, 

виділивши текст. 

1. Шрифтове форматування: 

- Надрукуйте або скопіюйте текст, відкрийте палітру Character (Символ), розкрийте за 

допомогою меню палітри повний набір її опцій (рис.4.8); 

 

 
Рис. 52. Палітра Символ 

– Виділіть текст і змініть гарнітуру – список Гарнітура (1) і накреслення (2) – Bold 

(Жирне), Italic (курсивним), Bold Italic (Жирний курсив) в списку Стиль; розмір шрифту – 

Кегль (3); – Відстань між базовими лініями рядків – Міжрядкові (4); 

 
Рис. 53. Зміна гарнітури, кегля і накреслення символів 

 

– Оптичні прогалини між парами букв – Кернинг (5); курсор повинен розташовуватися 

між буквами; 

– Інтервали між буквами прогалини – Трекинг (6); 

– Вертикальну та горизонтальну масштабування окремих символів (7 і 8); 

– Відхилення від базової лінії (9), поворот окремих символів (10). 

Гарнітуру і розмір символів можна встановлювати за допомогою пунктів Шрифт і Кегль 

з меню Текст. 
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4. За допомогою палітри Paragraph (Абзац) (рис. 53) можна змінити параметри 

форматування абзаців тексту: – вимкнення (вирівнювання рядків тексту вліво, вправо і т. д.) 

(1); – відступ зліва (2); – відступ справа (3); – відбиття перед абзацом (новий рядок) (4); 

– відбиття до і після абзацу (5 і 6) . 

 
Рис. 54. Палітра Абзац 
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ПЕРЕТВОРЕННЯ ТЕКСТУ НА КРИВІ. ВИКОРИСТАННЯ ЕФЕКТІВ  

Можна зробити двома способами. 

Перший – задайте область, в якій буде знаходитися майбутній текст. Для цього затисніть 

ліву кнопку в якому-небудь місці документа, створіть рамку і відпустіть миша. 

Другий – клацніть лівою кнопкою миші в лівій частині (щоб було достатньо місця для 

написи) робочої області. З`явиться миготливий курсор, такий же, як в текстових редакторах. 

Далі спільні дії для обох способів – наберіть з клавіатури який-небудь текст. 

Виберіть інструмент Selection Tool (Пряме виділення), після чого текстовий шар 

повинен виділитися самостійно. Якщо немає – клікніть по напису один раз лівою кнопкою 

миші.  

Перетворення написи в криві Безьє можна зробити трьома способами. 

– Перший – клікніть пункт меню «Type → Create outlines» (Текст – 

Перетворити в криві). 

– Другий – натисніть комбінацію клавіш Ctrl + Shift + O. 

– Третій – клацніть по напису правою кнопкою миші і виберіть пункт 

Create outlines (Перетворити в криві). 

 

  
Рис. 55. Приклад перетворення тексту в криві 

 

ЕФЕКТИ 

Ефект Перетікання 

Виберіть інструмент Blend (Перехід) .  

Виконайте одну з таких дій: 

– Для створення послідовного переходу без повороту клацніть кожен об'єкт в будь-

якому місці, крім опорних точок. 

– Для створення переходу в певній опорній точці об'єкта клацніть опорну точку 

інструментом Blend (Перехід). Коли курсор буде знаходитися над опорною точкою, його 

форма зміниться з білого квадрата на прозорий з чорною точкою в середині. 

– Для створення переходу для відкритих контурів виберіть кінцеву точку кожного 

контуру. 

Після завершення додавання об'єктів до переходу ще раз клацніть на інструменті Blend 

(Перехід). 

Примітка: 

За замовчуванням Illustrator обчислює оптимальну кількість кроків для створення 

плавного переходу кольорів. Для управління числом кроків або відстанню між кроками 

виберіть параметри переходу. 

Створення переходу за допомогою команди «Створити перехід» 

Виділіть об'єкти, для яких потрібно створити перехід. 

Виберіть команду «Object → Blend → Make» (Об'єкт → Перехід → Створити).  
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Параметри переходу 

Встановити параметри переходу можна, двічі клацнувши інструмент Blend (Перехід)  

або вибравши команду «Object → Blend → Blend Options» (Об'єкт → Перехід → Параметри 

переходу). Щоб змінити параметри існуючого переходу, виділіть об'єкт за переходом. 

 

 

Рис. 56. Діалогове вікно «Параметри переходу» 

 

Spacing (Інтервал) – визначає, скільки кроків слід додати до переходу. 

Smooth Color (Оптимальні кольору) – дозволяє Illustrator автоматично обчислити число 

кроків переходу. Якщо об'єкти мають заливку або штрихування різними кольорами, кроки 

обчислюються так, щоб забезпечити оптимальне число кроків для плавного переходу 

кольору. Якщо об'єкти містять ідентичні кольори, градієнти або візерунок, число кроків буде 

обчислюватися по максимальному відстані між кордонами обмежувальних рамок двох 

об'єктів. 

Specefied Steps (Заданий число кроків) – управляє числом кроків між початком і 

закінченням переходу. 

Specefied Distance (Задані інтервали) – управляє відстанню між кроками переходу. 

Відстань визначається від кордону одного об'єкта до відповідної межі іншого об'єкта 

(наприклад, від правої межі одного об'єкта до правої межі іншого об'єкта). 

Orientation (Орієнтація) – визначає орієнтацію об'єктів з переходом. 

Вирівняти по сторінці  – орієнтує перехід перпендикулярно осі Х сторінки. 

Вирівняти по контуру  – орієнтує перехід перпендикулярно до контуру. 

 

 
 

Рис. 57. До переходу застосовано параметр «Вирівняти по сторінці» 
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Рис. 58. До переходу застосовано параметр «Вирівняти по контуру» 
 

Зміна осі об'єкта з переходом 

Траєкторія – це контур, уздовж якого вирівнюються кроки для об'єкта з переходом. За 

замовчуванням траєкторія утворюється з прямої лінії. 

 Щоб налаштувати форми траєкторії, перетягніть опорні точки і сегменти контуру на 

вісь за допомогою інструменту Direct Sеlection Tool (Пряме виділення). 

 Щоб змістити траєкторію на інший контур, намалюйте об'єкт, який буде 

використовуватися в якості іншої траєкторії. Виберіть об'єкт траєкторії і об'єкт з переходом і 

потім команду «Object → Blend → Replace Spine» (Об'єкт → Перехід → Замінити 

траєкторію). 

 Щоб змінити порядок переходу по траєкторії, виділіть об'єкт за переходом і команду 

«Object → Blend → Reseve Spine» (Об'єкт → Перехід → Змінити траєкторію). 

Зміна напрямку порядку накладення в об'єкті з переходом 

1. Виділіть об'єкт з переходом. 

2. Виберіть команду «Object → Blend → Reseve Front to Bac» (Об'єкт → Перехід → 

Змінити порядок) 

 

 

Рис. 59. Вихідний порядок накладення (зверху) і порядок після застосування команди 

«Змінити порядок» (знизу) 
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Використання фільтрів у програмі Illustrator 
Фільтри мають дві основні області застосування: підвищення якості зображення 

створення спецефектів. 

Дія будь-якого фільтра, застосованої до зображення можна відкоригувати спеціальної 

командою Edit (Редагування). Команда виконує змішування зображення, отриманого у 

результаті застосування фільтра чи якогось інструмента малювання, з вихідним 

зображенням. Її теж можна викликати, натиснувши комбінацію клавіш Ctrl+Shift+F. 

Слід зазначити, що з повноцінного використання фільтрів потрібна велика практика. 

Немає однозначних правил застосування кожного фільтра у цьому чи іншому разі. Часто 

одним і тієї ж цілей можна досягнути комбінацією найрізноманітніших фільтрів, інколи ж – і 

взагалі без них. 

Фільтри об'єднують у групи з принципу на зображення. 

До фильтрів, що імітують класичну традиційний живопис, ставляться фільтри груп 

Artistic (Імітація) і BrushlStrokes (Мазки пензля). 

Художні фільтри використовують типові діалоги з вікнами попереднього перегляду і з 

декількома змінюваними параметрами. Всі ці фільтри перетворюють зображення у подобу 

малюнка, виконаного традиційними інструментами: кольоровими олівцями, крейдою, 

акварельними барвами й т. д. 

 

 

Рис. 60. Випадаюче меню фільтрів 

  



205 

 

У цю групу входять такі художні фільтри: 

> Colored Pencil (Кольоровий олівець) — фільтр створює штрихові лінії, приблизно 

відповідні основним контурам зображення. Чим менший товщина ліній, обумовлена 

параметромPencilWidth (Товщина олівця), й сильніша тиск, задаваємий параметром Stroke 

Pressun (Натиск), тим паче пропрацьованим виходить малюнок. Значення яскравості паперу 

PaperBrightness задає загальний відтінок результату застосування фільтра. 

> Cutout (Апплікація) – фільтр призначений до створення аплікації на папері. 

Значення,задаваемое двигунцем No of Levels (Кількість рівнів) визначає кількість квітів 

папери, движки Edge Simplicity (Простота країв) і Edge Fidelity (Чіткість країв) 

визначають простоту країв, і відповідність вихідним контурам зображення. Фільтр створює 

ефект пастеризації зображення. Хороші результати можна отримати, якщо це фільтр 

застосовується довисококонтрастним зображенням; 

> DryBrush (Сухий пензель) — фільтр імітує техніку малювання аквареллю і темперою. Він 

дуже добре працює з усіма типами зображень. Після його застосування хороші результати дає 

збільшення насиченості зображення. Повзунок Brush Size (Розмір пензля) визначає розмір 

"сухого пензля" і впливає, разом із параметром Brush Detail (Точність пензля), на роботи 

фільтра. Параметр Texture (>Текстура) впливає на ступінь пастеризації зображення; 

> Film Grain (>Зерниста фотоплівка) — фільтр імітує зернистість, властиву збільшених 

фотографій. Він нагадує фільтр Додати шум, та заодно дозволяє регулювати кількість (параметр 

Grain (Зерна)), розмір зерен (параметр Intensity (Інтенсивність)), і навіть яскравість світлих 

областей вихідного зображення (параметр High light Area (Області світел)). Сам цей фільтр 

застосовується рідко, а може знадобитися разом із іншими фільтрами; 

> Fresco (Фреска) – фільтр імітує настінний розпис по мокрою штукатурці. Результат дії 

фільтра нагадує фільтр Dry Brush (Сухий пензель), але набагато краще. Усі параметри даного 

фільтра аналогічні параметрами фільтра Dry Brush (Суха пензель); 

> Neon Glow (Неонове світіння) – одне із стандартних фільтрів, дає цікавий результат. 

Використовуючи поточні кольору переднього і заднього планів, він додають ще один колір, 

задаваемий в діалоговому вікні фільтра (> Glow Color (Колір перерізу)), і це створює ефект не-

онового світіння навколо контурів зображення. Величина світіння регулюється двигунцем Glow Size 

(Розмір світіння), а інтенсивність світіння — двигунцем Glow Brightness (>Яскравість світіння); 

> Paint Daubs (>Масляний живопис) – фільтр надає зображенню вид картини, написаної 

олією. Він також нагадує фільтр Dry Brush (Суха пензель), але фактично є більш універсальним. 

Розмір пензля визначається двигунцем Brush Size (Розмір пензля), жорсткість пензля – двигунцем 

Sharpness (Різкість), а розкриваючомуся списку Brush (>Кисть) можна вибрати тип пензля; 
 

 

Рис. 61. Приклад використання фільтра «Масляний живопис» 
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> Palette Knife (>Шпатель) – фільтр імітує техніку малювання мастихіном – 

інструментом типу шпателя чи широкого ножа, яким малюють олією. З використанням цього 

фільтра відбувається угрупованняпикселей зображення зі подібним кольором в блоки і 

обчислення їм середнього колірного значення. Розмір блоків визначається двигунцем Stroke 

Size (Розмір обведення), точність відповідності оригіналу — двигунцем Stroke Detail (Точність 

обведення), а параметр Softness (М'якість) визначає м'якість колірного переходу між блоками; 

> Plastic Wrap (>Целофанова упаковка) — даний фільтр створює ефект пластикової 

упаковки з допомогою додавання світіння навколо великих об'єктів. Сила світіння 

«пластикових відблисків» визначається параметром Highlight Strength (>Яскравість 

відблисків), кількість деталей – параметром Detail (Деталі), а м'якість — Softness (М'якість); 

> Poster Edges (>Очерчення краю) — фільтр створює з зображення плакат з допомогою 

обведення контурів чорним і зменшення кількості деталей. Движок Edge Thickness (Товщина 

країв) визначає величину області, оброблюваної фільтром навколо контрастних колірних 

переходів вихідного зображення. Движок Edge Intensity (Інтенсивність країв) виявляє міру 

впливу фільтра. Параметр Posterization (>Пастеризація) виявляє міру пастеризації: що стоїть 

значення даного параметра, тим більше коштів результат дії фільтра нагадує плакат; 

> Rough Pastels (>Пастель) – малювання пастеллю дозволяє домогтися дуже м'яких 

півтонів і плавних переходів кольору. Фільтр має розширеним діалоговим вікном, де з 

допомогоюраскривающегося списку Texture (>Текстура) можна вибрати жодну з готових 

текстур (або використати бодай свою текстуру), поставити висвітлення, використовуючи 

список LightDirection (Напрям світла) і налаштувати довжину (параметр Stroke Length 

(Довжина штриха)) і точність штрихів (параметр Stroke Detail (Точність штриха)), 

добавляемих фільтром в зображення; 

> Smudge Stick (Плями) – цей фільтр дає непоганий ефект, хоч і схожий решту. У 

результаті його застосування складається враження, ніби із зображення, намальованому 

крейдою чи кистю, провели сухий ганчіркою, розмазавши і змішавши кольору. Движок 

Stroke Length (Довжина штриха) визначає довжину штрихів, додаваємих в зображення, а 

движок Highlight Area (Області світел) визначає яскравість світлих областей зображення; 

>Sponge (Губку) – даний фільтр імітує техніку малювання губкою, змоченою фарбою. 

При невеликих значеннях дає непоганий ефект, хоча застосовується нечасто. Розмір мазків 

визначається з допомогою движка Brush Size (Розмір пензля), чіткість країв – з допомогою 

движка Definition (Чіткість), а м'якість – двигунцем Softness (М'якість); 
 

 

Рис. 62. Приклад використання фільтра «Губка» 
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>Underpaying (>Підрисовка) – цей фільтр теж намагається імітувати традиційну техніку 

малювання, коли він спочатку робиться ескіз широкої пензлем (воно задається двигунцем 

Brush Size (Розмір пензля)), та був тонкої пензликом виконується промальовування деталей. 

Цей фільтр, подібно фільтрові Rough Pastels (>Пастель), використовує текстури, що 

імітують матеріал, у якому виконано малюнок. Для вибору текстури використовується 

раскривающийся список Texture (>Текстура). Напрям падаючого світла задається у 

виглядіраскривающегося списку Light Direction (Напрям світла), рельєф текстури 

визначається двигунцем Relief (Рельєф), а масштаб – двигунцем Scale (Масштаб). Після 

застосування фільтра це часто буває необхідно підмалювати пензликом занадто розмиті 

деталі; 

>Watercolor (>Акварель) – фільтр належить до відверто невдалим: він дуже затемнює 

зображення та, крім того і не має нічого спільного з акварельному живописом, котра 

світлими, легкими фарбами. Точність акварельних мазків визначається двигунцем Brush 

Detail (Точність пензля), а інтенсивність чорного кольору – двигунцем Shadow Intensity 

(Інтенсивність тіней). Параметр Texture (>Текстура) використовується збільшення різкості 

і контрастності колірних переходів; 

Фільтри групи Brush Strokes (Мазки пензля) призначені для імітації малювання різними 

пензлями. 

>Accented Edges (Підкреслені краї) – фільтр шукає у виконанні контрастні межі 

і посилює їх. Забарвлення меж, посеред темні кольору відбувається за установці параметра 

Edges Brightness (>Яскравість кордонів) менше 25, а світлі – під час виборів значення 

більше 25; 

> Angled Strokes (>Углові мазки) – фільтр перетворює зображення у ескіз, створений 

перехресними штрихами; 

> Crosshatch (>Штриховка) — цей фільтр дуже подібний до попереднього, але не дає 

різкіше виражений ефект; 

> Dark Strokes (>Темні мазки) — досить цікавий ефекти цього ми фільтра вживають 

щодослабоконтрастним зображенням. Баланс між темними і світлими квітами можна 

регулювати з допомогою движков Balance (Баланс), Black Intencity (Інтенсивність чорного), 

і навіть White Intencity (Інтенсивність білого); 

> Ink Outlines (Кольорові контури) — фільтр працює із контурами зображення, 

спочатку завдаючи білу штрихування, та був обводячи чорним кордону, характерні для 

зображенні. Результат його застосування до пейзажів нагадуватиме старовинні роботи з 

дереві чи гравюри; 

> Spatter (Бризки) – фільтр створює тонку штрихування. Малі значення Smoothness 

(>Гладкість) приведуть до появи туману, що складається з крапель фарби. Радіус 

розпорошення визначається двигунцем Spray Radius (Радіус розпорошення); 

> Sprayed Strokes (> Розпилювач) – цей фільтр дуже нагадує попередній, але у ньому 

ставити напрям штрихування, використовуючираскривающийся список Stroke Direction 

(Напрям штрихування); 

>Sumi-e (>Суми-е) – Суми-е – це з видів японської живопису тушшю. Цей фільтр 

розмиває деталі зображення на темні плями. Результати його застосування нагадують ті, що 

дає фільтр Dark Strokes (Темні мазки). 
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Рис. 63. Приклад використання фільтра «Темні мазки» 
 

До деструктивним фильтрам ставляться фільтри групи Distort (Деформація). Спільним 

їм є принцип дії, заснований на зміщення вихіднихпикселей зображення тому чи іншому 

алгоритму: 

> Diffuse Glow (> Розсіяне світіння) – цей фільтр щось спотворює, а додає до найбільш 

світлим областям зображення млу, забарвлену кольором заднього плану (за умовчанням – 

білим). Фільтр дає непоганих результатів від застосування його до тексту; 

> Displase (Зміщення) – фільтр деформує зображення, використовуючи при цьому карту 

усунення (>Displasement Map). 

> Glass (Скло) – фільтр імітує ефект розглядання зображення через рифлене скло, що 

може мати різну структуру: «>морозко», блоки, полотно, пісок, і т. д. Можна ще 

завантажувати будь-яку іншу текстуру, як така може бути якесь зображення. Для вибору 

текстури служить розкриваючийся список Texture (>Текстура) у нижній частині діалогового 

вікна фільтра. Текстуру можна інвертирувати і масштабувати, домагаючись найкращого 

ефекту; 

> Ocean Ripple (Океанські хвилі) – фільтр нагадує дією попередній. Він вносить в 

зображення багато невеличких спотворень, що видаються на кшталт ряби. Движок Ripple 

Size (Розмір ряби) служить для настройки розміру хвилі, а движок Ripple Magnitude (Розмір 

ряби) – для завдання величини ряби; 

>Pinch (>Сжатие) — фільтр створює ефект опуклості чи увігнутості зображення; 

Polar Coordinates (Полярні координати) – дуже оригінальний фільтр, що багато хто 

недооцінюють тому, що важко зрозуміти, що відбувається із зображенням саме його 

використання. Насправді фільтр перетворює зображення в такий спосіб, начебто вона на 

сфері, а точка огляду перебуває згори. Фільтр може виконувати перетворення що з 

звичайних координат в полярні, і навпаки, навіщо служать два перемикача (>Rectangular to 

Polar (З звичайних в полярні) і Polar to Rectangular (З полярних у звичайні)) у нижній частині 

діалогового вікна фільтра Polar Coordinates (Полярні координати). 

>Ripple (Брижі) – іще одна схожий фільтр, тільки він вносить спотворення з точки; 

>Shear (>Скривлення) – фільтр викривляє зображення небалістичною траєкторією, 

задаваємої в діалоговому вікні; 

>Spherize (>Сферизація) – цей фільтр дуже нагадує Pinch (>Сжатие), але дозволяє 

обмежувати спотворення горизонтальній чи вертикальної осями, які можна вибрати 

враскривающемся списку Mode (Режим), що у частині діалогового вікна; 

>Twirl (>Скручування) – фільтр закручує зображення по годинниковий стрілці при 

позитивні значення параметра Angle (Кут) і боротьбу проти – при негативних 

>Wave (Хвилі) – досить складний фільтр, які зміщують пікселі зображення. Він дає 

змогу ставити кількість істочників-генераторів хвильових спотворень, і навіть силу, напрям і 
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алгоритм генерації хвиль. Ступінь викривлення може бути різною за горизонталлю і 

вертикалі. Якщо поставити нульовий значення для осі Vert (Вертикаль), то спотворення 

проводитимуться лише з горизонталі, і фільтр скидатиметься за своєю дією на фільтр Shear 

(>Скривлення). Переключатель Туре (Тип) задає форму генерованою хвилі; 

>ZigZag (>Зигзаг) — поняття «зигзаг» асоціюється звичайно з ламаної лінією. Фільтр 

під такими назвами дає цілком несподіваний результат — створює радіальне спотворення по 

радіально розбіжним колам чи спіралям. Стиль спотворень поставив у списку, що 

розкривається Style (Стиль), що у частині діалогового вікна фільтра; 

До мозаїчним фильтрам ставляться фільтри групи Pixelate (Оформлення). Усі вони 

працюють, створюючи блоки усередненого кольору з урахуванням зображення, у результаті 

воно набуває вигляду мозаїчного панно: 

> Color Halftone (Кольорові півтони) – фільтр вносить в зображення растр, на кшталт 

того, що можна побачити на зображеннях, віддрукованих друкарським способом, якщо ними 

через збільшувальне скло; 

> Crystallize (Кристалізація) – фільтр перетворює зображення у плями неправильної 

форми, схожі на шматочки скла в калейдоскопі. Розмір "скелець" можна змінювати, 

користуючись двигунцем Cell Size (Розмір осередка); 

> Mezzotint (>Гравюра) – термін ">Mezzotint" означає спеціальнийполутоновий растр, 

котрий, замість звичайних точок оперує укладеними випадково лініями. Діалогове вікно 

цього фільтраснабжено великим вікном попереднього перегляду іраскривающимся списком, 

де можна вибрати алгоритм дії фільтра. Фільтр впливає окремо за кожен канал зображення, 

тож результати його дії будуть різні на одне й того зображення на різних колірних моделях; 

>Pointillize (>Пуантилізм) – фільтр імітує особливу техніку живопису, яке у заподіянні 

безлічі точок, з яких складається зображення. При великих значеннях параметра Cell Size 

(Розмір осередки) зображення взагалі втрачається, замінюючись різнобарвними гуртками. 
 

 
 

Рис. 64. Приклад використання фільтра «Пуантилізм» 

 

Mosaic (Мозаїка) – фільтр створює ефект зображення з низьким дозволом, коли стають 

видно складові його пікселі. Розмір пікселей можна змінювати, використовуючи движок Cell 

Size (Розмір осередка); 

> Facet (>Фаска) — фільтр немає діалогового вікна. Він автоматично об'єднує області 

однаково забарвлених пікселей до створення ефекту ручного розфарбовування; 

>Fragment (Фрагмент) – цей фільтр також має діалогового вікна. Він чотири рази 

копіює вихідне зображення у квадратної області й щоразу у своїй знижує непрозорість, 

створюючи ефект "тремтіння"; 

Усі фільтри, які створюють ефекти, пов'язані висвітлити, належать до групи Render 

(Висвітлення) в більшості своєму дозволяють досягати дуже хороших результатів: 
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3DTransform (>Тривимірна трансформація) – фільтр дозволяє накласти частина 

зображення на сферу, куб чи циліндр, після чого крутити і переміщати цю галузь. Іноді вона 

дозволяє отримати дуже оригінальні ефекти; 

> Clouds (Хмари) — фільтр створює хаотичні плями, дуже близькі на хмари, 

використовуючи при цьому кольору переднього і заднього планів. Фільтр заміняє 

зображення шару на хмари й немає діалогового вікна. Плями, що імітують хмарний покрив, 

генеруються випадково; 

> Difference Clouds (Хмари з накладенням) – фільтр є варіантом застосування фільтра 

Clouds (Хмари) до порожньому прошарку, розташованому над вихідним зображенням, як 

накладення Difference (Різниця). Зазвичай, він надає хороший результат, але застосовувати 

звичайний фільтр Clouds (Хмари) до порожньому прошарку, та був експериментувати, 

змінюючи режими накладення і рівень прозорості шару – це дозволить значно більшу 

гнучкість; 

> Lens Flare (> Блік об'єктива) — фільтр додає до зображення відблиск – дефект, що 

виникає при фотозйомці, якого фотографи намагаються уникнути. Проте задля цифровий 

обробки зображень може надати реалізм, ще, непогано виглядає і простий при застосуванні; 

> Lighting Effects (Ефекти висвітлення) – одне із найбільш а потужних і фільтрів групи 

Render (Висвітлення). Він імітує висвітлення зображення різними джерелами світла, число, 

тип і інтенсивність світіння яких можна регулювати в діалоговому вікні фільтра. Є й список 

заготовок Style (Стиль), обравши будь-яку у тому числі, можна отримати роботу готову 

схему висвітлення. Джерела висвітлення може бути трьох типів: Directional (Спрямований), 

Omni (>Розсіяний) і Spot Light (>Прожектор). Вибрати тип джерела світла у списку, що 

розкривається. 
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КЕРУВАННЯ КОЛЬОРОМ. НАЛАШТУВАННЯ КОЛЬОРОВОЇ ПАЛІТРИ  

Кольори для ілюстрації можна вибирати з різноманітних інструментів, панелей та 

діалогових вікон Illustrator. Спосіб вибору кольору залежить від потреб роботи з 

ілюстрацією. Наприклад, якщо потрібно використати спеціальні кольори, схвалені 

компанією, ви вибиратимете кольори із схваленої компанією бібліотеки кольорів. Якщо 

необхідно, щоб ваші кольори збігалися з кольорами на інший ілюстрації, можна використати 

піпетку або палітру кольорів та ввести точні значення кольорів. 

Для вибору кольору можна використовувати будь-яку з наведених нижче функцій: 

Панель «Swatches» (Зразки) й панелі бібліотек зразків – дозволяє вибирати окремі 

кольори та групи кольорів. Колір можна вибрати з наявних зразків та бібліотек або створити 

власний. Крім того, ви можете імпортувати бібліотеки. 

Палітра «Color» (кольорів). Дозволяє візуально вибирати кольори з відображеного 

спектра, вручну визначати кольори шляхом введення відповідних значень у текстові поля, а 

також вибирати з-поміж наведених зразків кольорів. 

Інструмент «Eyedropper» (Піпетка). Дозволяє шляхом клацання на ілюстрації вибирати 

зразки кольору. 

Панель «Color» (Колір). Дозволяє використовувати спектр кольорів, повзунки для 

встановлення значення кожного окремого кольору (наприклад, повзунок для блакитного кольору), а 

також текстові поля для введення значень кольорів. З панелі «Колір» можна вказувати кольори 

заливки та обведення. За допомогою меню панелі «Колір» можна вибирати інверсні та додаткові 

кольори для поточного кольору заливки та пензля, а також створювати зразки з вибраного кольору. 

Огляд палітри кольорів  

Палітра кольорів дозволяє вказувати колір заливки або обведення об’єкта шляхом вибору з 

колірного поля й спектра, вказування цифрових значень кольорів або натискання на зразку. 

 

 

 
 

Рис. 65. Палітра кольорів. A. Поле кольору. B. Значення кольорів HSB. C. Прямокутник нового 

кольору. D. Прямокутник початкового кольору. E. Повзунок кольору. F. Спектр кольорів. G. Значення 

кольорів RGB. H. Шістнадцяткове значення кольору I. Значення кольорів CMYK 
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Використання панелі Color Themes 

Примітка.  

Для забезпечення належної роботи панелі тем Color під час запуску програми Illustrator 

комп'ютер має бути підключено до мережі Інтернет. Панеллю тем Color неможливо 

скористатися, якщо під час запуску програми Illustrator немає підключення до Інтернету. 

Зразки та теми панелі Color доступні лише для читання. Застосовувати зразки або теми 

до ілюстрації можна безпосередньо з панелі тем Color. А для редагування або зміни 

призначення зразка або теми їх слід спершу додати до панелі зразків. 

1. Аби відкрити панель, клацніть «Window → Color Themes» (Вікно → Колірні теми). 

Усі теми, доступні в обліковому записі Adobe Color на момент запуску Illustrator, 

відображаються на панелі Color Themes. 

2. Якщо тему було додано за допомогою панелі Color Themes після запуску Illustrator, 

натисніть «Update» (Оновити) на панелі Color Themes, щоб нова тема з'явилася на панелі. 

 

Рис. 65. Діалогове вікно «Color Themes» 

A. Пошук теми за назвою B. Значок папки теми C. Значок обраної теми D. Оновити 

E. Відкриття веб-сайту Adobe Color F. Змінення значка, який позначає теми, непридатні 

для редагування G. Назва колірної теми 

 

Примітка.  

На панелі тем Color відображається список тем, які були створені, змінені або позначені як 

улюблені (перераховані на веб-сайті Adobe Color в розділі «My Themes» (Мої теми)) 

3. До панелі «Зразки» можна додати зразок або ж всю колірну тему «Window → 

Swatches» (Вікно → Зразки ). 

Додавання зразка: 

o На панелі Color Themes виберіть зразок, а потім клацніть розкривне меню → «Add to 

Swatches» (Додати до зразків). 

Додавання кількох зразків: 

o На панелі Color Themes утримуйте клавішу Ctrl та виберіть кілька зразків, а потім 

клацніть розкривне меню → «Add to Swatches» (Додати до зразків). Для виділення кількох 

зразків одночасно можна також використовувати клавішу Shift. 

Додавання теми: 

o На панелі Color Themes виберіть усю тему, клацнувши значок папки з темами. Усю 

тему буде додано до панелі зразків. 
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Додавання кількох тем: 

o На панелі Color Themes утримуйте клавішу Ctrl та виберіть кілька значків тек із 

темами, а потім клацніть розкривне меню → «Add to Swatches» (Додати до зразків). Для 

виділення кількох тем одночасно можна також використовувати клавішу Shift. 

4. Якщо перелік тем досить довгий, виконуйте пошук теми за допомогою пошукового поля вгорі 

панелі (розкривне меню панелі → «Show Find Field» (Показати поле пошуку). Пошук виконується за 

назвою теми.  

5. Аби переглянути детальну інформацію щодо облікового запису Adobe Color, який 

нещодавно використовувався, і дату та час останнього оновлення панелі Color Themes, 

клацніть розкривне меню. 

Про зразки  

Зразки – це вибрані кольори, відтінки, градієнти та візерунки, яким було призначено 

назви. Пов’язані з документом зразки з’являються на панелі «Зразки». Зразки можуть 

відображатись окремо або групами. 

Ви можете відкривати бібліотеки зразків з інших документів Illustrator та різноманітних колірних 

систем. Бібліотеки зразків з’являються на окремих панелях і не зберігаються разом із документом. 

Панель «Swatches» (Зразки) та панелі бібліотек зразків можуть містити наступні типи зразків: 

Тріадні кольори – тріадний колір друкується за допомогою комбінації чотирьох 

стандартних тріадних фарб: блакитної, пурпурової, жовтої та чорної. За замовчуванням 

Illustrator визначає нові зразки як тріадні кольори. 

Глобальні тріадні кольори – глобальний колір під час редагування автоматично 

оновлюється по всій ілюстрації. Усі плашкові кольори є глобальними; проте, тріадні кольори 

можуть бути як глобальними, так і локальними. Зразки глобальних кольорів можна 

визначити за значком  (коли на панелі відображаються лише назви) або за трикутником у 

нижньому куті (коли на панелі відображаються мініатюри). 

Плашкові кольори –це попередньо змішана фарба, що використовується замість, до 

тріадних фарб CMYK або на додачу до них. Зразки плашкових кольорів можна визначити за 

значком  (коли на панелі відображаються лише назви) або за крапкою в нижньому куті 

(коли на панелі відображаються мініатюри). 

Градієнт – це градуйований перехід двох або більше кольорів або відтінків одного чи різних 

кольорів. Кольори градієнтів можна визначати у палітрах CMYK та RGB або як спеціальний колір. 

У разі збереження градієнта як зразка, рівень прозорості, застосований до певного вузла градієнта, 

зберігається. Значення ексцентриситету та кутів для еліптичних градієнтів (отриманих внаслідок 

зміни ексцентриситету або кутів радіального градієнта) не будуть збережені. 

Візерунки – це повторювані (розбиті на сегменти) контури, складені контури, текст із 

чистою заливкою або без заливки. 

Зразок «Немає» видаляє з об’єкта заливку або обведення. Цей зразок неможливо 

редагувати та видаляти. 

Суміщення. Зразок кольору суміщення  – це вбудований зразок, який дозволяє 

друкувати залиті чи обведені ним об’єкти на кожному кольороподілі із принтера PostScript. 

Наприклад, мітки суміщення використовують колір суміщення для точного вирівнювання 

друкарських форм у друкарській машині. Цей зразок неможливо видалити. 

Примітка. 

Якщо колір суміщення використати для тексту, а потім виконати поділ кольорів у файлі 

та надрукувати документ, текст може не зареєструватись належним чином, і чорна фарба 

може виявитись забрудненою. Щоб цього уникнути, використовуйте для тексту чорну фарбу. 
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Групи кольорів. Групи кольорів можуть містити тріадні, плашкові та глобальні тріадні 

кольори. Не можуть містити візерунки, градієнти, порожній зразок («Немає»), та зразок 

суміщення. Можна створювати групи кольорів на основі гармонії, використовуючи панель 

Color Guide (Довідник кольорів) або діалогове вікно «Edit Colors» (Редагувати кольори). 

Щоб включити наявні зразки до групи кольорів, виберіть зразки та клацніть по піктограмі 

Створити групу кольорів  на панелі «Swatches» (Зразки). Визначити групу кольорів 

можна за наявністю значка папки . 

На панелі «Swatches» (Зразки)  також можна створювати відтінки. Відтінок – це 

глобальний тріадний або плашковий колір зі зміненою інтенсивністю. Відтінки одного 

кольору пов’язані між собою. Тому, якщо ви зміните колір зразка відтінку, всі пов’язані 

зразки відтінків (та об’єкти, намальовані за допомогою цих зразків) також змінять колір, 

однак, значення відтінків залишаться незмінними. Відтінки можна визначити за 

відсотковими значеннями (коли на панелі «Зразки» відображаються лише назви) 

Огляд панелі зразків  
Панель «Swatches» (Зразки) «Window → Swatches» (Вікно → Зразки ) використовується 

для управління усіма кольорами, градієнтами та візерунками документа. Будь-якому з цих 

елементів можна дати назву та зберегти його для миттєвого доступу. Якщо заливка або 

обведення виділеного об’єкта містить колір, градієнт, візерунок або відтінок, застосований з 

панелі «Swatches» (Зразки), буде виділено відповідний зразок на панелі «Swatches» (Зразки). 

 
Рис. 66. Панель «Зразки» з маленькими мініатюрами та назвами 

A. Плашковий колір B. Глобальні параметри кольору C. Заливка або обведення типу «Немає» D. 

Зразок суміщення (друкується на всіх формах) E. Символ CMYK (коли документ відкрито в режимі 

CMYK) F. Символ RGB (коли документ відкрито в режимі RGB) G. Кнопка «Меню бібліотеки 

зразків» H. Кнопка «Показати меню категорій зразків» I. Кнопка «Параметри зразка» J. Кнопка 

«Створити групу кольорів» K. Кнопка «Створити зразок» 

Використання бібліотек зразків  

Бібліотеки зразків – це набори попередньо визначених кольорів, що включають такі 

бібліотеки фарб, як PANTONE, HKS, Trumatch, FOCOLTONE, DIC, TOYO, та тематичні 

бібліотеки тонів на зразок «Камуфляж», «Природа», «Грецькі» та «Дорогоцінне каміння». 

Коли ви відкриєте бібліотеку зразків, вона з’явиться на новій панелі (а не на панелі 

«Зразки».) Вибір, сортування та перегляд зразків у бібліотеці зразків здійснюється таким же 

чином, як і на панелі «Зразки». Однак, на панелі бібліотеки зразків ви не можете додавати, 

видаляти або редагувати зразки. 

Примітка.  

Щоб бібліотека зразків з’являлась щоразу під час запуску Illustrator, у меню панелі 

бібліотеки зразків виберіть «Постійно». 
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Відкривання бібліотеки кольорів  

 Виконайте одну з таких дій: 

o Виберіть «Window → Swatch Libraries → [назва бібліотеки]» (Вікно → Бібліотеки 

зразків → [назва бібліотеки]). 

o У меню «Swatches» (Зразки) виберіть «Open Swatch Library» (Відкрити бібліотеку 

зразків → [назва бібліотеки]). 

o На панелі «Swatches» (Зразки) натисніть кнопку «Swathe Libraries Menu» (Меню 

бібліотек зразків)  та виберіть необхідну бібліотеку зі списку. 

Створення бібліотеки зразків  

Бібліотеку зразків можна створити шляхом збереження поточного документа як 

бібліотеки зразків. 

1. Відредагуйте зразки на панелі «Swatches» (Зразки) таким чином, щоб на ній 

залишилися лише ті зразки, які необхідно додати до бібліотеки. 

2. Виберіть «Save Swatch Library» (Зберегти бібліотеку зразків) з меню панелі 

«Swatches» (Зразки). 

Примітка.  

Щоб видалити всі зразки, що не використовуються в документі, виберіть Виділити всі 

невикористані з меню панелі «Swatches» (Зразки)  та натисніть кнопку «Delete Swatchy» 

(Видалити зразок) .  

Редагування бібліотеки зразків  

1. Виберіть «File → Open» (Файл → Відкрити), знайдіть та відкрийте файл 

необхідної бібліотеки. За замовчуванням файли бібліотек зразків зберігаються в папці 

Illustrator/Presets/Swatches. 

2. Відредагуйте кольори на панелі «Зразки» та збережіть внесені зміни. 

Переміщення зразків з бібліотеки зразків на панель «Зразки»  

Виконайте одну з таких дій: 

 Перетягніть один або більше зразків з панелі бібліотеки зразків на панель «Swatches» 

(Зразки). 

 Виділіть зразки, які необхідно додати, та в меню панелі бібліотеки виберіть «Add to 

Swatches» (Додати до зразків). 

 Застосуйте зразок до об’єкта в документі. Якщо зразок є зразком глобального або 

плашкового кольору, він буде автоматично доданий до панелі «Swatches» (Зразки). 

Додавання кольорів з ілюстрації до панелі «Зразки»  

Ви можете автоматично додати до панелі «Swatches» (Зразки) усі кольори з 

вибраної ілюстрації або документа. Illustrator знайде кольори, яких іще немає на панелі 

«Swatches» (Зразки), перетворить тріадні кольори у глобальні та додасть їх до панелі як 

нові зразки. 

Під час автоматичного додавання кольорів до панелі «Swatches» (Зразки) додаються усі 

наявні в документі кольори, крім таких: 

 Кольори всередині непрозорих масок (коли ви не перебуваєте в режимі редагування 

непрозорої маски) 

 Інтерпольовані кольори в переходах 

 Кольори у пікселях зображення 

 Кольори шкали колірного охоплення 

 Кольори об’єктів, що знаходяться усередині складених фігур та не є видимими 
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Якщо ви зміните градієнтну заливку, заливку візерунком або однакові зразки символу 

на новий глобальний колір, цей колір буде додано як новий зразок, а зразок початкового 

кольору буде збережено. 

Додавання всіх кольорів документа  

o Переконайтеся, що нічого не виділено, та виберіть команду «Додати використані 

кольори» в меню панелі «Зразки». 

o Додавання кольорів з вибраної ілюстрації  

o Виділіть об’єкти, що містять кольори, які необхідно додати до панелі «Swatches» 

(Зразки), та виконайте одну з наступних дій: 

o У меню панелі «Swatches» (Зразки) виберіть «Add Used Colors» (Додати виділені 

кольори). 

o Натисніть кнопку «New Color Group» (Нова група кольорів)  на панелі 

«Swatches» (Зразки). У діалоговому вікні, що з’явиться, вкажіть параметри. 

Кольори впорядковуються і зберігаються за правилом «Відтінок вперед». 

Спільне з іншими програмами використання зразків  

Забезпечити спільне використання чистих зразків, створених у Photoshop, Illustrator та 

InDesign, можна, зберігши бібліотеку зразків для обміну. Кольори відображатимуться 

однаково в усіх програмах, у яких синхронізовано відповідні параметри кольорів. 

Примітка.  

Для створення зразків груп кольорів використовується панель Color Themes, що раніше 

називалася панель Kuler.  

На панелі «Swatches» (Зразки) створіть зразки тріадних та плашкових кольорів для 

спільного користування та видаліть зразки, які не будуть спільно використовуватись. 

Примітка.  

Неможливе спільне використання програмами зразків таких типів: візерунки, 

градієнти та зразок суміщення із програми Illustrator або InDesign; посилання на кольори з 

книжки, HSB, XYZ, двофарбові зразки, зразки монітора RGB, зразки непрозорості, зразки 

фарб та webRGB з Photoshop. Під час збереження зразків для спільного використання ці 

типи зразків автоматично виключаються. 

1. У меню панелі «Swatches» (Зразки) виберіть «Save Swatch Library as …» (Зберегти зразки 

для спільного використання), потім збережіть бібліотеки зразків у легкодоступному місці. 

Примітка.  

Коли завантажується бібліотека, яка містить зразки з ідентичними назвами, 

визначення зразків з ідентичними назвами перезаписуються. Переконайтеся, що назви 

зразків унікальні. 

2. Завантажте бібліотеку зразків на панель «Swatches» (Зразки) для Photoshop, Illustrator 

або InDesign. 

Створення зразків кольору  

Можна створювати зразки мішаних кольорів, спеціальних кольорів або градієнтів 

кольору. 
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Створення зразка мішаного кольору  

1. Виберіть необхідний колір за допомогою палітри кольорів чи панелі «Колір» або 

виділіть об’єкт, що містить бажаний колір. 

2. Виконайте одну з таких дій: 

o Перетягніть колір з панелі «Tools» (Інструменти або панелі) «Color» (Колір) на 

панель «Swatches» (Зразки). 

o На панелі «Swatches» (Зразки) натисніть кнопку «New Swatch» (Створити зразок) або 

виберіть пункт «New Swatch» (Створити зразок) в меню панелі. У діалоговому вікні, що 

з’явиться, виберіть «Global» (Глобальний), якщо необхідно, щоб зразок мав глобальні 

параметри кольору. Визначте додаткові параметри зразка і натисніть кнопку «OK».  

Створення зразків градієнту  

1. Створіть градієнт за допомогою панелі «Gradient» (Градієнт) або виділіть об’єкт, 

що містить потрібний градієнт. 

2. Виконайте одну з таких дій: 

o Перетягніть градієнтну заливку із фрагмента «Заливка» на панелі інструментів або 

панелі кольорів на панель «Swatches» (Зразки). 

o Відкрийте меню градієнта на панелі «Gradient» (Градієнт) (поруч з областю 

відображення градієнта) і клацніть значок Зберегти в бібліотеку зразків .  

o На панелі «Swatches» (Зразки) натисніть кнопку «New Swatch» (Створити зразок) 

або виберіть пункт «New Swatch» (Створити зразок) в меню панелі. У діалоговому вікні, що 

з’явиться, введіть назву зразка та натисніть «OK».  
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ІМПОРТУВАННЯ РАСТРОВИХ ЗОБРАЖЕНЬ 

В Illustrator не обов’язково створювати ілюстрацію з чистого аркуша – програма 

підтримує імпорт як векторних, так і растрових зображень із файлів, створених в інших 

програмах. Illustrator розпізнає всі поширені формати графічних файлів. Тісна інтеграція між 

продуктами Adobe та підтримка багатьох форматів спрощує обмін графікою між різними 

програмами за допомогою імпорту, експорту, копіювання та вставки. 

Про зв’язані та вбудовані ілюстрації  
Коли ви розміщуєте графіку, ви бачите версію файлу, яка відповідає роздільній 

здатності екрану, таким чином, ви можете переглядати та переміщувати її, але реальна 

ілюстрація може бути зв’язана або вбудована. 

 Зв’язана ілюстрація пов’язана з документом, але лишається незалежною від нього, що 

призводить до менших розмірів документа. Ви можете змінювати зв’язану ілюстрацію за 

допомогою засобів редагування та накладання ефектів; однак, ви не можете обрати та 

редагувати окремі компоненти в ілюстрації. Ви можете використовувати зв’язану ілюстрацію 

багаторазово без суттєвого збільшення розміру документа; також ви можете у будь-який 

момент оновити всі зв’язки. При експорті або друку одержується оригінальна ілюстрація, 

фінальний вивід виконується з використанням повної роздільної здатності оригіналів. 

 Вбудована графіка копіюється у документ за повної роздільної здатності, у результаті 

чого розмір файлу документа збільшується. Ви можете оновити документ у будь-який 

момент; як тільки ілюстрації будуть вбудовані, ваш документ стане самодостатнім. 

Для визначення того, чи є ілюстрація вбудованою або зв’язаною, або для зміни її 

статусу, використовуйте панель «Links» (Зв’язки). 

Якщо вбудована ілюстрація містить кілька компонентів, ви можете редагувати їх 

окремо. Наприклад, якщо ілюстрація містить векторні дані, Illustrator перетворює їх на 

контури, які ви можете потім редагувати, використовуючи інструменти та команди Illustrator. 

Illustrator зберігає також ієрархію об’єкта (таку, як групи та шари) в ілюстраціях, вбудованих 

з файлів певних форматів. 

Розташування (імпорт) файлів ілюстрацій  
Команда «Place» (Помістити) є основним методом для імпорту, оскільки вона надає 

найвищий рівень підтримки форматів файлів, параметрів поміщення, а також кольорів. Після 

того, як ви розмістили файл, використовуйте панель «Links» (Зв’язки)для його визначення, 

вибору, відстеження та оновлення. 

1. Відкрийте документ Illustrator, у якому ви хочете розмістити ілюстрацію. 

2. Оберіть «File → Place» (Файл → Помістити), потім оберіть текстовий файл, який ви 

хочете помістити. 

3. Оберіть зв’язок для створення зв’язку з файлом або зніміть виділення зі зв’язку для 

вбудовування ілюстрації у документ Illustrator. 

4. Натисніть «Place» (Помістити). 

5. Якщо застосовне, виконайте одне з наступного: 

o Якщо ви поміщаєте файл PDF з багатьма сторінками, ви можете обирати, яку сторінку 

ви хочете помістити, а також як кадрувати ілюстрації. 

o Вмонтовуючи файл Adobe® Photoshop®, можна вибрати, яким чином слід 

перетворити шари. Якщо файл містить композиції шарів, ви також можете обрати, яку 

версію зображення імпортувати. 

Імпорт тексту до контуру/фігури  
Розміщуйте текст із файлу підтримуваного формату просто в об’єкті, наприклад у 

фігурі. Ви можете розміщувати текст із файлів формату .txt чи .rtf і файлів, створених за 
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допомогою текстових редакторів. Наприклад, ви можете помістити текст із файлу .rtf у 

фігуру-багатокутник. 

1. Створіть контур/фігуру за допомогою будь-якого інструмента для малювання, 

наприклад «Прямокутник», «Перо» або інструмент створення фігур. Текст із файлу буде 

розміщено в цій фігурі. 

2. Оберіть «File → Place» (Файл → Помістити), потім оберіть файл, який ви хочете 

помістити. 

3. Натисніть кнопку «Place» (Помістити). 

4. Після завантаження текстового файлу до знаряддя поміщення клацніть контур 

відповідної фігури. 

Текст буде розміщено у фігурі. Після цього ви можете застосовувати до тексту бажані 

стилі й ефекти. 

Огляд панелі «Links» (Зв’язки)  

Використовуйте панель зв’язків для перегляду та керування всіма вбудованими та 

зв’язаними ілюстраціями. Панель відображає невеликі мініатюри ілюстрацій, для індикації 

статусу ілюстрацій використовуються значки. 

Редагування оригінальної ілюстрації  
Команда «Edit Original» (Редагувати оригінал) дозволяє відкрити більшість графічних 

файлів у програмі, у якій їх було створено, отже, за потреби їх можна редагувати. Після 

запису початкового файлу документ, з яким він був зв’язаний, оновлюється на нову версію. 

1. Виконайте одну з таких дій: 

o На панелі «Links» (Зв’язки) оберіть посилання та натисніть кнопку «Edit Original» 

(Редагувати оригінал). Можна також обрати команду «Edit Original» (Редагувати оригінал) 

у меню панелі. 

o Оберіть зв’язану ілюстрацію на сторінці, потім натисніть «Edit → Edit Original» 

(Редагування → Редагувати оригінал). 

o Виберіть зв’язану ілюстрацію на сторінці, потім на панелі керування натисніть 

кнопку «Edit Original» (Редагувати оригінал). 

2. Після виконання змін в оригінальній програмі збережіть файл. 

 

 

  



220 

ДРУК ДОКУМЕНТА  

Про позначки принтера  

Коли ви готуєте ілюстрацію для друку, для точного суміщення елементів ілюстрації та 

перевірки кольорів потрібна певна кількість позначок принтера. До вашої ілюстрації ви 

можете додавати наступні типи принтерних позначок: 

Мітки обрізки. Точні (тонкі) горизонтальні та вертикальні лінії, які визначають, де 

сторінка повинна бути відрізана. Мітки обрізки також допомагають зводити (вирівнювати) 

один кольороподіл від іншого. 

Мітки суміщення. Невеличкі позначки поза межами області сторінки для вирівнювання 

різних поділів у кольоровому документі. 

Колірні шкали. Невеличкі квадрати кольорів, що представляють фарби CMYK та 

відтінки сірого (з кроком 10%). Ваш провайдер послуг застосовує ці позначки для 

регулювання густини фарб у друкарській машині. 

Відомості про сторінку 

Позначає на плівці назву номера монтажної області, час і дату друку, використаний 

лінійний растр, кут встановлення растру для кольороподілу і колір кожної конкретної форми. 

Ці мітки з'являються у верхній частині зображення. 

 
Рис. 67. Позначки принтера. 

A. Радіальна міра (обов’язково). B. Мітка суміщення. C. Відомості про сторінку. D. Мітки обрізки. E. 

Колірна шкала. F. Шкала відтінків 

 

Додати позначки принтера  

1. Виберіть команду «File → Print» (Файл → Друк). 

2. Оберіть «Marks and Bleed» (Позначки та випуск за обріз) ліворуч у діалоговому вікні 

«Print» (Друк). 

3. Оберіть тип принтерних позначок, які ви хочете використати. Ви також можете 

обирати між латинським та японським стилем позначок. 

4.  Якщо ви обираєте мітки обрізки, вкажіть ширину ліній міток обрізки та відстань 

зсуву між мітками обрізки та ілюстрацією. 
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Рис. 68. Діалогове вікно «Друк» 

Про випуски за обріз  

Випуск за обріз є частиною ілюстрації, яка не потрапляє в межі обмежувальної рамки 

друку, або лежить за межами області кадрування або міток обрізки. Ви можете включити у 

вашу ілюстрацію випуск за обріз як межу помилок – для забезпечення того, що фарба все ще 

наноситься до країв сторінки, після того, як сторінку було обрізано, або що зображення було 

розбито відповідно до документа. Ви можете створити ілюстрацію, яка виходить за межі 

випуску за обріз, і використовувати Illustrator для визначення масштабів випуску за обріз. 

Збільшення випуску за обріз робить друкований відбиток Illustrator більше за ілюстрацію, 

розташовану під мітками обрізки. Мітки обрізки, тим не менше, задають той самий розмір 

обмежувальної рамки друку. 

Розмір випуску за обріз, який ви використовуєте, залежить від мети. «Bleeds» (Випуск за 

обріз), тобто частина зображення, що виходить за краї друкованого листа, повинне бути 

принаймні 18 пунктів. Якщо випуск за обріз повинен забезпечувати те, аби зображення 

співпадало з контуром, він не повинен складати більш ніж 2 або 3 пункти. Ваша типографія 

має підказати вам розмір випуску за обріз для конкретної роботи. 
 

Додавання випуску за обріз  

1. Виберіть команду «File → Print» (Файл → Друк). 

2. Оберіть «Marks and Bleed» (Позначки та випуск за обріз) ліворуч у діалоговому вікні 

«Print» (Друк). 

3. Виконайте одну з таких дій: 

o Введіть значення для «Top» (Зверху), «Left» (Зліва), «Bottom» (Знизу) та «Right» 

(Справа) для визначення розташування міток випуску за обріз. Натисніть на значок зв’язку 

для того, аби всі значення стали однаковими. 

o Виберіть пункт «Done» (Використати), щоб застосувати параметри обрізання. 

Максимальне значення випуску за обріз складає 72 пункти; мінімальне значення 0. 

Про кольороподіли  

Для відтворення як кольорових, так і безрастрових зображень, принтери зазвичай 

поділяють ілюстрацію на чотири форми (що називається тріадними кольорами) – по одній 

формі для блакитної, пурпурової, жовтої та чорної компоненти зображення. Ви можете 
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також включати власні фарби (які називаються плашковими кольорами). У цьому випадку 

окрема форма буде створена для кожного плашкового кольору. У результаті поетапного 

нанесення цих фарб і поєднання кольорів відтворюється вихідне зображення. 

Процес поділу зображення на два або більше кольорів називається кольороподілом, 

плівки, з яких створюються форми, називаються поділеними формами. 
 

 
 

Складене зображення, надруковане на кольоровому лазерному принтері, у порівнянні з 

поділеними формами чотирьох кольорів, надрукованими на пристрої фотовиводу.  

Підготовка ілюстрацій для кольороподілу  

Перш, ніж ви надрукуєте кольороподіли з Illustrator, непогано було би провести такі 

підготовчі роботи: 

 Впровадження керування кольором, в тому числі калібрування вашого монітора, 

вибір налаштувань кольору Illustrator. 

 Якщо документ знаходиться в режимі RGB, оберіть «File → Color Mode CMYK 

Color» (Файл → Колірний режим документу → Колір CMYK), аби перетворити його у режим 

CMYK. 

 Якщо ваша ілюстрація містить накладання кольорів, оптимізуйте їх так, аби вони 

друкувалися гладко (без дискретних смуг кольору). 

 Якщо ваша ілюстрація потребує трепінгу, встановіть відповідне накладання та 

трепінг. 

 Якщо ваша ілюстрація містить прозорі області чи накладання кольорів, скористайтеся 

попереднім переглядом результатів зведення і обміркуйте, які параметри зведення слід 

застосувати. 

Попередній перегляд кольороподілу  

За допомогою панелі «Separations preview» (Попередній перегляд кольороподілу) можна 

переглядати кольороподіл і накладання.  

Попередній перегляд поділених форм на моніторі дозволяє переглядати об’єкти з 

плашковими кольорами документа, а також перевіряти таке: 

Насичений чорний. Перегляд кольороподілів дозволяє визначити зони, які 

друкуватимуться насиченим чорним кольором, тобто тріадним чорним кольором (K), 

змішаним із кольоровими фарбами для зменшення прозорості й одержання більш насиченого 

кольору. 

Накладання. Цей параметр дає змогу побачити результати змішування, застосування 

прозорості й накладання кольорів на виході після поділу кольорів. Ефекти накладання можна 

також побачити, коли файл виводиться на пристрій друку зі сполученням кольорів. 

1. Виберіть команду «Window → Separations preview» (Вікно → Перегляд кольороподілу). 

2. Виберіть пункт Перегляд накладання кольорів. 

3. Виконайте будь-яку з таких дій: 
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o Щоб приховати на екрані чорнило поділу, натисніть на значок ока , який 

знаходиться ліворуч від назви поділу. Щоб переглянути поділ, клацніть ще раз. 

o Щоб приховати всі чорнила поділу, окрім одного, клацніть на піктограму ока для 

цього поділу, утримуючи клавішу Alt. Щоб знову переглянути всі поділи, ще раз клацніть на 

піктограму ока, утримуючи клавішу Alt. 

o Для одночасного перегляду всіх процесів натисніть значок CMYK . 

4. Щоб повернутися до звичайного режиму перегляду, зніміть прапорець Перегляд 

накладання кольорів. 

Хоча перегляд кольороподілу на моніторі може допомогти у виявленні проблем без 

витрат на друкування кольороподілу, але вплив трепінгу, параметри світлочутливого шару, 

типографські позначки, напівтонові растри й роздільна здатність залишаються недоступними 

для перегляду. Для перевірки цих налаштувань зверніться до свого постачальника послуг 

друку, застосовуючи цілісні чи накладні відтиски. Налаштування видимості чи прихованості 

чорнил у панелі «Попереднього перегляду кольороподілу» не впливає на фактичний процес 

поділів і стосується лише їх відображення на екрані під час попереднього перегляду. 

Друк кольороподілів  

1. Виберіть команду «File → Print» (Файл → Друк). 

2. Оберіть принтер та файл PPD. Для того, аби виконати друк у файл, а не на принтер, 

оберіть «Файл Adobe PostScript®» або «Adobe PDF». 

3. Виберіть «Output» (Вивід) у лівій стороні діалогового вікна «Print» (Друк). 

4. Для «Режиму» оберіть «Поділені форми» (централізовано) або «Поділені форми In-

RIP». 

5. Вкажіть емульсію, експозицію зображення, роздільну здатність принтера для 

поділених форм. 

6. Вкажіть параметри друкованих форм кольороподілу, які ви хочете використати: 

o Для скасування друку колірної форми клацніть на значок принтера . Для 

відновлення друку форми натисніть на значок іще раз. 

o Для перетворення конкретного плашкового кольору на тріадний натисніть на 

значок плашкового кольору . З’являється значок чотирифарбного тріадного кольору . 

Для перетворення на плашковий колір натисніть знов. 

7. Встановіть додаткові параметри у діалоговому вікні «Друк». 

Зокрема, ви можете задати, як розташовувати, масштабувати та обрізати ілюстрацію; 

встановити позначки принтера та випуск за обріз; обрати параметри зведення для прозорих 

ілюстрацій. 

8. Натисніть кнопку «Print» (Друк). 

 

Масштабування документа для друку.  

Для того, аби помістити завеликий документ на сторінці, меншій за реальні розміри 

ілюстрації, ви можете використати діалогове вікно «Print» (Друк) для симетричного або 

несиметричного масштабування висоти та ширини документу. Асиметричне масштабування 

корисне, якщо, наприклад, ви друкуєте плівку для використання у флексографічній машині: 

Якщо ви знаєте, якою стороною форма буде монтуватися на печатному барабані, 

масштабування може компенсувати від 2% до 3% розтягування форми, що зазвичай 

відбувається. Масштабування не впливає на розмір сторінок у документі, воно змінює лише 

масштаб, з яким друкується документ. 

1. Виберіть команду «File → Print» (Файл → Друк). 

2. Виконайте одну з таких дій: 

o Для відключення масштабування оберіть «Do not scale» (Не масштабувати). 
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o Для автоматичного масштабування документу за розміром сторінки оберіть «Fit to 

Page» (За розміром сторінки). Відсоток масштабування визначається областю друку, 

зазначеною в обраному PPD. 

o Для активації текстових полів «Висота» та «Ширина» виберіть пункт «Scale» 

(Власний масштаб). Для висоти та ширини оберіть відсоток від 1 до 1000. Зніміть виділення 

з кнопки «Зберегти пропорції» для зміни відношення між шириною й висотою. 

Зміна розміру і орієнтації сторінки 

1. Виберіть команду «File → Print» (Файл → Друк)... 

2. Оберіть розмір сторінки з меню «Custom» (Розмір). Доступні розміри залежать від 

принтера та файлу PPD. Якщо файл PPD принтера передбачає таку можливість, ви можете 

обрати «Власні» для визначення розміру сторінки у текстових вікнах «Ширина» та 

«Висота». 

3. Для встановлення орієнтації сторінки натисніть на кнопку «Orientation» (Орієнтація): 

Книжкова догори  – Друк у книжковій орієнтації, правою стороною догори. 

Альбомна зліва  – Друк альбомної орієнтації, повернутої вліво. 

Книжкова донизу  – Друк у книжковій орієнтації, верхньою стороною донизу. 

Альбомна вправо  – Друк альбомної орієнтації, повернутої вправо. 

4.  Оберіть «Transvers» (Поперечне) для повороту друкованої ілюстрації на 90°. Для 

використання даного параметра файл PPD має підтримувати поперечну орієнтацію сторінки 

та власні розміри сторінки. 
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ПРАКТИЧНІ ЗАВДАННЯ 

ВИВЧЕННЯ ПАНЕЛІ ІНСТРУМЕНТІВ ТА ПАНЕЛІ ВЛАСТИВОСТЕЙ 

Огляд панель інструментів  

 
 

При першому запуску програми панель інструментів з'являється на лівій стороні екрану. 

Панель «Інструменти» можна перемістити, перетягнувши її за смугу заголовку. Ви також можете 

відобразити або сховати панель «Інструменти», обравши «Вікно» «Інструменти». 

Ви можете використовувати інструменти на панелі інструментів для вибору та маніпулювання 

об'єктами Illustrator. Деякі інструменти мають параметри, які з'являються при подвійному клацанні на 

інструменті. Це стосується, зокрема, інструментів, що дозволяють вам використовувати текст, 

виділити, розфарбувати, малювати, брати зразок, редагувати та переміщувати зображення.  

Ви можете розгорнути деякі інструменти, аби переглянути приховані під ними інструменти. 

Про наявність прихованих інструментів сповіщає маленький трикутник у правому нижньому кутку 

значка інструмента. Для того, аби переглянути назву інструмента, розташуйте вказівник над ним.  

На панелі інструментів також можна змінювати режими малювання: «Звичайне малювання», 

«Малювання позаду» та «Малювання всередині».  
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Хід виконання роботи: 

1. Для створення нового документа виберіть команду File/New (файл/новий). 

2. Коли з’явиться вікно New Document (новий документ), залишіть значення параметрів за 

замовчуванням, крім розміру документа. У полі Size виберіть формат А4 і натисніть кнопку 

ОК (рис.1). На екрані з’явиться вікно нового документа (рис.2). 
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СТВОРЕННЯ ТА РЕДАГУВАННЯ ОБ’ЄКТІВ 

Мета роботи: Набути навичок в створенні та редагуванні об’єктів.  

Група інструментів геометричних об'єктів  

До інструментів малювання геометричних об'єктів відносяться прямокутник, еліпс, 

прямокутник зі скруглением і ряд інших. На рис. 1 показані ці інструменти. 

 
Рис. 1. Група інструментів геометричних об'єктів 

В роботі цих інструментів багато спільного: 

– Утримуючи клавішу «Alt» прямокутники і еліпси малюються з центру; 

– Для отримання квадрата або круга потрібно утримувати клавішу «Shift»; 

– Якщо під час малювання будь-якого з цих об'єктів натиснути клавішу «Пропуск», зображення 

можна перемістити по екрану. 

Група інструментів лінійних об'єктів 

Ця група розкривається клацанням на кнопці інструменту «Відрізок лінії» (Рис.2). 

 

 
 

Рис. 2. Група інструментів лінійних об'єктів 

Малювання ліній інструментом Перо 

1. Для малювання прямої лінії, активізуйте інструмент Перо, клацніть курсором миші в 

початковій і кінцевій точках лінії. Для завершення малювання клацніть в будь-якому місці, 

утримуючи клавішу «Ctrl». 

2. Утримання клавіші «Shift» дозволяє малювати лінії під кутом, кратним 45. 

3. Для замикання контуру необхідно клацнути в початковій точці (поруч з курсором 

з'являється зображення маленького гуртка). 

4. Останню крапку можна переміщати, якщо, не відпускаючи кнопку миші, натиснути кнопку 

«Пропуск». 

5. Для малювання кривих Безьє активізуйте інструмент Перо, клацніть на аркуші, перемістіть 

маркер на інше місце, натисніть кнопку миші і потягніть у сторону. З'являться керуючі лінії 

опорної точки і сегмент, який з'єднує дві опорні точки, зігнеться. 

Малювання довільних ліній інструментом Олівець 

1. Активізуйте інструмент Олівець і намалюйте криву, імітуючи вільне малювання звичайним 

олівцем. 

2. Отриманий контур містить опорні точки, число яких залежить від складності кривої і від 

установок у вікні Параметри інструменту Олівець. 

Завдання: Вивчити як створювати об’єкти та редагувати їх . 
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Порядок виконання роботи 

1. Для малювання лінії активізуйте інструмент Відрізок лінії, натисніть і не відпускайте курсор 

миші в початковій точці, простягніть лінію до потрібної точки і відпустіть кнопку миші. 

2. Намалюйте лінію, утримуючи «Alt». 

3. Активізуйте інструмент Спіраль і намалюйте кілька спіралей, використовуючи клавіші зі 

стрілками для зміни кількості завитків (рис. 1). 

4. Інструментом Прямокутна сітка намалюйте прямокутну і квадратну сітки. Намалюйте сітки 

з різною кількістю осередків, використовуючи горизонтальні і вертикальні стрілки (рис. 2). 

5. Намалюйте замкнутий сегмент – для цього під час малювання натисніть одноразово клавішу 

«C». Спробуйте під час малювання натиснути клавішу «F». 

 

 

 

 

 

 

 

 

 

 

Рис. 1  Рис. 2 

 

Питання для самоконтролю 

1. Які бувають групи інструментів? 

2. Як малювати лінії інструментом перо? 

3. Яким чином можливо малювати інструментом олівець? 
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РОБОТА З ПЕНЗЛЯМИ 

Мета роботи: набути навичок роботи з пензлями. Розглянути ряд різних пензлів 

Про пензлі  

Пензлі дозволяють вам стилізувати вигляд контурів. Ви можете застосовувати штрихи до 

наявних контурів або інструмент «Художній пензель», щоб намалювати контур та застосувати штрих 

одночасно. 

У Illustrator доступний ряд різних пензлів: каліграфічні, дискретні, об’єкті, візерункові та 

ворсові. Ви можете досягти наступних ефектів за допомогою цих пензлів: 

Каліграфічні пензлі. Створюють обведення, що нагадують обведення, намальовані за 

допомогою вигнутої точки каліграфічної ручки та намальовані вздовж центру контура. Якщо 

використовується інструмент «Пензель "ляпка"», можна малювати каліграфічним пензлем та 

автоматично розгортати штрих пензля у форму заливки, яка об’єднується з іншими об’єктами із 

заливками такого ж кольору, які перетинаються або дотичні у порядку складання. 

Дискретні пензлі. Розподіляють копії об’єкта (наприклад, комаху чи лист рослини) вздовж 

контура. 

Об’єктні пензлі. Розтягують форму пензля (наприклад, грубий вугільно-сірий) або об’єкта 

рівномірно вздовж контура. 

Ворсовий пензель. Мазки ворсового пензля виглядають як мазки справжнього пензля з 

ворсинками.  

Візерункові пензлі. Розфарбовують візерунок, що складається з окремих сегментів, що 

повторюється вздовж контура. Візерункові пензлі можуть включати до п’яти сегментів, для сторін, 

внутрішнього кута, зовнішнього кута, початку та кінця візерунку. 
 

 
 

A. Каліграфічний пензель B. Дискретний пензель C. Об’єктний пензель D. Візерунковий 

пензель E. Ворсовий пензель   

 
 

На візерунковому пензлі стрілки вигинаються, повторюючи контур (ліворуч), а на дискретному 

пензлі стрілки залишаються прямими (праворуч).  

Огляд панелі пензлів 

Панель пензлів («Вікно»  «Пензлі») відображає пензлі для поточного файлу. Кожного разу, 

коли ви виділяєте пензель у бібліотеці пензлів, він автоматично додається на панель пензлів. Пензлі, 
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які ви створюєте та зберігаєте на панелі пензлів, зв’язані лише з поточним файлом, це означає, що 

кожний файл Illustrator має різні набори пензлів на своїй панелі пензлів. 

Показ або приховування типу пензля  

 У меню панелі виберіть одних з таких пунктів: «Показувати каліграфічні пензлі», 

«Показувати дискретні пензлі», «Показувати об’єктні пензлі», «Показувати ворсові пензлі», 

«Показувати візерункові пензлі». 

Зміна перегляду пензлів  

 Оберіть «Перегляд мініатюр» або «Лише назви» у меню панелі. 

Зміна порядку пензлів на панелі пензлів  

 Перетягніть пензель на нове місце. Ви можете переміщувати пензлі лише у рамках їхнього 

типу. Наприклад, ви не можете перемістити каліграфічний пензель в область дискретного. 

Дублювання пензля на панелі пензлів  

 Перетягніть пензель не кнопку «Створити пензель»  або оберіть «Дублювати пензель» у 

меню панелі пензлів. 

Видалення пензлів із панелі пензлів  

 Виберіть пензлі та натисніть кнопку «Вилучити пензель» . Ви можете виділяти пензлі, що 

не використовуються у документі, шляхом обрання «Виділити усі невикористовувані» у меню панелі 

пензлі. 

Робота з бібліотеками пензлів  

Бібліотеки пензлів («Вікно» «Бібліотеки пензлів» [бібліотека]) – це колекції початкових 

пензлів, що супроводжують Illustrator. Ви можете відкривати декілька бібліотек пензлів, щоб 

переглянути їхній зміст та виділити пензлі. Також можна відкривати бібліотеки пензлів, 

використовуючи меню панелі пензлів. 

Якщо ви розміщуєте файл в іншій папці, можна відкрити бібліотеку, обравши «Вікно»  

«Бібліотеки пензлів» «Інша бібліотека» та виділивши відповідний файл бібліотеки. 

Видалення штрихів  

1. Виділіть контур, намальований пензлем. 

2. У меню панелі пензлів оберіть «Видалити штрих пензля» або натисніть кнопку 

«Видалити штрих пензля» . 

3. Щоб видалити мазок, можна також вибрати стандартний пензель на панелі «Пензлі» 

або панелі керування. 

Перетворення штрихів на контури  

Можна перетворювати штрихи пензля на контури, щоб відредагувати окремі компоненти 

контура, намальованого пензлем.  

1. Виділіть контур, намальований пензлем. 

2. Оберіть «Об’єкт»  «Розгорнути вигляд». 

Illustrator розташовує компоненти розширеного контура у групі. У групі розташовуються 

контур та підгрупа, що містять контури штрихів.  

Сегментований об’єктний пензель  

Сегментний об’єктний пензель дозволяє визначити частину, яка не подовжується, на кінцях 

об’єктного пензля. У діалоговому вікні параметрів об’єктного пензля виберіть параметр «Розтягнути 

між напрямними» і налаштуйте напрямні у вікні попереднього перегляду діалогового вікна.  
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Параметр «Розтягнути між напрямними» в діалоговому вікні параметрів об’єктного пензля  

 

 
Порівняння сегментованого та несегментованого об’єктних пензлів 

A. Сегментований об’єктний пензель B. Несегментований об’єктний пензель 

 

Параметри візерункового пензля  

Масштаб. Налаштовує розмір сегментів відносно їхнього вихідного розміру. Вказуйте 

значення масштабу за допомогою бігунця налаштування масштабу. У випадному списку «Масштаб» 

для візерункового пензля містяться параметри, аналогічні до даних пера планшета, які враховуються 

під час зміни ширини, наприклад натиск, копіювальне коліщатко, нахил, напрямок та поворот. 

Кнопки розбиття на сегменти. Дозволяють застосовувати різні візерунки для різних частин 

контура. Натисніть на кнопку розбиття на сегменти, які необхідно визначити, та виділіть зразок 

візерунку зі списку прокрутки. Повторіть для застосування зразків візерунку до інших сегментів як 

необхідно. 
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Розбиття у візерунковому пензлі 

 

A. Боковий сегмент B. Зовнішній кутовий сегмент C. Внутрішній кутовий сегмент  

D. Початковий сегмент E. Кінцевий сегмент 

 

Припасовування. Визначає припасування візерунку на контурі: «Розтягнути для 

припасування» подовжує або скорочує розбиття візерунку для припасування до об’єкта. Цей 

параметр може призвести до нерівного розбиття. «Додати простір для припасування» додає порожній 

простір між кожним візерунковим сегментом, щоб застосувати візерунок пропорційно до контура. 

Приблизний контур припасовує сегменти до найближчого приблизного контура, не змінюючи 

розбиття. Цей параметр застосовує візерунок трошки усередині або ззовні, але не центрує на контурі, 

щоб зберегти рівне розбиття. 

 
Параметри припасовування 

 

A. Розтягнути для припасування B. Додати пропуск, щоб припасувати C. Приблизний контур 
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Забарвлення. Виберіть для обведення колір та спосіб зафарбовування. Із цього випадного 

списку можна вибрати різні способи зафарбовування. Доступні такі варіанти: відтінки, відтінки і тіні, 

зсув тону. 

Ворсовий пензель. За допомогою ворсового пензля можна робити мазки, які виглядають як 

мазки справжнього пензля з ворсинками. Ворсовий пензель дозволяє:  

 створювати природні та плавні мазки, начебто нанесені справжнім пензлем та справжніми 

фарбами, наприклад аквареллю.  

 вибирати різні пензлі у бібліотеці стандартних пензлів або створюйте власні пензлі, 

наприклад круглі, пласкі або віялоподібні; можна також встановити інші параметри пензля, 

наприклад довжину ворсу, його густоту чи непрозорість фарбування. 

 
Ілюстрація з використанням ворсових пензлів різної форми та характеристик  

 

Якщо використовувати графічний планшет у поєднанні з ворсовим пензлем, Illustrator 

інтерактивно відстежує переміщення пера поверхнею планшета. Таким чином буде відтворено всі 

нюанси положення та притискання пера в будь-якій точці його шляху. Illustrator моделює об’єкт на 

основі таких параметрів руху пера: положення за осями X та Y, натиск, нахил, напрямок та 

обертання.  

Використання ворсового пензля. Для використання ворсового пензля виконайте такі дії:  

1. Створіть пензель, клацнувши значок створення нового пензля або вибравши пункт 

«Створити пензель» у меню панелі «Пензлі». 

2. Виберіть пункт «Ворсовий пензель» і натисніть «OK».  
 

 
Діалогове вікно параметрів ворсового пензля 
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3. Вкажіть потрібні параметри в діалоговому вікні параметрів ворсового пензля. 

 Назва 

 Форма 

 Розмір 

 Довжина ворсу 

 Густота ворсу 

 Товщина ворсу 

 Непрозорість фарбування 

 Жорсткість 

4. Щоб створити пензель із вибраними параметрами, натисніть «OK». 

 

Завдання: Вивчити як за допомогою пензлів стилізувати вигляд контурів . 

Порядок виконання роботи 

1. Натиснути Панель пензлів («Вікно»  «Пензлі») де буде відображатися пензлі для поточного файлу. 

2. На візерунковому пензлі стрілки вигинути, повторюючи контур (ліворуч) (рис.1), а на 

дискретному пензлі стрілки залишити прямими (праворуч) (рис. 2). 

3. За допомогою пензля зробити візерунок (рис. 3). 

 

 

 

 

 

 

 

Рис. 1    Рис. 2 

 

 

 

 

 

 

     Рис. 3 

Питання для самоконтролю 

1. Які бувають пензлі? 

2. Як зробити припасування візерунку на контурі? 

3. Яким чином перетворити штрихи на контури? 
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СТВОРЕННЯ ФІГУР ДОВІЛЬНОЇ ФОРМИ 

Мета роботи: набути навичок при створенні фігур довільної форми. 

Створення контурів інструментами Spiral і Arc. У переважній більшості випадків для 

малювання криволінійних контурів використовують інструмент Pen. Виняток становить 

формування спіралі і найпростішої дуги, для яких є спеціалізовані інструменти Spiral 

(Спіраль) і Arc (Дуга). Намалювати точно такі ж спіраль і дугу можна і інструментом Pen, але 

цей варіант виявиться більш трудомістким. 

Для прикладу активізуйте інструмент Spiral і намалюйте на аркуші довільну спіраль, 

перемістивши курсор по вільному простору при натиснутій лівій кнопці (рис. 3). Встановіть 

колір штриха (Stroke), порожній колір заливки (Fill) і скористайтеся відповідною 

каліграфічної пензлем - в даному випадку взята кисть 10 pt Oval (рис. 4). 

 

Рис. 3. Вихідний вид спіралі  Рис. 4. Остаточний вигляд спіралі 

Створення контурів інструментами з групи Pen (Перо) - це найголовніший інструмент 

роботи з контурами, і в його склад входять ще три інструменти: Add Anchor Point - (Перо +), Delete 

Anchor Point (Перо-) і Convert Anchor Point (Кут). Перший відповідає за додавання нових опорних 

точок, другий - за їх видалення, а третій здійснює перетворення опорних точок з одного типу в 

інший. 

При створенні і редагуванні кривої необхідно швидко перемикатися з одного пір'яного 

інструменту на інший, для чого служать клавіатурні комбінації. В цілому інструмент Pen вибирається 

при натисканні клавіші P, а далі: Add Anchor Point - натисканням клавіші «+», Delete Anchor Point - 

клавіші «-», а Convert Anchor Point - клавіші Alt. 

А тепер спробуйте намалювати стрілку. Спочатку інструментом Pen створіть контур у вигляді 

відрізка (рис. 5) і скористайтеся командою Filter> = Stylize> = Add Arrowheads (Фільтр => Стилізація 

=> Додати стрілку) при параметрах, представлених на рис. 5. Після цього зафарбуйте стрілку 

відповідним чином (рис. 6). 

 

  

 

 

 

 

 

 

 

 

 

 

Рис. 5. Налаштування параметрів стрілки Рис. 6. Остаточний вигляд стрілки 
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Якщо відмовитися від заливки стрілки, встановивши для параметра Fill варіант None, 

то на створену стрілку можна накласти ряд перетворень і отримати з прямої стрілки різні 

варіанти криволінійних стрілок. Для прикладу скористайтеся фільтром ZigZag по команді 

Filter => Distort => ZigZag (Фільтр => Спотворення => Зигзаг) з такими параметрами, як на 

рис. 7. Результат - на рис. 8. 

 

Рис. 8. Приклади криволінійних стрілок (вихідна 

стрілка і два варіанти спотворених стрілок) 

Рис. 7. Налаштування параметрів фільтра ZigZag 

 

Завдання: Вивчити як створювати фігури довільної форми . 

Порядок виконання роботи 

1. Відкрити документ «Лабораторні роботи». 

2. Створити контури за допомогою інструментів Spiral і Arc. 

3. Активізуйте інструмент Spiral і намалюйте на аркуші довільну спіраль, 

перемістивши курсор по вільному простору при натиснутій лівій кнопці (рис. 1). 

4. Розфарбуйте фігуру кольором на ваш вибір. 

5. Намалюйте стрілку. Спочатку інструментом Pen створіть контур у вигляді відрізка і 

скористайтеся командою Filter> = Stylize> = Add Arrowheads (Фільтр => Стилізація 

=> Додати стрілку). Після цього зафарбуйте стрілку відповідним чином (рис. 2). 

 

                                     Рис. 1    Рис. 2 

 

Питання для самоконтролю 

4. За допомогою якого інструменту можна створити контур? 

5. Чи можна створити криволінійні стрілки? 

6. Яким чином можливо розфарбувати контури? 
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РОБОТА З ОБ’ЄКТАМИ. БУЛЕВІ ОПЕРАЦІЇ 

Мета роботи: набути навичок з редагування графічних об’єктів. Навчитися 

використовувати прив’язки при розташуванні графічних об’єктів в документах. Вивчити 

принципи вирівнювання об’єктів. 

Редагування об’єктів 

Логічні операції з контурами. Палітра Pathfinder.У програмі Illustrator можна 

комбінувати векторні об'єкти, створюючи фігури різними способами. Утворені контури або 

фігури розрізняються залежно від способу об'єднання контурів. 

Ефекти обробки контурів дозволяють комбінувати різні об'єкти за допомогою однієї з 

десяти моделей взаємодії. На відміну від складових фігур, редагувати взаємодія об'єктів при 

використанні ефекту обробки контурів можна. 

Складові фігури дозволяють комбінувати об'єкти і вказувати, як кожен з них повинен 

взаємодіяти з іншими об'єктами. Складові фігури є більш гнучким засобом, ніж складові 

контури, оскільки забезпечують чотири способи взаємодії: додавання, віднімання, перетин і 

виключення. Крім того, нижні об'єкти не змінюються, що дозволяє вибирати кожен об'єкт в 

складовою фігурі для редагування або зміни його режиму взаємодії. 

Pathfinder (Обробка контурів) (рис. 1), яка викликається на екран однойменною 

командою меню Window (Вікно), призначена для комбінування об'єктів різними способами, 

найчастіше з утворенням складових контурів (compound path). Своєрідність складних 

контурів полягає в тому, що пересічні області двох різних контурів, стають прозорими 

(аналогія з «дірками» від бублика). Слід врахувати, що об'єктами для палітри Pathfinder 

(Обробка контурів) не можуть служити результати роботи інструменту Gradient Mesh 

(Градиентная сітка) (Щ). Крім того, краще використовувати замкнуті контури без обводок. 

При комбінуванні контурів з різними кольоровими заливаннями, як правило, результуючому 

об'єкту присвоюється заливка верхнього об'єкта (про винятки повідомляється особливо). 

 

Рис. 1. Палітра Pathfinder з відкритим меню 

Для комбінування об'єктів слід розмістити і виділити необхідні об'єкти, а потім натиснути одну 

з кнопок палітри Pathfinder (Обробка контурів). Залежно від виконуваної операції на екран може бути 

виведено діалогове вікно, в якому слід ввести необхідні додаткові дані.  У команд палітри Pathfinder 

(Обробка контурів) існує кілька загальних установок, які змінюються в діалоговому вікні Pathfinder 

Options (Обробка контурів: Параметри) (рис. 2), яке викликається командою Pathfinder Options 

(Параметри обробки контурів) меню палітри. 

 

Рис. 2. Діалогове вікно Pathfinder Options 
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У цьому діалоговому вікні можна задати наступні параметри: 

У поле Precision (Точність обчислень) вводиться ступінь точності, з якою команди 

палітри Pathfinder (Обробка контурів) виконує обчислення при комбінуванні виділених 

об'єктів. За замовчуванням приймається значення, рівне 0,028 пунктам. При установці 

прапорця Remove Redundant Points (Видаляти зайві точки) забезпечується видалення будь-

яких опорних точок, які розташовані точно один над одним і при комбінуванні є зайвими. 

При установці прапорця Divide and Outline Will Remove Unpainted Artwork (Видаляти 

незафарбовані об'єкти) видаляються всі незаповнені об'єкти, одержувані в результаті 

виконання команд Divide (Поділ) і Outline (Обведення). Для того щоб повторити останню 

операцію, виконану за допомогою палітри Pathfinder (Обробка контурів), можна 

скористатися командою Repeat (Повторити) меню палітри.  

Кнопка Add to shape area (Додавання в складений об'єкт) на панелі комбінує виділені 

об'єкти таким чином, що контур результуючого об'єкта збігається із загальним периметром 

всіх об'єктів (рис. 3). Якщо потрібно створити складовою контур, слід натиснути кнопку 

Expand (Перетворити). Всі об'єкти і деталі, розташовані всередині загального периметра, 

видаляються, тому, якщо вони потрібні для подальшої роботи, слід попередньо створити їх 

копію. Якщо комбіновані об'єкти не мають перетинів, вони все одно об'єднуються в єдиний 

об'єкт з однаковими параметрами контуру і заливки. 

 

Рис. 3. Вихідні об'єкти і результат дії кнопки Add to shape area 

Якщо потрібно таким же чином об'єднати всі контури, що входять в групу або розташовані на 

шарі (подслое), слід використовувати команду Add (Додати) меню Effect | Pathfinder (Ефект | Обробка 

контурів). Це саме можна сказати і до шрифтовим об'єктів. Якщо будь-яку команду з цього меню 

застосувати до простих об'єктів, то на екран буде виведено відповідне попередження (рис. 4). 

 

Рис. 4. Вікно Pathfinder Group Alert 
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Кнопка Subtract from shape area (Видалення з складеного об'єкта) комбінує виділені 

об'єкти таким чином, що контур результуючого об'єкта дорівнює площі самого нижнього 

об'єкта з вирізом площ об'єктів, розташованих над ним (рис. 5). Якщо потрібно створити 

складовою контур, слід натиснути кнопку Expand (Перетворити). Всі об'єкти і деталі, які не 

потрапляють в результуючий контур, видаляються, тому, якщо вони потрібні для подальшої 

роботи, необхідно попередньо їх скопіювати. 

 

Рис. 5. Вихідні об'єкти і результат дії кнопки Subtract from shape area 

Якщо потрібно таким же чином об'єднати всі контури, що входять в групу або 

розташовані на шарі (подслое), то слід використовувати команду Subtract (Видалення) меню 

Effect | Pathfinder (Ефект | Обробка контурів). Це саме можна сказати і до шрифтових об'єктів. 

Кнопка Intersect shape areas (Перетин складових об'єктів) на панелі комбінує виділені 

об'єкти таким чином, що контуром результуючого об'єкта є область перетину об'єктів (рис. 6). 

Якщо потрібно створити складовою контур, то слід натиснути кнопку Expand (Перетворити). 

Всі об'єкти і деталі, які не потрапляють в результуючий контур, видаляються, тому, якщо 

вони необхідні для подальшої роботи, слід попередньо створити їх копію. Виконання 

команди можливо, якщо об'єкти «перетинаються». 

 

Рис. 6. Вихідні об'єкти і результат дії кнопки Intersect shape areas 

Якщо потрібно таким же чином об'єднати всі контури, що входять в групу або 

розташовані на шарі (подслое), слід використовувати команду Intersect (Перетин) меню 

Effect | Pathfinder (Ефект | Обробка контурів). Це саме можна сказати до шрифтовим об'єктів. 
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Кнопка Exclude overlapping shape areas (Виняток пересічних областей) комбінує 

виділені об'єкти таким чином, що не перетинаються області входять в результуючий об'єкт, а 

пересічні - «виключаються», робляться прозорими (рис. 7).  

Однак при цьому слід враховувати кількість перетинаються областей: 

 якщо їх число парне, то вони стають прозорими; 

 якщо їх число непарне, вони включаються в об'єкт з відповідною заливкою. 

Якщо подумки провести лінію зліва направо через виділені об'єкти, то з першого 

контуру, який перетнула лінія, починається заливка, після другого контуру заливка 

припиняється, після наступного - починається і т. д. (Рис. 8). Насправді, ситуація дещо 

складніша. Якщо потрібно створити складовою контур, необхідно натиснути кнопку Expand 

(Перетворити). Всі об'єкти і деталі, які не потрапляють в результуючий контур, видаляються, 

тому, якщо вони знадобляться для подальшої роботи, слід попередньо створити їх копію. 

Якщо необхідно таким же чином об'єднати всі контури, що входять в групу або розташовані 

на шарі (подслое), то слід використовувати команду Exclude (Виняток) меню Effect | 

Pathfinder (Ефект | Обробка контурів). Це саме можна сказати і до шрифтовим об'єктів. 

Рис. 8. Емпіричне правило для кнопки Exclude 

overlapping shape areas кнопка Divide 

 

 

 

 

 

 

Кнопка Divide (Поділ) на панелі виконує в певному сенсі протилежну дію в порівнянні 

з комбінуванням: вона розбиває складний об'єкт на прості об'єкти (рис. 9). Користувач 

повинен заздалегідь вирішити, видаляти або зберігати об'єкти без заливки. 
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Рис. 9. Вихідні об'єкти і результат дії кнопки Divide, отримані об'єкти розгрупувати і розведені 

Для цього призначений прапорець Divide and Outline Will Remove Unpainted Artwork 

(Видаляти незафарбовані об'єкти) діалогового вікна Pathfinder Options (Параметри палітри 

«Обробка контурів»). Слід звернути увагу, що команда Divide (Поділ) не повертає вихідні 

об'єкти, існуючі до виконання, наприклад, команди Exclude (Виняток), а розбиває складний 

об'єкт на об'єкти, що представляють собою окремі заповнені області. Після застосування 

кнопки Divide (Поділ) все утворені об'єкти залишаються в групі, для вільного маніпулювання 

окремими об'єктами слід виконати команду Ungroup (Розгрупувати) меню Object (Об'єкт). 

Якщо необхідно таким же чином об'єднати всі контури, що входять в групу або розташовані 

на шарі (подслое), слід використовувати команду Divide (Поділ) меню Effect | Pathfinder 

(Ефект | Обробка контурів). Це саме можна сказати до шрифтовим об'єктів. 

Кнопка Trim (Обрізка) комбінує виділені 

об'єкти таким чином, що видаляє всі частини об'єктів, 

які є прихованими, при цьому об'єкти з однаковими 

заливками не об'єднує (рис. 10). Слід мати на увазі, що 

при цьому видаляються параметри обведення. Після 

застосування кнопки Trim (Обрізка) все утворені 

об'єкти залишаються в групі, для вільного 

маніпулювання окремими об'єктами слід виконати 

команду Ungroup (Розгрупувати) меню Object (Об'єкт). 

Якщо необхідно таким же чином об'єднати всі 

контури, що входять в групу або розташовані на шарі 

(подслое), слід використовувати команду Trim 

(Обрізка) меню Effect | Pathfinder (Ефект | Обробка 

контурів). Це саме можна сказати і до шрифтовим 

об'єктів. 

 Рис. 10. Вихідні об'єкти і результат дії 

кнопки Trim, отримані об'єкти 

розгрупувати і розведені 

Кнопка Merge (Злиття) комбінує виділені об'єкти таким чином, що видаляє всі частини 

об'єктів, які є прихованими, при цьому об'єкти з однаковими заливками об'єднуються (рис. 

11). Слід мати на увазі, що при цьому видаляються параметри обведення. Після застосування 

кнопки Merge (Злиття) все утворені об'єкти залишаються в групі, для вільного 

маніпулювання окремими об'єктами слід виконати команду Ungroup (Розгрупувати) меню 

Object (Об'єкт). Якщо необхідно таким же чином об'єднати всі контури, що входять в групу 

або розташовані на шарі (подслое), слід використовувати команду Merge (Злиття) меню 

Effect | Pathfinder (Ефект | Обробка контурів). Це саме можна сказати і до шрифтовим 

об'єктів. 



242 

 

Рис. 11. Вихідні об'єкти і результат дії кнопки Merge, отримані об'єкти розгрупувати і розведені 

Кнопка Crop (Обрізати) комбінує виділені об'єкти таким чином, що видаляє всі 

частини об'єктів, які виходять за межі самого верхнього об'єкта (рис. 12). Верхній об'єкт 

після застосування кнопки видаляється, а все утворені об'єкти залишаються в групі. Для 

вільного маніпулювання окремими об'єктами необхідно виконати команду Ungroup 

(Розгрупувати) меню Object (Об'єкт). Слід мати на увазі, що при цьому видаляються 

параметри обведення. 

 

Рис. 12. Вихідні об'єкти і результат дії кнопки Crop, отримані об'єкти розгрупувати і розведені 
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Якщо необхідно таким же чином об'єднати всі контури, що входять в групу або 

розташовані на шарі (подслое), слід використовувати команду Crop (Обрізати) меню Effect | 

Pathfinder (Ефект | Обробка контурів). Це саме можна сказати до шрифтовим об'єктів. 

Завдання: Вивчити роботу з об’єктами  і обробити контури. 

Порядок виконання роботи 

1. Створіть два графічних елемента: коло і прямокутник подібні до наданих у прикладі 

(Рис., 1). 

2. На панелі комбінуємо виділені об'єкти таким чином, що контуром результуючого 

об'єкта є область перетину об'єктів (Рис., 2). 

3. Комбінуємо виділені об'єкти таким чином, що не перетинаються області входять в 

результуючий об'єкт, а пересічні - «виключаються», робляться прозорими (Рис., 3). 

4. Об'єднати всі контури, що входять в групу або розташовані на шарі (подслое), то 

слід використовувати команду Exclude (Виняток) меню Effect | Pathfinder (Ефект | 

Обробка контурів). (Рис., 4). 

5. Кнопкою Divide (Поділ) на панелі виконуємо в певному сенсі протилежну дію в 

порівнянні з комбінуванням: вона розбиває складний об'єкт на прості об'єкти (Рис., 

5). 

6. Збережіть роботу натиснувши Ctrl + S. 

 

Рис., 1     Рис., 2     Рис., 3 

 

 

 

 

 

 

 

 

 

 

Рис., 4      Рис., 5 

 

 

 

 

 

 

Питання для самоконтролю 

1. Чи можливо тимчасово приховати зображення на певних шарах? 

2. Чи можна об’єднати всі контури в одну групу? 

3. Яким чином можливо розбити складні об’єкти на складні? 
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РОБОТА З КОНТУРАМИ ТА ЗАЛИВКАМИ 

Мета роботи: набути навичок з контурами та  надання графічним об’єктам кольору 

заливок та обвідок. 

Створювати і редагувати контури можна за допомогою інструментів з груп Pencil 

(Олівець) і Pen (Перо), а також інструментами Brush (Кисть), Spiral (Спіраль) і Arc (Дуга). 

Прямокутники (Rectangle), закруглені прямокутники (Rounded Rectangle), еліпси (Ellipse), 

багатокутники (Polygon), зірки (Star) і відблиски (Flare), що створюються за допомогою 

відповідних інструментів, - також є контурами. Однак основним інструментом для побудови 

кривих Безьє є Pen, що надає максимальні можливості як для їх створення, так і для 

редагування. 

 

При створенні контурів досить часто доводиться міняти масштаб зображення, 

збільшуючи його при малюванні дрібних деталей і зменшуючи при створенні великих. Для 

швидкої зміни масштабу зручніше користуватися комбінаціями клавіш: Ctrl + «+» (в разі 

збільшення масштабу) і Ctrl + «-» (при його зменшенні). Якщо обраний великий масштаб, то 

зображення не буде вміщатися на екрані і за нього доведеться переміщатися. 

Використовувати ж для цього смуги прокрутки незручно, тому набагато краще з цією метою 

натискати клавішу пробілу (при цьому курсор набирає вигляду руки) і переміщати 

зображення. При відпуску пробілу ви знову повернетеся в звичайний режим роботи. 

Створення контурів інструментами з групи Pencil. Інструмент Erase працює звичайним 

чином: для стирання окремих фрагментів контуру треба лише поводити ластиком уздовж 

переться фрагмента. Намалюйте, наприклад, звичайну зірку (рис. 1), а потім спробуйте 

ластиком акуратно видалити точки контуру в її вершинах (рис. 2). 

 
Рис. 1. Початкове зображення контуру Рис. 2. Зовнішній вигляд контуру після видалення вершин 

  

Спробуємо скористатися цією можливістю в процесі створення зображення казкового 

павука. Спочатку намалюйте звичайну коло (мал. 3) і виділіть її інструментом Direct 

Selection, утримуючи клавішу Shift (клацати потрібно не по всьому колу, а по її опорних 

точках) - в результаті коло не просто виділиться, але у неї будуть позначені напрямні лінії 

(рис. 4). Тепер інструментом Pen, утримуючи клавішу Alt перетягніть кутові точки нижньої 

напрямної так, щоб окружність перетворилася в еліпс, звужений в нижній частині (рис. 5). 
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Щоб перенести точки симетрично, краще попередньо включити сітку інструментом 

Restangular Grid, орієнтуючись по вузлах якої, буде простіше визначити потрібні положення 

направляючих крапок. Потім виділіть отриману криву інструментом Selection і стисніть. 

Залийте контур відповідним градієнтом (рис. 6). 

 
Рис. 3. Вигляд стрілки    Рис. 4. Зовнішній вигляд з направляючою 

 
Рис. 5. Результат переміщення  Рис. 6. Остаточний вигляд  

кутів точок нижньої направляючої 

 

Зробіть дві копії створеного контуру, зменшіть їх в розмірах, змініть заливку і 

розмістіть на оригінальному документі (рис. 7) - це буде перший очей павука. Виділіть всі 

елементи очі інструментом Selection, для зручності об'єднайте їх в групу командою Object => 

Group (Об'єкт => Група) і скористайтеся командою Effect => Warp => Twist (Ефект => 

Деформація => Вигин) при таких, наприклад, параметрах, як на (рис. 8). Потім продублюйте 

очей, зробивши його дзеркальну копію по 

горизонталі за допомогою інструменту Reflect 

(рис. 9). 

 
Рис. 7. Вигляд першого ока 

 

 

 

 

 

Рис. 8. Налаштування параметрів ефектів Twist 

 
Рис. 9. Поява наступного ока 

 

Тепер приступимо до малювання голови. Створіть коло і, не знімаючи виділення, 

помістіть її на задній план - для цього клацніть на колі правою кнопкою миші і з 

контекстного меню виберіть команду Edit => Arrange => Send to Back (Редагування => 

Розмістити => Надіслати на задній план) (рис. 10). Потім змініть її форму інструментом Pen - 

так само, як при редагуванні очі (рис. 11), і зафарбуйте відповідним градієнтом (рис. 12). 
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Рис. 10. Контур голови павука Рис. 11. Результат редагування  інструментом Pen 

 
Рис. 12. Закінчений вигляд голови павука 

 

Домальовуйте павуку тулуб, перемістіть його на задній план і залийте градієнтом. Потім 

інструментом Pen створіть першу ніжку у вигляді звичайної ламаної, підібравши для неї потрібне 

параметру Stroke значення ширини (Weight). Зробіть дзеркальну копію ніжки по горизонталі за 

допомогою інструменту Reflect і перемістіть її відповідним чином. Виділіть обидві ніжки за 

допомогою інструменту Selection і зробіть дві їх копії, застосувавши команди Edit => Copy 

(Редагування => Копіювати) і Edit => Paste (Редагування => Вставити). Активувавши інструмент 

Rotate, поверніть кожну ніжку на потрібне число градусів (в даному прикладі об'єкти першої копії 

були повернені на 20 ° і на -20 ° відповідно, а другий - на 35 ° і на -35 °). Відкоректуйте положення 

кожної ніжки, і отриманий вами результат буде походити на (рис. 13). 

 
Рис. 13. Зовнішній вигляд павука після добавлення тіла та ніжек  
 

І нарешті, для більшого ефекту на голову і тулуб павука, попередньо виділивши їх 

інструментом Selection, утримуючи клавішу Shift, необхідно накласти фільтр Roughen командою 

Filter => Distort => Roughen (Фільтр => Спотворення => Шорсткість) з такими приблизно 

параметрами, як на (рис . 14). Результат представлений на (рис. 15). 

 

 
Рис. 14. Налаштування параметрів ефектів Roughen 

 

 

Рис.15. Закінчений вигляд павука 
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СПОСОБИ РОЗФАРБОВУВАННЯ 

Намалювавши об'єкт, можна застосувати до нього заливку, обведення або і те, і інше. 

Після цього можна намалювати інші об'єкти і розфарбувати їх подібним же чином, маючи в 

своєму розпорядженні кожен новий об'єкт поверх попередніх. В результаті виходить щось 

подібне колажу з фігур, вирізаних з кольорового паперу. Зовнішній вигляд ілюстрації 

залежить від того, які об'єкти знаходяться поверх інших в добірці об'єктів. 
 

 

Розфарбовування групи з швидкою заливкою   

 
 

Об'єкт, що складається з одного контуру і розфарбований з застосуванням однієї заливки і 

однієї обведення (зліва). Той самий об'єкт, перетворений в групу з швидкою заливкою, можна 

розфарбувати із застосуванням різних заливок для кожної грані і різних обводок для кожного краю 

(праворуч). 

 
 

При розфарбовуванні об'єкта традиційним способом залишаються ділянки, до яких 

неможливо застосувати заливку (зліва). Розфарбовування групи з швидкою заливкою за 

допомогою функції виявлення зазорів (в центрі) дозволяє уникнути зазорів і накладення 

(праворуч). 

Заливка - це колір, візерунок або градієнт всередині 

об'єкта. Можна застосовувати заливки до відкритих і закритих 

об'єктів і до граней в групах з швидкою заливкою. 

Обведення може бути видимим зовнішнім контуром 

об'єкта, контуру або краю в групі з швидкою заливкою. Для 

обведення можна задати ширину і колір. Крім того, можна 
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створювати пунктирні обведення за допомогою параметрів «Контур» і розфарбовувати 

стилізовані обведення, використовуючи кисті.  

Поточні кольори заливки та обведення відображаються на панелі «Інструменти». 

Завдання: Вивчити контури та їх заливки. 

Порядок виконання роботи 

1. Намалюйте звичайну коло (мал. 1) і виділіть інструментом Direct Selection. 

2. Тепер інструментом Pen, утримуючи клавішу Alt перетягніть кутові точки нижньої 

напрямної так, щоб окружність перетворилася в еліпс, повторіть текіла разів щоб вийшло око 

(рис. 2). 

3. Малюємо голову. Створіть коло і, не знімаючи виділення, помістіть її на задній план 

Edit => Arrange => Send to Back (Редагування => Розмістити => Надіслати на задній план) (рис. 

3). Потім змініть її форму інструментом Pen. 

4. Малюємо тулуб, потім інструментом Pen створіть першу ніжку у вигляді звичайної 

ламаної, підібравши для неї потрібне параметру Stroke значення ширини (Weight). Зробіть 

дзеркальну копію ніжки по горизонталі за допомогою інструменту Reflect і перемістіть її 

відповідним чином. Виділіть обидві ніжки за допомогою інструменту Selection і зробіть дві 

їх копії, застосувавши команди Edit => Copy (Редагування => Копіювати) і Edit => Paste 

(Редагування => Вставити). Активувавши інструмент Rotate, поверніть кожну ніжку на 

потрібне число градусів (в даному прикладі об'єкти першої копії були повернені на 20 ° і на -

20 ° відповідно, а другий - на 35 ° і на -35 °). Від коректуйте положення кожної ніжки, і 

отриманий вами результат буде походити на (рис. 4). 

5. На голову і тулуб павука, попередньо виділивши їх інструментом Selection, 

утримуючи клавішу Shift, необхідно накласти фільтр Roughen (рис. 5). 

 
Рис. 1 Рис. 2 Рис. 3 Рис. 4 Рис. 5 

 

Питання для самоконтролю 

1. Що треба зробити щоб окружність перетворилася еліпс? 

2. Як зробити дзеркальне відображення? 

3. Яким чином можливо задати колір? 
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РОБОТА З ТЕКСТОВИМИ РЯДКАМИ 

Мета роботи: набути навичок роботи з текстом та рядками. 

Введення тексту у точці 

Текст від точки - це горизонтальний або вертикальний рядок тексту, що починається 

там, де ви клацнули мишею, і продовжується в міру введення символів (Рис. 1).  

1. Оберіть інструмент «Текст»  або Інструмент «Вертикальний текст» . Вказівник 

набуде вигляду «І» з пунктирним квадратиком. Невеличка 

горизонтальна риска внизу І-вказівника позначає позицію базової 

лінії, на яку лягатиме текст. 

2. Встановіть параметри форматування тексту на панелі керування, 

панелі «Символ» або «Абзац». 

3. Клацніть, де бажаєте почати рядок тексту. 

4. Введіть текст. Натисніть Enter або Return, щоб розпочати новий 

рядок тексту в межах того самого текстового об’єкта. 

5. Коли ви закінчите вводити текст, клацніть на інструменті 

«Виділення» , аби виділити текстовий об’єкт. Або клацніть на 

тексті, утримуючи Ctrl. 

 

Створити рядки і стовпчики тексту (Рис. 2) Рис. 1 

1. Виділіть об’єкт тексту в області. 

2. Виберіть «Текст»  «Параметри тексту в області». 

3. У розділах «Рядки» і «Стовпчики» діалогового вікна встановіть такі параметри: 

Число - Визначає число рядків і стовпчиків, які має містити об’єкт.  

Середник - Визначає відстань між рядками чи стовпчиками. 

Діапазон - Визначає висоту окремих рядків і ширину окремих стовпчиків. 

Зафіксований - Визначає, що відбувається з діапазоном рядків і стовпчиків, коли ви 

змінюєте розмір текстової ділянки. Коли цей параметр вибрано, зміна розміру ділянки може 

змінити число рядків і стовпчиків, але не їхню ширину. Залиште цей параметр невибраним, 

якщо бажаєте, щоб ширина рядків і стовпчиків змінювалася, коли ви змінюєте розмір текстової 

ділянки. 

 

 

A. - Цільовий документ стовпці 

 

 

 

 

B. - Змінені стовпчики з вибраним 

параметром «Сталий» 

 

 

 

C. - Змінені стовпчики з 

невибраним параметром «Сталий» 

 

 

Рис. 2 Параметри для зміни розміру рядків і стовпчиків 
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4. У розділі «Параметри» діалогового вікна виберіть параметр «Розміщення тексту», 

щоб визначити, як текст має розміщуватися між рядками і стовпчиками: «За 

рядками»  або «За стовпчиками» . 

5. Натисніть «ОК». 

Завдання: Навчитися працювати з рядками та стовпчиками. 

Порядок виконання роботи 

1. Оберіть інструмент «Текст»  або Інструмент «Вертикальний текст» . Вказівник 

набуде вигляду «І» з пунктирним квадратиком. Невеличка горизонтальна риска 

внизу І-вказівника позначає позицію базової лінії, на яку лягатиме текст. 

2. Ввести текст в текстовий блок (Рис. 1). 

3. Розбити текстовий блок на дві, три колонки (Рис. 2, 3) 

 

 

 

 

 

 

 

 

Рис. 1 

Рис. 2 

Рис. 3 
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РОБОТА З ТЕКСТОВИМИ БЛОКАМИ 

Мета роботи: набути навичок роботи з текстовими блоками. 

Введення тексту в області 

Текст в області (також - тип абзацу) використовує межі об’єкта для керування потоком 

символів, як по горизонталі, так і по вертикалі. Коли текст досягає межі, він автоматично 

переноситься, щоб уміститися на визначеній ділянці. Вводити текст в такий спосіб зручно, 

якщо вам потрібно створити більше одного абзацу, наприклад, для брошури. 

1. Визначте обмежувальну ділянку: 

 Візьміть інструмент «Текст»  або «Вертикальний текст»  і перетягніть по 

діагоналі, щоб визначити прямокутну обмежувальну ділянку. 

 Намалюйте об’єкт, який ви бажаєте застосовувати як обмежувальну ділянку. 

Візьміть інструмент «Текст» , «Вертикальний текст» , «Текст в області» 

 або «Вертикальний текст в області»  і клацніть будь-де на контурі об’єкта (Рис. 

1). 

 
Рис. 1 Створення текстової ділянки шляхом перетягування (верх) порівняно з перетворенням 

наявної фігури на текстову ділянку (низ) 

 

2.  Встановіть параметри форматування тексту на панелі керування, панелі 

«Символ» або «Абзац». 

3. Введіть текст. Натисніть Enter або Return, щоб розпочати новий абзац. 

4. Коли ви закінчите вводити текст, клацніть на інструменті «Виділення», 

аби виділити текстовий об’єкт. Або клацніть на тексті, утримуючи Ctrl 

(Windows).  Якщо ввести текст, що виходить за межі області, біля 

нижньої частини обмежувальної рамки з'являється невелике вікно з 

символом «плюс» (+) (Рис. 2). 

 Рис. 2 Приклад переповнення тексту 

 

Ви можете змінити розмір області тексту або розширити контур, щоб нормально відобразити 

весь текст. Також ви можете перенести частину тексту до іншого об’єкта. 

Зміна розміру текстової ділянки 

Щоб змінити розмір, виконайте одну з таких дій: 

 Виділіть текстовий об’єкт інструментом «Виділення» або за допомогою панелі «Шари» і 

перетягніть держак рамки розміру (Рис. 3). 
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Рис. 3 Зміна розміру текстової ділянки інструментом «Виділення» 

 Виділіть край або кут контуру тексту інструментом «Часткове виділення» . Перетягніть, 

щоб налаштувати форму контуру (Рис. 4). 
 

 
 

Рис. 4 Зміна розміру текстової ділянки інструментом «Часткове виділення» 
 

 Виділіть текстовий об’єкт інструментом «Виділення» або скориставшись панеллю «Шари», 

виберіть «Текст»  «Параметри тексту в області». Введіть значення у полі «Ширина» та 

«Висота» і клацніть на «OK». Якщо текстова ділянка не є прямокутною, ці значення 

визначатимуть ширину і висоту рамки розміру об’єкта. 

Зміна поля навколо текстової ділянки 

Працюючи з об’єктом тексту в області, ви можете встановлювати проміжок між текстом. Це 

поле зветься відбиттям (Рис. 5). 

1. Виділіть об’єкт тексту в області. 

2. Виберіть «Текст»  «Параметри тексту в області». 

3. Задайте значення відбиття і клацніть на «OK». 
 

 
 

Рис. 5 Текст без відбиття (ліворуч) порівняно з текстом із відбиттям (праворуч) 
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Зв’язування текстових блоків між об’єктами 

Щоб зв’язати (або продовжити) текст від одного об’єкта до наступного, зв’яжіть об’єкти. 

Зв'язані текстові об’єкти можуть мати будь-яку форму, проте текст повинен вводитися в ділянці або 

вздовж контуру (не в точці). 

Кожен об'єкт тексту в області містить порт вводу і порт виводу, що дозволяють вам зв'язувати 

об'єкти і створювати зв'язані копії текстового об'єкта. Порожній порт показує, що весь текст є 

видимим, і що об’єкт не прив’язано. Стрілка на порті показує, що об’єкт прив’язано до іншого 

об’єкта. Червоний знак плюса на порті виводу показує, що об’єкт містить додатковий текст. Цей 

текст, що залишається невидимим, зветься переповненням тексту (Рис. 6). 

 

 
 

Рис. 6 Порти на зв’язаних текстових об’єктах 

Ви можете розривати низки і розміщувати текст або в першому, або в наступному 

об’єкті, або ви можете усунути всі низки, залишивши текст на місці. 

Зв’язаний текст 

1. Для виділення об’єкта тексту в області скористайтеся інструментом «Виділення». 

2. Клацніть на порті вводу або виводу виділеного текстового об’єкта. Курсор миші 

набуде вигляду значка завантаженого тексту . 

3. Виконайте одну з таких дій: 

 Щоб прив’язатися до наявного об’єкта, поставте вказівник на контур об’єкта. 

Вказівник змінює форму на . Клацніть на контурі, щоб зв’язати об’єкти. 

 Щоб прив’язатися до нового об’єкта, клацніть або перетягніть вказівник по порожній 

ділянці монтажної області. Клацання створює об’єкт того самого розміру і форми, що й 

первинний, перетягування дає вам змогу створити прямокутний об’єкт будь-якого розміру. 

Ще один спосіб зв’язування тексту між об’єктами: виділити об’єкт тексту в області, 

виділити об’єкт, які ви бажаєте зв’язати, потім виберіть «Текст» «Зв’язані текстові блоки» 

«Створити». 

Усунення або розбиття низок 

1. Виділіть зв’язаний текстовий об’єкт. 

2. Виконайте одну з таких дій: 

 Щоб розірвати низку між двома об’єктами, двічі клацніть на порт або будь-який 

кінець низки. Текст розміщується у першому об’єкті. 

 Щоб звільнити об’єкт з текстової низки, виберіть «Текст»  «Зв’язані текстові блоки» 

«Звільнити виділене». Текст розміщується у наступному об’єкті. 

 Щоб вилучити всі низки, виберіть «Текст» «Зв’язані текстові блоки» «Вилучити 

низки». Текст залишається на місці. 

Завдання: Вивчити як розбивати текст на блоки. 

Порядок виконання роботи 

1. Намалювати текстовий блок  

2. Помістити туди текст. 

3. Зв’яжіть між собою текстові блоки. 



254 

Питання для самоконтролю 

1. Що треба зробити щоб помістити текст? 

2. Як намалювати текстовий блок? 

3. Яким чином створити порт між блоками? 
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РОЗТАШУВАННЯ ТЕКСТУ ПО КРИВІЙ 

Мета роботи: набути навичок роботи з текстовими та розміщення його по кривій. 

Текст за контуром лягає вздовж краю відкритого або замкненого контура. Коли ви вводите 

текст по горизонталі, символи лягають паралельно до базової лінії. Коли ви вводите текст по 

вертикалі, символи лягають перпендикулярно до базової лінії. У будь-якому випадку текст лягає у 

напрямку, у якому точки додавалися до контура. 

Введення тексту вздовж контура 

 Щоб створити горизонтальний текст вздовж контура, візьміть інструмент «Текст» або 

інструмент «Текст за контуром». 

 Щоб створити вертикальний текст вздовж контура, візьміть інструмент «Вертикальний 

текст» або інструмент «Вертикальний текст за контуром». 

Переміщення або віддзеркалення тексту вздовж контура 

1. Виділіть об’єкт типу «текст на контурі». 

На початку тексту, у кінці тексту, посередині між початком і кінцем з’являються дужки. 

2. Поставте вказівник на центральну дужку тексту – поряд із вказівником має з’явитися 

маленький значок. 

3. Виконайте одну з таких дій: 

 Щоб перемістити текст вздовж контура, перетягуйте центральну дужку вздовж нього. 

Утримуйте Ctrl (Windows), щоб текст не перекинувся на другий бік контура (Рис. 1). 

 
Рис. 1 Переміщення тексту вздовж контура 

 

 Щоб перекинути текст вздовж контура, змінюючи напрям на протилежний, 

перетягніть дужку через контур. Або виберіть «Текст» «Текст за контуром» «Параметри 

тексту за контуром», виберіть «Віддзеркалити» і клацніть на «OK» (Рис. 2). 

 
Рис. 2 Перекидання тексту вздовж контура 
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Примітка. 

Щоб перемістити текст вздовж контура, не змінюючи напрямок тексту, застосуйте 

параметр «Відхилення від базової лінії» на панелі символів. Наприклад, щоб опустити створений 

текст, розміщений зліва направо вздовж вершини кола, таким чином, щоб він містився всередині 

вершини кола, необхідно ввести від’ємне значення в текстовому полі «Відхилення від базової лінії». 

Застосування ефектів до тексту на контурі 

Ефекти тексту за контуром дають змогу викривляти орієнтацію символів на контурі. Для 

застосування цих ефектів потрібно спочатку створити текст на контурі. 

1. Виділіть об’єкт типу «текст на контурі» (Рис. 3). 

2. Виконайте одну з таких дій: 

 Виберіть «Текст»  «Текст за контуром» і ефект із підменю. 

 Виберіть «Текст»  «Текст за контуром» «Параметри тексту за контуром». Потім виберіть 

параметр в меню «Ефект» і клацніть на «OK». 

Примітка. Застосування ефекту «Гравітація» до тексту на ідеально круглому контурі матиме 

такий самий результат, як і застосування ефекту «Веселка» зі стандартними параметрами. На 

еліптичних, квадратних, прямокутних та інших неправильної форми контурах цей ефект працює 

нормально. 

 

 

Рис. 3 Ефекти тексту за контуром 

Налаштування вертикального вирівнювання тексту за контуром 

1. Виберіть текстовий об’єкт. 

2. Виберіть «Текст» «Текст за контуром» «Параметри тексту за контуром». 

3. Виберіть параметр в меню «Вирівняти за контуром», щоб встановити, як вирівнювати всі 

символи за контуром, відносно загальної висоти шрифту: 

 Верхній виносний елемент - Вирівнює за верхнім краєм шрифту. 

 Нижній виносний елемент - Вирівнює за нижнім краєм шрифту. 

 За центром - Вирівнює за точкою посередині між верхнім та нижнім виносними 

елементами шрифту. 

 Базова лінія - Вирівнює вздовж базової лінії. Це значення параметра є усталеним. 

Завдання: Вивчити як розташовувати текст по кривій. 

Порядок виконання роботи 

1. Намалювати криву та помістити туди текст. 
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2. Перемістити текст вздовж контура, перетягуйте центральну дужку вздовж нього. 

Утримуйте Ctrl (Windows), щоб текст не перекинувся на другий бік контура (Рис. 1). 

3. Перекинути текст вздовж контура, змінюючи напрям на протилежний, перетягніть 

дужку через контур. Або виберіть «Текст» «Текст за контуром» «Параметри тексту за 

контуром», виберіть «Віддзеркалити» і клацніть на «OK» (Рис. 2). 

 

 
Рис. 1 Рис. 2 

Питання для самоконтролю 

1. Що треба зробити щоб помістити текст на криву? 

2. Як намалювати криву? 

3. Яким чином створити ефект до тексту на контурі? 
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РОБОТА З ШАРАМИ 

Мета роботи: набути навичок роботи з шарами. 

Про шари 

Під час створення складних ілюстрацій важко слідкувати за всіма елементами у вікні 

документа. Менші елементи ховаються за більшими, що ускладнює виділення ілюстрації. Шари 

дають можливість керувати всіма елементами, які входять до складу вашої ілюстрації. Вважайте 

шари чистими теками, які містять ілюстрацію. Якщо ви переставляєте теки, ви змінюєте порядок 

стикування елементів у ілюстрації.  

Структура шарів у документі може бути простою або складною в залежності від вашого 

бажання. За замовчуванням всі елементи організовані у вигляді окремого шару. Однак ви можете 

створювати нові шари та переміщати в них елементи або переміщати елементи із одного шару в 

інший у будь-який час. Панель «Шари» забезпечує простий спосіб для виділення, приховування, 

блокування та зміни атрибутів вигляду ілюстрації.  

Огляд панелі «Шари» 

Користуйтеся панеллю «Шари» («Вікно Шари») для створення списку, організації та 

редагування об'єктів у документі. За замовчуванням кожен новий документ містить один шар, кожен 

створений вами об'єкт вноситься до списку цього шару. Однак, ви можете створювати нові шари та 

переставляти елементи так, як буде найзручніше для вас. 

За замовчуванням застосовує певний колір (всього дев'ять кольорів) до кожного шару на панелі 

«Шари». Колір відображується на панелі біля назви шару. Таким самим кольором у вікні ілюстрації 

відображаються рамка, контур, опорні точки та центральна точка виділеного об'єкту. За допомогою 

цього кольору ви можете швидко відшукати місце знаходження відповідного шару об'єкта на панелі 

«Шари», а також можна змінити колір шару у разі потреби. 

Якщо елемент на панелі «Шари» містить інші елементи, зліва від назви елементу з'являється 

трикутник. Клацніть на трикутникові, щоб показати або приховати зміст. Якщо трикутник не 

з'являється, елемент не містить додаткових елементів (Рис. 1). 

 

 Рис. 1 Панель «Шари» 

A. Колонка видимості 

B. Редагувати колонку 

C. Кінцева колонка 

D. Колонка виділення 

Панель «Шари» відображує колонки з лівої та правої сторони списків. Для керування 

наступними характеристиками натисніть у колонці: 

Колонка видимості - Вказує, чи елементи на шарах видимі  чи приховані (пробіл), а також, 

чи є шари шаблонними , чи контурними . 

Редагувати колонку - Вказує, заблоковані елементі чи ні. Значок блокування  показує, що 

елемент заблоковано і його не можна редагувати, пробіл показує, що елемент не заблоковано, його 

можна редагувати. 

Кінцева колонка - Показує, чи елементи призначені для застосування ефектів та атрибутів 

редагування на панелі вигляду. Якщо кнопка призначення з'являється у вигляді значка подвійного 

кільця (або   або ), елемент є кінцевим; значок одного кільця означає, що елемент не кінцевий. 

Колонка виділення - Вказує, чи виділені елементі. Фрагмент кольору з'являється, коли 

виділяється елемент. Якщо елемент, такий як шар або група, містить деякі виділені та невиділені 

об'єкти, біля батьківського елементу з'являється менший фрагмент кольору виділення. Якщо у 
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батьківському елементі виділені всі об'єкти, фрагменти кольору виділення такого ж самого розміру, 

що й позначки, які з'являються поряд із виділеними об'єктами. 

Для відображення деяких шарів як контурів та інших елементів у тому вигляді, в якому вони 

відображатимуться у кінцевій ілюстрації, ви можете скористатися панеллю «Шари». Ви також 

можете затіняти зв'язані зображення та бітові зображення для полегшення процесу редагування 

ілюстрації у верхній частині зображення. Це особливо зручно під час відслідковування бітового 

зображення (Рис. 2). 

 

Рис.2 Відобразити параметри для ілюстрації шарами 

 

A. Об'єкти, які відображуються у перегляді контурів 

B. Бітове зображення затінене на 50% 

C. Виділені об'єкти, які відображуються у перегляді 

«Перегляд» 

 

 

 

Змінення відображення панелі «Шари» 

1. Виберіть панель параметрів із меню палітри «Шари». 

2. На панелі «Шари» оберіть «Показувати лише шари» для того, щоб сховати контури, 

групи та спільні елементи. 

3. Для розміру рядка виберіть параметр для позначення висоти рядків. (Щоб вказати 

персональний розмір, введіть значення від 12 до 100). 

4. Для мініатюр виділіть поєднання шарів, груп та об'єктів, для яких потрібно 

відображати перегляди мініатюр. 

Налаштування параметрів шарів та підшарів 

1. Виконайте одну з таких дій: 

 На панелі «Шари» двічі клацніть на назві елементу. 

 Клацніть на назві елементу та оберіть «Параметри для <назва елементу>» з меню 

панелі «Шари». 

 Оберіть «Створити шар» або «Створити підшар» в меню палітри «Шари». 

2. Вкажіть одне з наступного: 

 Ім'я - Вказує назву елементу, коли він відображується на панелі «Шари». 

 Колір - Вказує налаштовування кольорів шару. Ви можете обирати колір з меню 

або двічі клацнути на зразку кольору для того, щоб визначити колір. 

 Шаблон - Перетворює звичайний шар на шаблон. 

 Блокувати - Не дозволяє змінювати елемент. 

 Показати - Відображує всі ілюстрації, які містяться у шарі на монтажній області. 

 Друк - Робить ілюстрацію, яка міститься у шарі, придатною до друку. 

 Попередній перегляд - Відображує ілюстрації, які містяться у шарі, у кольорі, а не 

у вигляді контурів. 

 Затемнені зображення - Зменшує інтенсивність зв'язаних та бітових зображень, які 

містяться у шарі, до вказаного відсоткового співвідношення. 

Створення шару 

1. На панелі «Шари» натисніть на назві шару, над яким (або у який) ви хочете додати 

новий шар. 
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2. Виконайте одну з таких дій: 

 Для додавання нового шару над виділеним шаром, натисніть кнопку «Створити новий 

шар»  на панелі «Шари». 

 Для створення нового підшару у виділеному шарі, натисніть кнопку «Створити новий 

підшар»  на панелі «Шари». 

Для налаштування параметрів під час створення нового шару оберіть «Створити шар» 

або «Створити підшар» в меню панелі «Шари». 

3. Для різних режимів малювання у Illustrator передбачено такі можливості: 

 Режим малювання позаду автоматично створює новий активний шар позаду наявного 

активного шару. 

 У режимі малювання позаду нові елементи ілюстрації створюються позаду всіх 

об'єктів на виділеному шарі, якщо не виділено жодного об'єкта. 

Переміщення об'єкта в інший шар 

1. Виділіть об'єкт. 

2. Виконайте одну з таких дій: 

 Натисніть на назві потрібного шару на панелі «Шари». Потім оберіть 

«Об'єкт Упорядкувати  Перемістити до поточного шару». 

 Перетягніть індикатор виділеного арт-об'єкта , який розташований справа від 

шару на панелі «Шари», до потрібного вам шару. 

Розподілення елементів між різними шарами 

Команда «Звільнити у шари» перерозподіляє всі елементи, які містяться у шарі, в окремі шари, 

а також може вбудовувати нові об'єкти у кожен шар на основі порядку стикування об'єкта. Ви можете 

скористатися цією функцією для підготовки файлів до роботи веб-анімації. 

1. Натисніть на назві шару або групи на панелі «Шари». 

2. Виконайте одну з таких дій: 

 Для розподілу кожного елементу по новому шару оберіть команду «Звільнити у 

шари» (послідовно) з меню панелі «Шари». 

 Для розподілу елементів між шарами та дублювання об'єктів для створення 

кумулятивної послідовності оберіть команду «Звільнити у шари» (створити) з меню панелі 

«Шари». Об'єкт, розташований найнижче, з'являється у кожному новому шарі, а найвищий 

об'єкт - лише в найвищому шарі. Наприклад, уявіть, що Шар 1 містить у собі коло 

(найнижчий об'єкт), квадрат та трикутник (найвищий об'єкт) (Рис. 3). Дана команда створює 

три шари - один із колом, квадратом та трикутником; один із колом та квадратом; один лише 

із колом. Це зручно для створення послідовностей кумулятивних анімацій. 

 
Рис. 3 Команда «Звільнити у шари» (створити) створює нові шари. 

Об'єднання шарів та груп 

Функції сполучення та зведення шарів подібні, оскільки дозволяють об'єднувати об'єкти, групи 

та підшари в один шар або групу. За допомогою сполучення ви можете виділяти елементи, які хочете 

об'єднати; за допомогою зведення всі видимі елементи у ілюстрації об'єднуються в єдиний шар. Під 
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час застосування кожного з цих параметрів порядок стикування ілюстрації залишається незмінним, 

але інші атрибути рівня шару, такі як відсічні маски, не зберігаються. 

 Для сполучення елементів у єдиний шар або групу, утримуючи клавішу Ctrl (Windows), 

клацніть на назвах шарів або груп, які ви хочете сполучити. Також це можна зробити утримуючи 

клавішу Shift для виділення всіх списків між назвами шару або групи, на які ви натискаєте лівою 

кнопкою миші. Потім у меню панелі «Шари» виберіть команду «Об'єднати виділені». Зауважте, що 

елементи будуть об'єднані у шар або групу, які ви виділяли востаннє. 

Шари можна об'єднувати лише з іншими шарами, які знаходяться на однаковому рівні ієрархії 

на панелі «Шари». Так само підшари можна об'єднувати лише з іншими підшарами, які знаходяться в 

межах одного шару та на одному рівні ієрархії. Об'єкти можуть об'єднуватися з іншими об'єктами. 

 Для об'єднання шарів натисніть на назві шару, у якому ви хочете об'єднати ілюстрацію. Потім 

в меню панелі «Шари» виберіть команду «Виконати склеювання». 

Розміщення елементів на панелі «Шари» 

Коли ви виділяєте елемент у вікні документа, ви можете швидко знайти місце розташування 

відповідного елементу на палітрі «Шари» за допомогою команди «Локалізувати об'єкт». Ця команда 

особливо допомагає при локалізації елементів у згорнутих шарах. 

1. Виділіть об'єкт у вікні документа. Якщо ви виділяєте більше одного об'єкту, 

локалізованим буде об'єкт, що знаходиться на передньому плані порядку стикування. 

2. Виберіть команду «Локалізувати об'єкт» із меню палітри «Шари». Дана команда 

зміниться на команду «Локалізувати шар», якщо параметр «Показувати лише шари» активний. 

Завдання: Вивчити роботу з шарами. 

Порядок виконання роботи 

1. Відкрий панель «Шари» («Вікно Шари») для створення списку, організації та 

редагування об'єктів у документі. 

2. Налаштувати параметри шарів та підшарів відкривши на панелі «Шари» двічі 

клацніть на назві елементу та оберіть «Параметри для <назва елементу>» з меню 

панелі «Шари». Оберіть «Створити шар» або «Створити підшар» в меню палітри 

«Шари». Вкажіть одне з наступного: Ім'я, Колір, Шаблон, Блокувати, Показати, Друк, 

Попередній перегляд, Затемнені зображення. 

3. Розподілити елементи між шарами та дублювати об'єкти  для створення кумулятивної 

послідовності оберіть команду «Звільнити у шари» (створити) з меню панелі «Шари». 

Об'єкт, розташований найнижче, з'являється у кожному новому шарі, а найвищий 

об'єкт - лише в найвищому шарі. Наприклад, уявіть, що Шар 1 містить у собі коло 

(найнижчий об'єкт), квадрат та трикутник (найвищий об'єкт). Дана команда створює 

три шари - один із колом, квадратом та трикутником; один із колом та квадратом; 

один лише із колом. 

Питання для самоконтролю 

1. Де знайти панель шарів? 

2. Які колонки передбачає панель шарів? 

3. Як переміщувати об’єкт в інший шар ? 
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РОБОТА З РАСТРОВИМИ ЗОБРАЖЕННЯМИ 

Мета роботи: набути навичок роботи з растровими зображеннями. 

Про бітові зображення 

Бітові зображення, що ще називаються растровими, для представлення зображень 

використовують прямокутну сітку елементів (пікселів). Кожному пікселеві призначається окреме 

місце і колірне значення. Працюючи з бітовими зображеннями, ви редагуєте пікселі, а не об'єкти чи 

фігури. Бітові зображення – найпоширеніший електронний носій для зображень із плавними 

переходами кольорів, таких як світлини чи цифрові малюнки, бо вони ефективніше представляють 

тонкі градієнти, відтінки й кольори. 

Інструкція з роздільної здатності зображення для кінцевого виводу 

Растрові зображення містять стале число пікселів, що зазвичай вимірюється у пікселях на дюйм 

(ppi). Зображення з високою роздільністю містить більше пікселів (меншого розміру), ніж 

зображення з тим самим друкованим розміром з низькою роздільною здатністю. Наприклад, 

зображення 1 на 1 дюйм з роздільною здатністю 72 ppi містить загалом 5184 пікселів (72 пікселі 

завширшки х 72 пікселі заввишки = 5184). Те саме зображення 1 на 1 дюйм із роздільною здатністю 

300 ppi містило б загалом 90 000 пікселів. 

Для імпортованих растрових зображень роздільна здатність визначається вихідним файлом. 

Для растрових ефектів ви можете задати власну роздільну здатність. Щоб визначити роздільну 

здатність зображення, врахуйте носій, на якому розповсюджуватиметься кінцеве зображення. 

Наведені нижче вказівки допоможуть вам визначити, яка роздільна здатність зображення потрібна: 

Переводимо растрове зображення в векторне  

Може таке статися, що вам раптом знадобиться перевести звичайне растрове зображення у 

векторний формат. Якщо раніше ви ніколи не мали справу з векторною графікою або ж маєте про неї 

вельми невиразні уявлення, то напевно першим, що вам прийде в голову це відшукати в Інтернеті 

програму конвертер, завантажити в неї растрову картинку і як це водиться на виході отримати 

готовий результат. Але не все так просто. 

На так звані конвертери з растра в вектор якраз покладатися і не варто, так як далеко не всі 

вони дають потрібний результат. Велика частина цих програм банально переганяють один формат в 

інший, наприклад в JPG в EPS, але суть від цього не змінюється. А все тому, що растр і вектор це 

принципово різні речі і конвертувати їх безпосередньо ніяк не можна. Якщо растрова картинка являє 

собою набір точок - пікселів, то векторне зображення за своєю суттю є математичною формулою, 

тому і підхід до нього повинен бути зовсім іншим (Рис. 1). 

Рис. 1 

До речі, той же самий EPS може зберігати в собі як векторні, так і растрові об`єкти. І все ж 

спосіб перевести звичайну картинку в вектор існує, тільки називається він не конвертацією, а 

трасуванням або векторизацією. Є два основних типи трасування - ручна і автоматична. При ручному 

трасуванні відкрите в векторному редакторі растрових зображень обводиться по контурах на новому 

шарі, після чого розфарбовується. При автоматичної векторизації всі ці дії виконує програма. 

Наприклад, у векторному редакторі Adobe Illustrator для цих цілей передбачена окрема опція. 

Щоб перевести картинку в вектор відкриваємо її в редакторі, виділяємо її мишкою, після чого в 

верхньому меню вибираємо "вікно" -gt; "трасування зображення" (Рис. 2). 
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Рис. 2 

При цьому відкриється невелика панелька інструментів, де ви можете підібрати найбільш 

підходящий шаблон. За замовчуванням Illustrator переводить зображення в чорно-білий 

векторний "силует" (Рис. 2). 

 

 
Рис. 2 

Для створення ж максимально реалістичного зображення слід вибирати пресет "Фотографія 

високої точності". Замість цього також можна встановити максимальне значення для 

параметра "точність кольору" За допомогою бігунка, при цьому інші параметри будуть підібрані 

автоматично. Перед тим як запустити процес векторизації переконайтеся, що режим як і раніше 

виставлений "колір", а палітра"Полнотоновая". Натисніть кнопку "трасування" і дочекайтеся 

завершення процесу перетворення (Рис. 3). 
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Рис. 3 

Завдання: Вивчити як працювати з растровими зображеннями. 

Порядок виконання роботи 

1. Відкрийте Adobe Illustrator і створіть в ньому новий документ. Для цього клікніть 

пункт меню File -gt; New або натисніть гарячі клавіші Ctrl + O. У вікні в випадаючому 

меню Units задайте Pixels, в полях Width і Height, вкажіть, наприклад, по 500, клацніть 

ОК. У робочій області програми з`явиться створений вами документ. 

2. Виберіть інструмент Rectangle tool (гаряча клавіша M). З його допомогою створіть 

прямокутник на зображенні - це і є векторний об`єкт. 

3. Знайдіть панель налаштувань інструменту (вона знаходиться під головним меню) і 

пограйте з кольором контуру і внутрішньої порожнини створеного об`єкта. 

Налаштування Stroke дозволяє поміняти товщину контуру. Якщо властивості об`єкта 

не змінюються, отже, ви якимось чином зняли з об`єкта виділення. Виберіть 

інструмент Selection tool (гаряча клавіша V) і клацніть по прямокутнику, щоб знову 

його виділити. 

4. За допомогою інструменту Rectangle tool намалюйте ще один прямокутник. Виберіть 

інструмент Pen tool (P), наведіть курсор на один з кутів новоствореного об`єкта, 

зачекайте "х" поруч з ним зміниться на "-", І натисніть ліву кнопку миші. 

Прямокутник перетвориться в трикутник. Використовуючи маркери навколо цього 

об`єкта, зробіть з нього трикутник. 

5. Наведіть курсор до одного з кутів таким чином, щоб він прийняв вигляд дугоподібної 

двосторонньої стрілочки. Це означає, що тепер ви можете обертати об`єкт. Додайте 

його таким чином, щоб він встав вершиною вгору. Колір контуру і внутрішньої 

порожнини цього трикутника можна змінювати таким же чином, як і створеного 

раніше прямокутника. 

6. Перемістіть трикутник трохи вище прямокутника. Тепер створене 

вами зображення має бути схоже на схематичне зображення одноповерхового 

будинку. Щоб зберегти результат, натисніть Ctrl + Shift + S, в вікні вкажіть шлях для 

майбутнього файлу, його формат і натисніть "Зберегти".  

Питання для самоконтролю 

1. Що таке бітові зображення? 

2. Як перевести растрове зображення у векторне? 

2 
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СТВОРЕННЯ ФОТОКОЛАЖУ 

Мета роботи: набути навичок в створенні фото колажу 

Зробити колаж повинні вміти робити всі, хто практикує дизайн і верстку, навіть просто 

любителі. Існує маса варіантів і технологій верстки колажу. Сьогодні ми розглянемо лише один з них. 

Досить простий прийом, підходить для виконання навіть тим хто робить його перший раз - і при 

цьому виглядає досить ефектно. 

Завдання: Вивчити всі параметри для створення фотоколажу. 

Порядок виконання роботи 

1. Виберіть «Файл» «Створити», щоб створити нове пусте зображення. Вкажіть розмір 

зображення на основі значення необхідного розміру друку. 

2. Виберіть меню «Файл»  «Відкрити» і відкрийте перше зображення, яке необхідно 

додати до колажу. Тепер у вас є зображення колажу і перше зображення (рис. 1). 

3. Намалюйте прямокутники довільного розміру та кольору, та помістіть в нього фото 

(рис. 2). 

4. Зробити ефект прямокутнику та виставивши параметри (рис. 3).  

 

Рис. 1 
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Рис. 3 

Питання для самоконтролю 

1. Що таке фото колаж? 

2. Як помістити малюнки на заданий формат? 

3. Як задати ефекти об’єктам? 

  



267 

СТВОРЕННЯ АФІШНО-ПЛАКАТНОЇ АКЦИДЕНЦІЇ 

Мета роботи: набути навичок в створенні афіш та плакатів 

Завдання: Вивчити всі параметри для створення афіш  та брошур. 

Порядок виконання роботи 

1. Виберіть «Файл» «Створити», щоб створити нове пусте зображення. Вкажіть розмір 

зображення на основі значення необхідного розміру друку. 

2. Виберіть меню «Файл»  «Відкрити» і відкрийте перше зображення, яке необхідно 

додати до колажу. Тепер у вас є зображення колажу і перше зображення. 

3. Намалюйте текстовий блок на малюнку який помістили на основне поле (рис. 1). 

4. Вибрати шрифт для тексту, розмір літек, виділивши текст задати йому колір та контур 

літер (рис. 2).  

5. Зберегти файл. 
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